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Introducing Unifier uDesigner 

Within our documentation, some content might be specific for cloud deployments while other 
content is relevant for on-premises deployments. Any content that applies to only one of these 
deployments is labeled accordingly. 

The uDesigner module is a design tool for those customers who want to create and publish their 
own customized shells, managers, and business processes. The uDesigner module enables you 
to create your own shells and managers, and any combination of forms and workflows to 
automate business processes, such as funding requests, commits, spends, maintenance 
records, or any other process used by capital project, sustaining, or site operations personnel. 

After you have created a shell, manager, business process or other entity in uDesigner, you can 
configure, setup, and test your designs in both the Development environment and Test 
environment for completeness and functionality.  

Note: The instructions and information presented in the Unifier 
documentation is based on an out-of-the-box setup and before being 
customized by the user.  

The Development, or Test, environment replicates the Unifier Production environment. 

Once the element has been tested and meets your requirements, it can be imported into the 
Unifier Production environment and used by Unifier users.  

Note: The uDesigner users must be experienced in using Unifier and 
must have a solid understanding of business processes, forms, and 
workflows. 

In uDesigner, you design and create the following Unifier components: 

 Shells: Using attribute forms 

 Managers: Using attribute forms 

 Business processes: Using forms, workflows, logs, pickers, and other elements 

To create shells, managers, and business processes, you must first define the following 
components, as needed: 

 Data definitions 

 Data elements 

 Statuses 

 Dynamic data sets  

 Data pickers 

In This Section 

Before Using uDesigner ........................................................................................... 12 
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Before Using uDesigner 

This guide assumes that you and your company, along with the help of Oracle Consulting 
Services group, have completed a detailed "top-down" analysis of your business goals and 
needs. 

Top-Down Analysis 

A top-down analysis of your business goals means that you have: 

1) Defined the goal of each of your business processes and designed the organization of your 
data, typically into shells and managers. 

2) Outlined the workflow each business process should follow. 

This outline should help you see where you need a sub-workflow or a conditional routing, 
and clarify the soundness of the business process before you solidify it. 

3) Translated this workflow into one that will be usable in Unifier. 

This will help you decide on the forms that will be necessary for each step in the process. 
Knowing what forms you will need at each step and what fields should be on each form will 
make designing the rest of the business process easier and more efficient. 

4) Gained a thorough understanding of the data flow in your company so that you know where 
data from one business process must flow into another business process. 

5) Determined the statuses each form should be in at every step in the workflow, for example, 
open, closed, pending, or waiting for approval. 

6) Designed the forms you need to accompany the workflow, for example purchase orders, 
invoice approvals, document transmittals, or asset forms, including all the fields that should 
be on these forms. 

This should help you organize the data you want for upper and detail forms, and help you 
determine exactly how the form will be used in the workflow. 

7) Determined the data elements that will support these fields, and how the data will be stored 
in Unifier. 

Once you have completed this analysis and design, you will then be ready to create the 
business processes, shells, or managers with uDesigner. 

Bottom-Up Design 

In uDesigner, you will be creating business processes, shells, or managers from the bottom up; 
that is, you will be creating each piece of the business process, beginning with elemental details: 

Data definitions To support how data is entered and stored in Unifier 

Data elements To create the fields on the forms 

Statuses 
For records, line items, and assets to indicate their 
condition or state during their life cycle in Unifier 
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Attribute or detail forms 

To launch the Unifier managers (Asset, Cost, Document, 
etc.) and collect information about costs, funds, 
documents, schedule activities, resources, plans, assets, 
facilities, and shells that is not relevant to the steps in a 
workflow 

Forms For users to fill out in Unifier 

Workflows 
To specify how a business process should proceed, from 
start to finish 

Logs 
To contain all the records that were created in Primavera 
Unifier during runtime 

For more detailed information on these components, see Business Processes Overview (on 
page 13). 

Business Processes Overview 

A Business Process (BP) is a set of coordinated tasks and activities that lead to the 
accomplishment of a specific business goal. For example, creating, routing, and approving a 
purchase order is a business process. Most business processes include a workflow that 
specifies how the BP should proceed, from start to finish. 

By using uDesigner, you will be launching the business process and designing its components. 
You will be designing forms that users fill out in Primavera Unifier. In Primavera Unifier, these 
forms drive the business process. For most BPs, these forms will become attached to the steps 
in a workflow that you design. As part of the workflow, users will use these forms to collaborate 
as a team to complete the business process. The users will fill in the forms with the "who, what, 
where, and when" information for each business process, as well as the information they will 
need to run the project—to maintain action items, manage document archiving, track workflow 
tasks and milestones, communicate and collaborate with project team members, and generate 
project reports. 

In uDesigner, you will also design Logs that will list the records that were created whenever the 
business process completed its cycle through the workflow and whenever a record is created for 
a manager or shell. 

To help you prepare for designing business processes, Unifier provides an outline of how to 
analyze your business goals and needs. Oracle Consulting Services often provides the initial 
analysis of these; however, it helps to re-acquaint yourself with this analytic approach whenever 
you need to create a new business process. This outline is described under Before Using 
uDesigner (on page 12). 

Business Process Components 

To create business processes, you need to design and create the following components in 
uDesigner: 
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Data 
Definitions 

To support how data is entered and stored in Primavera Unifier: 

Data definitions are the building blocks on which you create data 
elements. Data definitions describe how data is entered into Primavera 
Unifier and stored. The definition consists of the data type (whether it is 
an alphabetical string or a number), the data size (in number of 
characters for strings), and the input method (from a text box, 
pull-down menu, radio button, or check box). Unifier has provided a 
number of standard data definitions for your use in uDesigner. You can 
add others of your own. 

(Optional) To support data pickers: 

If you are designing a business process that will operate across shells, 
data pickers will help Primavera Unifier users locate and pick the 
correct BP records within the hierarchy. A data picker filters the 
information that appears on the picker so that users do not have to 
search through a multitude of records in the shell hierarchy. 

Data Elements To create the fields on the forms: 

Data elements are the fields the users see on the forms in Primavera 
Unifier. A data element can be a text box, where the user types in 
information; a pull-down menu of choices, such as dates or names; 
radio buttons, where the user must select one of the options presented; 
or a check box, where the user has the option of choosing something 
or not. The behavior of a data element is governed by the data 
definition associated with it. 

Using uDesigner, you can create a "dictionary" of elements that can be 
re-used on multiple business process forms, asset classes, and 
attribute forms. 
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Statuses For records, line items, and assets to indicate their condition or state 
during their life cycle in Primavera Unifier: 

 A record status indicates the position a form is in at any point in 
the business process, such as "approved," "pending," or "closed." 
Each business process produces at least one, and sometimes 
many, transactions during its workflow. At each step, the Primavera 
Unifier user must apply a record status to the form. The status is 
the action designated as the link between two steps in the 
workflow. The action the link takes appears in Primavera Unifier as 
a choice the user makes on the form. This choice moves the task to 
the next step. When creating a business process, you will be 
specifying what statuses the user can choose from at the 
completion of each step in the workflow. You can mark a status as 
active or inactive when you create a business process, and you can 
later update the status as well. Inactive statuses are not displayed 
to users when they create new records. 

 A line item status indicates the position of a line item at any point 
in the business process. It is distinct from a record status, and 
unlike a record status, it is not a visible part of a workflow; rather, a 
line item status is part of the form that moves through the workflow. 
For example, a document BP might bundle several documents 
together for review. Each document in the bundle is represented as 
a line item and as such, can be given a separate status: One 
document can be approved, while another can be sent back for 
editing. Each line item must be given a status. 

 Asset statuses differ from other statuses. Instead of affecting the 
disposition of a BP or line item, an asset status controls which 
assets are displayed on an asset class sheet. For example, a user 
might want the sheet to show assets that are in "Out of Service" 
and "Decommissioned" status. 

Forms For users to fill out in Primavera Unifier: 

Forms are what users see and fill out in Primavera Unifier; they drive 
the business processes. For most BPs, these forms become attached 
to the steps in a workflow for the purpose of exchanging information. 
As part of the workflow, users fill in the forms with the information they 
will need to run the project—to maintain action items, manage 
document archiving, track workflow tasks and milestones, 
communicate and collaborate with project team members, and 
generate project reports. 
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Workflows 

(Optional) 

To specify how a business process should proceed, from start to finish:

Workflows define how records are routed and govern the behavior of 
each step in the business process. Each step uses the forms that you 
have created in uDesigner. 

 Most business processes will include a workflow or workflows; 
however, some business processes have a single purpose of storing 
data. These business processes are called non-workflow BPs. An 
example of a non-workflow BP is one or more forms that record contact 
and other general information about a company. 

Logs To contain all the records that were created in Primavera Unifier for a 
manager, shell, or business process: 

Every manager, shell, and business process includes a log. This log 
contains all the records that were created in Primavera Unifier for this 
component; and for business processes, all the records that were 
created during the BP's runtime, from creation to archive. The logs 
contain one record for each transaction that occurred. Each record 
contains all the information that was generated during the transaction, 
including the forms, documents, comments, and other data that was 
collected. 

To create a tree structure for data pickers: 

You can design a special Picker log to create a tree structure for data 
pickers. This tree structure makes it easier for the Primavera Unifier 
user to select the correct record from a log. (For more information on 
this log, see Designing a Business Process Log (Standard or 
Picker) (on page 412). For more information on data pickers, see 
About Data Pickers (on page 195).) 

Each business process type requires specific pieces to make up the forms it will use. The forms 
can consist of: 

Upper Form The upper form contains the basic information the form is managing, 
such as the name of a record and its description, who created the 
record and when, and so on. It also contains general data entry, 
informational, or reference fields for the business process form. 

Detail Form Most detail forms are for the purpose of adding or modifying line items 
on certain types of BPs. For planning purposes, detail forms are used 
to enter new planning items. For schedule purposes, they are used to 
enter the activities that will appear on a schedule. 

Item Log This list displays items at the bottom of a BP form that have been 
added to a BP record, such as WBS cost codes or document 
attachments. 

Line items can be organized under multiple tabs to make accessing 
information easy for complex processes. 

Text Entry 
Form 

This is an area at the bottom of a BP form where users can directly 
enter text. 
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Response List This is an area at the bottom of a BP form where the user can add and 
organize text comments or file attachments. 

Business Processes Types 

A review of Primavera Unifier Business Process (BP) types will help you understand how they 
work and what is required to make them operate effectively.  

Some BPs employ different sub-types and classifications. For these BPs, the sub-type 
determines what type of code the BP will use, for example, a Fund or a CBS code. 

The classification dictates the behavior of the BP. For example, a Base Commit classification of 
a Cost Type BP can create a Schedule of Values (SOV) sheet and General Spends 
classification can create an invoice at the CBS level. 

The following sections explain each BP type and provides details. 

 Cost Type: Line Items with CBS Code (on page 20) 

 Cost Type: Line Item with Fund Code (on page 25) 

 Cost Type: Line Items with Both CBS and Fund Codes (on page 26) 

 Cost Type: Commit at Company Level (on page 28) 

 Cost Type: Line Items with Company Account Code (on page 29) 

 Cost Type: Line Items with Asset Code (on page 33) 

 Document Type (on page 41) 

 Generic Cost: Line Items with Multiple Codes (on page 34) 

 Line Item Type (on page 43) 

 Project/Shell Creation (on page 59) 

 Request for Bid (RFB) (on page 50) 

 Resource Booking (on page 55) 

 Simple Type (on page 49) 

 Text Type (on page 42) 

 TimeSheet (on page 57) 

Cost Type 

Cost type BPs employ different sub-types and classifications. The sub-type determines what 
type of code it will use, such as a fund or CBS code. The classification dictates the behavior of 
the BP. For example, a Base Commit classification of a Cost Type BP can create a schedule of 
values; a General Spends classification can create an invoice at the CBS level. 

The following explains the sub-types, and the associated classifications, of Cost-type BPs 
(Company Workspace > Admin mode > uDesigner node > Business Processes > click New 
from the log window > Cost > Edit Studio window > General tab > Sub-Type): 

Sub-Type Classification
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Sub-Type Classification

Commit at company level No classification 

Line Items with CBS 
Code 

 Generic 

 Base Commit 

 Change Commit 

 Transfer 

 General Spends 

 Payment Applications 

Line Items with Fund 
Code 

 Generic 

 Transfer 

Line Items with both CBS 
and Fund Codes 

 Generic 

 Transfer 

Line Items with both CBS 
and WBS Codes  

No classification 

Line Items with Company 
Accounts Code 

 Generic 

 Transfer 

Line Items with Asset 
Code 

No classification 

Line Items with Multiple 
Code 

 Generic 

 Base Commit 

 Change Commit 

 Transfer 

 General Spends 

 Lease 

 Reservation 

The following explains the Cost-type BPs classifications: 

Classification Description

Generic Use this for miscellaneous line item BPs that do not directly 
relate to commitments, change commits, spends, or 
funding. 

Transfer Use this for transferring currency from one account or line 
item to another. 
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Base Commit Use this for: 

 Monies committed to be spent; for example, a contract 
or purchase order 

 Creating an SOV for a general spends or pay application

Change Commit 

A Change Commit must 
reference a Base 
Commit. 

Use this for: 

 Changing or adding to a previous base commit 

 Modifying a general spends or pay application SOV 

General Spends 

A General Spends must 
reference a Base 
Commit. 

Use this for monies to be spent; for example, an invoice or 
partial payment of services, often charged against a prior 
commit. 

Payment Applications This BP will create an SOV from the detail form. It will also 
support complex calculations, such as retainage, stored 
materials, paid-to-date, and payment based on percentage 
complete. Use this for: 

 Scheduling payments against construction contracts 

 Tracking/viewing previous and current payments made 
against these contracts 

 Rolls up to the Cost Manager 

The Statuses tab of the Cost-type BPs (Company Workspace > Admin mode > uDesigner 
node > Business Processes > click New from the log window > Cost > Edit Studio window > 
Statuses tab) lets you specify the following statuses for a given record, as the record moves 
through a workflow, or during the records use in Unifier:  

 Pending 

 Approved 

 Rejected 

 Open 

 Closed 

 In_Service 

 Under_Maint 

 Review 

 Certified 

 Deployed 

 Certify 

 Created 

 Cancelled 

 Original_Approved 

 Change_Approved 

 Error_Cancel 
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 Active 

 Estimated 

 Quoted 

 Negotiated 

 Final 

 Final_Approved 

 Inactive 

 Withdrawn 

 Canceled 

A status indicates the condition or state of a record at any point in its life cycle. Statuses will vary 
according to the type of record. To include a status, click Add. You can select multiple statuses, 
from the list. 

Statuses are necessary for a non-workflow business process to: 

 Designate the record final disposition 

 Keep the record active and editable 

 Close it to any further activity 

Note: By default, all existing statuses for a non-workflow business 
process are defined as Active and the Inactive column is blank. 
Deactivating a Record Status affects a status if the user updates an 
existing business process record and requires the user to select a 
different status. (Inactive Record Statuses are not displayed to users 
when they create new records.) 

To make entering line items easier for the user, you can set a default status, such as "Pending," 
for all the new line items. To do so, select the status and click Default. 

The statuses for records must include at least one terminal status; otherwise, the workflow 
cannot be completed. To make a status terminal, select the status and click Terminal. You can 
define more than one terminal status. 

Note: You can use a terminal record status to trigger certain functions 
outside the scope of the business process or to make external data 
easily accessible from the business process or form. 

Cost Type: Line Items with CBS Code 

The Cost Type--Line Items with CBS Code Business Process (BP) type: 

 Is used for Project/Shell cost transactions. 

 Directly affect the budget and relate to the Project/Shell Cost Sheet. 

Use the Cost Type--Line Items with CBS Code BP type for a BP that includes a CBS picker to 
reference CBS codes. 

Use the Cost Type--Line Items in a: 

 Standard Project 
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 Shell that uses the Standard Cost Manager 

The Cost Type--Line Items with CBS Code has the following classifications: 

 Generic 

 Transfer 

 Base Commit 

 Change Commit 

 General Spends 

 Payment Applications 

The following explains each of the classifications in detail: 

Generic

 To use for miscellaneous Line Items BPs that do not directly relate to commitments, change 
commits, spends, or funding. 

 Use it to automate fund consumption at a specific status (not necessarily a terminal status). 

Transfer

To use for transferring currency from one account or line item to another. 

Base Commit

 For monies committed to be spent; for example, a contract or purchase order. 

 For creating a Schedule of Values (SOV) sheet for a General Spends, Payment Applications, 
or Summary Payment Applications. 

Note: In Standard Cost Manager, the Base Commit BP creates a 
Schedule of Values (SOV) sheet. 

Change Commit

 For changing or adding to a previous Base Commit. 

 For modifying a General Spends, Payment Applications, or Summary Payment Applications. 

Note: A Change Commit must reference a Base Commit. 

General Spends

For monies to be spent; for example, an invoice or partial payment of services, often charged 
against a prior commit. Can be used for invoicing at the CBS or breakdown level. A General 
Spends BP does not calculate retainage, stored materials, etc. 

Note: A General Spends must reference a Base Commit. 

Payment Applications

 To create an SOV from the Detail Form. 

 Supports complex construction calculations, such as retainage, stored materials, 
paid-to-date, and payment based on percentage complete. Use for invoicing at the CBS or 
breakdown level. Payment Applications auto-populate data to and from the SOV to manage 
balance-forward formulas. 
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 For scheduling payments against construction contracts. 

 For tracking/viewing previous and current payments made against these contracts 

 For rolls up to the Cost Manager 

Note: A Payment Application must reference a Base Commit. 

For the Business Processes of Type: Cost, Sub-Type: Line Items with CBS Code, Classification: 
Payment Applications, the "Previous Payment Calculation" option in the BP Properties 
enables you to select additional data element for calculating the total previous payments from 
the payment application. This field (drop-down) enables you to select which value to add to the 
total previous payments. The values are:  

 Amount 

 Balance to Finish 

 Completed and Stored To Date 

 Material Stored Retainage Amount 

 Requested This Period 

 Work Retainage Amount 

Transient Record Funding Option 

Once a BP record reaches the terminal status (the end step of a workflow), the user cannot 
assign funds, even if the end step is using an Action form. For example, a user sends an invoice 
that is pending (a Transient Record) to the finance department for approval. The finance 
department approves the fund assignment. The invoice reaches the terminal status (the end 
step of a workflow). The process is confirmed and the invoice gets funded. In this example, once 
the funds have been assigned to the invoice, the funds cannot be changed and the fundings 
override any manual fund assignments, on an Action form, at the end step of a workflow. 

The "Transient Record Funding Option" is available for the following Cost Type--Line Items with 
CBS Code classifications: 

 Generic 

 General Spends 

 Pay Application 

 Summary Pay Application 

These classifications of Cost Type--Line Items with CBS Code allow you to design a BP that the 
user can: 

 Assign funds to 

 Route the BP record for review 

 Make changes to 

 Confirm the fund sources before the BP record reaches a terminal status (the end step of a 
workflow) 

Design Requirements for Line Items with CBS Code Business Processes 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 
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 Upper form 

 Detail form 

 Line Item List 

 Workflow 

 Log 

In order to see the same Data Elements (DEs) on the Detail Form of a Cost-type Business 
Process, you need to add the DEs to the:  

 Detail Form, or the Item Log, of the Business Process. 

 Cost Code Attribute Form. 

Design Flow 

The following outlines, and explains, the design steps necessary to create this business 
process. 

1. Create a data structure (if necessary) 

This structure will include the data elements to be used on the forms. If the data structure has 
not already been created, see the instructions beginning with Creating a Data Structure (on 
page 189). 

2. Start the design

This step initializes the design process for the BP. See Starting a New Design (Edit Studio)
(on page 219). 

3. Design an upper form

See the instructions beginning with Designing an Upper Form (on page 257). 

4. Design a detail form

See the instructions beginning with Designing Detail Form (on page 291). Also: 

For this 
classification:

These fields are mandatory:

Base Commit  Amount (amount) 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

If the transaction currency is different from project currency, include a 
currency picker (currencyid) on the form. 

Change 
Commit 

 Amount (amount) 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

 Reference (ref_bpo_lineitem) 

If the transaction currency is different from project currency, include a 
currency picker (currencyid) on the form. 
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Spends  Amount (amount) 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

Generic  Amount (amount) 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

Payment 
Application 

 Scheduled value (scheduled_value) 

 Amount (amount) 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

Transfer  Amount (amount) 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

5. Create a line item list

See Adding an Item Log to a Detail Form (on page 291). 

6. Create a workflow

See the instructions beginning with Starting a Workflow (on page 394) 

7. Create a log

See Designing a Business Process Log (Standard or Picker) (on page 412). 

Data Elements Properties for Auto Populate 

The Auto Populate window contains the following fields and options:  

 Destination Element

 Source Name

 Source Element

 Do not get latest SOV values when merging

Do not select the Do not get latest SOV values when merging option for 
scheduled_value, uuu_unit_price, and the system-defined uuu_spa_prev_amt
because they are predefined data elements that receive the latest values from SOV, when 
the SOV is updated by a Change Order. 

When you select the Do not get latest SOV values when merging option, you will not 
receive the latest value from SOV, when SOV merge occurs for in-flight and draft payments. 
That is to state that at the run time whenever a user opens a draft or an in-flight payment 
record and accepts the merge alert, the data elements that have the Do not get latest SOV 
values when merging option selected in uDesigner do not get refreshed with the latest 
updated values from SOV. 

When the value of the Source Name field changes from SOV to other sources, the Do not 
get latest SOV values when merging option will not be displayed. In the Elements 
Properties window, the Do not update latest value from SOV field corresponds (Yes or 
No) to the Do not get latest SOV values when merging option. 
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Cost Type: Line Item with Fund Code 

Use this type of BP for fund appropriation at the project level. With this type of BP, you can 
design business processes that will automatically allocate or consume funds to specific CBS 
codes. These transactions are for fund management and do not necessarily affect the budget. 
Transactions on this type of BP roll up to the Fund Manager. 

You can use this BP in: 

 A Standard Project 

 A shell that uses the Standard Cost Manager 

Cost type business processes employ different sub-types and classifications. The sub-type
determines what type of code it will use, such as a fund or CBS code. The classification
dictates the behavior of the BP. For example, a Base Commit classification of a Cost Type BP 
can create a schedule of values; a General Spends classification can create an invoice at the 
CBS level. There are two classifications of this BP type. 

Generic Use this to allocate funds from the company fund master sheet to specific 
projects. 

Transfer Use this for transferring fund amounts from one fund code to another. 

Design Requirements for Line Items with Fund Code Business Processes 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

 Upper form 

 Detail form 

 Line Item List 

 Workflow 

 Log 

Design Flow 

The following table outlines the design steps necessary to create this business process. 

1. Create a data 
structure (if 
necessary) 

This structure will include the data elements to be used on the 
forms. (If the data structure has not already been created, see the 
instructions beginning with Creating a Data Structure (on page 
189).) 

2. Launch the 
design 

This step initializes the design process for the BP. See Starting a 
New Design (Edit Studio) (on page 219). 

3. Create an upper 
form 

See the instructions beginning with Designing an Upper Form
(on page 257). 
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4. Create a detail 
form 

See the instructions beginning with Designing Detail Form (on 
page 291). 

Mandatory fields for the detail form are: 

Funding source (row_id) 

Short description (short_desc) 

Amount (amount) 

5. Create a line 
item list 

See Adding an Item Log to a Detail Form (on page 291). 

6. Create a 
workflow 

See the instructions beginning with Starting a Workflow (on page 
394). 

7. Create a log See Designing a Business Process Log (Standard or Picker)
(on page 412). 

Cost Type: Line Items with Both CBS and Fund Codes 

Use this type of BP for fund appropriation to specific CBS codes. These transactions are for fund 
management and do not necessarily affect the budget. Transactions on this type of BP roll up to 
the Fund Manager and Cost Manager. 

You can use this BP in: 

 A Standard Project 

 A shell that uses the Standard Cost Manager 

Cost type business processes employ different sub-types and classifications. The sub-type
determines what type of code it will use, such as a fund or CBS code. The classification
dictates the behavior of the BP. For example, a Base Commit classification of a Cost Type BP 
can create a schedule of values; a General Spends classification can create an invoice at the 
CBS level. There are two classifications of this BP type. 

Generic Use this for allocating funds from the Company Fund Sheet to specific 
projects. 

Transfer Use this for moving allocated funds within a project between fund 
codes. 

Design Requirements for Line Items with Both CBS and Fund Codes BPs 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

 Upper form 

 Detail form 

 Line Item List 

 Workflow 
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 Log 

Design Flow 

The following table outlines the design steps necessary to create this business process. 

1. Create a data structure (if 
necessary) 

This structure will include the data elements to be 
used on the forms. (If the data structure has not 
already been created, see the instructions 
beginning with Creating a Data Structure (on 
page 189).) 

2. Launch the design This step initializes the design process for the BP. 
See Starting a New Design (Edit Studio) (on 
page 219). 

3. Create an upper form See  the instructions beginning with Designing 
an Upper Form (on page 257). 

4. Create a detail form See the instructions beginning with Designing 
Detail Form (on page 291). 

Mandatory fields for the detail form are: 

Funding source (row_id) 

Short description (short_desc) 

Amount (amount) 

CBS picker (uuu_cost_code) 

5. Create a line items list See Adding an Item Log to a Detail Form (on 
page 291). 

6. Create a workflow See the instructions beginning with Starting a 
Workflow (on page 394). 

7. Create a log See Designing a Business Process Log 
(Standard or Picker) (on page 412). 

Cost Type: Line Items with Both CBS and WBS Codes 

The Cost Type-Line Items with CBS and WBS Code Business Process (BP) is used for a project 
or shell cost transaction. This BP directly impacts the budget, and it relates to the project or shell 
WBS Sheet and Cost Sheet. That is to state: This BP rolls up cost to both WBS Sheet and Cost 
Sheet.  

This BP enables you to breakdown the cost lines by Work Breakdown Structure (WBS). 



Unifier uDesigner User Guide

28

Cost Type: Commit at Company Level 

This is a company-level cost BP sub-type that you can use to track and control costs at the 
company level above the CBS level. It is independent of a budget or cost sheet and is used for 
tracking non-CBS expenses across projects. It does not use a workflow. 

Use this BP to commit a money amount to a specific vendor. Primavera Unifier then validates 
and enforces spends against this amount. 

At the company level, Primavera Unifier users can create a blanket PO business process and 
store it in the Company Data Manager. They can then set up project-level Commit and Change 
Commit BPs to reference the blanket purchase order, and charge against the remaining balance 
of the blanket PO. 

Design Requirements for Commit at Company Level Business Processes 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

 Upper form 

 Detail form 

 Line Item List 

 Workflow 

 Log 

Design Flow 

The following table outlines the design steps necessary to create this business process. 

1. Create a data structure

(if necessary) 

This structure will include the data elements to be used on 
the forms. (If the data structure has not already been 
created, see the instructions beginning with Creating a 
Data Structure (on page 189).) 

2. Start the design 
This step initializes the design process for the BP. See 
Starting a New Design (Edit Studio) (on page 219). 

3. Design an upper form 
See the instructions beginning with Designing an Upper 
Form (on page 257). 

4. Design a detail form See the instructions beginning with Designing Detail Form
(on page 291). 

For this sub-type: These fields are mandatory: 
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Base Commit 

 amount 

 amount 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

Change Commit 

 amount 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

 Reference (ref_bpo_lineitem) 

Spends 

 amount) 

 amount 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

Generic 

 amount 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

Payment Application 

 Scheduled value 
(scheduled_value) 

 amount 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

Transfer 

 amount 

 Short description (short_desc) 

 CBS picker (uuu_cost_code) 

5. Create a line item list See Adding an Item Log to a Detail Form (on page 291). 

6. Create a workflow 
See the instructions beginning with Starting a Workflow
(on page 394). 

7. Create a log 
See Designing a Business Process Log (Standard or 
Picker) (on page 412) and Creating a Business Process 
Log (Standard or Picker) (on page 411). 

Cost Type: Line Items with Company Account Code 

This BP is a cost BP type that you can use to track cost transactions at the company level for 
items such as resources or facility maintenance. Transactions on this type of BP can roll up to 
the company-level Accounts Sheet. 

Cost type business processes employ different sub-types and classifications. The sub-type
determines what type of code it will use, such as a fund or CBS code. The classification
dictates the behavior of the BP. For example, a Base Commit classification of a Cost Type BP 
can create a schedule of values; a General Spends classification can create an invoice at the 
CBS level. There are three classifications of this BP type: 
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Generic Use this for miscellaneous line item BPs that do not fall into the other 
categories. 

Transfer Use this for transferring fund amounts from one account code to 
another (usually used for making corrections). 

Reservation Use this to reserve an asset, space, or shell; an object from a line 
item, simple, or document type business process; or an item from a 
configurable manager (Code and Records-based). 

How the Reservation business process works 

In order to design the Reservation type of business process, it will help to understand how it 
works. 

This business process is meant for reserving objects from different Primavera Unifier modules: 

 A record in the Document Manager 

 An object from a line item type business process 

 An object from a simple type business process 

 An object from a Code and Records-based configurable manager 

In uDesigner, these objects are made reservable (that is, "calendar-enabled") if you: 

 Specify that the object is calendar-enabled when you start the design 

 Include the following data elements on their attribute or detail forms: 

 uuu_rsv_reservable (allow item to be reserved) 

 uuu_rsv_overbook (allow item to be overbooked) 

When you design the Reservation business process, you need to design one or more data 
pickers and include them on the upper or detail form. These data pickers will list the objects that 
have been calendar-enabled so that the Primavera Unifier user can choose the object to 
reserve. The Reservation business process is where the Primavera Unifier user will specify the 
dates and times for the reservation, recurring reservation dates (if necessary), and (optionally) 
the auto-creation of other business processes. 

When the business processes for the reservable objects reach a specific status (which you 
specify in the design), the object becomes available for reservation; that is, it becomes available 
to a data picker on the Reservation business process. 

Auto-creation on a Reservation business process 

You can design the Reservation business process to auto-create other business processes. The 
auto-creation must include a BP Creator element and certain other elements (see the Design 
Flow below). 
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You can auto-create another business process from the upper or detail form of the Reservation 
business process. Auto-creation on a Reservation business process works differently from most 
other auto-creation processes. For most auto-creations, the Primavera Unifier administrator sets 
up the auto-creation. However, for a Reservation business process, the Primavera Unifier end 
users set up the auto-creation when they create a new Reservation record. For the 
auto-creation, users must specify a time offset relative to the reservation event; that is, they must 
specify whether the auto-creation should occur before or after the reservation event, and how 
many days, hours, and minutes before/after the event. For example, for a room reservation, the 
Reservation business process could auto-create a work order for catering two days before the 
event, and auto-create an "action item" follow-up business process that would go to all 
attendees eight hours after the event. 

Auto-creation and recurring reservations

The Reservation business process includes a "Recurrence" feature that users can use to make 
a reservation automatically occur at specific intervals. For auto-creation on a recurring 
reservation, Primavera Unifier re-evaluates the trigger date for each recurrence. The 
Reservation business process will show a hyperlink to only the last record created; however, 
users can see all the records created by opening the View References window. 

Design Requirements for Line Items with Company Account Code Business Processes 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

 Upper form 

 Detail form 

 Line Item List 

 Workflow 

 Log 

Design Flow 

The following table outlines the design steps necessary to create this business process. 

1. Create a 
data structure 

(if necessary) 

This structure will include the data elements to be used on the forms. 
(If the data structure has not already been created, see the instructions 
beginning with Creating a Data Structure (on page 189).) 

For a Reservation sub-type, you need to create one or more data 
pickers. Primavera Unifier users will use these data pickers to choose 
the objects to reserve. The data pickers will be populated with the 
business process records (such as a space) that have been "calendar 
enabled." 

2. Start the 
design 

This step initializes the design process for the BP. See Starting a New 
Design (Edit Studio) (on page 219). 



Unifier uDesigner User Guide

32

3. Design an 
upper form 

See the instructions beginning with Designing an Upper Form (on 
page 257). 

For a Reservation sub-type, these fields are mandatory on the upper 
form: 

 Reserved from date (uuu_date_from) 

 Reserved to date (uuu_date_to) 

 Reservation name (uuu_rsv_calendar_item_name) 

 Set reservation recurrence (uuu_recurrence) 

If a Reservation business process should auto-create another business 
process before or after the reserved event takes place, these fields are 
mandatory, and can be added to either the upper or detail form: 

 BP Creator element 

 When the auto-creation should occur, relative to the reservation 
(uuu_before_after) 

 Date the auto-creation should occur (uuu_rsv_trigger_date) 

 # of days before/after the reservation the auto-creation should 
occur (uuu_rsv_trigger_days) 

 # of hours before/after the reservation the auto-creation should 
occur (uuu_rsv_trigger_hrs) 

 # of minutes before/after the reservation the auto-creation should 
occur (uuu_rsv_trigger_min) 

4. Design a 
detail form 

See the instructions beginning with Designing Detail Form (on page 
291). 

For this 
sub-type: 

These fields are mandatory: 

Generic 
 Company account code picker Amount 

((uuu_company_acc_codepicker)) 

 Short description (short_desc) 

Transfer 
 Company account code picker Amount 

((uuu_company_acc_codepicker)) 

 Short description (short_desc) 
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Reservation 

If a Reservation business process should auto-create 
another business process before or after the reserved 
event takes place, these fields are mandatory, and can 
be added to either the upper or detail form: 

 BP Creator element 

 When the auto-creation should occur, relative to the 
reservation (uuu_before_after) 

 Date the auto-creation should occur 
(uuu_rsv_trigger_date) 

 # of days before/after the reservation the 
auto-creation should occur (uuu_rsv_trigger_days) 

 # of hours before/after the reservation the 
auto-creation should occur (uuu_rsv_trigger_hrs) 

 # of minutes before/after the reservation the 
auto-creation should occur (uuu_rsv_trigger_min) 

5. Create a 
line item list 

See Adding an Item Log to a Detail Form (on page 291). 

6. Create a 
workflow 

See the instructions beginning with Starting a Workflow (on page 
394). 

7. Create a log
See Designing a Business Process Log (Standard or Picker) (on 
page 412). 

Cost Type: Line Items with Asset Code 

This is a cost BP type that you can use for cost transactions at the company level that are 
specific to assets, such as a maintenance order. Transactions on this type of BP can roll up to 
the company-level Assets Sheet. 

Design Requirements for Line Items with Asset Code Business Processes 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

 Upper form 

 Detail form 

 Line Item List 

 Workflow 

 Log 

Design Flow 

The following table outlines the design steps necessary to create this business process. 
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1. Create a data structure 
(if necessary) 

This structure will include the data elements to be used on 
the forms. (If the data structure has not already been 
created, see the instructions beginning with Creating a 
Data Structure (on page 189).) 

2. Launch the design This step initializes the design process for the BP. See 
Starting a New Design (Edit Studio) (on page 219). 

3. Create an upper form See the instructions beginning with Designing an Upper 
Form (on page 257). 

4. Create a detail form See the instructions beginning with Designing Detail Form
(on page 291). 

Mandatory fields for the detail form are: 

Asset code picker (uuu_asset_picker) 

Short description (short_des) 

Amount  (amount) 

5. Create a line items list See Adding an Item Log to a Detail Form (on page 291). 

6. Create a workflow See the instructions beginning with Starting a Workflow
(on page 394). 

7. Create a log See Designing a Business Process Log (Standard or 
Picker) (on page 412). 

Generic Cost: Line Items with Multiple Codes 

Business processes for a generic cost manager are line item type BPs; and to distinguish them 
from line item cost BPs for the standard Cost Manager, they are called "line items with multiple 
codes."  

Note: These BPs do not use a CBS code structure. Instead, it uses a 
coding structure that you must create when you launch the BP. 

There are several classifications of this BP type: 

Generic Use this for miscellaneous line item BPs that do not fall into the other 
categories, including fund-related or those related to blanket purchase 
orders. 

With this type of BP, you can: 

 Reference against a company-level commit BP 

 Enforce the line items against a company-level commit amount 

 Consolidate line items 

Transfer Use this for transferring currency from one account to another. 

With this type of BP, you can consolidate line items. 
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Base 
Commit 

Use this for: 

 Monies committed to be spent; for example, a contract or purchase 
order 

 Creating an entry in the Commitment Summary 

With this type of BP, you can: 

 Reference against a company-level commit BP 

 Enforce the line items against a company-level commit amount 

 Create a commitment summary when the BP is in a terminal status 

 Consolidate line items 

From this type of BP, you can: 

 Select only a General Spends type of commitment summary 

 View commitment summary line items only by individual line items, or 
grouped by commit codes 

Change 
Commit 

Use this for: 

 Changing or adding to a previous base commit BP 

 Modifying an entry in the Commitment Summary 

With this type of BP, you can: 

 Reference against a company-level commit BP 

 Enforce the line items against a company-level commit amount 

 Update the commitment summary 

 Consolidate line items 

From this type of BP, you can: 

 Select only a General Spends type of commitment summary 

 View commitment summary line items only by individual line items, or 
grouped by commit codes 

General 
Spends 

Use this for monies to be spent; for example, an invoice or partial 
payment of services, often charged against a prior commit. This BP 
updates an entry on the Commitment Summary. 

Lease Use this for creating payment schedules for rental properties. This BP 
shows users the expected payments for the lifetime of a lease according 
to a regular or straight-line schedule. A Lease BP automatically creates 
these schedules, on which users can track incoming and outgoing 
payments. 

You can design a Lease BP to auto-create other BPs, such as a payment 
request. 

Users can also create an "allocation template" to pro-rate lease 
payments into different amounts for multiple tenants in a building. The 
template will designate a breakdown of the costs for each tenant and this 
breakdown will be used to create the payment calculations. 
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Reservation Use this to reserve a space, an object from a line item, simple, or 
document type business process; or an item from a configurable 
manager (Code and Records-based). 

For information on how the Reservation business process works, see 
Cost Type: Line Items with Company Account Code (on page 29). 

Note: For cost BPs of this type, you can give users permission to modify 
line items at any time during the workflow before the end step is 
reached. 

Design Requirements for Line Items with Multiple Codes BPs 

For Line Items with Multiple Codes business processes to work effectively in Unifier, you will 
need to create the following components in uDesigner: 

 Upper form 

 Detail form 

 Line Item List 

 Workflow 

 Log 

Design Flow for Line Items with Multiple Codes BPs 

The following outlines the design steps necessary to create this business process. 

1) Create a Data Structure (if necessary)

2) Launch the Design

3) Design an Upper Form

4) Design a Detail Form

5) Create a Line Items list

6) Create a Workflow

7) Create a Log

The following explains each step in detail: 

1. Create a Data Structure (if necessary) 

This structure will include the data elements to be used on the forms. (If the data structure has 
not already been created, see the instructions beginning with Creating a Data Structure (on 
page 189).) 

(Optional) If you are designing a business process that will roll up data across shells to a Code 
and Records-based manager, you will need to design data pickers to help Primavera Unifier 
users locate and pick the correct BP records within the hierarchy. For more information on data 
pickers, see Across-Shell Functioning and also About Data Pickers (on page 195). 

Reservation sub-type, you need to create one or more data pickers. Primavera Unifier users will 
use these data pickers to choose the objects to reserve. The data pickers will be populated with 
the business process records (such as a space) that have been "calendar enabled." 



Business Processes Types

37

2. Launch the Design 

This step initializes the design process for the BP. See Starting a New Design (Edit Studio)
(on page 219). 

3. Design an Upper Form 

See the instructions in Designing an Upper Form (on page 257). 

For Change Commit sub-type, this field is mandatory: 

A reference ID (Refid) 

You will need to link the Change Commit BP to the Base Commit BP using this reference ID. 

For Spends sub-type, this field is mandatory: 

A reference ID (Refid) 

You will need to link the Spends BP to the Base Commit BP using this reference ID. 

For Lease sub-type: 

If you want the straight-line rent amount to appear on the upper form of the lease, include this 
field: 

 uuu_lse_sl_rent

If you include this field on the form, the user will not have to open the Payment Schedule to see 
the rent amount. 

If you want to allow the Primavera Unifier user to adjust the date terms of a straight-line lease, or 
to add or subtract a one-time currency amount to/from the lease amount, include these fields on 
the Upper Form: 

 Commencement date (uuu_lse_commencement_date) 

 Termination date (uuu_lse_termination_date) 

 Lease term modifier (uuu_lse_term_modifier) 

 Currency amount adjustment (uuu_lse_sl_adjustment) 

For Reservation sub-type: 

 Reserved from date (uuu_date_from) 

 Reserved to date (uuu_date_to) 

 Reservation name (uuu_rsv_calendar_item_name) 

 Set reservation recurrence (uuu_recurrence) 

If a Reservation business process should auto-create another business process before or after 
the reserved event takes place, these fields are mandatory and can be placed on the upper or 
Detail Form: 

 BP Creator element 

 When the auto-creation should occur, relative to the reservation (uuu_before_after) 

 Date the auto-creation should occur (uuu_rsv_trigger_date) 

 # of days before/after the reservation the auto-creation should occur 
(uuu_rsv_trigger_days) 
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 # of hours before/after the reservation the auto-creation should occur 
(uuu_rsv_trigger_hrs) 

 # of minutes before/after the reservation the auto-creation should occur 
(uuu_rsv_trigger_min) 

4. Design a Detail Form 

If this business process is to roll up data from across shells, the following fields are mandatory 
on these forms to provide user navigation to records across shells: 

 A data picker for each manager class 

 A configurable manager picker 

These fields are mandatory for the form, but are not required to be filled in at runtime. However, 
if these fields are left blank on the form at runtime, data rollups will not occur. 

See the instructions in Designing an Upper Form (on page 257). 

For Base Commit sub-type, these fields are mandatory: 

 Manager picker (uuu_cm[1...25]_picker) 

 Cost code picker (uuu_cm0_code) 

 Effective date for the code (uuu_effective_date) 

 Amount (amount) 

 Short description (short_desc) 

For Change Commit sub-type, these fields are mandatory: 

 Manager picker (uuu_cm[1...25]_picker) 

 Cost code picker (uuu_cm0_code) 

 Effective date for the code (uuu_effective_date) 

 Commit line item picker (uuu_sovlinum) 

 Amount (amount) 

 Short description (short_desc) 

 Reference (ref_bpo_lineitem) 

For Spends sub-type,these fields are mandatory: 

 Manager picker (uuu_cm[1...25]_picker) 

 Cost code picker (uuu_cm0_code) 

 Effective date for the code (uuu_effective_date) 

 Amount (amount) 

 Short description (short_desc) 

For Generic sub-type, these fields are mandatory: 

 Manager picker (uuu_cm[1...25]_picker) 

 Amount (amount) 

 Short description (short_desc) 

For Payment Application sub-type, these fields are mandatory: 

 Manager picker (uuu_cm[1...25]_picker) 
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 Scheduled value (scheduled_value) 

 Amount (amount) 

 Short description (short_desc) 

For Lease sub-type, these fields are mandatory: 

 Manager picker (uuu_cm[1...25]_picker) 

If the lease BP is linked to a configurable manager. 

 Generic Cost Manager picker (uuu_cm0_picker) 

If the lease BP is linked to a Generic Cost Manager. 

 uuu_lse_start_date 

 uuu_lse_end_date 

 uuu_lse_frequency 

 uuu_lse_pay_due_day 

 uuu_lse_pay_latest_due_day 

 uuu_lse_pay_creat_lead_time 

 uuu_lse_pay_type 

 uuu_lse_proration_method 

 uuu_lse_esc_method 

 uuu_lse_esc_value 

 uuu_lse_esc_freq_len 

 uuu_lse_esc_freq_type 

 uuu_lse_add_pay_amt 

 uuu_lse_pay_due_date 

 uuu_lse_pay_latest_due_date 

 uuu_lse_pay_creation_date 

 uuu_lse_pay_amount 

 Amount (amount) 

 short_desc 

To accommodate lease payment allocation, these fields are also mandatory: 

 uuu_allocation_amount 

 uuu_lse_allocation_name (this is a picker) 

 The amount of lead time a payment request needs for approval and 
payment—uuu_lse_pay_creat_lead_time 

If you want to allow the user to manually specify a first payment due date, include this field: 

 uuu_lse_first_pay_due_date 

For Reservation sub-type, f the detail form should auto-create another business process before 
or after the reserved event takes place, these fields are mandatory: 

 BP Creator element 

 When the auto-creation should occur, relative to the reservation (uuu_before_after) 

 Date the auto-creation should occur (uuu_rsv_trigger_date) 

 # of days before/after the reservation the auto-creation should occur (uuu_rsv_trigger_days) 



Unifier uDesigner User Guide

40

 # of hours before/after the reservation the auto-creation should occur (uuu_rsv_trigger_hrs) 

 # of minutes before/after the reservation the auto-creation should occur 
(uuu_rsv_trigger_min) 

5. Create a Line Items list 

See Adding an Item Log to a Detail Form (on page 291). 

6. Create a Workflow 

See the instructions beginning with Starting a Workflow (on page 394). 

7. Create a Log 

See Designing a Business Process Log (Standard or Picker) (on page 412). 

Tips for Lease Business Process (BP) 

The Lease BP works best as a non-workflow BP, at the highest level of a shell hierarchy. 

If you create leases at multiple levels in a hierarchy, you need to be sure that the cost codes are 
consistent across shells so that the costs roll up properly to the Cost Sheet. 

If you design a Lease BP with a workflow, make sure the leases do not reach a terminal status; 
otherwise, you will not be able to edit or add lease amendments to the BP. 

If you want the Lease BP to auto-create another BP (such as a payment request), include a BP 
Creator element on the standard detail form and use the line-item-to-record method of 
auto-creation (see Auto-Creating a Record or Line Item from a Form. 

Note: By design, the Line Item Details, in the Lease BP, cannot be 
auto-created.  

On the auto-created BP: 

 Include a BP Picker for referencing the Lease BP. This will ensure that when users view the 
referenced records in the Lease BP, they will see all the auto-created BPs for the Lease. 

 Auto-populate the effective date so that the costs roll up to the Cost Sheet in the right time 
frame. 

Index rate based rent escalation: 

Follow these steps if you want to include the option to escalate rent based on the index rate: 

1) Create a simple BP and include these data elements: uuu_index_rate, 
uuu_index_code, and status.  

2) Create a data picker using the BP you created in step 1. 

3) Open the Lease BP and select Open > General .  

4) Select the Options tab.  

5) For the field Index Rate Data Picker, select the index rate data picker you created in step 2. 

6) On the Detail Form of the Lease BP, open Payment Setup. 

7) Under Payment Escalation Setup, include the index rate data picker you created in step 2. 
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The following data elements (DEs) exist in group, only, and if the user has added any of these 
DEs, then adding the other DEs is mandatory.  

 uuu_lse_annual_discnt_rate

 uuu_lse_npv_amount

 uuu_lse_inc_in_npv

Additional error check will be added for this during the business process error check to check for 
the presence of these elements in upper form/payment setup. These DEs will not be available 
for any other non standard detail form in lease type of BP. 

The system will conduct error check for the presence of the above DEs in Upper Form/Payment 
Setup. 

The above DEs are not available for non-standard Detail Form in Lease type BP. 

Document Type 

Document business processes are document-type BPs commonly used as "envelopes" to 
package a set of files—such as spreadsheets, drawings and design documentation—that flow 
from one group to another. An example is a Transmittal. Primavera Unifier users have the option 
of having each file attachment be a separate line item, which allows additional functionality such 
as line item status modification. (Line item functionality is activated by creating a detail form for 
the BP.) 

There are two sub-types of document BPs: With Folder Structure, allowing users to attach and 
organize documents and folders and maintain a folder structure; and Without Folder Structure, 
allowing attachments as a flat list only. 

Note: For document-type business processes With Folder Structure, you 
can specify that a configured folder path be appended to the folder 
structure. This appended path is based on the path configured in the 
uuu_dm_publish_path data element on the business process form, and 
the selection of the Append Line Items Folder Structure to 
AutoPublish Path option. See Designing an Upper Form (on page 
257) for details. 

Design Requirements for Document Business Processes 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

 Upper form 

 Detail form 

 Line Item List 

 Workflow 

 Log 

Design Flow 

The following table outlines the design steps necessary to create a document business process. 
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1. Create a data structure 
(if necessary) 

This structure will include the data elements to be used on 
the forms. (If the data structure has not already been 
created, see the instructions beginning with Creating a 
Data Structure (on page 189).) 

2. Launch the design This step initializes the design process for the BP. See 
Starting a New Design (Edit Studio) (on page 219). 

3. Create an upper form See the instructions beginning with Designing an Upper 
Form (on page 257). 

4. Create a detail form See the instructions beginning with Designing Detail Form
(on page 291). 

If users should be able to reserve this document record, 
these fields are mandatory: 

 Short description (short_desc) 

 Allow item to be reserved (uuu_rsv_reservable) 

 Allow over-booking (uuu_rsv_overbook) 

5. Create a line items list See Adding an Item Log to a Detail Form (on page 291). 

6. Create a workflow (if 
necessary) 

See the instructions beginning with Starting a Workflow
(on page 394). 

7. Create a log See Designing a Business Process Log (Standard or 
Picker) (on page 412). 

Text Type 

Text BPs accommodate "discussion type" business processes such as requests for information 
(RFIs) or action items for collaborative situations where users need to discuss issue resolution. 
They make dialog-driven collaboration easy and visible because the response list area shows 
the dialog thread. 

This type of BP contains a text entry area where the person initiating the business process 
explains the request or issue. Below this area, the BP will show a response list. This area is 
where participants can add and organize text comments or file attachments. 

Design Requirements 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

 Upper form 

 Text entry form 

 Response list 

 Workflow 

 Log 
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Design Flow 

The following table outlines the design steps necessary to create this business process. 

Create a data structure(if 
necessary) 

This structure will include the data elements to be used on 
the forms. (If the data structure has not already been 
created, see the instructions beginning with Creating a 
Data Structure (on page 189).) 

Launch the design This step initializes the design process for the BP. See 
Starting a New Design (Edit Studio) (on page 219). 

Create an upper form See the instructions beginning with Designing an Upper 
Form (on page 257). 

Create a text entry form See Adding a Text Entry Area to a Form (on page 354). 

Create a response list See Adding a Response List to a Text Business 
Process (on page 354). 

Create a workflow (if 
necessary) 

See the instructions beginning with Starting a Workflow
(on page 394). 

Create a log See Designing a Business Process Log (Standard or 
Picker) (on page 412). 

Line Item Type 

Line item BPs can be used for any generic data. They lend themselves well to business 
processes that involve miscellaneous information you may want to document for a company or 
project; for example, a vendor contact list. Or, they are useful for project-specific information that 
only needs to be documented on a single form, such as the overall project scope, or meeting 
minutes. 

Line item BPs are also useful for collecting data that other, more restricted types of BPs cannot. 
For example, while a simple-type BP can be used to collect basic vendor information, a 
company-level line item BP can collect additional vendor information, such as multiple business 
addresses. At the project level, you can use a line item BP to filter large numbers of company 
records into smaller lists of records for your projects. 

Line item BPs use a separate detail form to enter line items, which then appear on a line item list 
at the bottom of the form. Or, for short line items, Primavera Unifier users can enter information 
directly into the line item list using a "grid view" of the list. 

You can design these BPs to accommodate line item status, so you can control modifications to 
individual line items based on their status. 

There are three sub-types of this BP: 

Generic

Use this sub-type for all line item BPs unless you want to filter BP records. To filter BP records, 
use the sub-type explained below. 
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Line Items to filter Company Business Process Records

Use this sub-type to filter company records into smaller lists of records for your projects. This BP 
is particularly suited for routing a list of vendors for approval for a project, thereby filtering the list 
of company vendors into lists of vendors who are appropriate for specific projects. Used for this 
purpose, this BP type can be linked (as a reference process) to an RFB to supply a 
project-specific vendor list for bid invitations. 

Preventive Maintenance (if the module is available) 

Use Preventive Maintenance to maintain assets proactively and on a regular basis, even when 
no issue has been reported on the asset. The Preventive sub-type has 5 classifications (Asset, 
Asset Template, PM Book, PM Book Template, and Meter Reading) and they are available for 
selection from Classification drop-down menu, once you select Preventive Maintenance as a 
sub-type. A Company can have more than one BP of a particular type (e.g., two or more Asset 
BPs, two or more Asset Template BPs, and so forth). 

Use Preventive Maintenance to maintain assets proactively and on a regular basis, even when 
no issue has been reported on the asset. The Preventive sub-type has 5 classifications: 

 Asset 

 Asset Template 

 PM Book 

 PM Book Template 

 Meter Reading 

These classifications are available for selection from the Classification drop-down list, once you 
select Preventive Maintenance. 

Note: A Company can have more than one BP of a particular sub-type 
(e.g., two or more Asset BPs, two or more Asset Template BPs, and so 
forth). 

Design Requirements 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

 Upper form 

 Detail form 

 Line Item List 

 Workflow 

 Log 

Design Flow 

The following table outlines the design steps necessary to create this business process. 

1. Create a data 
structure 

(if necessary) 

For the line item sub-type Line items to filter company 
business process records, you will need to create a BP 
picker to specify the business process from which the user 
will select the items to include on the filtered list. Use the BP 
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Picker data definition to build this picker. 

If you are designing a business process for a Generic 
sub-type that will roll up data across shells to a Code and 
Records-based manager, you will need to design data 
pickers to help Primavera Unifier users locate and pick the 
correct BP records within the hierarchy. You will also need to 
link the data picker to a manager picker using a formula. For 
more information on data pickers, see Across-Shell 
Functioning" and also About Data Pickers (on page 195). 
For information on linking a data picker to a manager picker, 
see Adding Formulas to Fields (on page 315). 

2. Launch the design 
This step initializes the design process for the BP. See 
Starting a New Design (Edit Studio) (on page 219). 

3. Design an upper form
See the instructions beginning with Designing an Upper 
Form (on page 257). 

4. Design a detail form 

See the instructions beginning with Designing Detail Form
(on page 291). 

For this sub-type: These fields are mandatory: 

Line items to filter 
company business 
process records 

 uuu_line_item_status to 
specify what status the line 
item should be to include or 
exclude the item from the 
filtered list. 

 BP picker 

Users will use this picker to select 
records from the business 
process this field references. The 
records the users select will be 
included on the filtered list for the 
project. (This picker should be the 
same picker that you specify on 
the Options tab when you start 
the BP design.) 

Generic 

If this business process is to roll 
up data from across shells, the 
following fields are mandatory on 
this form to provide user 
navigation to records across 
shells: 

 A data picker for each 
manager class 

 A configurable manager 
picker 
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These fields are mandatory for 
the form, but are not required to 
be filled in at runtime. However, if 
these fields are left blank on the 
form at runtime, data rollups will 
not occur. 

If users should be able to reserve 
this item, these fields are 
mandatory: 

 Allow item to be reserved 
(uuu_rsv_reservable

 Allow over-booking 
(uuu_rsv_overbook) 

5. Create a line item list See Adding an Item Log to a Detail Form (on page 291). 

6. Create a workflow 

(if necessary) 

See the instructions beginning with Starting a Workflow (on 
page 394). 

7. Create a log 
See Designing a Business Process Log (Standard or 
Picker) (on page 412). 

8. Link to a reference 
process 

(For sub-type Line items 
to filter company 
business process 
records) 

Link the BP picker on the detail form to the BP that contains 
the list of records the users will choose from. 

See Adding a Reference Process to Auto-Populate Data
(on page 355). 

Preventive Maintenance 

Note: If you do not have the Preventive Maintenance module loaded, 
you cannot create Preventive Maintenance business processes. 

The Preventive Maintenance business process line items generate work order business process 
records.  

A preventive maintenance type business process can be set up to create work orders for assets 
at periodic intervals depending on the service needs of the asset. 

For example, if you wanted to use auto-creation to create a work order business process to 
order maintenance on a vehicle, you would first create a preventative maintenance business 
process (the source business process) and have your administrator set up the auto-creation 
of a work order for vehicle maintenance business process (the destination business process) 
to order the work on the vehicle. 
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In this example, the uDesigner user set up which business process is the source business 
process and which is the destination business process. The company administrator specifies 
the conditions and defaults for the auto-creation. End users can set up the periodic 
auto-creation, based on their needs.  

In the Preventive Maintenance Book (PM Book), for:  

 Floating Line Items holding non-terminal work orders, you cannot edit the following DEs: 

 Family Identifier 

 Line Item Status 

 Schedule Type 

 Fixed Line Items holding non-terminal work orders, you can edit the following DE: 

 Line Item Status 

To access Preventive Maintenance module, go to Company Workspace, select 
Administration Mode, expand Data Structure Setup, and click System Modules to open the 
Modules window. 

To create Preventive Maintenance business processes, go to Company Workspace, select 
Administration Mode, expand uDesigner, from menu click New, and select Line Item to open 
edit window. Proceed to complete the form as follows: 

1) ID (Required): Enter ID. 

2) Name (Required): Enter name. 

3) Description: Enter description. 

4) Ensure Line Item appears in the Type field. 

5) Sub-Type (Required): Click the drop-down menu and select Preventive Maintenance. 

6) Classification: Asset appears as default. Click the drop-down menu to select other 
classifications. You options are Asset (default), Asset Template, PM Book, PM Book 
Template, and Meter Reading. 

7) Configurable Manager: Click Select to open Select Configurable Manager(s) window, 
select an appropriate item from the list, and click OK. 

8) Click to select the appropriate choices for the Level, Behavior, and Record Instances
fields, and when finished click Apply.  

9) Complete the fields in the Statuses, Options, and Consolidation, tabs within the edit 
window and when finished click OK to complete creating a new Preventive Maintenance 
business process. 

Preventive Maintenance Main Business Processes 

Asset

Objects which need maintenance. 

PM Book

Objects that hold details on maintenance schedules (usually one per Asset). This business 
process captures the copy of PM Book Template associated with an Asset record. Each PM 
Book points to an Asset.  
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Notes:  

 A PM Book generates recurring Work Orders for an Asset, a PM 
Book Template does not 

 A PM Book holds a picker to PM Book Template in its upper form 

Preventive Maintenance Supporting Business Processes 

Asset Template

Use the Asset Template as a basis to create several assets. This business process captures 
templates that can be used to create new Assets.  

PM Book Template

Use to create several Preventive Maintenance books (PMBs). This business process contains 
the Time and Meter schedules in two different detail tabs. Each schedule is captured within one 
line item. 

Meter Reading

Use to capture readings of meters belonging to Asset. This business process captures meters 
with the readings, as line items. There might be several meters associated with an Asset and 
readings must be captured for each meter. Each Meter Reading record picks an Asset in its 
upper form. An Asset holds its Meter Reading records via a QBT on the Asset business 
process. The "meter schedules" on a PM Book capture the frequency at which work orders 
should be generated (via the pattern picker). Each "meter schedules" on a PM Book points to a 
Meter Reading record. 

Preventive Maintenance Additional Line Item or Simple Business Processes 

Meter Templates

Use to capture generic information about Asset Meters. 

Job Plans

Use to plan on how a preventive maintenance activity should be performed (a set of tasks and 
items which might be needed to complete those tasks). This business process captures a list of 
tasks and materials that are needed to complete tasks. 

Asset Creators

Use to create new Assets. You can copy information from Asset Templates. 

Work Orders

Use to capture work orders that need to be performed on assets by technicians. A PM Book
business process generates work orders on recurring basis and based on the time or meter 
schedules. Since each schedule is linked to a job plan, the contents of the Details tab (Tasks 
and Items) of a Work Orders business process is generated by the Job Plan. 

About the Designs of the PM Book Template and PM Book Business Processes 

An Asset Business Process (BP) record auto-creates a PM Book BP record. As a result, the 
design of a PM Book BP must contain the following elements: 
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 The BP Data Picker must reference to the source PM Book Template BP. At runtime, the PM 
Book BP record displays the referenced PM Book Template BP record.  

 The Line Items in the PM Book BP record must have links to the Line Items in the PM Book 
Template BP record. 

 The integration interface must be defined for the PM Book PB record that needs to be 
updated. 

If you link your Time and Meter Schedules within a PM Book BP, you can avoid generating 
multiple PM work orders if a meter-schedule occurs sooner than a time-schedule, or vice versa. 
The following scenario provides a good example for this feature:  

A commercial vehicle is scheduled for an oil change either when it reaches 5000 miles 
(meter) or 12 months (time) after the last oil change, whichever is reached first. If the vehicle 
reaches 5000 miles prior to 12 months, then Unifier generates a PM work order and 
automatically prevents a second PM work order when the 12 months time-frame comes. 
Conversely, if 12 months passes and the vehicle does not reach 5000 miles, then Unifier 
generates a PM work order and automatically prevents a second PM work order when the 
vehicle reaches 5000 miles. 

To prevent generating an additional work order, in such a case, you can use the 
"uuu_rec_related_family_id" data element to link the meter-schedule and the time-schedule 
within a PM book or PM book template. To select the "uuu_rec_related_family_id" data 
element, to use for all PM Books, go to either of these locations: 

  Shell (Admin mode >Business Process Updates node > Setup

 Company Workspace tab (Admin mode > Company Workspace > Business Process 
Updates) 

Once selected, all of the PM Books will be updated with correct values from the related PM Book 
Template, according to the push schedule defined within this log. 

Simple Type 

Simple BPs consist of an upper form only and do not have a "view form vs. action form" 
distinction. Simple BPs are generally used to add company or project information that does not 
require line items. Examples might include a vendor list or a request for information (RFI). 

Design Requirements 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

 Upper form 

 Log 

Design Flow 

The following table outlines the design steps necessary to create this business process. 
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Create a data structure(if 
necessary) 

This structure will include the data elements to be 
used on the forms. (If the data structure has not 
already been created, see the instructions 
beginning with Creating a Data Structure (on 
page 189)) 

Launch the design This step initializes the design process for the BP. 
See Starting a New Design (Edit Studio) (on 
page 219). 

Create an upper form See  the instructions beginning with Designing 
an Upper Form (on page 257) 

If users should be able to reserve this item, these 
fields are mandatory: 

 Allow item to be reserved 
(uuu_rsv_reservable) 

 Allow over-booking (uuu_rsv_overbook) 

Create a log See Designing a Business Process Log 
(Standard or Picker) (on page 412). 

Request for Bid (RFB) 

The Request for Bid (RFB) is a type of line item BP. RFBs are unique in that the business 
process requires participation from personnel outside your company. For an RFB, you need to 
create two sets of forms—one for the requestor (the user who creates the RFB and invites bids) 
and another for the bidders (the vendors) to fill out with bid information. 

An RFB must include a reference process to a vendor list business process, which contains the 
pool of vendors to whom the RFB will be sent. This vendor reference process will populate the 
upper fields of the RFB at runtime. Primavera Unifier automatically launches this reference 
process when the RFB is activated. 

The RFB can also include a BP Data Picker that references a line item type BP that will be used 
to filter the available bidders in the Option tab. Once the additional bidder/vendor filtering ability 
option is set correctly, then the query conditions for the data picker can also be used to filter the 
list of vendors.  

Tip: When you create the bidder's view of RFB forms, keep in mind that the bidders may or may 
not be Primavera Unifier users. You might want to keep some fields hidden or non-editable. You 
might also want to allow bidders to modify line items, but prevent them from adding or removing 
them. 

The RFB type BP Requestor and Bidder form do not have access to pickers.  

Note: Ensure that you include both the first name and the last name data 
elements (for the vendor) in the RFB form.  

The following is a workflow for a bid process: 
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1) Create Bid 

2) Review or Approve Bid 

3) Send Bid invite to Vendors 

4) Compare or View Received Bids 

5) Negotiate with preferred Bidders 

6) Select Winning Bid 

7) Create Contract with Winning Bid 

Bid Comparison 

The RFB business process includes a bid tabulation feature that users can use to compare all or 
selected bids that have been received from vendors. This feature is available after the bidding 
process is closed. The bid tabulation is displayed on a sheet that you can design in uDesigner. 
(If you do not design a bid comparison sheet, Primavera Unifier automatically provides a default 
sheet.) 

How a Request for Bid Works 

Once the RFB type Business Process is active in Primavera Unifier, the bid procedure runs as 
follows: 

The Primavera 
Unifier user 

To start the procedure, the user: 

 Opens the RFB, fills in the form, and sends it for internal 
review. During this process, the scope of the project might be 
verified, as well as other things, such as terms and conditions, 
architectural drawings, and structural materials. 

When the internal review workflow is complete, the user: 

 Assembles the bid package and prepares the bid invitation for 
distribution. 

 Sends out the bid invitations, along with a user name and 
password so that the vendors can log into Primavera Unifier 
"Lite" and submit their bids. 

Once the bid invitations have been sent, the user must wait for the 
bid due date to pass. 

The vendor  Logs into Primavera Unifier and opens the bid request. 

 (Optionally) Requests clarification of any questions or issues 
before submitting the bid. 

 Submits the bid. 

The Primavera 
Unifier User 

When the due date is reached, the user: 

 Tabulates the bids for comparison. 

 (Optional) Opens discussions about the bids, if necessary, 
with company employees. (Classic View only) 

 Selects a winning bid 

 Awards the bid to a vendor and creates a contract by copying 
details from the bid record into the awarded contract. 
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Design Requirements 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

 A vendor master Business Process (BP) to contain vendor or supplier information. Your 
company is allowed only one vendor master list business process. Create this vendor master 
using the information under the Simple Type (on page 49). 

Tip: You can create an "approved vendors" list for a specific project that 
includes a sub-set of the company's master list of vendors. This makes 
the bidding process easier because the requestor does not have to 
select vendors from the entire list of company suppliers. To create this 
list, use a Line Item BP with a sub-type of "Line Items to Filter BP 
Records" (see Line Item Type (on page 43)). 

In order for the vendor master BP (Master Vendor BP) to work properly with the RFB, the upper 
form of the master list (RFB master vendor list) must include the following data elements: 

 Date picker (uuu_due_date) 

 Contact Company (uuu_contact_company) 

 Contact Last Name (uuu_contact_last_name) 

 Contact First Name (uuu_contact_first_name) 

 Contact Language (uuu_contact_lang) 

 Date Format (uuu_dateformat) 

 Time Zone (uuu_user_timezone_pref) 

 User ID (uuu_user_id) 

 Status 

 A Requestor form, which should include: 

 Upper form 

 Detail form 

 Line Item List 

 Workflow 

 Log 

 Reference process (to reference the vendor list business process) 

 A Bidder form, which should include: 

 Upper form 

 Detail form 

 Line Item List 

 Log 

 (Optional) A bid comparison sheet, which should include: 

 Upper form 

 Detail form 
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Design Flow 

The following table outlines the design steps necessary to create the RFB business process. 

1) Create a data structure, if necessary. 

See the instructions beginning with Creating a Data Structure (on page 189). 

2) Launch the design. 

This step initializes the design process for the BP. See Starting a New Design (Edit Studio)
(on page 219). 

For the Requestor: 

1) Create an Upper form. See the instructions beginning with Designing an Upper Form (on 
page 257). The mandatory fields for the upper form is: Date picker (uuu_rfb_due_date) to 
specify a due date. This is the date on which the bid will expire. Bidders will not be able to 
bid after this date, and requestors will not be able to see bids before this date. 

2) Create a Detail form. See the instructions beginning with Designing Detail Form (on page 
291). The mandatory field for the Detail form is: Short description (short_desc). 

3) Create a Line Item list. See Adding an Item Log to a Detail Form (on page 291). 

4) (Optional) Create a workflow. See the instructions beginning with Designing an Upper 
Form (on page 257). 

5) Create a log. See Designing a Business Process Log (Standard or Picker) (on page 
412). 

6) Create a reference process. See Adding a Reference Process to Auto-Populate Data (on 
page 355). 

For the Bidder: 

1) Create an Upper form. See the instructions beginning with Designing an Upper Form (on 
page 257). 

2) Create a Detail form. See the instructions beginning with Designing Detail Form (on page 
291). The mandatory field for the Detail form is: Short description (short_desc). 

3) Create a Line Item list. See Adding an Item Log to a Detail Form (on page 291). 

4) Create a log. See Designing a Business Process Log (Standard or Picker) (on page 
412). 

5) Create a reference process. See Adding a Reference Process to Auto-Populate Data (on 
page 355). 

For the Bid Comparison Sheet: 

1) (Optional) Create an Upper form. See the instructions beginning with Designing an Upper 
Form (on page 257). The Upper form must contain the same elements that are on the bidder 
upper form. 

2) Create a Detail form. See Designing a Bid Comparison Sheet for an RFB (on page 372). 
The detail form must contain the same elements that are on the bidder detail form. 

Additional information about RFB 

Upper Forms
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You can place the Bid Picker DE (uuu_rfb_winning_bid) on any Requestor Upper form of 
any RFB Business Process. 

The Bid Picker DE: 

 Can be placed in hidden block 

 Can be designated as "Required" or "Read Only." 

 Must be available in the list of "Custom" DEs, when user attempts to add the DE to a form. 

 Can be added to Dynamic Dataset (behavior set). 

Note: The Dynamic Dataset (DDS) must not be added to any Business 
Process form, other than the Requestor Upper form on an RFB type 
Business Process. 

 Can be used as source for auto-populate. 

Note: During the auto-population, the "Source Element" picker lists all 
"Bidder" Upper form DEs. 

 Cannot be used as a destination for Reverse Auto-Populate. 

 Cannot be set to: Formula. 

 Cannot be set as: Reset. 

Detail Form

You can define an additional Detail tab for the Requestor section of all RFB type Business 
Process forms. This second Detail tab (non-standard tab) can be used to record the lines of the 
winning bid, as the user copies the data from the Bid Comparison Sheet. 

Note: This applies to all RFB Business Process sub-types (Generic, Line 
Items with CBS Code, and Line Items with Generic Cost Manager). 

The second Detail tab is similar to that of any other non-standard Detail tab on any other Cost 
type BP which allows multiple tabs.   

When the RFB type Business Process has Line Item with CBS Code, the new Detail form allows 
you to include both the "Custom" DE "bitemID" and the "Standard" DE "bi_item" on the form. 

Note: If you place the DE "bitemID" on the form, you must designate 
the DE as "Required." This DE cannot be designated as "Editable." 

The second Detail Form log window contains the following options: 

 New

Allows you to create the second Detail tab for the "Winning Bid." When you click New, the 
Properties window opens which allows you to enter a name and description for the second 
Detail tab. The Name field is pre-populated as "Winning Bid." 

Also, you can: 

- Select Winning Bid option from New to open the properties window and create the new 
form. The Name field is pre-populated as "Winning Bid." 
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- Select the Standard tab and select Copy to create the new form. The Name field is 
pre-populated as "Copy of <form name>." You cannot create more than two Detail tabs for 
an RFB type Business Process. 

Note: For data integrity reasons, the Winning Bid tab cannot be deleted 
after the RFB BP has been deployed. You can add or remove the 
Winning Bid tab before you deploy the RFB BP, only.  

 Copy

Allows you to create the second Detail tab (Winning Bid) by copying a "standard" tab. This 
option is available only if the Business Process has a "standard" tab. You cannot create 
more than two Detail forms for an RFB type Business Process. 

Note: The second Detail tab will have special behavior, if a winning bid 
picker is placed on BP upper form. If no bid picker is placed on the 
Upper form, the tab behaves like any other non-standard tab. 

 Open

Allows you to open an existing Detail form. 

 Properties

Allows you to change the properties of the second Detail tab. You can use the Properties 
option to edit the "Name" and the "Description" fields of your form. 

 Delete

Allows you to delete the second Detail tab (non-standard tab). The Delete option, here, does 
not allow you to delete a "standard" Detail tab. 

Resource Booking 

Resource booking business processes track personnel assignments at the company and shell 
levels. These BPs go through an assignment workflow to fill the personnel openings for a 
project. The process draws personnel only from the allocated roles on a project's or shell's 
allocation sheet. Personnel are "hard" or "soft" booked until the assignment workflow reaches its 
end step, at which time the personnel are then considered either hard-booked or rejected. The 
booking BP allows users to manually balance personnel resources over the duration of the 
project. 

Note: The Resource Booking BP is not available in generic shells. 
However, users can book resources via manual entry on the Booking 
Summary Sheet. 

Only one resource booking BP is allowed at the company, project, or shell level, but that BP can 
be modified if necessary. The resources and their costs from this business process are rolled up 
to both the Company and Project/Shell Cost Sheets. Resource bookings also integrate with the 
Schedule Manager in assigning resources to project schedule activities. 

If necessary, you can design a Resource Booking BP to manage overbooking, which happens 
when resources are booked for more hours than a role has been allocated. 
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Resource booking BPs typically enter hours and cost information onto company and project cost 
and booking sheets as follows: 

The Resource Booking BP enters this information: Onto this sheet: 

The name and hours of hard-booked personnel when the 
BP reaches terminal status. By default, costs are 
calculated based on the rate obtained from the Role 
Attribute form. Users can override the rate directly from 
the booking sheet. 

Project Booking Sheet 

Same Company Booking Sheet 

Costs from the Project Booking Sheet. These costs will be 
added and reported against undistributed costs. Once a 
CBS code is assigned, costs are reported based on the 
BP status (e.g., "Pending" for soft bookings; "Approved" 
for hard bookings). 

Project Cost Sheet 

Costs from the Project Booking Sheet. These costs will be 
added and reported against the project cost code. Costs 
are reported based on the BP status (e.g., "Pending" for 
soft bookings; "Approved" for hard bookings). 

Company Cost Sheet 

Design Requirements for Resource Booking Business Processes 

For Resource business processes to work effectively in Primavera Unifier, you will need to 
create the following components in uDesigner: 

 Upper form 

 Workflow 

 Log 

 Link to a reference process (depending on the BP setup) 

Design Flow 

The following table outlines the design steps necessary to create a these business processes. 

1. Create a 
data structure 
(if necessary) 

This structure will include the data elements to be used on the forms. 
(If the data structure has not already been created, see the 
instructions beginning with Creating a Data Structure (on page 
189).) 

2. Launch the 
design 

This step initializes the design process for the BP. See Starting a 
New Design (Edit Studio) (on page 219). 
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3. Create an 
upper form 

See the instructions beginning with Designing an Upper Form (on 
page 257). 

Mandatory fields for the upper form are: 

 A resource picker (uuu_resource_name) to select the resource 
(personnel or equipment) on which to report time. 

 A date picker (uuu_week_picker) to identify the week for which 
the time sheet is being entered. 

 Status 

4. Create a 
detail form 

See the instructions beginning with Designing Detail Form (on page 
291). 

Mandatory fields for the detail form are: 

 Date picker (uuu_from_date) 

 Date picker (uuu_to_date) 

 Status 

5. Create a 
workflow 

See the instructions beginning with Starting a Workflow (on page 
394). 

6. Create a log See Designing a Business Process Log (Standard or Picker) (on 
page 412). 

TimeSheet 

Timesheet business processes track reportable time for personnel at both the company and 
project/shell level. They are used by individual personnel to enter hours worked. A timesheet BP 
is created under the Resource Manager, but is considered a type of cost BP in that it integrates 
with the Cost Manager to use cost codes at the company and project/shell level. Timesheet BPs 
can reflect the resource, the role, the task being performed, hours worked as well as overtime 
hours, and wage rate. Primavera Unifier users can use multiple line items to enter time for 
various types of work during the same week, including non-project time, such as holidays and 
PTO. 

Depending on how the detail form of the BP is set up, timesheet hours and costs can be rolled 
up to various cost and resource sheets at both company and project/shell level. Timesheets in 
CBS shells can roll up values to the Actuals Sheet. 

Only one timesheet BP is allowed for a company, but you can create multiple workflow schemas 
for the BP. 

Design Requirements for Timesheet Business Processes 

For timesheet business processes to work effectively in Primavera Unifier, you will need to 
create the following components in uDesigner: 

 Upper form 

 Detail form 

 Line Item List 
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 Workflow (optional) 

 Log 

Design Flow 

The following table outlines the design steps necessary to create a timesheet business process. 

1. Create a data structure (if 
necessary) 

This structure will include the data elements to be 
used on the forms. (If the data structure has not 
already been created, see the instructions 
beginning with Creating a Data Structure (on 
page 189).) 

2. Launch the design This step initializes the design process for the BP. 
See Starting a New Design (Edit Studio) (on 
page 219). 

3. Create an upper form See the instructions beginning with Designing an 
Upper Form (on page 257). 

Mandatory fields for the upper form are: 

 A resource picker (uuu_resource_name) to 
select the resource (personnel or equipment) 
on which to report time. 

 A date picker (uuu_week_picker) to identify 
the week for which the time sheet is being 
entered. 

 Status 

4. Create a detail form See the instructions beginning with Designing 
Detail Form (on page 291). 

Mandatory fields for the detail form are: 

 A role picker (uuu_role_name) for users to 
identify the type of work to be performed. 

 Cost code picker (uuu_costcode_picker) 

 Regular rate (uuu_resc_reg_rate) 
(auto-populated from the role picker) 

 Total regular hours 
(uuu_resc_tot_reg_hours) 

 Total dollar amount (uuu_resc_tot_amount) 

If you want users to be able to track non-project 
time on the timesheet, this data element is 
required: 

 Non-project 
time—uuu_resc_non_project_time

5. Create a line items list See Adding an Item Log to a Detail Form (on 
page 291). 
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6. Create a workflow See the instructions beginning with Designing 
Workflows (on page 392). 

7. Create a log See Designing a Business Process Log 
(Standard or Picker) (on page 412). 

Project/Shell Creation 

This type of business process creates new standard projects and shells from the upper form of 
the BP or from line items. The data necessary to create projects/shells is provided by this BP. In 
addition to creating a new shell, this type of business process can also be designed so that 
users can choose the managers and employees who should be automatically assigned to the 
shell when it is created. 

Notes: 

 This BP is not available for configurable managers. 

 You cannot create multiple tabs for this type of business process. 

For example, you could use this type of BP at the company level to request a new site for a 
project and send the request through a review and approval workflow. Once the record reaches 
an approved status, Primavera Unifier would create a new shell at the proper place within a 
hierarchy (or a new standard project if a shell hierarchy is not being used). Information from the 
BP could be passed on to the new shell or project so that users do not need to enter it. 

For another example, you could use this type of BP at the company or shell level to request that 
multiple shells be created. Each record for this BP would collect information for the shells as line 
items. When the record reaches a terminal status, and each line item reaches a status (which 
you specify), Primavera Unifier would create a new shell at the proper place within a hierarchy. 
Information from each line item could be passed on to the new shell so that users do not need to 
enter it. 

Works with Planning Items 

If you include a Planning Item Picker on this business process, users can link new 
projects/shells with planning items. Instead of linking a planning item to a project in the Planning 
Manager, this BP will automatically create the link when the project/shell is created, and data will 
begin to roll up to the Planning Sheet from the business processes in this project. 

This BP creates projects and shells using templates. For shell creation, it also uses an 
integration interface. 

Integration Interface 

If you use the project/shell creator business process to create shells, you must first create an 
integration interface for the shell. The interface should contain all the fields (data elements) 
necessary to create the shell in your environment. In operation, the BP fills in these field values 
in the interface. The interface then uses the template the user specifies to create the project or 
shell. 
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Integration of the project or shell via CSV import is available only for the simple-type business 
process (upper form). 

Currency override is available for CSV import if the project currency picker field is included on 
the Integration form. 

 The CSV import file must use a valid currency code. 

 The override currency must exist in Exchange Rates. 

For instructions on designing the interface, see the Integration section. 

Templates 

This BP creates projects and shells using the templates that have been designed in Primavera 
Unifier. When you design this business process, you must include a template picker, and in 
Primavera Unifier, users will specify the template that should be used to create the project or 
shell. Be aware of the following: 

 The entire template will be used, including any modules. 

 The Project/Shell Creation BP will use the auto-numbering set up in the template, if any, 
to override any number manually entered by the Primavera Unifier user. 

Note: You cannot create an anchor shell (single-instance shell) using a 
template with this BP. 

 The Project/Shell Creation BP will provide the shell or project name, number, location, 
and status for the new project/shell, and also any image and phase data elements, if they 
have been included in the BP. 

 If the image and phase elements have not been included in the business process, 
those values from the template will be used (if any). 

 If designed and configured to do so, the BP will also automatically assign a 
manager and employees to the project/shell. 

 Currency designation: 

 For a project or shell, the currency designation can come from the template; or if 
the business process design includes the project currency picker 
(uuu_proj_currency), the user can override the template currency by using the 
project currency picker to select a valid currency from Exchange Rates. 

 In addition to the defined shell or project currency, users can add multiple 
"candidate" currencies to the project/shell template. 

 If the desired currency is not included in the list of candidate currencies, Primavera 
Unifier will add the override currency from Exchange Rates to the template, set the 
rate as Float, and create the project or shell using that currency. 

 If the template includes links, these will be placed on the new project/shell. 

The following pertains to auto-population in shells: 

If the attribute form of the shell is designed with data elements that should be auto-populated, 
the elements will be populated in the following order: 

1) From the shell or project template 

2) From single-record business processes 
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3) From the shell attribute form of the parent shell 

4) From matching elements in the Project/Shell Creation BP 

Note: For shell creation, be sure you include the elements to be auto-populated on the 
integration interface you create! 

Where to Use This BP 

You can use this BP at the company, project, or shell level. 

At this level: This BP can create: 

Company  Shells in or across a shell hierarchy from the upper form or a line 
item 

 Standard projects from the upper form or a line item 

Shell Shells in or across a shell hierarchy from the upper form or a line 
item 

Project Projects from the upper form or a line item 

Sub-Types 

There are two sub-types of this BP type: 

Simple This sub-type creates a single shell or project from an upper form 
when the record reaches a terminal status. 

Line Item This sub-type creates multiple projects or shells using an upper form 
and line items. The projects/shells are created when the record 
reaches a terminal status, and each line item reaches a specific 
status that the user specifies. 

Projects/shells will be created using the values from the fields on the 
line item detail form; however, if the new projects/shells will contain 
common information, such as the location or phase, you can include 
the fields that are common on the upper form so they need to be 
filled in only once. 

There are two classifications for this sub-type: 

Project or Shell will create projects or shells from line items using 
the location the user specifies. 

Shell and sub-shell will create shells and sub-shells from line items 
using the location the user specifies. 

Note: Whenever a record reaches terminal status, and the line items 
reach the status that the user specifies, the system creates projects 
or shells for each line item. If a line item contains errors, the, the 
system ignores the entire creation and returns the record to a 
non-terminal status. 
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Design Requirements 

For these business processes to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

 Data elements for shell number, shell name, and project phase 

 (For shells) Integration interface for the shell to be created 

 Upper form 

 Detail form (for a Line Item sub-type) 

 Line Item List (for a Line Item sub-type) 

 (Optional) Workflow 

 Log 

Design Flow 

The following table outlines the design steps necessary to create this business process. 

1. Create a 
data structure 

For this business process, you must create three data elements: 

 One to gather the name from the BP for a new shell or project. Use 
the SYS Shell Name data definition to build this element. 

 One to gather the number from the BP for a new shell or project. 
Use the SYS Shell Number data definition to build this element. 

 One to gather the project phase from the BP for a new project. Use 
the Project Phase data definition to build this element. The data 
set for this field will be specified in Primavera Unifier and will be 
available under the project shell as a project phase field when a 
project is auto-created in Primavera Unifier using this business 
process. 

 If you want the user to be able to assign managers and employees 
to the shell during its creation, you will need to create one or more 
user data pickers to place on the upper form of this business 
process. Use the User Data Picker data definition to build these 
elements. When the administrator configures this business 
process, the picker(s) can be filtered to show only certain 
employees. Note: If you place user data pickers on this business 
process form, be sure the same pickers are on the shell attribute 
form. 

See the instructions beginning with Creating a Data Structure (on 
page 189).) 

2. Design an 
integration 
interface 

Use the integration interface to create shell creation business 
processes that will, in turn, create shells. 

See Creating an Integration Template. 

3. Launch the 
design 

This step initializes the design process for the BP. See Starting a New 
Design (Edit Studio) (on page 219). 

4. Design an 
upper form 

See the instructions beginning with Designing an Upper Form (on 
page 257). 
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For this 
sub-type: 

These fields are mandatory: 
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Line Item  status to specify the status of the business process 
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Simple 

For a shell: 

 uuu_shell_creator

 uuu_shell_location to specify where the shell should 
reside in the hierarchy 

 uuu_administrator to specify the shell administrator 

 uuu_shell_template_picker to specify the shell 
template for the auto-created shell 

 uuu_shell_status to specify what status the shell 
should have when it is created the shell name (based 
on the SYS Shell Name data definition) the shell 
number (based on the SYS Shell Number data 
definition) 

 status to specify the status of the creation BP. When 
the BP reaches this status, Primavera Unifier will 
create the shell. 

If you want to automatically link the shell to a planning 
item, include a Planning Item Picker 
(uuu_planning_item_picker) 

If you want the user to be able to assign managers and 
employees to the shell during its creation, include the 
user data picker(s) you created in Step 1. 

For a project: 

 uuu_project_creator

 uuu_administrator to specify the project 
administrator 

 uuu_proj_template_picker to specify the project 
template for the auto-created project 

 uuu_shell_status to specify what status the project 
should have when it is created 

 uuu_proj_address_1 

 uuu_proj_address_2 

 uuu_proj_address_3 

 uuu_proj_city 

 uuu_proj_state 

 uuu_proj_country 

 uuu_proj_zip 

 uuu_proj_phone 

 uuu_proj_fax 

 uuu_project_phase 

 the project name (based on the SYS Shell Name
data definition) 

 the project number (based on the SYS Shell Number
data definition) 

 status to specify the status of the creation BP. When 
the BP reaches this status, Primavera Unifier will 
create the project. 

Note: If you want to automatically link the project to a 
planning item, include a Planning Item Picker 
(uuu_planning_item_picker) 



Unifier uDesigner User Guide

66

5. Design a 
detail form 

(Simple 
sub-types do 
not need detail 

See the instructions beginning with Designing Detail Form (on page 
291) 

For this 
sub-type: 

These fields are mandatory: 
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Project or 
Shell 

For a shell: 

 uuu_shell_creator 

 short_desc 

 uuu_shell_location to specify where the shell should 
reside in the hierarchy 

 uuu_administrator to specify the project/shell 
administrator 

 uuu_shell_template_picker to specify the 
project/shell template for the auto-created shell or 
project 

 uuu_shell_status to specify what status the shell 
should have when it is created 

 the project/shell name (based on the SYS Shell 
Name data definition) 

 the project/shell number (based on the SYS Shell 
Number data definition) 

 uuu_line_item_status to specify the status of the 
line item. When the line item reaches this status, 
Primavera Unifier will create the shell. 

Note: If you want to automatically link the project/shell to 
a planning item, include a Planning Item Picker 
(uuu_planning_item_picker) 

For a project: 

 uuu_project_creator

 short_desc 

 uuu_administrator to specify the project 
administrator 

 uuu_proj_template_picker to specify the project 
template for the auto-created project 

 uuu_shell_status to specify what status the project 
should have when it is created 

 uuu_proj_address_1 

 uuu_proj_address_2 

 uuu_proj_address_3 

 uuu_proj_city 

 uuu_proj_state 

 uuu_proj_country 

 uuu_proj_zip 

 uuu_proj_phone 

 uuu_proj_fax 

 uuu_project_phase 

 the project name (based on the SYS Shell Name
data definition) 

 the project number (based on the SYS Shell Number
data definition) 

 uuu_line_item_status to specify the status of the 
line item. When the line item reaches this status, 
Primavera Unifier will create the project. 

Note: If you want to automatically link the project to a 
planning item, include a Planning Item Picker 
(uuu_planning_item_picker)
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Shell and 
Sub-Shell 

 uuu_shell_creator 

 short_desc 

 uuu_shell_location to specify where the shell should 
reside in the hierarchy 

 uuu_administrator to specify the shell administrator 

 uuu_shell_template_picker to specify the shell 
template for the auto-created shell 

 uuu_shell_status to specify what status the shell 
should have when it is created (Note: Make this field 
a "Required/Editable" field on the design. If the shell 
status of the parent shell is inactive or has no value, 
child shells will not be created.) 

 the shell name (based on the SYS Shell Name data 
definition) 

 the shell number (based on the SYS Shell Number
data definition) 

 uuu_line_item_status to specify the status of the 
line item. When the line item reaches this status, 
Primavera Unifier will create the shell. 

Note: If you want to automatically link the shell to a 
planning item, include a Planning Item Picker 
(uuu_planning_item_picker) 

6. Create a 
workflow 

See the instructions beginning with Starting a Workflow (on page 
394). 

7. Create a log
See Designing a Business Process Log (Standard or Picker) (on 
page 412). 

Asset Manager Overview 

In Unifier, the Asset Manager is where users can enter company assets, set up depreciation 
schedules for them, and classify them into categories to make managing them more efficient. 
Ultimately, Unifier can gather these assets onto a sheet to track asset depreciation in monthly, 
quarterly, or yearly increments. 

The Asset Manager uses the three most common depreciation methods—straight line, double 
decline, or sum of year digits—as well as manual depreciation. Regardless of which method is 
used, asset depreciation is calculated for the entire life of the asset over whatever period you 
specify. For example, if an asset is depreciating over two years and you specify a monthly 
depreciation increment, then the asset's value will be recalculated each month for two years 
from the date of acquisition. 

Asset values on the asset sheets at both the classification level and on the summary sheet are 
recalculated automatically, but users can also refresh the values manually at any time. These 
values are then rolled up to the company account sheet. 
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Unlike most modules in Unifier, the Asset Manager does not use business processes; rather, it 
uses attribute forms to create asset classes and detail forms to create the assets themselves. In 
Unifier, an asset class maps assets to company account codes, tracks asset costs and 
depreciation, and keeps the company account sheet updated with current asset values. In 
addition, the manager uses reference processes to extract the asset's acquisition cost from a 
company-level BP. 

In Unifier, the Asset Management node lists the names of every class. These nodes are where 
Unifier users create and modify new assets, set up their depreciation schedules, and refresh 
assets to recalculate their values and update the asset class sheet and the company account 
sheet. 

The Asset Sheets node displays the asset sheets for each class, as well as a summary asset 
sheet that shows the total value of each class from the class asset sheets. Unifier automatically 
creates an asset sheet for every asset class that is created. On these sheets, Unifier users can 
add new assets and specify what should appear on the sheet for the asset; map assets to 
company account codes and roll up an asset's current depreciated value to the company 
account sheet. On the summary asset sheet, they can refresh the asset values and export them 
in csv format. 

Design Requirements for the Asset Manager 

For the Asset Manager to work effectively in Unifier, you will need to create the following 
components in uDesigner: 

Asset Class Attribute form Sets up the Asset Manager and defines asset classes 
and their corresponding codes. To define codes, you 
must use a formula to build the code from the 
segments of data elements that were created for your 
assets (such as location segments: 
country-state-city). 

The codes appear on the company Asset sheet, 
where users can drill down to see assets by code 
segment. Also appears on the Asset picker on 
resource-type business process forms. 

Log Lists every asset class designed for Unifier. Allows 
Unifier users to choose the asset class they want to 
work with. 

Link to a reference process) (if 
necessary 

Retrieves the asset's acquisition cost from a 
company-level business process. 

Design Flow 

The following outlines the design steps necessary to launch the manager and create an asset 
class. 
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1. Create a data 
structure (if necessary)

See Creating a Data Structure (on page 189) 

2. Launch the manager See Launching a Manager (on page 158) 

3. Create an Asset 
Class Attribute Form 

See the instructions 
beginning with Adding 
Blocks to the 
Attribute Form (on 
page 175) and also 
Adding Fields to the 
Form (on page 304) 

Mandatory fields for the asset 
attribute form are: 

 Asset code (uuu_asset_code) 

 Asset name (uuu_asset_name) 

 Asset acquisition cost 
(uuu_asset_acquisition_cost) 

 uuu_asset_depreciation_prd 

 uuu_asset_calc_as_of_date 

 uuu_asset_net_book_value 

 Cumulative depreciation 
(uuu_asset_cum_depreciation) 

 Current period depreciation 
(uuu_asset_curr_period_dep) 

 Asset salvage value 
(uuu_asset_salvage_value) 

 Asset navigation code (must 
contain at least 2 code segments 
to create the tree hierarchy) 
(uuu_asset_navigation_code) 

 Status 

If users should be able to reserve this 
asset, these fields are mandatory: 

 Allow asset to be reserved 
(uuu_rsv_reservable) 

 Allow over-booking 
(uuu_rsv_overbook) 

4. Create a log for the 
manager 

See Designing a Log for a Manager (on page 181) 
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Standard Cost Manager Overview 

The Standard Cost Manager is where Unifier users keep track of costs at both the Company 
level and Project/Shell level. 

The Standard Cost Manager is typically used for construction projects and, therefore, uses a 
CBS code structure to break down the work. You can use a CBS code structure, as well as 
company account codes and fund codes, to link income and expenses on a detailed level. 

The Standard Cost Manager combines a number of costing features and functions to generate 
the following cost management tools: 

 Cost Sheets to show: 

 Company and Program budgets and the monies that have been spent. 

 Project/Shell budgets to track costs by CBS code. 

Note: Costs can be added to this sheet manually or automatically using 
rollups from Cost-type Business Processes, Project/Shell budgets, or 
Worksheets. 

 A Company Accounts Sheet to track company-level information, such as assets, resources, 
or facility maintenance. It is similar to a cost sheet, but it uses the account codes instead of 
CBS codes. 

 Fund Sheets to track the company's income and the distribution of funds across 
projects/shells. Funds can be added to this sheet manually or automatically using cost-type 
business processes and formulas. Likewise, funds can be assigned or consumed manually 
or automatically using cost business processes. 

 A Schedule of Values (SOV) for every blanket purchase order (Base Commits) to streamline 
tracking and reimbursing invoices or payment applications. 

 Cash Flows to generate a variety of cash flow curves at user-specified frequencies. 

Cost Management Levels 

In Unifier, you can track costs at the: 

 Company level 

 Program level 

 Project/Shell level 

Company level

 Cost Sheet 

The Cost Sheets node contains the Company Cost Sheet (a detailed accounting of the 
company budget and costs), broken down by project/shell. The node works much like a 
spreadsheet that calculates and maintains cost information on all "active" and "on-hold" 
projects/shells. As Project/Shell Cost Sheets are created, the Project/Shell Cost Sheet data 
rolls up and the data is displayed on the Company Cost Sheet. 

 Funding 
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The Funding node is where the Company Funding Sheet is stored. This sheet tracks all 
sources of funding for all project/shells and programs. There is only one funding sheet per 
company, from which monies are distributed to the project/shell funding sheets. This sheet 
has auditing features that disclose the details of all funding events. The Company Funding 
Sheet must be created in Unifier before any project/shell funding sheets. 

 Cash Flow 

This is a costing feature users can use to create cash flow sheets and curves. Specifically, 
users can: 

 Set baselines for projected spends 

 Track actual costs 

 Calculate future spends, based on a known forecast (extrapolation) 

 Calculate from trends compared to baseline curves (interpolation) 

Cash Flow values can roll up from the Project/Shell level to the company level to show cash 
flow data across multiple projects. Users can save generated cash flow sheets and curves 
and refresh them to include new data. They can also generate table data showing 
incremental and cumulative values and graphs displaying multiple cash flow curves. 

See About Cash Flow Curves (on page 74). 

Program level

 Cost Sheet 

Unifier automatically creates Program Cost Sheets once a Project Cost Sheet has been 
created in at least one project within the program. The Program Cost Sheet displays cost 
data for all projects within the program that have a status of "active" or "on-hold." The data 
from individual Project Cost Sheets can be configured to automatically roll up to the Program 
Cost Sheet. The currency used for the Program Cost Sheet will be the company's base 
currency. 

 Cash Flow 

This is a costing feature users can use to create cash flow sheets and curves. Specifically, 
users can: 

 Set baselines for projected spends 

 Track actual costs 

 Calculate future spends, based on a known forecast (extrapolation) 

 Calculate from trends compared to baseline curves (interpolation) 

See About Cash Flow Curves (on page 74). 

Project/Shell level

 Cost Sheet 

This node contains the Project Cost Sheet, a detailed accounting of the project's budget and 
costs. It works much like a spreadsheet that calculates and maintains cost information. The 
rows of this cost sheet display CBS codes or cost codes. These codes can be used to link 
project or program costs to the General Ledger for Finance. Cost information can be entered 
manually, pulled from work packages or worksheets, or rolled up automatically from business 
processes when transactions occur in Unifier. 
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This cost sheet can work in conjunction with work packages and worksheets, if the Unifier 
user creates them. 

A Work Package is a group of cost sheet rows that is a subset of the Project Cost Sheet. 
Work packages provide insight into the budget without providing full access to the details of 
the Project Cost Sheet. 

A Worksheet can be created by the Unifier user to support the Project Cost Sheet. The user 
can use this as a separate sheet to perform complex calculations or enter other cost data not 
required on the cost sheet. Information from this worksheet can then be rolled up into a 
Project Cost Sheet column. 

 Funding 

This Funding node contains the Project Funding Sheet. This sheet tracks where project 
funding comes from and how it is being spent on the project. There is only one funding sheet 
per project. Project funding sheets work in conjunction with the company-level funding sheet, 
which maintains the sources of all project funding. Funding sheets are independent of cost 
sheets. 

Funding data can be entered manually on this sheet, or rolled up automatically from business 
processes when transactions occur in Unifier. 

Funding data for projects rolls up to the Company Funding Sheet. 

 Cash Flow 

This is a costing feature users can use to create cash flow sheets and curves. Specifically, 
users can: 

 Set baselines for projected spends 

 Track actual costs 

 Calculate future spends, based on a known forecast (extrapolation) 

 Calculate from trends compared to baseline curves (interpolation) 

Cash flow values can roll up from the project level to the company level to show cash flow 
data across multiple projects. Users can save generated cash flow sheets and curves and 
refresh them to include new data. They can also generate table data showing incremental 
and cumulative values and graphs displaying multiple cash flow curves. 

 Schedule of Values (SOV) 

A Schedule of Values (SOV) is maintained at the project level. An SOV is a way to 
assemble information from contract, change order, and invoice/payment application business 
processes into a single sheet. This SOV sheet streamlines the process of invoicing for 
completed phases of a project. The SOV: 

 Includes a breakdown of the contract values that has been agreed to by the owner and 
contractor. 

 Works in conjunction with Commit types of Business Processes (BPs), such as a 
purchase order. Commit-types of BPs can be designed to automatically create an SOV 
sheet when they reach a designated step in a workflow. 

The following is a list of SOV sheet types: 

 General Spends 

 Payment Applications 

 Summary Payment Applications 
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The General Spends SOV sheet type gathers information from any contract, change 
order, or invoice/payment application BP into an SOV sheet. 

The Payment Applications SOV sheet type allows users to enter values directly onto the 
SOV sheet. Unifier then automatically adds these values to the payment application 
sheet. 

Note: Both the General Spends and Payment Applications SOV sheet 
types can be designed to show CBS information, either as grouped CBS 
codes, or as individual line items from commit BPs. 

The Summary Payment Applications SOV allows users to allocate cost to line items 
based on the line item type (Lump Sum or Unit Cost). Use the Summary Payment 
Applications SOV type in association with Commit and Spends Business Processes 
(BPs) that are designed for Summary payment applications SOV type. The Summary 
Payment Applications sub-node will be available under the Schedule of Values node only 
if a Base Commits, or Change Commits, of SOV type Summary Payment Applications is 
deployed in uDesigner. 

Note: An error will occur after clicking Unit Cost if you do not select the 
Item Unit Cost and Item Quantity (uuu_unit_price and uuu_Quantity) 
fields in the Detail form design. 

See About the Schedule of Values (SOV) (on page 76). 

 Earned Value (EV) 

The Earned Value (EV) is a costing feature you can use to track quantitative information 
about project status using an "earned value analysis." This analysis provides specific 
numerical measurements for reviewing progress as the project team advances through the 
tasks on the project schedule. It can help project managers monitor whether or not projects 
are on schedule and on budget by providing accurate and consistent methods to estimate 
the: 

 Percentage of budget spent 

 Percentage of work completed 

 Percentage of time elapsed 

See About Earned Value (on page 77). 

About Cash Flow Curves 

Different curve types produce different cash flow curves: 

This type of curve: Does this: 

Calculation Generates a curve based on sigma and mu values. 

Data from Cost Sheet 
column 

Generates curves based on cost sheet column data. 
Cost sheet columns entered manually are not included in 
the curve. 
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This type of curve: Does this: 

Manual Generates a curve based on data that was manually 
entered into the cash flow sheet, at the project level or 
CBS level. For this type of curve, users will need to 
specify the start and end date for the curve. 

Combination Manual and 
Calculation 

Generates a calculation curve with the option of entering 
values manually. This allows users to plot graphs based 
on manually entered forecast information, but starting at 
the end of actual values. This type of curve also allows 
users to force manually entered numbers to the foot of 
the column in the Cost Sheet. 

Extrapolate vs. Interpolate 

When users create a cash flow curve, they have the option of extrapolating the actual cost 
based on a provided data set. For example, they can estimate (extrapolate) the cash flow curve 
for this year based on last year's data. They will need to specify which data from last year's Cash 
Flow Sheet they want to base the extrapolation on. 

Interpolation is estimating the cash flow curve based on known start and end values. There 
isn't an equivalent option to "interpolate" as there is for "extrapolate based on data set," but it is 
possible to interpolate data by specifying end point cost data. For interpolation, the curve will be 
based on a specified end point. The base curve and interpolated curve will merge together if the 
end values are the same. 

Users can show both extrapolation and interpolation by specifying an "S Curve" and a beginning 
calculation point. The curve will be generated from the last point of actual data. To create such a 
curve at the CBS level, Unifier calculates the extrapolated and interpolated data based on an 
end point and then sums all of the curve points to display one curve from the period where the 
first value appears. 

About CBS Codes 

A Work Breakdown Structure (CBS) code is a number that you can apply to a task that matches 
the specific needs of your business. In Project Management, CBS codes are used to break 
down a project into manageable pieces that can be more effectively estimated and monitored. 
CBS codes organize the total work scope of a project. These codes are typically composed of 
segments that can precisely describe the cost item from a general level down to any number of 
specific levels. Each descending level represents an increasingly detailed definition of the 
project work. 

A CBS code consists of 1 to 10 segments, each defined in uDesigner as a cost code definition. 
For example, a five segment CBS code would require five data definitions. 

A CBS code becomes a row on a project cost sheet, describing a cost item. Each cost sheet row 
corresponds to the unique CBS codes that link costs on a project to the General Ledger for 
Finance. 
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About the Schedule of Values (SOV) 

An SOV sheet streamlines the process of invoicing for completed phases of a project. It works in 
conjunction with commit types of business processes, such as a purchase order. The 
Commit-types of business processes can be designed to automatically create an SOV sheet 
when they reach a designated step in a workflow. 

Unifier users can define one SOV sheet per Commit-type business process (such as a purchase 
order). The rows on the SOV sheet are automatically populated by the CBS or account codes in 
the Commit BP. 

For SOV creation in Unifier, the user must set up the correct column structure for the SOV sheet 
so that the required columns and formulas are included for validating Summary Commitments 
(by CBS) and a Remaining Commits Balance. In the SOV structure, the user must define a 
formula for Remaining Commits Balance that reflects the amount of Commits, minus Spends. 
This column ensures the Spend BP line items are not overdrawn from SOV breakdown amounts. 

The following lists the types of Schedule of Values (SOV): 

 General Spends 

 Payment Applications 

 Summary Payment Applications 

General Spends

Use the General Spends SOV type for any Commit Business Process and associated Change 
Commits and Spends/Invoices. 

Payment Applications

Use the Payment Applications SOV type: 

 In association with Commit and Spends Business Processes that are designed for payment 
applications. This allows direct entry of values in an SOV sheet, which are automatically 
added to a payment application. 

 For invoicing at the CBS or breakdown level. Payment Applications auto-populate data to 
and from the SOV to manage balance-forward formulas. The breakdown is similar to the 
General Spends SOV sheet. 

The General Spends and Payment Applications SOV types can show CBS information either by 
grouping CBS codes (CBS mode) or as individual line items from commits (Base Commits and 
Change Commits together). The information that SOVs display is dependent upon the design of 
the Base Commits. 

Summary Payment Applications

The Summary Payment Applications SOV allows users to allocate cost to line items based on 
the line item type (Lump Sum or Unit Cost). 

Use the Summary Payment Applications SOV type in association with Commit and Spends 
Business Processes (BPs) that are designed for Summary Payment Applications SOV type. 

The Summary Payment Applications sub-node will be available under the Schedule of Values 
node (Project/Shell > Cost Manager node > Schedule of Values node) only if a Base Commits, 
or Change Commits, of SOV type Summary Payment Applications is deployed in uDesigner. 
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Note: An error will occur after clicking Unit Cost if you do not the Item 
Unit Cost and Item Quantity (uuu_unit_price and uuu_Quantity) fields in 
the Detail form design. 

About Earned Value 

"Earned value" is a method for measuring project performance. It compares the amount of work 
that was planned with what was actually accomplished to determine if cost and schedule 
progress is as planned.  

Earned value analysis is an industry standard used to measure a project's progress, forecast its 
completion date and final cost, and provide schedule and budget variances. 

Schedule activities "earn value" as they are completed. 

The earned value function in Unifier 
calculates the following for every 
scheduled activity: 

The results of these calculations are used by 
Unifier to calculate the: 

 Budget Cost of Work Scheduled 
(BCWS) 

 Budget Cost of Work Performed 
(BCWP) 

 Actual Cost of Work Scheduled 
(ABCWP) 

 Cost Variance (CV) 

 Schedule Variance (SV) 

 Cost Performance Index (CPI) 

 Schedule Performance Index (SPI) 

 Cost Schedule Index (CSI) 

 To Complete Performance Index (TCPI)

Note: All calculations are done from the start date of an activity to the 
current date. 

In Unifier, the earned value sheet always represents data by CBS code. Earned value 
calculations depend on the Company Cost Sheet and Cash Flow, and can optionally include 
activities on the Schedule Sheet. Users can also view a graphical representation of Earned 
Value, Budget at Completion (BAC) and Actual Cost. 

Example Budget Cost of Work Scheduled (BCWS) Calculation 

Assume a budget of $1000 is to be consumed by an activity scheduled to be performed in one 
week (5 days). 

 BAC = $1000.00 

 BCWS = $200.00 per day 

 BCWS for day 3 will be $600.00 

Mar 10 Mar 11 Mar 12 Mar 13 Mar 14 Total 

BAC $200 $200 $200 $200 $200 $1000 

BCWS $200 $200 $200 $600 
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Note: This is a simplified example. Normally, costs are incurred per 
CBS. BAC, % Complete, and ACWP will differ based on the CBS in 
consideration 

Example Budget Cost of Work Performed (BCWP) or Earned Value 

This is the value of the planned (not actual) work performed by the status date, measured in 
currency. 

 BCWP = BAC * % Complete 

For example, based on the previous example, if 40% of the work is completed on day 3, then 
BCWP is $400. 

Mar 10 Mar 11 Mar 12 Mar 13 Mar 14 Total 

BAC $200 $200 $200 $200 $200 $1000 

BCWS $200 $200 $200 $600 

BCWP $200 $200 $ 0 $400 

Example Actual Cost of Work Performed (ACWP) or the Actual Cost 

This is the total of direct and indirect costs incurred in performing work during a given period. 
Assume that the task's actual cost (ACWP) at the status date is $750. 

Mar 10 Mar 11 Mar 12 Mar 13 Mar 14 Total 

BAC $200 $200 $200 $200 $200 $1000 

BCWS $200 $200 $200 $600 

BCWP $200 $200 $ 0 $400 

ACWP $250 $200 $300 $750 

This earned value analysis identifies discrepancies between ACWP, BCWS, and BCWP— 
problems for which the user can then take immediate steps to remedy. 

Earned Value and Derived Measures 

From the examples above, Unifier will calculate the following values: 

Cost Variance Cost Variance (CV) is the difference between a task's estimated or 
budgeted cost and its actual cost. A negative variance indicates the 
project is over budget. 

 CV = BCWP - ACWP       Example: $400 - $750 = -$3 
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Scheduled 
Variance 

Scheduled Variance (SV) is the difference between the current 
progress and the scheduled progress of a task, in terms of cost. It is a 
comparison of the amount of work performed during a given period of 
time to what was scheduled to be performed. A negative variance 
means the project is behind schedule. 

 SV = BCWP - BCWS        Example: $400 - $600 = -$200 

Cost 
Performance 
Index 

Cost Performance Index (CPI) is the ratio of budgeted costs of work 
performed to actual costs of work performed. A value of less than 
1(less than 100%) indicates that the project is over budget; you are 
getting less work per dollar than planned. 

 CPI = BCWP/ACWP      Example: 400/750 = 0.53 or 53% 

Scheduled 
Performance 
Index (SPI) 

Schedule Performance Index (SPI) is the ratio of budgeted costs of 
work performed to budgeted costs of work scheduled. A value of less 
than 1 (less than 100%) indicates that the project is behind schedule. 

 SPI = BCWP/BCWS      Example: 400/600 = 0.67 or 67% 

Cost Schedule 
Index 

The Cost Schedule Index (CSI) reflects the relationship between CPI 
and SPI. CSI value should be close to 1.0. The farther the value from 
1.0, then project recovery becomes more difficult to achieve. 

 CSI = CPI x SPI      Example: 0.53 x 0.67 = 0.3551 

To Complete 
Performance 
Index (TCPI) 

The To Complete Performance Index (TCPI) is the ratio of the work 
remaining to be done to funds remaining to be spent, as of the status 
date. A TCPI value greater than 1 indicates a need for increased 
performance; less than 1 indicates performance can decrease. This 
helps determine how much of an increase in performance is necessary 
on the remaining project tasks in order to remain within budget. 

 TCPI = (BAC - BCWP) / (BAC - ACWP)  Example: ($1000 - $400) / 
($1000 - $750) = 2.4 

Estimate At 
Completion 

Estimate at Completion (EAC) is the expected total cost of a task or 
project, based on the performance as of status date. 

 EAC = ACWP + [(BAC - BCWP) / CPI]  Example: $750 + [($1000 - 
$400) / 0.53] = $1882 
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Variance At 
Completion 

VAC is the difference between the Budget At Completion (BAC) and 
the Estimate At Completion (EAC). 

 VAC = BAC - EAC       Example: $1000 - $1882 = -$882 

How Cost Transactions Work in Unifier 

At the company level, finances are monitored on two sheets: a Company Cost Sheet, which 
shows the amounts of costs incurred; and a Funding Sheet, which shows how much money is 
available to spend, and the sources from which these monies come. To begin a project/shell, a 
Blanket PO or Base Commit is issued at the company level authorizing the spending of funds 
on the project/shell. As Commit BPs or Change Order BPs are approved, monies are drawn 
down from the Base Commit, and reflected on the Company Cost Sheet, which is broken down 
into CBS codes. 

When a Base Commit BP is approved, it creates a Schedule of Values (SOV). The SOV is the 
"working document" on which committed monies are entered. The committed monies shown on 
the SOV are rolled up to the Company Cost Sheet. Change Commit BPs continue to change or 
add costs to the SOV during the life of the project/shell. 

When a Spends BP is approved, three things happen: 

1) An invoice or payment application is created from the SOV. 

2) The monies requested on the Spends BP are rolled up and debited on the Company Cost 
Sheet. 
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3) The company Funding Sheet is changed to reflect the monies consumed by the approved 
Spends BP. 

Design Requirements for the Cost Manager 

For the cost Manager to work effectively in Unifier, you will need to create the following 
components in uDesigner. 

Note: For a description of the business processes the Cost Manager 
uses, see Business Processes Overview (on page 13). 
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Cost Attribute 
Form 

Defines the cost codes that support the CBS breakdown of the 
Company Cost Sheet. The information from this attribute form appears 
in Unifier in the CBS Details window; also appears on the CBS picker
on cost-type business processes where users must choose a CBS 
code from a list. 

To open the Picker log, users can click on the Picker node under cost 
attributes. The picker log has four tabs: General, Layout, Sort Order, 
and Find. In the General tab, users can edit Name and Description. In 
the Layout tab, users can add any data elements from the cost 
attribute form to be shown in the Picker log. In the Sort Order tab, 
users can select the sort order of the CBS code to be ascending or 
descending. In the Find tab, users can add search elements which will 
be used to filter CBS rows at run time.  

The data element values on this form automatically populate 
corresponding data elements in cost business process line items. The 
auto-population occurs when the CBS code is added to the line item in 
the business process. 

Fund Attribute 
Form 

Defines a fund code and its corresponding code segments. To do this, 
you must use a formula to build the code from the segments of the 
data elements that were created for your company funds. 

Note: This attribute form does not create a record; the information 
exists only as part of a fund sheet. Consequently, you will need to 
design a fund picker for this form to populate. 

Unifier users will see the information from this form in the Fund 
Details window in Unifier; also appears on the Fund picker on 
cost-type business processes where users must choose a fund from a 
list. 

Account Code 
Attribute Form 

Defines the codes for company-level accounts and cost accounts. 
These codes or accounts can then be used to track company-level 
costs, such as assets, resources, or facility maintenance. These 
account codes are independent of CBS cost codes. 

Note: This attribute form does not create a record; the information 
exists only as part of a cost sheet. Consequently, you will need to 
design an account picker for this form to populate. 

The information from this attribute form appears in Unifier on the 
Account Sheet at the company level; also appears on the Account 
picker on cost-type business processes where users must choose an 
account from a list. 
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Pickers for 
funds and 
account codes 

Unifier populates most pickers with the records that you see in the 
logs on the right pane of the screen, and uses the layout of the 
headings on the logs for the layout of the picker. These logs show the 
records that were created, for the most part, with attribute forms. 
However, attribute forms for funds and account codes use pickers 
designed specifically for them because they do not create records that 
will appear on logs; they exist only as part of a fund sheet or cost 
sheet. In these cases, you will need to design a picker in the same 
way you would design a log. 

Design Flow 

The following table outlines the design steps necessary to create the attribute forms for the Cost 
Manager. 

1. Create a data 
structure 

(If necessary) 

See Creating a Data Structure (on page 189) 

2. Launch the design for 
each attribute form 

See Launching a Manager (on page 158) 

3. Create a Cost 
Attribute Form 

See the instructions 
beginning with Adding 
Blocks to the Attribute 
Form (on page 175) 

Mandatory fields for the Cost attribute form are: 

CBS Code (uuu_cost_code) 

Cost Type (uuu_cost_cost_type) 

CBS Item  (uuu_cost_item) 

Status (uuu_cost_status) 

4. Create a Fund 
Attribute Form 

See the instructions 
beginning with Adding 
Blocks to the Attribute 
Form (on page 175) 

Mandatory fields for the Fund attribute form are: 

Fund Code (uuu_fund_code) (must be a formula type field) 

Fund Name (uuu_description) 

5. Create a Company 
Cost Account Attribute 
Form 

See the instructions 
beginning with Adding 
Blocks to the Attribute 
Form (on page 175) 

Mandatory fields for the Company Account attribute form are: 

Company Account Code 
(uuu_company_account_code)(must be a string formula 
type field) 

Company Account Name (uuu_company_account_name)

6. Create a Fund Picker 

See Designing a Picker (on page 180) 
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7. Create a Company Cost Account Code Picker 

See Designing a Picker (on page 180) 

When you select an item from the CBS picker, the cost codes (in the Cost business process) will 
be displayed according to the order that was selected in the Cost Sheet (the selected default 
view set in the (Company Workspace > Admin mode > uDesigner node > Cost Manager > 
Cost Attributes > Picker node log > Log Page Design window > Sort Order tab > Sort Order
field). The Sort Order field will be disabled when the Sort By field is set as Cost Sheet Default 
View.  

Note: The Sort Order field displays the data elements that are added in 
the Layout tab. 

For other columns, the Sort Order is enabled, and you can select any column from the Sort By 
field. At run time, if you have selected any particular column in the Sort By field, the CBS picker 
log sorts the summary codes, and the leaf-level codes will be sorted based in ascending, or 
descending, order which was selected in uDesigner. 

Generic Cost Manager Overview 

Generic cost managers monitor cost-related activities for configurable shells in Unifier. Unlike 
the Standard Cost Manager in Unifier, the data analyzed by a generic cost manager comes from 
the cost sheets of shells and sub-shells, not standard projects. The Standard Cost Manager in 
Unifier is designed to accommodate business financing, which typically suits projects that 
proceed over a fixed time range. Generic cost managers, on the other hand, are well-suited for 
projects/shells of an ongoing nature, such as a building shell, where you would typically want to 
collect and analyze operating and maintenance costs for a specific building over the life of that 
building. 

In designing a generic cost manager, you will be defining cost codes that will collect and analyze 
cost-related information for anything that exists under a shell. You can create cost codes for all 
the various projects or business needs you are likely to manage in any shell and include them in 
a single cost manager that will support all of the various shells. 

A generic cost manager works similarly to Unifier's Standard Cost Manager, but with the 
following differences. 

Notes:  

 You can create only one Generic Cost Manager. This manager can 
be used in all your shells. 

 You cannot use both a Standard Cost Manager and a Generic Cost 
Manager in the same shell. 
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Standard Cost 
Manager 

Generic Cost Manager 

Is available for 
standard projects as 
well as shells 

Is only available for shells 

Used for capital 
projects with limited 
life cycles 

Used for projects with extended life cycles 

Uses a CBS code 
structure 

Uses a customized coding structure; it does not use CBS codes 
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Standard Cost 
Manager 

Generic Cost Manager 

Cost Sheet: 

 Has no time 
dimension 

 User creates 
columns and 
rows in the 
sheet itself 

 Enables 
forecasting 
adjustments via 
AFC and YTB 
values 

 Can be viewed 
in flat or tree 
format, but 
cannot be 
changed 

 Cannot modify 
the exchange 
rate; uses the 
rate defined in 
the shell 
properties 

 Cost transaction 
data is shown in 
the project 
currency at the 
project level, 
and in base 
currency at the 
company level 

 Accepts data 
entered 
manually, via 
business 
processes, from 
a worksheet, or 
generated by a 
formula 

Cost Sheet: 

 Has a time dimension; user must specify time scale units by 
which to view the sheet 

 Has two components—sheet and structure; user creates 
columns and rows using the structure of the sheet 

 Does not offer forecasting 

 Can be toggled between flat and tree format views and offers 
default views of current shell, current shell and sub-shells, or 
sub-shells only 

 Can modify the exchange rate; can revert to the rate specified 
for the shell; user can view the exchange rate history 

 Cost transaction data is shown in the shell currency or the 
base currency 

 Accepts data entered manually or generated by a formula 



Generic Cost Manager Overview

87

Standard Cost 
Manager 

Generic Cost Manager 

Rolls up only 
currency amounts 

Note: Shells do not 
support any roll-ups 
from the Standard 
Cost Manager. 

 Rolls up quantity amounts as well as currency amounts 

 Rolls up to the Company Cost Sheet only line items with 
multiple codes, including leases, base/change commits, 
transfers, and general spends 

Includes a Funding 
Sheet 

Does not support a Funding Sheet 

Provides earned 
value and cash flow 
features 

Does not offer earned value or cash flow features 

Base Commit BP 
creates a Schedule 
of Values (SOV) 
sheet 

Base Commit BP creates "Commitments Summary" rather than 
an SOV 

Design Requirements for a Generic Cost Manager 

For a Generic Cost Manager to work effectively in Unifier, you will need to create the following 
components in uDesigner. 

Note: For a description of business processes this Cost Manager uses, 
see Business Processes Overview (on page 13). 

Generic Cost 
Manager 
Attribute 
Form 

The information from this attribute form appears in Unifier in the Generic 
Cost Code Details window when a user adds a row to the cost sheet 
template; also appears on the picker on cost-type business processes 
where users must select a cost code from the generic cost manager. 

Picker Unifier populates most pickers with the records that you see in the logs 
on the right pane of the screen, and uses the layout of the headings on 
the logs for the layout of the picker. These logs show the records that 
were created, for the most part, with attribute forms. However, attribute 
forms for generic cost managers use pickers designed specifically for 
them because they do not create records that will appear on logs; they 
exist only as part of a cost sheet. In these cases, you will need to design 
a picker in the same way you would design a log. 
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Design Flow 

The following table outlines the design steps necessary to launch the manager and create the 
attribute form. 

1. Create a data 
structure (if necessary) 

See Creating a Data Structure (on page 189). 

2. Launch the manager See Launching a Manager (on page 158). 

3. Create a Generic 
Cost Manager Attribute 
Form 

See the instructions 
beginning with Adding 
Blocks to the 
Attribute Form (on 
page 175) and also 
Adding Fields to the 
Form (on page 304)  

Mandatory fields for the attribute form are: 

Code name (uuu_cm0_name) 

Cost code picker (uuu_cm0_code) 

Status (uuu_cm0_status) 

4. Create a picker See the instructions under Designing a Picker (on page 
180). 

Document Manager Overview 

In Unifier, the Document Manager maintains all the files and documents for a project. Each 
project/shell includes its own Document Manager, and another Document Manager resides at 
the company level. The manager ensures that employees and project/shell members are always 
using the most current versions of documents and makes accessing and distributing documents 
efficient. Files in the Document Manager are stored on the Unifier file server. In Unifier, they can 
be organized into a folder structure to categorize them and make them easily available, much 
like a filing cabinet.  

The Document Manager is integrated with business processes. Unifier users can initiate a 
business process directly from the Document Manager and automatically attach files and folders 
to it. In addition, you can design a business process to automatically publish its records, along 
with their comments and attachments, to the Document Manager. In effect, this produces a 
detailed audit trail of the record information through the business process (for both workflow and 
non-workflow processes). Depending on how the administrator sets up the business process, it 
can be automatically published to the Document Manager when it reaches a specific step in a 
workflow, or whenever an email notification is sent regarding the status of the business process, 
or both. (Refer to the uuu_dm_record_info_path element description in the Unifier Data 
Reference Guide.) 
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In Unifier, the Documents node in the navigator is where all project documents—such as 
drawings, spreadsheets, image files, Microsoft Office files—are stored and managed. Users can 
store documents directly in this node, or organize them into folders under this node. Users can 
upload, download, revise, or mark up all project documents from this node.The Documents node 
has check-in/check-out, document lock, and revision history features for version control. 

The Unpublished Documents node is the temporary, automatic repository for files that have 
been uploaded from local machines and attached to business processes, but which have not yet 
been published to the Documents node. When a user uploads a file from a local machine and 
attaches it to a business process, the document is automatically stored in the Unpublished 
Documents node with a link to the business process to which it belongs (unless a path to a 
folder has been configured using the uuu_dm_publish_path data element; see note below). The 
link to the business process allows the administrator to review where the document originated 
from. This way, the administrator can control the documents that are accessible in the Document 
Manager. For example, a subcontractor might submit a Request for Information (RFI) with 
attached documents requesting input from the architect. The attached documents can be traced 
to the original business process through the link, and the documents will become available in the 
unpublished node. The administrator can then review the documents, decide where to store 
them, and publish them to the Documents node; or the administrator can decide not to publish 
them at all. 

Notes:  

 Creating Document Manager Attributes is optional and all default 
properties will apply. 

 Drawing files are handled with the base file listed, and the associated 
reference files bundled with it, similar to a zip file. 

 For document-type business processes With Folder Structure, you 
can specify that a configured folder path be appended to the folder 
structure. This appended path is based on the path configured in the 
uuu_dm_publish_path data element on the business process form, 
and the selection of the Append Line Items Folder Structure to 
AutoPublish Path option. See Designing an Upper Form (on page 
257). 

Document Attribute forms can contain fields that are numbered using auto-sequencing. This 
functionality requires that the Document Attribute form contain up to two data elements that are 
based on the SYS Auto Sequence data definition. You can create any number of data elements 
(fields) using this definition. Fields using this definition provide auto-sequencing of unique 
numbers for all documents created. The content of the field is automatically generated based on 
the format for the auto-sequence data elements that is configured in Unifier. Data elements that 
use this data definition: 

 Are always read-only 

 Can be placed in a hidden block 

 Are available for Mobile configuration 

 Can be selected as a display element of a Data Picker 

 Can be added to Integration, marked as Output only 

 Cannot be selected as a linked element 
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 Cannot auto-populate or reverse auto-populate 

 Cannot use a hyperlink 

 Cannot be part of a Dynamic Data Set definition  

To set up SYS Auto Sequencing for the Document Manager, go to Company Workspace
(Admin mode) > uDesigner > Document Manager > Folder and Document Attributes > 
Open > Data Elements. See Auto Sequence Tab (on page 245) for more information on using 
the Auto Sequence tab.  

Design Requirements for the Document Manager 

For the Document Manager to work effectively in Unifier, you will need to create the following 
components in uDesigner:  

Note: For a description of business processes the Document Manager 
uses, see “Overview of Business Processes”. 

Folder 
Properties 
Attribute Form

Collects Properties related to the folders used to organize documents in 
the Document Manager. 

The information from this attribute form appears in Unifier in the DMS 
Folder Properties window. 

Document 
Properties 
Attribute Form

Collects data (including the title, name, and issue date) related to the 
documents that users store in the Document Manager. 

The information from this attribute form appears in Unifier in the DMS 
Document Properties window 

Log Lists the document folders and documents in Unifier. Allows Unifier 
users to choose the document or folder they want to work with. 

Design Flow 

The following outlines the design steps necessary to launch the manager and create folder and 
document properties. 

1. Create a data 
structure (if necessary) 

See Creating a Data Structure (on page 189) 

2. Launch the manager See Launching a Manager (on page 158) 

3. Create a Folder 
Properties Attribute 
Form 

See the instructions 
beginning with Starting 
an Attribute or Detail 
Form for a Manager
(on page 161). 

Mandatory field for the Folder Properties attribute form: 

Document Manager (uuu_dm_node_name) 

You must place this field in the first row of the form. You can 
set this field as Editable (Required) or Read-Only. If you 
want to allow users to rename files, select the Editable 
(Required) option. 
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4. Create a Document 
Properties Attribute 
Form 

See the instructions 
beginning with Starting 
an Attribute or Detail 
Form for a Manager
(on page 161) 

Mandatory field for the attribute form is: 

 Document Manager (uuu_dm_node_name) 

 Mandatory field for the Document Properties attribute form 
if auto-sequencing is desired: Any data element that uses 
the SYS Auto Sequence data definition 

 If users should be able to reserve this document record, 
these fields are mandatory: 

 Allow record to be reserved (uuu_rsv_reservable) 

 Allow over-booking (uuu_rsv_overbook) 

 If you want a document URL to display in the document 
properties, use the data element (uuu_doc_attribute_url). 

5. Create a log for the 
Manager 

See Designing a Log for a Manager (on page 181) 

Creating Multiple Attributes Forms 

The following explains how to create multiple attributes forms in the Document Manager node.  

The Document Manager node contains the following sub-nodes: 

Note: You must open the existing Attribute form in order to view the 
nodes. 

 Folder Properties

 Document Properties

 Log

The following explains each sub-node in details. 

Folder Properties 

Go to Company Workspace > Admin mode > Document Manager > Folder Properties. 

You can create multiple attribute forms in DMS Folder Properties node. The following explains 
different functionalities available in Folder Properties. 

The following are the menu options of the DMS folder properties log: 

 File

 Edit

 Properties

 Delete

 View

 Help

The following are the toolbar options of the DMS folder properties log: 

 New
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Enables you to create new attribute forms. By default, when a DMS attribute design is 
created in Document Manager, the corresponding DMS Attributes - Folder properties form 
will be available to the user and will be marked by the system as default. The user will have 
the ability to create multiple attributes form either by New or Copy action. When the user 
clicks New to create folder properties attribute form, a new window opens where user must 
enter name and description for the form to be created. Once the user clicks OK, the newly 
created folder properties attribute will be seen in the log. For example, if the user entered the 
form name as "test dms," then in the log the user will see the name as "test dms - Folder 
properties." Once the folder properties attributes form is created, the corresponding 
document properties attribute form and document log will be created. For example, if the 
user has "test dms - Folder properties" form in folder properties, then the user will see "test 
dms - Document properties," in Document Properties log. In the Log node, the user will see 
"test dms - Log." 

 Copy

When the user clicks Copy, the selected attribute form will be copied over. The user will see 
a window open where the user will enter the name and description. The Name field will be 
auto-populated with name from the original form with a prefix "Copy From." For example, if 
the user is trying to copy "test dms - Folder properties," then the window will show an 
auto-populated name for the form as "Copy From test dms." If the user clicks OK, then the 
folder properties will show an entry as "Copy From test dms - Folder Properties." Once the 
folder properties attributes form is created, the corresponding document properties attribute 
form and document log will be created. For example, in Document Properties log, the user 
will see "Copy From test dms - Document properties." In the Log node, the user will see " 
Copy From test dms - Log." 

 Open

When the user clicks Open, the form will open and user will be able to add various DEs to 
the attribute form. For newly created attribute form, an empty form opens. For a copied 
attribute form, the form shows all the DEs from the original attribute form. For an existing 
form, the form shows all the DEs which were last saved. 

 Properties

When the user clicks Properties, the user will be able to change the description for the 
attribute form. The name will be read-only. 

 Delete

When user clicks Delete, the user will be able to delete the folder attribute form. Once a 
folder attribute form is deleted, the corresponding Document attribute and Document log will 
be deleted as well. 

Important: 

 The user will not be able to delete published attributes forms. 

 The user will not be able to delete the system defined form as well. 

 Once the form is deleted, Unifier marks the DM configuration "inactive," and the user will 
not be able to activate this DM configuration again; however, the user will be able to 
delete the configuration. 

 The delete option will be disabled in Production environment. 

 Once an attribute form is deleted, the corresponding DM configuration will be deleted as 
well. 
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The following are the columns of the DMS folder properties log: 

 Name

Displays the name of the attribute form. 

 Description

Displays the description given to the attribute form. 

 Last Saved

Displays the last saved date for that attribute form. 

 System Defined

The DMS attribute - Folder Properties is always the default form to be used in the DMS 
attribute. 

 Published Date

Displays the last published date for that attribute form. The published date will only be seen 
when a DMS attribute form was part of the published configuration package for production.  

Document Properties 

Go to Company Workspace > Admin mode > Document Manager > Document Properties. 

Once the folder properties attributes form is created, the corresponding document properties 
attribute form will be created. For example, if the user has "test dms - Folder properties" form in 
Folder Properties, then in the Document Properties log the user will see "test dms - 
Document properties." Once the folder properties attributes form is created (by way of copying 
the corresponding document properties), the attribute form will be created. For example, if "Copy 
From test dms - Folder Properties" was created (by way of copying the corresponding document 
properties), then in the Document Properties log the user will see "Copy From test dms - 
Document properties." 

The existing validations for DMS attribute forms in Document Properties will take place across all 
of the multiple attribute forms. 

Log 

Go to Company Workspace > Admin mode > Document Manager > Log. 

Once the Folder Properties attributes form is created, the corresponding document log will be 
created. For example, if the user has "test dms - Folder properties" form in Folder Properties, 
then in Document Properties log, the user will see "test dms - Log." Once the folder properties 
attributes form is created via copy corresponding document log will be created. For example: If 
"Copy From test dms - Folder Properties" was created (by way of copying the corresponding 
document properties), then in Document Properties log the user will see "Copy From test dms - 
Log." 

The existing validations for log will take place across all of the multiple logs. 
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Planning Manager Overview 

The Planning Manager is where Unifier users can plan for new projects/shells and proposals 
and create forecasts for those projects/shells that are already running in Unifier. They cannot 
administer planned projects/shells the way they administer real projects/shells in Unifier; 
however, they can manage the planning phases for these projects/shells as business processes 
in Unifier using the same functions used by other business processes. Planned projects/shells 
can include cost sheets, resource sheets, funding sheets, and other typical business processes; 
but certain data, such as dates and monies, can be viewed as future forecasts. 

Note: Because planning BPs are not "live" projects/shells, the data 
elements for planned projects/shells and proposals cannot be 
auto-populated, cannot contain formulas, and should not be part of a 
dynamic data set. 

You can have a Planning Manager at both the company and project/shell levels. 

The Planning Sheet is central to Planning Manager functions. Each planning item "type" (such 
as a capital plan or a campus remodel) can have one or more planning sheets that contain 
information about the plans of this type being considered by your company. It is from these 
sheets that Unifier users access, create, update, and import or export the company's plans. 
Business processes designed for planning items can roll up information onto the planning 
sheets. 

In addition, using a Project/Shell Creation type of business process, you can create new projects 
or shells for planning items when they reach a certain status or condition. If the Project/Shell 
Creation BP includes a Planning Item Picker, Unifier users can link new projects/shells with 
planning items. Instead of linking a planning item to a project in the Planning Manager, this BP 
will automatically create the link when the project/shell is created, and data will begin to roll up to 
the Planning Sheet from the business processes in this project. (See Project/Shell Creation (on 
page 59).) 
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Notes:  

About Rolling Up Planning Item Data: 

 You can roll up values for planning items in two ways: 

 Using a Project Picker or Shell Picker: If a planning item is for a 
specific project or shell, you must include a Project or Shell Picker on 
the planning item attribute form. The user can link the planning item 
directly to the project/shell, and business processes in the project or 
shell with fields that match those on the attribute form will roll up 
values to the Planning Sheet. 

 Using a Planning Item Picker: If you include a Planning Item Picker on 
a Project/Shell Creation BP, the user can include a planning item in 
the project or shell when it is created. Business processes in the 
project or shell with fields that match those on the planning item 
attribute form will roll up values to the Planning Sheet. 

Using Unifier's snapshot feature, Unifier users can take a "picture" of the planning sheet at any 
point in time. This is a way of "drilling down" into the planning process to expose specific plans 
or planning phases for particular attention. 

In Unifier, the Planning Items node is where users create new plans and proposals, import 
plans from outside applications, export a plan template, and link a plan to a running project/shell 
in Unifier. 

The Planning Sheets node is where users create and manage planning sheets. A planning 
sheet can contain data for one or multiple plans and proposals. From the planning sheets, users 
can automatically update individual plans with changes made on the planning sheet. 
Reciprocally, they can refresh the planning sheet with changes made to individual plans. 

Design Requirements for the Planning Manager 

For the Planning Manager to work effectively in Unifier, you will need to create the following 
components in uDesigner: 

Planning Item 
Attribute Form 

Describes the type of plan being considered, such as capital, IT, 
or resource. The information from this attribute form appears in 
Unifier as a record in the planning log, and can also appear on the 
Planning Sheet if it is added to the sheet. Also appears on the 
Planning Item picker on business processes where users must 
choose a planning item at the company level. 

Using the Project Picker or Shell Picker on the attribute form, 
users can link the planning item directly to a project or shell. If 
they do this, information will roll up into the planning item from the 
data elements (fields) that are common between BPs in that 
project/shell and this attribute form. Users can see the latest 
values for these fields by clicking the Refresh button on the 
planning sheet. 
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Planning Sheet 
Attribute Form 

Describes what the planning sheet will show at the company 
level. The information from this attribute form appears in Unifier 
on the Planning Sheet Properties window. The attribute data 
appears on the General tab when the user opens the planning 
sheet Properties window from the Planning Manager > 
[planning sheet name] node. 

Log for both the 
plan and sheet 

Lists the planning items and planning sheets currently in use in 
Unifier. Allows Unifier users to choose the plan or planning sheet 
they want to work with. 

Design Flow 

The following outlines the design steps necessary to launch the manager and create a planning 
item or planning sheet. 

1. Create a data structure (if necessary) See Creating a Data Structure (on page 
189). 

If the planning item types will reside across 
shells, you will need to create a data picker 
for the planning items. See Creating a Data 
Picker Definition (on page 200) 

If you intend to design business processes 
that will auto-create new planning items, you 
will need to create a planning item creator 
data element to place on the business 
processes. Refer to the description of the 
Planning Item Creator data definition in the 
Unifier Data Reference Guide for more 
information. 

2. Launch the manager See Launching a Manager (on page 158). 

3. Create a Planning Item Detail Form 

See the instructions beginning with 
Starting an Attribute or Detail Form for 
a Manager (on page 161) 

Mandatory fields for the attribute form are: 

Planning Item (uuu_planning_item) 

If this planning item is for a standard project, 
this field is also mandatory: 

Project Picker (uuu_proj_picker) 

If this planning item is for a shell, this field is 
also mandatory: 

Shell Picker (uuu_default_shell_picker) 

4. Create a Planning Sheet Detail Form 

See the instructions beginning Starting 
an Attribute or Detail Form for a 
Manager (on page 161) 

Mandatory fields for the attribute form are: 

Planning Sheet Name (uuu_name) 

Last Update 
(uuu_last_update_date)(read-only) 

5. Create a log for both See Designing a Log for a Manager (on 
page 181). 
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Portfolio Manager Overview 

The Portfolio Manager is where the budget forecast planners in your company can gather cost 
and schedule information on projects (both planned and in execution) and perform analyses on 
"what if" scenarios. These scenarios are used to propose an optimal mix of projects for a 
portfolio, based on available budget targets and the strategic goals of the company. 

Using the Portfolio Manager, planners can create a portfolio for a specific "planning horizon" (for 
example, from 2014 through 2020) and then create multiple scenarios in that portfolio. Each 
scenario can use forecast numbers and actuals, as well as schedule dates, for both planned and 
active projects in a specific shell type across a hierarchy in the company. 

Budget forecast planners create these scenarios on sheets, one for each scenario. Using a 
query condition set up by the administrator, the scenario sheets can pull in the following data 
from any shell type in a hierarchy: 

 Project information from the shell attribute form or single-record business process 

 Project start and end dates from the shell attribute form or single-record business 
process 

 Cash flow data (both forecasted and actual) from each project's Cost Manager 

With this data, the planner can forecast costs over a specific time period (called a "period 
structure"). Planners can then manipulate scenarios by: 

 Including or excluding projects 

 Pushing start dates for planned projects into the future 

 Modify project end dates to change the project's duration 

 Proposing different cash flow distribution numbers by manually editing the cash flow 
columns 

 Negotiating proposed budgets with project managers 

Note: The numbers the planner proposes in a scenario will NOT affect a 
project's live data. The proposed numbers are stored only in the Portfolio 
Manager and will not affect live project data until a scenario has been 
approved by your company management. 

Once these scenario analyses have been completed, the best (or several best) scenario(s) can 
be sent to the executive decision makers for approval. 

When a scenario has been approved, Unifier: 

 Marks the approved scenario "shared" so that project managers can see the approved 
dates and numbers. The scenario is set to read-only mode and can no longer be 
modified or deleted. 

 Updates each project's original budget numbers with the proposed numbers on the 
approved scenario. 
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 Updates each project's monthly or yearly cash flow numbers with the proposed numbers 
on the approved scenario. 

 Updates the project start date (if it was changed) for any planned projects that will begin 
during the portfolio's planning period. 

 Updates the project/shell data with any project/shell information that was changed on the 
scenario sheet, and sends you an email notification of the updates. 

 Locks the budget and cash flow numbers to prevent any further changes. 

Design Requirements for the Portfolio Manager 

Design Requirements for the Portfolio Manager 

For the Portfolio Manager to work effectively in Unifier, you will need to create the following 
components in UDesigner: 

Portfolio 
Attribute 
Form 

Describes the type of portfolio being created, such as "capital." The 
information from this attribute form appears in Unifier as a record in the 
Portfolio Manager log. 

Log for the 
portfolios 

Lists the portfolios currently in use in Unifier. Allows Unifier users to 
choose the portfolio they want to work with. 

Design Flow 

The following outlines the design steps necessary to launch the manager and create a portfolio. 

1. Create a data 
structure (if necessary)

See Creating a Data Structure (on page 189). 

2. Launch the manager See Launching a Manager (on page 158). 

3. Create a portfolio 
detail form 

See the instructions 
beginning with 
Starting an Attribute 
or Detail Form for a 
Manager (on page 
161) 

Mandatory fields for the portfolio form: 

 Creator ID—creator_id 

 Creation date—uuu_creation_date 

 Portfolio name—uuu_ppm_name 

 Period picker—uuu_ppm_period_picker 

4. Create a log for the 
portfolios 

See Designing a Log for a Manager (on page 181). 

5. Create an 
integration interface to 
push information from 
an approved portfolio 
to the project/shell 
attribute form 

See Integration (on page 425). 
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Resource Manager Overview 

The Resource Manager is where Unifier users can set up and manage a company's or shell's 
personnel resources. These resources are always maintained at the company level, to be 
distributed among the company's projects or shells. Resources can also include those of a 
partner company. 

Notes: 

 The Resource Manager has limited functionality in generic shells: 

 Users cannot allocate resources in a generic shell. This means they 
cannot view the Allocation and Utilization sheets. 

 The Resource Booking business process is not available; however, 
users can book resources directly onto the Resource Summary sheet 
in a generic shell. 

Using the Resource Manager, Unifier users can classify job functions into roles that can then be 
allocated to projects/shells. These roles will be used to define billable rates, which are used in 
budgeting, and can also be used in planning for resource demands across projects. Roles are 
filled with personnel resources—the people who can perform these roles in a project/shell. The 
Resource Manager is where users can assign personnel to roles and projects/shells. 

In the Resource Manager, personnel can serve multiple roles, depending on their skills or 
interests. For example, a construction role and a plumbing role might be served by one person 
who has both carpentry and plumbing skills. 

The Resource Manager supports Timesheet business processes for capturing and tracking 
actual resource costs associated with activities and assignments at the project, shell, and the 
company level. The manager also supports hard and soft Resource Booking BPs using a 
calendar that shows what project/shells a resource has been booked for, as well as the times 
during which the resource is unavailable. 

The Resource Manager automatically creates the following sheets users need to manage 
resources, bookings, and certain budgeting and forecast functions: 

Allocations 
Summary 

Master allocation sheet that shows role allocations at the company and 
project level. Read-only. 

Resource 
Allocation 

Allows manual entry of role allocations against projects from company 
level so users can balance resources across projects. The Resource 
Allocation Sheet rolls up to the Allocations Summary Sheet at both the 
project and company level. 

Booking 
Summary 

Shows hard resource bookings across projects in both hourly and 
currency views. 

Actuals 
Summary 

Shows resource actuals from timesheet data for the company. 
Read-only. 
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Utilization 
Summary 

Shows current total utilization of resources as a percentage of the total 
at the company level. Read-only. 

Bookings vs. 
Actuals 

At both the company and project/shell level, shows hard resource 
bookings across projects/shells in both hourly and currency views, 
similar to the Booking Summary Sheet. Also shows columns per 
resource for booked hours, actual hours, and the variance (booked, 
minus actual hours). Read-only. 

Availability At the company level, shows current availability of each resource 
across projects/shells. The resource availability equals the resource's 
total capacity, minus the total bookings across the projects/shells, 
minus the non-project times specified. 

Design Requirements for the Resource Manager 

For the Resource Manager to work effectively in Unifier, you will need to create the following 
components in uDesigner: 

Note: For a description of the business processes the Resource 
Manager uses, see Business Processes Overview (on page 13). 

Role Attribute Form Describes the types of work being performed. Roles are 
for work performed for specific projects, or for general 
administrative work not specific to any project. The 
information from this attribute form appears in Unifier in 
the Role Properties window. The attribute form data 
appears on the General tab when the user opens the 
role from the Resource Manager > Roles node at the 
company level. Also appears on the Role picker on 
resource booking and time sheet business processes. 

Resource Attribute Form Lists the personnel users can specify for project 
bookings and assignments. The information from this 
attribute form appears in Unifier in the Resource 
Properties window. The attribute form data appears on 
the General tab when the user opens the resource BP 
from the Resource Manager > Resources node at the 
company level. Also appears on the Resource picker on 
resource booking and time sheet business processes. 

Log for the resources Lists every resource entered into Unifier. Allows Unifier 
users to choose the resource they want to work with. 
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Design Flow 

The following table outlines the design steps necessary to launch the manager and create a role 
or resource. 

1. Create a data 
structure (if necessary) 

See Creating a Data Structure (on page 189). 

2. Launch the manager 
See Starting an Attribute or Detail Form for a Manager
(on page 161). 

3. Create a Role 
Attribute Form 

See the instructions 
beginning with Adding 
Blocks to the Attribute 
Form (on page 175) 

Mandatory fields for the attribute form are: 

Role name (uuu_role_name) 

Role status (uuu_role_status) 

4. Create a Resource 
Attribute Form 

See the instructions 
beginning with Adding 
Blocks to the Attribute 
Form (on page 175) 

Mandatory fields for the Resource attribute form are: 

Resource name—uuu_resc_name 

Resource status—uuu_resc_status 

Resource code—uuu_resc_code 

Default resource capacity—uuu_resc_capacity 

This is the number of hours a person can work in a day. Can 
be overridden by the capacity fields noted below. 

If you want to calculate the weekly hours that a resource is 
available, include the following fields. With these values, 
Unifier will calculate and display the resource's available 
hours on the Availability sheet. 

Monday hours—uuu_resc_mon_capacity 

Tuesday hours—uuu_resc_tue_capacity 

Wednesday hours—uuu_resc_wed_capacity 

Thursday hours—uuu_resc_thu_capacity 

Friday hours—uuu_resc_fri_capacity 

Saturday hours—uuu_resc_sat_capacity 

Sunday hours—uuu_resc_sun_capacity 

5. Create a log for the 
resources 

See Designing a Log for a Manager (on page 181). 
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Schedule Manager Overview 

The Schedule Manager is where Primavera Unifier users can create and manage schedules at 
both the project/shell and program level. They can create a Project/Shell Schedule Sheet that 
is customized to the project's or shell's needs. When they create the first Schedule Sheet for a 
project/shell, Primavera Unifier automatically creates a Program Schedule Sheet. Once these 
sheets are created, users can then use them to create project/shell activities and tasks, assign 
resources to tasks, create relationships between activities, track schedule progress and 
variables, and calculate the schedule's critical path. 

In Primavera Unifier, users can also import project schedule records from Primavera Project 
Planner P3® or Microsoft® Project. These external project schedules can provide additional 
detail or supporting schedule information; for example, resource information, or subcontractor or 
vendor schedules. Imported schedules are editable within Primavera Unifier, and the data can 
be used in reports. 

The Schedule Manager presents schedule activities as interactive Gantt charts, where users 
can: 

 Zoom in to see tasks at the day, week, or month level 

 Move activities and add dependency relationships, and automatically update the dates on 
the schedule 

 Create critical path calculations that will flag activities that, if delayed, can cause the 
schedule to go beyond the planned project end date 

Using Primavera Unifier's snapshot feature, users can take a "picture" of the schedule sheet at 
any point in time. This is a way of "drilling down" into the scheduling process to expose specific 
activities or milestones for particular attention. Using the Schedule Manager's baseline function, 
users can measure progress and determine payments against original estimates; and with the 
"tracking Gantt" feature, they can compare schedule dates, such as baseline estimates against 
the actual schedule. 

If users are copying activities from one schedule to another, Primavera Unifier will immediately 
notify them if the change will create a schedule conflict so that they can make corrections as 
they work. Each change in the Schedule Manager creates a record in Primavera Unifier, which is 
useful for auditing purposes. An audit report of these records shows detailed information on 
dates, events, actions, and old values vs. new values, along with the user or proxy user who 
performed the action. 

Each project/shell can have multiple schedule sheets, and one master schedule sheet. This 
master sheet drives project start and end dates, tracks the project's progress, and serves as the 
interface between the Schedule Manager and other Primavera Unifier modules. In particular, the 
master schedule updates resource assignment information in the Resource Manager, which 
affects timesheets and resource utilization figures; and it integrates cost items on the schedule 
with the Cost Manager. Primavera Unifier users can refresh resource rates on the schedule 
sheet and post the new rates to the Cost Manager, update the cost sheet with assignment costs, 
and refresh costs on the sheet to recalculate labor costs and post them to the cost sheet. 
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Entering and Viewing Cost Data 

You can add data elements that allow users to enter and view cost data on their schedule 
sheets. These data elements are Activity Cost 1 (and Activity Total Cost 1 Per CBS) and Activity 
Cost 2 (and Activity Total Cost 2 Per CBS). The Cost and Per CBS data elements have a 
predefined association between them. Also, you can add a data element (Activity Latest 
Progress As Of) that allows users to view the date of the last activity data change. 

In Primavera Unifier activity setup, users can associate one or more CBS Codes to an activity. 
The value carried by Total Cost data element on activity form gets passed onto these CBS 
codes as the result of calculations such as data rollup to a Cost Sheet, or earned value 
calculations. The logic used by the Activity Cost 1 and Activity Cost 2 and the associated Activity 
Total Cost 1 Per CBS and Activity Total Cost 2 Per CBS data elements is based on the 
association of an activity to a CBS code. 

The values for Activity Total Cost 1 Per CBS and Activity Total Cost 2 Per CBS data elements 
are calculated by the system based on the corresponding Activity Cost 1 or Activity Cost 2 data 
element values. 

These are the steps the system follows to calculate values for Activity Total Cost 1 Per CBS and 
Activity Total Cost 2 Per CBS data elements: 

1) If the combination of Cost and Per CBS data elements are used on an Schedule Activity 
Attribute form, the system will scan through all of the activities and associated CBS codes. 

2) The system will accumulate all of the values in the Activity Cost 1 or Activity Cost 2 data 
elements for all activities per CBS code associated with each activity. 

3) Use the total value calculated in step 2 per CBS code as the value for each Activity Total 
Cost 1 Per CBS and Activity Total Cost 2 Per CBS data element specified for each activity. 

4) Each activity gets a total value calculated in step 2 based on the CBS code associated with 
it. 

This example explains these calculations. For this example, the data elements Activity Cost 1 
and Activity Total Cost 1 Per CBS have been added to the attribute form: 

Activity Name Activity Cost 1 Activity Total Cost 1 Per CBS 

Control Account 1 $28,000.00 

Control Activity 1.1 $19,000 

Control Point 1.1.1 $10,000.00 $28,000.00 

CBS - 1 $10,000.00 

Control Point 1.1.2 $9,000.00 $28,000.00 

CBS - 1 $9,000.00 

Control Activity 1.2 $9,000.00 

Control Point 1.2.1 $5,000.00 $28,000.00 

CBS - 1 $5,000.00 
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Activity Name Activity Cost 1 Activity Total Cost 1 Per CBS 

Control Point 1.2.2 $4,000.00 $28,000.00 

CBS - 1 $4,000.00 

Control Account 2 $20,000.00 

Control Activity 2.1 $20,000.00 

Control Point 2.1.1 $8,000.00 $20,000.00 

CBS - 2 $8,000.00 

Control Point 2.1.2 $12,000.00 $20,000.00 

CBS - 2 $12,000.00 

In the above example, Control Point 1.1.1 has a value $28000.00, which was arrived at by 
adding the value of CBS - 1 across all activities. 

Automating a Schedule Using Scope Management 

The Schedule Manager includes a schedule automation feature called "Scope Management" 
that you can use for those projects that can "self-manage" themselves. Scope Management 
creates project deliverables, assigns resources to the deliverables, and drives the coordinated 
completion of the deliverables. It initiates the activities that produce the deliverables based on 
fixed durations and the completion of dependencies; routes the activities to the responsible 
person or group; monitors their completion; and updates the activity's status automatically. 

Note: You can use Scope Management on any schedule, including a 
master schedule. 

Any project, large or small, can benefit from scope management if it uses a set of discrete, 
standardized deliverables and dependencies which must be produced within specific, 
predictable durations. The typical volume of these projects can be in the hundreds or thousands; 
they might use 10 to 30 roles or participants on each project; and there are typically 10 to 1,000 
deliverables per project. 

The design of Scope Management particularly suits high-volume, quick-turnaround projects, 
such as constructing a chain of coffee houses, or installing wireless cell towers or commercial 
security systems. These projects typically: 

 Are shorter in scope 

 Have the same deliverables 

 Follow activities of fixed duration 

 Use the same roles and participants 
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In operation, Scope Management automatically creates a business process record from any 
activity on a schedule sheet that is set for scope management. In Primavera Unifier, users link 
the activity to a business process, select the users or groups that should work on the tasks, and 
specify what conditions the activity must meet before Scope Management can declare the 
activity complete. The activity BP proceeds through the workflow, where team members work on 
each task in the activity, and the Scope Management feature automatically sends the task to the 
next assignee and updates the activity status on the schedule sheet. 

Note: In schedule automation, a single activity can be linked to only one 
BP record at a time; no two activities can share the same record. 

To prepare scope management for a project: 

The uDesigner 
user must: 

The Primavera Unifier administrator must: 

 Add certain 
data 
elements to 
the Activity 
Attribute form 
to prepare the 
activity for 
scope 
management 

 Design BPs 
to be used by 
the activity in 
scope 
management 

Set up the scope management in the schedule template by: 

 Turning on auto-scheduling for the schedule 

 Entering a start date for the automated project 

 Specifying the name of the BP that should be launched by the 
activity 

 Specifying the users or groups that will be responsible for the 
completion of the activity 

 Specifying the conditions under which the activity will be 
considered "complete" 

To function in Primavera Unifier, Scope Management: 

 Obtains the name of the BP to launch from the activity's setup in Primavera Unifier 

 Creates the BP record and copies the Forecast Duration value into the new Record 
Duration 

 Auto-populates the appropriate data elements (fields) on the BP, including the activity's 
actual start date and record number 

 Sets the activity's status to "In Progress" 

 Sends the BP to an "initiation" step before the beginning of the workflow for assignment 
to the users or group responsible for its completion (For information on the initiation step, 
see Auto-Creating a Record or Line Item from a Form (on page 359).) 

Scope Management Activity Statuses

Scope Management activity statuses are pre-defined and cannot be changed or added 
to. These statuses are attached to activities as they proceed through the Scope 
Management workflow. They are: 
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Scope Management Activity Statuses

Scope Management activity statuses are pre-defined and cannot be changed or added 
to. These statuses are attached to activities as they proceed through the Scope 
Management workflow. They are: 

Not Started 
All activities are in this status by default. This status means that a BP has 
not yet been launched for this activity. 

In Progress 

Scope Management sets the activity status to In Progress when all 
predecessor activities have been completed and the current activity is Not 
Started. When this occurs, a new BP record is created and linked to the 
activity. 

Complete 
An activity is Complete when the BP linked to the activity is complete, 
based on the completion conditions that were specified for the activity. 

Not 
Applicable 

This status is only available if the activity has been switched to manual 
mode. If a user takes the activity off "auto-update" and specifies a Not 
Applicable status, the Schedule Manager will ignore this activity when it 
evaluates predecessors and will set its successor activity to In Progress. 

Assuming Manual Control 

In Primavera Unifier, users can take manual control over an activity at any time by deselecting 
the Auto-update Activity Data checkbox on the activity's Properties window. If they do this: 

 The link to the BP record (if any) and the activity's current status are both retained. 

 Primavera Unifier continues to enforce the Scope Management update rules for the 
activity's status; however, the user must manually attach the status to the activity. 

 The user must manually enter the actual start date, the actual finish date, and the 
completion date, for an activity because the system does not track those dates. 

Subsequently, the user can return the activity to Scope Management mode by selecting the 
Auto-update Activity Data checkbox on the activity's Properties window. To resume Scope 
Management, Primavera Unifier: 

 Updates the BP record status for the activity 

 Checks the record for "complete" conditions 

 Sets the appropriate status of the activity (either In Progress or Complete) 

If an activity is not linked to a BP, then the system checks the internal scope conditions. 

 If the internal scope conditions are satisfied, then the system launches the appropriate 
BP, and sets the activity status to "In Progress." 

 If the internal scope conditions are not satisfied, then the system sets the activity status 
to "Not Started." 
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Accumulating and Calculating Progress Data 

The Schedule Manager includes the capability to capture detailed activity progress data for a 
project, including earned progress. You can add optional additional data elements to the Activity 
Attribute form to support this detailed progress data, or the user can use the default progress 
accumulation that is part of the Schedule Manager. 

Earned progress is a key component to calculating earned value. Earned Value Management 
(EVM) is a project management technique for measuring project progress in an objective 
manner, and combines the measurement of scope, schedule, and cost in a single integrated 
system. Earned Value analysis (performed in the Cost Manager in Primavera Unifier) allows 
project managers and project stake holders to determine whether project is on schedule and on 
budget. Based on the outcome of the earned value analysis, the project manager can decide if 
corrective action is needed to ensure that the project can be completed within defined 
constraints. Examples of corrective actions are changing the scope of work, extending the 
schedule, or adding or reassigning resources. 

One of the key components of this technique or tool is to capture progress of a project. This 
progress is usually provided by a general contractor or the person who is in charge of the 
project. These progress entries are analyzed to determine the state of the project, or the earned 
progress. In Primavera Unifier, earned progress is captured in the context of activity progress, 
and the link between the Cost Manager and the activities in the Schedule Manager is provided 
through the CBS codes assigned to each activity. The CBS codes are assigned to activities in 
the CBS Codes tab of the activity's Properties window. 

In Primavera Unifier, the earned progress calculation is optional. Not all users of the Schedule 
Manager will want to accumulate and calculate earned progress. In that case, you do not have 
to add the earned progress data elements (Earned Progress and Earned Amount) to the 
Activity Attribute form. 

To prepare progress accumulation and calculation, including earned progress data elements if 
needed: 

The uDesigner 
user must: 

The Primavera Unifier Administrator must: 

Add certain data 
elements to the 
Activity Attribute 
form to prepare 
the activity for 
progress 
accumulation 

Import the updated Activity Attribute form that contains the optional 
additional data elements 

The Resource Assignment Attribute form (described in the next section) can also contribute to 
the earned progress calculation. 
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Resource Assignment by Resource Type and Resource Effort 

By default, users can select the names of hard booked resources in the Resource tab of an 
activity's Properties. These hard booked resources are named individual resources added 
through the Resource Manager or directly to an activity on the schedule sheet. Using the hard 
booked resources limits resource use to specific named individuals. It does not give insight into 
the effort expended by that resource, or the expense incurred due to that effort, both of which 
can be part of the calculation of activity progress. Also, this data can be captured and used as 
part of the earned progress calculation for use with Earned Value. See "Accumulating and 
Calculating Progress Data (on page 107)" for details on earned progress and Earned Value. 

The deployment of the optional Resource Assignment Attribute form enables users to select 
Resource Types (non-booked, such as man hours or equipment) rather than specific individual 
(booked) resources, and to capture effort and expense incurred due to that effort. The Resource 
Assignment Attribute form allows users to assign a resource to a Resource Type, rather than to 
a hard booked resource. Also, it allows the capture of progress with respect to effort, and the 
base-lining of resource assignment. Expenses associated with resources are treated as part of 
the overall cost to complete an activity. As part of resource assignment Primavera Unifier will 
allow the accumulation of the following data: 

 Effort: Depending on the type of resource: 

 Labor (number of hours) 

 Equipment (number of pieces of equipment) 

 Cost: Cost associated with each resource. 

 Progress: Progress made by each resource in order to complete activity with respect to 
effort and not by a percentage value. For example, if the effort for a resource of the 
Resource Type Labor is 100 hours, then progress should be entered in number of hours 
and not by percentage. In this case the user should enter progress as 50 hours, not 
progress as 50%. 

 Earned Quantity: Quantity that has been earned based on progress. 

 ETC: Estimate to complete or estimate of effort that is still required to complete the task. 

 Baseline: Baseline or snapshot of originally accepted effort and cost information. 

 Resource Type: Assign a resource of a specific type (such as man hours or equipment), 
and not be a named user (hard booked resource). 

The Activity Attribute form can also contribute to the earned progress calculation through the 
addition of the Earned Progress and Earned Amount data elements to the form. 

Design Requirements for the Schedule Manager 

For the Schedule Manager to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

Activity Attribute form Describes information about each activity on the 
schedule, including its start and end dates. The 
information from this attribute form appears in Primavera 
Unifier in the Activity Properties window. The attribute 
form appears on the General tab when the user adds an 
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activity to the schedule. Also appears on the Activity 
picker on project-level business processes where users 
must choose an activity from the master schedule sheet.

Resource Assignment 
Attribute Form 

Describes information about resources for an activity. 
These resources are represented by Resource Types. 
This form appears on the Resource tab in the Activity 
Properties window, and is imported only if the user is 
going to assign resources by Resource Type instead of 
using hard booked individual named resources. 

Log for the manager Lists the schedules currently in use in Primavera Unifier. 
Allows Primavera Unifier users to choose the schedule 
sheet they want to work with. 

Design Flow 

The following table outlines the design steps to take to launch the manager and create a 
schedule activity. 

1. Create a data structure (if 
necessary) 

(Optional) Create tags to work with uDesigner's linked 
elements feature to connect schedule sheet activities 
with business processes, shells, spaces, and 
configurable manager objects. Tagged elements make it 
possible for a user to view key activity dates, such as 
milestones, on forms without having to open the 
schedule activity sheet. 

See Creating a Data Structure (on page 189) 

2. Launch the manager See Launching a Manager (on page 158) 

3. Create an Activity 
Attribute Form 

See the instructions 
beginning with Starting an 
Attribute or Detail Form for 
a Manager (on page 161) 

Mandatory fields for the attribute form are: 

Activity name (uuu_activity_name) 

Milestone activity (uuu_flag_milestone)

Activity ID (uuu_activity_id

Start Date (uuu_start) 

Finish Date (uuu_finish) 

Task Duration (uuu_duration) 

To accommodate any activities on which users want to 
enter or view cost data associated with a schedule sheet, 
and track the latest date of progress, these fields are 
mandatory: 

Activity Cost 1 - uuu_act_cost1

Activity Cost 2 - uuu_act_cost2

Activity Total Cost 1Per CBS - 
uuu_act_tot_cost1_per_CBS
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Activity Total Cost 2Per CBS - 
uuu_act_tot_cost2_per_CBS

Activity Latest Progress As Of - 
uuu_act_latest_prog_as_of

Note: If the Activity Cost 1 data element is added to a 
form, the corresponding Activity Total Cost 1 Per CBS 
data element must also be added to the form; if the 
Activity Cost 2 data element is added to a form, the 
corresponding Activity Total Cost 2 Per CBS data 
element must also be added to the form. 

Note: You can also add data elements that are based on 
the SYS Project Cost Data Source data definition. 

To accommodate any activities that may become part of 
a "scope management" schedule, these fields are also 
mandatory: 

"On/Off switch" to trigger automatic launching of scope 
management schedule and BPs 
(uuu_auto_update_activity) 

Actual start date (uuu_actual_start_date) 

Actual finish date (uuu_actual_finish_date) 

Actual duration (uuu_actual_duration) 

Activity status (uuu_activity_status) 

Hyperlink to the BP auto-created by the scope 
management function (record_no) 

Status of auto-created BP (uuu_linked_record_status) 

To accommodate any activities that may become part of 
the detailed progress calculation (including earned 
progress, if needed), these fields are also mandatory: 

uuu_activity_earn_progress 

uuu_activity_earn_amt 

Forecast 1 Start—uuu_activity_fc_start_1

Forecast 1 Finish—uuu_activity_fc_finish_1

Forecast 1 Duration—uuu_activity_fc_duration_1

Forecast 2 Start—uuu_activity_fc_start_2

Forecast 2 Finish—uuu_activity_fc_finish_2

Forecast 2 Duration—uuu_activity_fc_duration_2

uuu_activity_etc_amount 

Activity Percent 1—uuu_activity_per_1

To accommodate the display of a CBS code associated 
with an activity in a column, this field is mandatory: 

CBS Codes-- uuu_activity_CBS_codes

If you want to add a Calendar drop-down menu to the 
form, to allow users to select a calendar to apply to a 
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specific activity, this field is mandatory: 

Calendar —uuu_activity_calendar

If you are using an Activity Attribute form designed in 
uDesigner to manage activities, this data element must 
be added to the form if you want users to be able to 
select calendars. If you are not using a designed Activity 
Attribute form (that is, you are using the default form 
provided), this data element is automatically included on 
the default form. 

If you want a add a filtered group drop-down menu to the 
form to allow users to enforce group activity-level editing 
permissions on certain restricted cells in the schedule 
sheet, this field is mandatory: 

uuu_filtered_groups 

4. Create a Resource 
Assignment Attribute Form 

See the instructions 
beginning with Adding 
Blocks to the Attribute 
Form (on page 175) and 
also Adding Fields to the 
Form (on page 304) 

Mandatory fields for the attribute form are: 

Resource Picker—uuu_resc_picker

Resource Name—uuu_resc_name

Resource Code—uuu_resc_code

Resource Type—uuu_resc_type

uuu_role_name 

Quantity (Qty)—uuu_resc_assign_qty

uuu_resc_assign_uom 

uuu_resc_assign_rate 

uuu_resc_assign_amt 

uuu_resc_assign_untper 

uuu_resc_assign_compl_per 

Baseline Quantity—uuu_resc_assign_qty_bl

Baseline UOM—uuu_resc_assign_uom_bl

Baseline Rate—uuu_resc_assign_rate_bl

Baseline Amount—uuu_resc_assign_amt_bl

Baseline% Units—uuu_resc_assign_untper_bl

Optional fields for the Resource Assignment attribute 
form are: 

Earned Progress—uuu_resc_assign_earn_prog

Earned Amount—uuu_resc_assign_earn_amt

Progress Quantity—uuu_resc_assign_prog_qty

uuu_resc_assign_etc_qty 

ETC Amount—uuu_resc_assign_etc_amt

Resource Percent 1—uuu_resc_assign_per_1

Role Amount - uuu_role_amt 
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Note: In addition to Baseline data element listed above, 
you can also add Baseline 1 to 10 data elements to the 
Resource Assignment Attribute form. 

5. Create a log for the 
manager 

See Designing a Log for a Manager (on page 181) 

6. Design the BPs that 
should be launched by an 
activity 

(Optional; only for Scope 
Management) 

Starting a New Design 

Designing a Form 

Designing a Workflow 

Designing a Log for a Business Process 

Design Requirements for Activity Sheet Attribute Form (AP & RAP) 

This section explains the design requirements for the Activity Sheet Attribute in auto-populated 
(AP) and reverse auto-populated (RAP) forms. 

Activities in P6 have several pre-defined field attributes. In addition to the pre-defined field 
attributes, the P6 users can also define custom field attributes to capture more Activity related 
information. In P6, the custom attributes are referred to as: User Defined Fields (UDFs). 

All field attributes of a P6 activities (pre-defined attributes), or UDFs, can exchange data with 
Unifier because in Unifier a user can map the P6 activity attributes to the "Activity Sheet" 
attributes. 

To open the Activity Sheet Attributes node, go to: Company Workspace > Admin mode > 
uDesigner > Schedule Manager. In the Schedule Manager log page click New from the toolbar 
and select Activity Sheet Attributes to open the Edit Studio, General tab, window. 

Creating a new Activity Sheet Attributes is similar to creating a new Schedule Manager or 
Resource Manager attribute forms. 

After you create a new Activity Sheet Attributes, the system generates the following sub-nodes 
on the Navigator under the Schedule Manager node: 

 Activity Sheet Attributes - Home 

 Detail Form 

 Picker 

 Integration 

Detail 

When you click Activity Sheet Attributes node, the Activity Sheet Attributes log or landing page 
opens. The options on the landing page are similar to those in the Schedule Manager or 
Resource Manager attribute forms. 
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Detail Form 

The following options are available (enabled) in the Detail Form: 

 Adding new blocks

 Adding "Custom" elements to blocks

 Insert Row

 Delete Row

 Delete

 Save

 Undo

 Redo

 Close Window

In addition, when you want to add a new block, the column field is read-only (with a value of "1"). 

For a list of Data Elements (DEs), refer to the "P6 DEs" section of the Unifier Data Reference 
Guide.  

This is so the user cannot add an additional (second) column to the block. Unifier recognizes the 
ordering of columns when the attributes render within an Activity Sheet, during runtime. 

Note: Only one column can be created in a block, and you cannot hide 
blocks within the Detail Form. 

In uDesigner Data Structure Setup (uDesigner > Data Structure Setup), the following pre-defined 
Data Elements (DEs) are provided for you to manually add to a P6 Activity Sheet attribute form: 

Note: The DEs listed in the following table can be added to any other 
form in uDesigner, these DEs behave like any other regular DE in 
Unifier. 

Item 
P6 Activity 
Attribute 
Label 

Data Element 
Name 

Data Definition 

1 Activity ID uuu_P6Activi
tyId

SYS Short Description Text 40 

2 Activity 
Name 

uuu_P6Activi
tyName

SYS Short Description Text 120 

3 CBS Code uuu_P6CBSCod
e

SYS Short Description Text 40 

Note: The P6 User Interface (UI) does not 
allow the CBS Code to be more than 20 
characters. The P6 database stores the CBS 
Code field as Varchar(40 Characters). 



Unifier uDesigner User Guide

114

Item 
P6 Activity 
Attribute 
Label 

Data Element 
Name 

Data Definition 

4 CBS Name uuu_P6CBSNam
e

SYS Short Description Text 120 

Note: The P6 User Interface (UI) does not 
allow CBS Name to be greater than 100 
characters. 

5 CBS Path uuu_P6CBSPat
h

SYS Description Text 500 

6 Activity 
Status 

uuu_P6Activi
tyStatus

SYS Short Description Text 50 

7 Activity 
Type 

uuu_P6Activi
tyType

SYS Short Description Text 50 

8 Activity % 
Complete 

uuu_P6Percen
tComplete

Decimal Amount 

9 Planned 
Total Cost 

uuu_P6Planne
dTotalCost

Currency Amount 

10 Actual 
Total Cost 

uuu_P6Actual
TotalCost

Currency Amount 

11 At 
Completion 
Total Cost 

uuu_P6AtComp
letionTotalC
ost

Currency Amount 

12 Remaining 
Total Cost 

uuu_P6Remain
ingTotalCost

Currency Amount 

13 Planned 
Start 

uuu_P6Planne
dStart

Date Picker 

14 Planned 
Finish 

uuu_P6Planne
dFinish

Date Picker 

15 Actual Start uuu_P6Actual
Start

Date Picker 

16 Actual 
Finish 

uuu_P6Actual
Finish

Date Picker 

17 Start uuu_P6Start Date Picker 

18 Finish uuu_P6Finish Date Picker 

19 Remaining 
Early Start 

uuu_P6Remain
ingEarlyStar
t

Date Picker 
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Item 
P6 Activity 
Attribute 
Label 

Data Element 
Name 

Data Definition 

20 Remaining 
Early 
Finish 

uuu_P6Remain
ingEarlyFini
sh

Date Picker 

21 Planned 
Duration 

uuu_P6Planne
dDuration

Decimal Amount 

22 Actual 
Duration 

uuu_P6Actual
Duration

Decimal Amount 

23 At 
Completion 
Duration 

uuu_P6AtComp
letionDurati
on

Decimal Amount 

24 Remaining 
Duration 

uuu_P6Remain
ingDuration

Decimal Amount 

25 Primary 
Constraint 

uuu_P6Primar
yConstraint

SYS P6 Activity Constraints 

26 Secondary 
Constraint 

uuu_P6Second
aryConstrain
t

SYS P6 Activity Constraints 

27 Cost Code bitemID CBS Picker  

You have the option of excluding the other fields in the form, except the Activity ID and the 
Activity Name fields (items 1 and 2 in the preceding table) which are required and mandatory. 

If you choose to exclude any of the pre-defined fields, Unifier will not receive data for the 
excluded field from P6. 

Note: The excluded field may still be present within Gateway data 
mapping template, but the Unifier Activity Sheet will not receive the data 
for that excluded field. 

The Activity Attributes in P6 can only have a limited set of DDs, which are needed for data 
exchange with Unifier. As a result, when you add a new DE to the Detail Form, using the 
"Custom" option, the resulting page (window) presents a list of DEs with the following DDs, only: 

 SYS Short Description Text 32 

 SYS Short Description Text 36 

 SYS Short Description Text 40 

 SYS Short Description Text 50 

 SYS Short Description Text 120 

 SYS Short Description Text 255 

 SYS Description Text 500 

 SYS P6 Activity Constraints 
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 Date Picker 

 Currency Amount 

 Decimal Amount 

 Integer Amount 

 SYS P6 Indicator 

The Form Designer - Detail Form window has the following options available: 

 File 

Save, Restore, and Close window 

 Edit 

Undo, Redo, Define Blocks, Insert Row, Add Elements, Delete, Access, Move, and 
Validation 

The Define Blocks option allows you to open the Form Blocks window and add, modify, 
remove, or move blocks. The Blocks section of this window allows you to see the name, 
label, number of columns and rows, border, visibility, label width, and label position. 

The Add Elements option allows you to add Custom Data Elements to the form 

 View 

Preview and Properties 

 Help 

Unifier Help, Unifier Library, and About Unifier 

In uDesigner, you can capture all of the Activity Sheet Attributes fields by adding the fields in the 
form and each Unifier DE in this form maps to the corresponding element in P6 Activity attribute, 
within Gateway Data Mapping template. 

You are not required to define the Activity Sheet Attribute form in uDesigner for integration to 
work. In other words, the P6 Activity Data will get pulled into unifier without having to create the 
form. 

You are required to define the Activity Sheet Attribute form and use the P6 Activity Picker Data 
Elements to set up auto-populate (AP) or reverse auto-populate (RAP) in uDesigner forms if you 
want to: 

 Pick activities on Business Process or Shell Attribute forms 

 Be able to auto-populate activity data to Business Process or Shell Attribute forms 

 Be able to reverse auto-populate data into the Activity Sheet so that the updated data can be 
sent back to a 3rd party application 

The following options are unavailable (disabled) in the Detail Form: 

 Editable 

 Editable Required 

 Read-Only 

 Validation 

 Preview 

 Properties 

 Standard 

 Linked 
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 Summary 

 Dynamic Datasets 

Picker 

You can use the Picker node to define the Activity Picker log when used on a Unifier Business 
Process Upper form or Detail form. Defining the Activity Picker log, like other uDesigner object 
logs, will include the following tabs in the Log Page Design window: 

 General 

 Layout 

 Sort Order 

 Find 

You can add any DEs, from the Activity Sheet attribute form, to the Activity Picker log (Picker 
log) and perform actions such as removing, modifying, and moving the fields. 

The options available in the Activity Picker log (Picker log) window perform the same functions 
as in other log definition windows in uDesigner. 

The Activity ID and the Activity Name fields are required and mandatory and DEs in the Add 
window of the Layout tab are in alphabetical order. 

If you select the bitemID in the detail for of the Activity Sheet, then the value appears in the 
Activity Sheet as a column that is labeled, "Cost Code."  

Integration 

You can define the integration form by way of the Detail node (Activity Sheet Attributes - 
Home > Integration > Detail). 

When you create the integration form, you must include all the mandatory elements from the 
Activity Sheet Attribute form as shown in the following table: 

For a list of Data Elements (DEs), refer to the "P6 DEs" section of the Unifier Data Reference 
Guide.  

Item Activity Sheet Attribute Name Data Definition 

1 Activity ID Output 

2 Activity Name Output 

3 CBS Code Output 

4 CBS Name Output 

5 CBS Path Output 

6 Activity Status Output 

7 Activity Type Output 

8 Activity % Complete Output 
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Item Activity Sheet Attribute Name Data Definition 

9 Planned Total Cost Output 

10 Actual Total Cost Output 

11 At Completion Total Cost Output 

12 Remaining Total Cost Output 

13 Planned Start Output 

14 Planned Finish Output 

15 Actual Start Both 

16 Actual Finish Both 

17 Start Output 

18 Finish Output 

19 Remaining Early Start Output 

20 Remaining Early Finish Output 

21 Planned Duration Output 

22 Actual Duration Output 

23 At Completion Duration Output 

24 Remaining Duration Output 

The other fields for the Activity Sheet Attribute form (including the Primary Constraint and the 
Secondary Constraint) must have a default direct of "Both." The integration settings define which 
fields are available for a Reverse Auto-Populate, from a Business Process record, to an Activity 
Sheet. 

Note: If you do not define an Activity Sheet Attribute form, the P6 Activity 
Picker will still be available on a Business Process or a CBS type Shell 
to pick activities from an Activity Sheet. However, you cannot use the 
undefined Activity Sheet Attribute form for Auto-populate, or Reverse 
Auto-populate, DEs on Business Process form or a CBS type Shell 
attribute form. 

Activity Manager Overview 

An "Activity" is defined as a part of the work or event that must be completed on a schedule.  

An activity sheet captures scheduling data from the mapped P6 projects and role and resource 
rates from the company-level Master Rate Sheet (default) or shell-level rate sheets, and 
calculates the Earned Values metrics and derivatives. It is the primary source of data for the 
Earned Value Analysis. 
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Unifier enables the user to create, consolidate, and monitor activities that must be completed on 
a schedule by way of the Activity Manager. 

To access the Activity Manager sub-node: 

Go to your Company Workspace and switch to Admin mode. 

1) From the left-hand Navigator click uDesigner node to expand. 

2) Click Activity Manager sub-node to open the Designer - Activity Manager log. 

3) Click Activity Sheet in the log and open. 

4) From the left-hand Navigator click Activity Sheet-Home sub-node to expand, if not 
expanded, to access the following sub-nodes: 

 Detail Form

 Picker

 Integration

Detail Form 

The Detail Form sub-node lists the attributes available for the activity sheet in the Activity 
Sheet Attributes log.  

Example 

Activity Sheet-Folder Properties 

Manual Activity Attributes Form 

Picker 

The Picker sub-node lists the available pickers in the Log.  

Example 

Activity Sheet-Picker 

You can click to select the picker, in the Log, and click Preview (from the toolbar) to see the 
following details in the Activity Sheet window that opens: 

 WBS Path

 WBS Code

 WBS Name

 Activity ID

 Activity Name

 Activity Type

 % Complete (percent complete)

 Planned Start

 Planned Finish

Integration 

Click the Integration sub-node to expand and click the Detail sub-node to open the Detail log.  
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When you open Detail, from the Detail log, the Detail Design window opens which has the 
following tabs: 

 General

In this tab, you can enter the name and description 

 Data Elements

In this tab, you can click to add, modify, remove, or change the position of the data elements 
and data definitions, or labels, on the CSV template. The following columns are included in 
this tab: 

 Row

 Element Label

 Data Element

 Direction

You can double-click on a row to open the Modify Data Element window and change the 
value for the Direction field to one of the following options: 

 Both

 Output

 Input

The Data Elements tab enables you to define the data elements that can be part of the CSV 
template. Users are able to add all of the data elements from the new manual activity 
attribute form defined. The data element direction can be set either as input, output, or both. 
Unifier ignores the import of any formula fields that have a direction set as input or both data. 
The data elements whose direction is set as the output will not be seen in the CSV template, 
for the creation and update of activities. 

Defining the integration interface is not mandatory for the CSV import of activities. If the 
integration is not defined, then export CSV for activities will show all the default columns, 
such as uuu_P6 columns and so forth. 

The uuu_P6ActivityID and uuu_P6ActivityName will be included in the exported CSV 
template irrespective of the data element direction set in the integration interface. 

The data elements uuu_P6ActivityID and uuu_P6ActivityName are required if the user 
updates the integration form defined. The data elements cannot be removed from the 
interface, and the direction for the data elements will be Both.  

If any of the above elements are removed from the integration interface, and the user tries to 
complete the attribute form design, then Unifier displays an error message. Similarly, if the 
Direction for the data elements uuu_P6ActivityID and uuu_P6ActivityName is set as Output, 
then Unifier displays an error message during error check or at the completion of the attribute 
design. 

The following data elements that are formula columns will default to Direction > Output, in 
the integration form: 

 uuu_P6ActualTotalCost 

 uuu_P6ActualTotalUnits 

 uuu_P6PlannedTotalCost 

 uuu_P6PlannedTotalUnits 

 uuu_P6AtCompletionTotalCost 
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 uuu_P6AtCompletionTotalUnits 

Users should be able to add the custom data elements that are added to the activity attribute 
form into the integration interface. 

If the user selects the uuu_predecessor and uuu_successor data elements Direction > 
Input or Both, then Unifier displays an error message. 

Manually Creating New Activity Sheet and Activity Attributes Form 

You can manually create a new activity sheet and proceed to create a new activity attribute form 
that you can use to capture the activity details in your newly created activity sheet.  

You can use the new activity sheet to create and maintain project schedules within the Unifier. 
The Activity Sheet that you create manually: 

 Captures the schedule of activities within a project. 

 Captures the resource assignments and rates. 

 Can be used to track progress of activities, over the lifetime of the project. 

Multiple activity sheets can exist within a project and customer will be able to define the work 
tasks, the estimates of the required resources and duration for tasks and the identification of 
dependencies among the different work tasks within the sheet. 

For any project schedule, you can use the following applications to create and manage your 
Activity Sheet and activity resources: 

 P6 

 Primavera Cloud 

A project schedule is pushed to your Activity Sheet, in Unifier, where you can assign rates and 
calculate the costs, which will be used in cost modules such as: 

 Earned Value 

 Cost Sheet 

 Cash Flow 

In order to be able to capture the attributes for activities that have been created manually (in a 
newly created Activity Sheet), you must define a new activity attribute form, in the Activity 
Manager node (in the Activity Sheets log). 

In the Detail Form log (uDesigner > Activity Manager > Activity Sheet - Home > Activity 
Sheet Attributes - Current View: All) click New and select the Manual Activity Attributes
option. 

The new detail form enables you to define the attributes required for the creation of activities 
within the new activity sheets. The New option (in the detail form log) will be disabled once the 
you create the new activity attribute form. You can use the Detail Form sub-node to define the 
attributes that are required to define the activities, or tasks, and milestones to define the project 
schedule. 

You can create manual activity attribute form provided that the standard activity attribute form 
already exists. 
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When you attempt to create manual activity attribute form without the standard activity attributes 
defined, Unifier will display an error message. 

Data Elements (uuu) of Manual Activity Sheet Attributes 

The manually created activity sheet attributes form displays system-defined data elements 
(displayed below) that are mandatory and enables you to be able to add custom data elements 
such as currency, decimal, integer, text, and date fields in the attribute form.  

The system-defined data elements will be added by default, when you create the new manually 
created activity sheet attributes form. 

When you save the attribute form, the Detail Form log displays an entry for the new manually 
created activity sheet attributes form. 

You can change the function of the data elements on the form, except for the mandatory data 
elements (such as Activity ID, Activity Name, Start, Finish, Duration, and so forth). 

You can edit the block properties and rearrange the data elements in multiple columns in the 
form. 

Data Elements 
(uuu) of Manual 
Activity Sheet 
Attributes 

Description 

Activity ID 
(uuu_P6ActivityI
D) 

Editable and required (behavior of element cannot be changed) 

Activity Name 
(uuu_P6ActivityN
ame)  

Editable and required  (behavior of element cannot be changed) 

Activity Percent 
Complete 
(uuu_P6Percent
Complete) 

Editable 

Performance 
Percent 
Complete 
(uuu_P6PerfPerc
Complete) 

Editable 

Activity 
Type (uuu_P6Act
ivityType) 

Editable with data set values - Task Dependent and Start Milestone 
with default value 'Task Dependent'   

Actual Duration 
(uuu_P6ActualDu
ration) 

Editable   

Actual Duration will be read-only and calculated as duration 
between Actual Start and data date or Actual Finish. 
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Data Elements 
(uuu) of Manual 
Activity Sheet 
Attributes 

Description 

Actual Finish 
(uuu_P6ActualFi
nish) 

Editable   

Actual Duration will be read-only and calculated as duration 
between Actual Start and data date or Actual Finish. 

Actual Start 
(uuu_P6ActualSt
art) 

Editable   

Actual Duration will be read-only and calculated as duration 
between Actual Start and data date or Actual Finish. 

CBS 
Code (bitemID) 

Editable 

Duration 
(uuu_P6Duration
) 

Editable and required  (behavior of element cannot be changed) 

ETC Technique 
(uuu_P6ETC) 

Read-only and displays the etc. technique selected using 
uuu_cmwbs_picker. 

Finish 
(uuu_P6Finish) 

Editable and required  (behavior of element cannot be changed) 

Planned Duration 
(uuu_P6Planned
Duration) 

Editable 

Planned Finish 
(uuu_P6Planned
Finish) 

Editable 

Planned Start 
(uuu_P6Planned
Start) 

Editable 

Remaining 
Duration 
(uuu_P6Remaini
ngDuration) 

Editable 

Remaining Early 
Finish 
(uuu_P6Remaini
ngEarlyFinish) 

Editable 

Remaining Early 
Start 
(uuu_P6Remaini
ngEarlyStart) 

Editable 

Start Editable and required  (behavior of element cannot be changed) 
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Data Elements 
(uuu) of Manual 
Activity Sheet 
Attributes 

Description 

(uuu_P6Start) 

Status (uuu_P6A
ctivityStatus) 

Editable with data set values - Not Started, In Progress and 
Completed. Default value- 'Not Started' 

uuu_P6ActualTot
alCost 

Read-only on form and grid and cannot be changed to editable. 

uuu_P6PlannedT
otalCost 

Read-only on form and grid and cannot be changed to editable. 

uuu_P6AtComple
tionTotalCost 

Read-only on form and grid and cannot be changed to editable. 

uuu_P6ActualTot
alUnits 

Editable. 

At runtime, by default the summed up value from the assignments is 
shown (Planned Total Units will show sum of planned units from the 
assigned resources/roles. The same is the case with other Total 
units fields.  

uuu_P6PlannedT
otalUnits 

Editable. 

At runtime, by default the summed up value from the assignments is 
shown (Planned Total Units will show sum of planned units from the 
assigned resources/roles. The same is the case with other Total 
units fields.  

uuu_P6AtComple
tionTotalUnits 

Editable. 

At runtime, by default the summed up value from the assignments is 
shown (Planned Total Units will show sum of planned units from the 
assigned resources/roles. The same is the case with other Total 
units fields.  

uuu_P6AtComple
tionDuration 

Read-only 

uuu_P6BAC Read-only 

uuu_P6PVCost Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6CPIndex Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6CSIndex Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6CostVaria
nce 

Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6EACCost Read-only on form and grid and cannot be changed to editable. 
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Data Elements 
(uuu) of Manual 
Activity Sheet 
Attributes 

Description 

Fields show the computed values. 

uuu_P6ETC Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6ETCCom
puteType 

Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6ETCUser
Value 

Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6EVCost Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6Remainin
gTotalCost 

Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6Remainin
gTotalUnits 

Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6Schedule
Variance 

Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6TCPInde
x 

Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

uuu_P6VAC Read-only on form and grid and cannot be changed to editable. 
Fields show the computed values. 

WBS Code 
(uuu_P6WBSCo
de) 

WBS Code and WBS Name - Not Mandatory elements in the default 
attribute form created they will be added and marked as read-only. 

WBS Path and ETC technique - read only on the form. 

User can define the auto populate using WBS Attribute as source 
for the above data elements in Activity attribute form. 

WBS Name 
(uuu_P6WBSNa
me) 

WBS Code and WBS Name - Not Mandatory elements in the default 
attribute form created they will be added and marked as read-only. 

WBS Path and ETC technique - read only on the form. 

User can define the auto populate using WBS Attribute as source 
for the above data elements in Activity attribute form. 

WBS Path 
(uuu_P6WBSPat
h) 

WBS Code and WBS Name - Not Mandatory elements in the default 
attribute form created they will be added and marked as read-only. 

WBS Path and ETC technique - read only on the form. 

User can define the auto populate using WBS Attribute as source 
for the above data elements in Activity attribute form. 
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Data Elements 
(uuu) of Manual 
Activity Sheet 
Attributes 

Description 

ETC Technique 
(uuu_P6ETC) 

WBS Code and WBS Name - Not Mandatory elements in the default 
attribute form created they will be added and marked as read-only. 

WBS Path and ETC technique - read only on the form. 

User can define the auto populate using WBS Attribute as source 
for the above data elements in Activity attribute form. 

WBS 
Code (uuu_P6W
BSCode) 

Read-only  

WBS Picker 
(uuu_cmwbs_pic
ker) 

Editable on the form and grid 

WBS Picker 
(uuu_cmwbs_pic
ker) 

Editable  

For details, see the Unifier Data Reference Guide. 

Additional System-Defined Data Elements of Manual Activity Sheet Attributes 

The following additional system-defined data elements are available to add into the new activity 
attribute form:  

Notes: 

 The following system-defined data elements are a part of the default 
activity attribute form, if there are no custom-defined data elements 
in the activity attribute form. 

 You cannot use the following additional data elements in activity 
sheets because they are all date pickers. 

Data 
Element 
Name 

Data 
Definition 

Element 
Label 

Purpose 

uuu_P6Act
ivityCalend
ar 

SYS 
Activity 
Calendar 

Activity 
Calenda
r 

This element will be used to select an individual 
calendar for each calendar. It will show list of all 
calendars defined in custom calendars node. 

uuu_activit
y_predece
ssor 

SYS 
Descriptio
n Text 

Predece
ssor 

This element will display the predecessor activities 
for the selected activity 
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Data 
Element 
Name 

Data 
Definition 

Element 
Label 

Purpose 

2000 

uuu_float Decimal 
number 

Float This element will hold the float value, for each 
activity, calculated as a result of the Critical Path 
calculation. 

uuu_activit
y_resource
s 

SYS 
Descriptio
n Text 500

Assigne
d 
Resourc
es 

This element will display the list of resources 
assigned to the activity 

For details, see the Unifier Data Reference Guide. 

System-Defined Data Elements for Activity Attribute Form 

You can use the following system-defined data elements for the Activity Attribute Form:  

Data 
Element 

Data Definition Element 
Label 

Purpose 

uuu_activity
_successor 

SYS Description Text 
2000 

Successo
r 

This element will display the 
successor activities for the selected 
activity 

uuu_activity
_early_start

Date Only Picker Early 
Start  

This date data element will capture 
the early start date of the activity for 
float calculation 

uuu_activity
_early_finis
h 

Date Only Picker Early 
Finish 

This date data element will capture 
the early finish date of the activity for 
float calculation 

uuu_activity
_late_start 

Date Only Picker Late Start This date data element will capture 
the late start date of the activity for 
float calculation 

uuu_activity
_late_finish 

Date Only Picker Late 
Finish 

This date data element will capture 
the late finish date of the activity for 
float calculation 

uuu_activity
_constraint
_type 

Activity Constraint 
Type (Data Set: As 
Soon As Possible) 

Activity 
Constrain
t Type 

This element will show the constraints 
available at activity level 

For details, see the Unifier Data Reference Guide. 
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Custom Data Elements for Activity Attribute Form 

You can add input-type custom data elements as:  

 Integer 

 Date 

 Decimal 

 Currency 

 Text 

You can arrange the input-type custom data elements in different blocks, and the form will 
display the activity details in the sheet, at run time. The Activity Attribute Form supports all types 
of data pickers. 

Data Element Properties for System-defined and Custom-defined Data Elements 

When designing an Activity Attribute Form note that: 

 Adding standard data elements and linked data elements to the form is not allowed. 

 Form validations are not allowed. 

 The user cannot define any custom-defined data elements (including the system-defined 
data elements, except the mandatory data elements) as: Read-only, editable, or required. 

 Defining formulas for any of the custom-defined data elements is not allowed. 

 Adding Dynamic Data Sets (DDSs) to the form is not allowed. 

 Defining auto-populate (AP) for system-defined data elements and custom-defined data 
elements is allowed. The auto-population source must stem from a single record business 
process, Cost attributes, WBS attributes, or Shell attributes. 

 Defining reverse auto-populate (RAP) on system-defined data elements is not allowed. The 
custom-defined data elements can be set to reverse auto-populate in to Shell attributes or 
single record business processes. 

 Reseting the data elements or use hyperlink is not allowed. 

 Defining a data element for mobile or summary data elements is not allowed. 

Completing Activity Attribute Form 

To be able to complete the activity attribute form and conduct an error check, you must add the 
following uuu_P6 attributes and system-defined data elements to the form:  

Note: These are mandatory data elements for completing the activity 
attribute form. If you remove the activity attribute form, error check will 
result in errors. The following is a list of the required data elements: 

 Activity ID (uuu_P6ActivityId)  

 Activity Name (uuu_P6ActivityName)   

 Start (uuu_P6Start) 

 Finish (uuu_P6Finish) 

 Duration (uuu_P6Duration) 

 All other uuu_P6 elements, except: 
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 uuu_P6WBSCode 

 uuu_P6WBSName 

 uuu_P6WBSPath 

 uuu_P6WBSType 

Importing, Exporting, and Updating Activities within Manual Activity Sheets 

A user must be able to:  

 Import activities in to the activity sheet 

 Update existing activity details into the activity sheet 

 Add or update CBS Code, WBS hierarchy for the activities in the sheet 

Unifier enables the user to create and update activities in an activity sheet that supports manual 
addition of activities (Manual Activity Sheets) in bulk and through CSV files. Updating the 
existing activities would include updating CBS Code or WBS Code assignments for the activities.  

Linked Data Elements Using P6 Activity Picker 

You can define linked data elements by using P6 Activity Picker through the Link Elements 
option in the business process upper form, detail form, or shell attribute form. All of the data 
elements from the attribute forms (both manual and standard activity attributes) are available to 
be added as linked elements using P6 Activity Picker.  

The following table explains the options: 

Option Description 

Source Name Displays all of the data elements which are of data definition type as 
P6 Activity Picker. This is a required field where user should be able 
to choose one of P6 Activity Picker type data element. 

Source Element Lists all of the data elements from the activity attribute forms (both 
manual and standard and Manual). The user can select one of them. 
This is a required field. 

Destination 
Element 

Lists all of the data elements from Data Structure Setup that match 
the data definition of the "Source Element" selected above. The data 
elements which are already added as custom element in the form will 
not be seen in the list of matching data elements. 

Manually Creating WBS Sheet 

When a user receives scheduling data from a source application such as P6, Unifier creates a 
WBS Sheet that includes all of the summary activities (WBS). Users, in this case, can view the 
total costs associated with the WBS in the WBS Sheet.  
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With the ability to create manual activity sheet, you can create a WBS Sheet to create, update, 
and maintain the WBS within a Unifier project. In this case, the manually created activity sheet 
will associate with the WBS defined in the WBS Sheet, for the Unifier project. 

A manually created WBS Sheet enables the user to do the following: 

 Define the work breakdown structure for the entire project in the WBS Sheet. In this case, 
the work breakdown structures created in the manual WBS Sheet will be used across the 
manual activities. 

 Define the ETC technique for WBS. 

 View the rolled up costs (like planned total costs or units, actual total costs or units, at 
completion total costs or units, and remaining costs associated to the work breakdown 
structures) in this sheet. 

 Define custom attributes for additional formulas like CPI, SPI calculations and so forth. 

 Capture the actuals incurred from the business processes using WBS Picker. 

 Assign Control Account Managers using OBS Picker  

 Create variance analysis reports based on the performance of the project. 

Project manager can use a manually created WBS Sheet to: 

 Modify additional WBS Codes in the structure, if the WBS Codes are not associated to 
activity sheet. 

 Add additional WBS Codes to the structure, if the WBS Codes are not associated to activity 
sheet. 

 View the WBS Codes (hierarchy) that is associated to activity sheet, per activity sheet. 

 Define the columns (from cost business processes) and to roll up of the actual units and 
actual costs incurred through contracts and payments. 

You can add the data element "uuu_P6WBSPath" in the existing WBS attribute form. Unifier 
automatically adds the data element "uuu_P6WBSPath" when the user defines the new WBS 
attribute form. The data element "uuu_P6WBSPath" is read-only. 

At runtime, the WBS Path will be populated whenever the user defines the WBS hierarchy in the 
Project WBS Sheet. 

Note: For System WBS Sheet, the WBS Path will be empty, if the user 
has not defined the path in the gateway mapping. 

Earned Value Manager Overview 

The following topics explain how to create the forms for:  

 OBS 

 WBS 

Organization Breakdown Structure (OBS) 

A new uDesigner form (OBS Attributes Form) can be created under the Earned Value 
Manager node (uDesigner > Earned Value Manager). 
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To create a new design, click New and select OBS Attributes to open a new window in General
tab. The General tab has the following fields: 

 Name

 Description

 Type

Once you create a new design, Unifier creates the following sub-nodes under the he Earned 
Value Manager node: 

 Detail Form

 Picker

 Integration

The Detail Form contains the following pre-populated Data Elements (DEs): 

 Record No (uuu_obs_recordno) 

 Full Name(uuu_obs_fullname) 

 Title (uuu_obs_title) 

 Department (uuu_obs_department) 

 Status (uuu_obs_status) 

You can add a new system defined data element "uuu_obs_assignee" in the OBS attribute form. 

If you delete a Record No, Full Name, or Status and proceed to change the status back to 
complete, then Unifier displays an error message (for the missing DE). 

The following functionalities are not required for the OBS sheet: 

 DDS 

 Summary Elements 

 Rules 

 Validations 

 Standard 

 Blocks 

 Properties 

The Picker will have a default (OBS Picker) layout in the new design, and the form will be 
pre-populated with the Full Name data. 

The Integration enables you to set up the fields that you need for integration (CSV import). By 
default, the Name and Description fields are empty. 

Once you create a Detail Form (creating Picker and Integration is optional), you can deploy the 
design after: 

 Performing error check 

 Changing the status from draft to complete 

Once you deploy an OBS Sheet design, the user (and the administrator) will not have 
permission to delete the design. 
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Work Breakdown Structure (WBS) 

A new uDesigner form (WBS Attributes Form) can be created under the Earned Value 
Manager node (uDesigner > Earned Value Manager). 

To create a new design, click New and select WBS Attributes to open a new window in 
General tab. The General tab has the following fields: 

 Name

 Description

 Type

Once you create a new design, Unifier creates the following sub-nodes under the Earned Value 
Manager node: 

 Detail Form

 Picker

 Integration

The Detail Form sub-node: 

The Detail Form sub-node contains the following pre-populated Data Elements (DEs): 

 WBS Code (uuu_P6WBSCode) 

 WBS Name (uuu_P6WBSName) 

 WBS Type (uuu_P6WBSType) 

 ETC Technique (uuu_P6ETCComputeType) 

The Detail Form sub-node also contains the following hidden pre-populated Data Elements 
(DEs): 

 Planned Units (uuu_P6PlannedTotalUnits) 

 At Completion Units (uuu_P6AtCompletionTotalUnits) 

 Actual Units (uuu_P6ActualTotalUnits) 

 Remaining Units (uuu_P6RemainingTotalUnits) 

 Planned Total Cost (uuu_P6PlannedTotalCost) 

 Actual Total Cost (uuu_P6ActualTotalCost) 

 At Completion Total Cost (uuu_P6AtCompletionTotalCost) 

 Remaining Total Cost (uuu_P6RemainingTotalCost) 

To assign a Control Account Manager to WBS, you can add the OBS picker up to two times. 
This will also enable you to auto-populate the DEs from the OBS Sheet to the DEs in the WBS 
Sheet. 

Note: Only OBS picker will be available for the WBS sheet design form 
(no other pickers will appear in the custom list of DEs).  

If you add the OBS picker in the WBS attributes detail form, then the form will be available in the 
Data Picker list (Open > Data Picker) to define a query. You can define query conditions from 
the Data Picker Configuration window.  

You can reverse auto-populate a field in the WBS attribute (to the OBS Sheet). 
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Note: Only OBS picker will be available for the WBS sheet design form 
(no other pickers will appear in the custom list of DEs).  

The following functionalities are not required for the WBS sheet: 

 DDS 

 Summary Elements 

 Rules 

 Validations 

 Linked Elements 

 Standard 

Once you create a Detail Form (creating Picker and Integration is optional), you can deploy the 
design after: 

 Performing error check 

 Changing the status from draft to complete 

Once you deploy an OBS Sheet design, the user (and the administrator) will not have 
permission to delete the design. 

The Picker sub-node: 

You can create a new WBS picker, which will allow you to roll up amount from cost type 
BP-detail form. In this scenario, the system creates a new sub-type of cost BP. 

The Picker will have a default (OBS Picker) layout in the new design, and the form will be 
pre-populated with the Full Name data. You can define the layout in the uDesigner as follows: 

 *WBS ID & Name 

These are mandatory in the WBS picker. The WBS Code corresponding to an activity in 
activity sheet is available by way of P6, and it is not editable in Unifier. 

 WBS Code, WBS Name, WBS Type, & ETC Technique 

These are pre-populated fields in the integration form. If there is no integration form defined, 
then these will be the default DEs which will still be available with direction as both. 

The Integration sub-node:

You can setup the fields needed for integration (reverse auto-population and CSV import) 
through the Integration sub-node. Once you create a detail form, picker, and integration form, 
the design can be deployed after performing error check and changing the status from draft to 
complete. If a mandatory field is missing in the design, then an error message will be displayed 
accordingly. 

The Integration sub-node enables you to set up the fields that you need for integration (CSV 
import). By default, the Name and Description fields are empty. 

Adding User Picker or User Data Picker in the WBS Attribute Form  

Similar to the Cost Manager, you can add the following data elements in the WBS attribute form:  

 SYS BP Currency Amount 

 SYS BP Decimal Amount 
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 SYS BP Integer Amount 

 SYS Date Logical Datasource 

 SYS Numeric Logical Datasource 

User Administration 

The User Administration sub-node (Company Workspace > Admin mode > User 
Administration) enables you to manage company and partner users.  

The User Administration log (Designer - User Administration) has the following elements:  

Toolbar

 File

 New (User, Copy, Import)

 Open

 Error Check

 Deploy

 Integration (Input XML, Output XML, Input CSV Template)

 Export

 Edit

 Status (Draft, Complete)

 Restore

 Import

 Delete (Last Completed, Last Published)

 View

 All

 Help

 Unifier Help

 Unifier Library

 User Productivity Kit

 About Unifier

Menu options

 New (User, Copy, Import)

 Open

 Error Check

You can click Error Check to detect errors. You must resolve all errors to mark a design as 
complete. 

 Deploy

Click Deploy to make the selected form available for testing/use in Unifier (the Deployed 
date is updated, and the Deployed Version is incremented every time the shell is deployed). 

 Status (Draft, Complete)
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 Delete

 Integration (Input XML, Output XML, Input CSV Template)

The User Administration log (Designer - User Administration) has the following columns: 

The first five columns display properties, and the last six columns are related to version control. 

 Name

The Name column indicates the name of the user attributes form. Open it to view and design 
its components. The Owner column displays the name of the creator. The Status column 
indicates if a design is in draft or completed status. 

 Owner

The Owner column displays the name of the creator. 

 Status

The Status column indicates if a design is in draft or completed status. 

 Level

The Level column shows Company. 

 Type

The Type column shows User Attribute. 

 Last Saved

The Last Saved column is updated when a draft status is changed to complete. 

 Deployed

 Published

The Published and Published Version columns are populated/updated when a 
configuration package is published for production. 

 Design Version

Each time a completed design is returned to draft status, the Design Version is 
incremented. 

 Deployed Version

 Published Version

The Published and Published Version columns are populated/updated when a 
configuration package is published for production. 

When you select an existing record from the log and click Open, the User Administration
sub-node expands to display the following child-nodes:  

 General User - Home 

 Additional Attributes 

 Log 

Company Users Log 

Partner Users Log 

 Integration 

Users 

 Picker 

See "Creating User Attribute Form" for more details. 
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User Attribute Form 

All designs, including the User Attributes form, are designed in uDesigner and deployed to 
Unifier. For more information, see Importing Configuration Packages in the Unifier Modules 
Setup Administration Guide. In uDesigner, you can: 

 Add additional data elements to the User Attribute form. 

 Configure Company User and Partner User logs. 

 Add additional attributes to the View User Profile form and a User/Group picker. 

The additional data elements appear as user properties on the General tab of the user 
administration edit studio form for Company users and Partner users (Company Workspace > 
Admin mode > User Administration > User Attributes - Home) as well as on the user View 
Profile form.  

Example 

The additional user properties can include a user's department and location, or other details. 

Note: The new attribute will be available only for Company users log and 
Partner users log and will not be available as part of custom attributes in 
other module designs. 

In general, the User Attribute Form: 

 Allows you to create a form to store metadata about a user. 

 Adds user-defined fields to an existing user information. 

 Allows you to define a log for owner and partner users. 

 Defines picker for users. 

 Is not required. 

Note: If you do not define a User Attribute Form in uDesigner, Unifier 
uses default forms, logs, and user pickers. 

The General tab also allows you to apply the User Attributes from a project or shell directory: 
Apply User Attributes from Project/Shell Directory.  

If you select the Apply User Attributes from Project/Shell Directory option, then the user 
can use the User Attributes from a project or shell directory when the user is rendering the 
users log or picker details that are launched within a project or shell. 

If you do not select the Apply User Attributes from Project/Shell Directory option, then no 
data will be copied (to the User Attributes from) from the company level to the shell level. In 
this scenario, the administrator must manually copy the information at the shell level; 
otherwise, the default forms, logs, and user pickers will not have any data to display for the 
additional attributes. 
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Note: If you add a user data picker in the User Attributes from, Unifier 
fetches values from the Company level and not the values from the 
project- or shell-level, and selecting the Apply User Attributes from 
Project/Shell Directory option would not be applicable in such scenario. 

After you are done with your selection, click: 

a) Apply to save changes and keep the edit studio window open, or 

b) OK to save changes and close the edit studio window. 

You can click Cancel to discard your changes and close the edit studio window. 

The User Attributes form name, description, and type are read only fields, and their values are 
entered during the creation of the User Attributes form. 

Creating User Attribute Form 

To create a User Attribute Form: 

1) Go to Company Workspace (Admin mode). 

2) Navigate to uDesigner and click User Administration. 

3) Click New > User to open the General tab. 

4) Enter a name in the Name field and add a description in the Description field. 

The Type is always User Attributes. 

Now you can create the node that holds the components of the user attributes (the fields). The 
columns in the log are pre-configured. 

Note: You can create one user attribute item, only. 

Each attribute form has the following sub-nodes:  

 Additional Attributes 

 User Detail Form 

 View Profile Form 

 Log 

 Company Users Log 

 Partner Users Log 

 Integration 

 Users 

Used for integration for both Company as well as Partner users. Also, it can be used to 
define the data elements for integration, when exporting or importing.  

 Picker 

Unless you design and import your own user administration attribute form, for company user 
administration, Unifier displays: 

 A default log, General User - Home (used when creating a user with the Company or Partner 
detail form) 
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 User/Group picker 

The following associated functionalities exists:  

 Auto-population to form 

 Auto-population from form to other objects 

 Reverse auto-population from form 

 Reverse auto-population to other objects 

Once the integration form is created, the following attribute, and the Additional Attributes that 
you have defined will be added, by default, as data elements available for integration. 

Note that: 

 The direction is set to Output and only Company users will be created (when Import option is 
used). If Partners users are to be created, the direction has to be set to Input or Both. 

 For the DE uuu_user_company, the direction must be set to Input or Both to be able to 
integrate Partner users from Partner users log in the User Administration.  

 The validation applicable to company users data elements, for integration, will be applicable 
to partner users as well. 

Name Data Element Direction 

First Name uuu_user_firstname Both 

Last Name uuu_user_lastname Both 

E-Mail uuu_user_email Both 

Home Phone uuu_user_homephone Both 

Mobile Phone uuu_user_mobilephone Both 

Work Phone uuu_user_workphone Both 

Company 

When set to Input /Both will 
be available to create 
Partner user. 

uuu_user_company Both 

Date Format uuu_user_dateformat Both 

Fax uuu_user_fax Both 

Pager uuu_user_pager Both 

Time Zone uuu_user_timezone_pref Both 

Status uuu_user_status Both 

Title uuu_user_title Both 

User Type uuu_user_type Both 

Name uuu_user_name Output 

Login User Name uuu_user_loginname Both 
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Name Data Element Direction 

Password uuu_user_password Input 

Proxy Name uuu_user_proxy Output 

Proxy Configuration 
Allowed? 

uuu_user_proxy_config Both 

See "Design Requirements for User Properties Attribute Form" below for details. 

Data Pickers and User Attribute Form 

You can create data pickers based on User Attribute Form. 

Note: You can define filtered selection of assignees in BP Setup, based 
on a user data picker: Additional conditions to filter assignees. 

You can define auto-population, or reverse auto-population (RAP), by using data picker 
associated with User Attribute Form. 

By default, at the Company level, Unifier displays a default log, General tab (used when creating 
a user with the Company or Partner detail form), and User/Group picker. In uDesigner, you can 
add additional data elements to the User Attribute form, configure Company User and Partner 
User logs, add additional attributes to the View User Profile form, and a User/Group picker. The 
additional data elements appear as user properties on the General tab for Company and Partner 
users, as well as on the user View Profile form. For example, the additional user properties can 
include a user's department and location, or other details. 

Note: Any reporting on business processes that contain a designed 
User/Group picker will include the attributes that are added to the 
designed picker. 

The additional attributes are added to the existing default attributes. For example, the user 
properties can include a user's department and building, or other details. 

Design Requirements for User Properties Attribute Form 

For the User Administration properties to work effectively in Unifier, you will need to create the 
following components in uDesigner:  

 User Detail Form 

Allows you to add additional data elements for both Company and Partner user forms. These 
data elements are displayed on the General tab of the User Properties for both types of 
users. 

 View Profile Form 

Allows you to add additional data elements to display on user profiles. Any data elements 
you add to the User Detail Form can be selected to add to the View Profile Form. 

 Log 
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Allows you to design a log for user administration, as well as Find and sort order. Lists 
Company or Partner users in the Company Users Log and the Partner Users Log. Allows 
Unifier users to choose the user they want to work with. You can add navigation to these 
logs. 

 Integration 

Sets up integration for the import of Company users, which enables Web Services and the 
CSV export and import of user information as well as bulk edit (edit of multiple users from the 
user log). Integration is not available for Partner users, but will be used for bulk edit for 
Partner users. 

 Picker 

Allows you to define data elements displayed on the User/Group picker. You can specify the 
layout, sort order, and find for the picker. This design is available for the Show By User 
mode, but not for the Show By Group and Show By User/Group modes in the picker. 

Design Flow 

The following outlines the design steps necessary to design User Administration user 
properties attribute forms. 

1. Create a data 
structure (if necessary) 

See Creating A Data Structure (on page 189) 

2. Create a User Detail 
Form 

See the instructions beginning with Adding Blocks to the 
Attribute Form and also Adding Fields to a Form 

3. Create a View Profile 
Form 

The fields that you add to the User Detail Form can be 
selected to add to the View Profile Form. You cannot add any 
data elements to the View Profile Form that are not already on 
the User Detail Form. 

4. Create a log See Designing a Log. This log can have navigation 
configured, like that of an advanced log. Optional fields for the 
logs, in addition to any Additional Attributes: 

 First Name—uuu_user_firstname 

 Last Name—uuu_user_lastname 

 Title—uuu_user_title 

 E-mail—uuu_user_email 

 Work Phone—uuu_user_workphone 

 Home Phone—uuu_user_homephone 

 Mobile Phone—uuu_user_mobilephone 

 Pager—uuu_user_pager 

 Fax—uuu_user_fax 

 Timezone—uuu_user_timezone_pref 

 Date Format—uuu_user_dateformat 

 Proxy Name—uuu_user_proxy 

 Company—uuu_user_Company 

 Name—uuu_user_name 
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 Login User Name—uuu_user_loginname 

 Password—uuu_user_password 

 Status—uuu_user_status 

 User Type—uuu_user_type 

A new attribute uuu_user_type with a data definition SYS 
User Type will be added to list of attributes available for the 
company users log and partner users log. If this attribute is 
added, then the attribute will be seen in the Company users 
log and partner users log in the User Administration node.  

Note: The attribute will be available only for company users 
log and partner users log. These should not be seen as part of 
custom attributes in other module designs. 

5. Define Integration for 
Company Users 

Set up integration for the import of Company users, which 
enables the Web Services and CSV export and import of user 
information as well as bulk edit (edit of multiple users from the 
user log). Integration is not available for Partner users. 

6. Define a User Picker 
Log 

Specify data elements displayed on the User/Group picker. 
You can specify the layout, sort order, and find for the picker. 
This design is available for the Show By User mode, but not 
for the Show By Group and Show By User/Group modes in 
the picker. 

Space Manager Overview 

In Unifier, the Space Manager is where users can perform the tasks of facilities management. 

Using the Space Manager, users can gather data about the levels in their facility (such as floors 
and parking lots) and the spaces that exist on each level (cubicles, offices, conference rooms, 
etc.). Similar to the Asset Manager, you can create categories (called types) of spaces in 
uDesigner, and Unifier users can add records of individual spaces to these types and manage 
them on an electronic sheet. 

The Space Manager is a means of organizing all the square footage in your facility to make 
monitoring, maintaining, and reconfiguring it more efficient. You can integrate the Space 
Manager with other managers or business processes to give users a broader view of your 
company's physical capital and resources. For example, you can integrate the Space Manager 
with the Asset Manager to include the computers that reside in each cubicle on a level; or 
integrate the Resource Manager to include the employees who occupy each space on a level. 

In uDesigner, you will be creating one attribute form for a “level” type in your facility and multiple 
attribute forms for “spaces” types. (Think of a level as the "platform" on which spaces reside.) 
With these attribute forms, Unifier users can create a hierarchy of levels and spaces within levels 
to store the facilities data you choose to collect. If designed so on the attribute form, the Unifier 
user can reserve the space for use using a Reservation type business process. 
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In Unifier, the Sheets node in the Space Manager stores the manager sheet on which all the 
levels in your facility are shown. Unifier automatically creates a level sheet for every level type 
that is created. From the level sheet, users can also automatically update individual level records 
with data added to the sheet, either manually or via a formula created for a column. 

The Stack Plans node is where users can create stack plans to show the actual usage of the 
levels in the company's building(s). Users can choose the information (data elements or specific 
spaces) they want to see on the stack plan and update the plan periodically to keep abreast of 
changes in the levels' space usage. For example, users might want to know the square footage 
used by each department on each floor (level); or how many square feet of a floor are vacant vs. 
leased. 

The Levels node lists all the levels that exist in your facility.  

The Spaces node shows a list of all the space types, and under the space type sub-node, all the 
spaces that exist in your facility. This is where users can create new spaces or update existing 
ones, import data from CSV files, or export templates to CSV. 

Design Requirements for the Space Manager 

For the Space Manager to work effectively in Unifier, you will need to create the following 
components in uDesigner: 

Level Attribute 
Form (see 
"Launching a 
Manager" on 
page 158) 

Collects information about a level. Information from this form appears 
on the Level Properties window in Unifier. The attribute form data 
appears on the General tab when the user opens the level from the 
Space Manager node. 

Space Attribute 
Form 

Collects information about a space, including the unit of measure 
used to dimension it and the level to which it belongs. Information 
from this form appears on the Space Properties window in Unifier. 
The attribute form data appears on the General tab when the user 
opens the space from the Space Manager node. 

Log for the 
manager(standa
rd or advanced)

Shows a list of the level and spaces that have been created for the 
manager. 

Standard logs display fields from the manager's attribute form (level 
and space) that you want to monitor. For example, you might want a 
log for the Space Manager to include the names of all levels on your 
property and the square footage. 

Advanced logs support data pickers. An advanced log should be 
designed for any space type that contains records that will be 
displayed on a data picker. (For more information on data pickers, 
see About Data Pickers (on page 195).) 

For instructions on designing a log, see Designing a Log for a 
Manager (on page 181). 
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Design Flow 

The following table outlines the design steps necessary to launch the manager and create a 
level or space type. 

1. Create a data 
structure 

See Creating A Data Structure (on page 189) 

2. Launch the manager See About Launching a Manager (see "Launching a 
Manager" on page 158) 

3. Create a Level 
Attribute Form 

See the instructions 
beginning with Adding 
Blocks to the 
Attribute Form (on 
page 175) 

Mandatory fields for the level attribute form are: 

Level name (uuu_sp_level_name) 

Status (status) 

This field is mandatory if you want to track the last date that a 
level record was modified. You can include this data element 
on logs to allow the user to sort records by the last date of 
modification: 

Record Last Update Date (uuu_record_last_update_date) 

4. Create a Space 
Attribute Form 

See the instructions 
beginning with Adding 
Blocks to the 
Attribute Form (on 
page 175) 

Mandatory fields for the space attribute form are: 

Area (uuu_sp_area) 

Unit of measure (uuu_sp_uom) 

Level picker (uuu_sp_level_picker) 

Space picker (uuu_phy_space_picker) 

This field is mandatory if you want to track the last date that a 
space record was modified. You can include this data element 
on logs to allow the user to sort records by the last date of 
modification: 

Record Last Update Date (uuu_record_last_update_date) 

If users should be able to reserve this space, these fields are 
mandatory: 

Allow space to be reserved (uuu_rsv_reservable) 

Allow over-booking (uuu_rsv_overbook) 

5. Create a log for the 
manager 

See Designing a Log for a Manager (on page 181) 

Except the User Data pickers for Space Manager, Space-type Attribute Form, Unifier does not 
allow any other data pickers in the Space Manager, Space-type Attribute Form. 

Note: There are no data pickers available for Space Manager, 
Level-type Attribute Form. 
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Shell Manager Overview 

A "shell" is where users can assemble business information in one place to make managing it 
easy. Significantly, a shell can contain its own suite of tools—those functions and features 
necessary to manage the information in that shell, such as a Cost Manager, a Document 
Manager, or a configurable manager.  

An example of such a shell could be a "facilities" shell where you could gather all your company 
campuses worldwide and incorporate the Primavera Unifier features you will need to manage 
them, such as a Generic Cost Manager and a Schedule Manager. 

In uDesigner, you will be using the Shell Manager to: 

 Create shell types

 Import shells 

 Manage shells 

In Primavera Unifier, the shells that you create in uDesigner can be arranged in hierarchies to 
represent your company's physical or organizational structure. For example, a physical location 
structure could be composed of shells for city, property, state, and building and be arranged in 
this hierarchy: 

 State 

 City 

 Property 

 Building 

There are three default shells, with anchor tabs: 

 Home 

Where users can access their tasks, messages, and mail. 

 Company Workspace 

Where users can access the tools, managers, and functions available under the company 
space. 

 Projects 

Where users can access standard projects and the modules, managers, and functions 
available under the projects. 

Shells will change the look of Primavera Unifier. For both the uDesigner-user and the Unifier 
administrator, the Shell Manager appears as a node in the navigator. Once the shell is 
operational in Unifier, the end-user will not see a Shell Manager node. The Primavera Unifier 
interface changes to a tab-based view. 

The end-users in Unifier use the shell structure to move around the hierarchy and work in 
different shells. Each part of the hierarchy will include the features and tools they will need to 
accomplish their tasks in that shell. 

The Shell Manager does not use business processes; rather, it uses attribute forms to create 
shell types and detail forms to create instances within a shell type. In Unifier, the information 
from the detail form becomes the General tab the administrator sees when they start a new 
instance. 
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To prepare a shell for use in Primavera Unifier: 

The uDesigner user: The Primavera Unifier administrator: 

Creates the shell types 

Examples: 

Buildings

Regions

Properties

 Imports the shell types and organizes them into 
hierarchies. For example: 

Regions 

| 

Properties 

| 

Buildings 

 Creates shell instances 

 Specifies what functions and features will be included in 
the shell, such as a cost manager (standard or generic), 
Resource Manager, Schedule Manager, etc. 

How does a Configurable Shell differ from a Standard Project? 

For users familiar with "projects" in Primavera Unifier, shells work in a similar manner. The 
difference is that a shell is not required to function like a time-based project. A shell can 
encompass a static entity, such as a university campus, where maintenance activities are 
on-going. 

Primavera Unifier projects are now referred to as "standard" projects, and are listed under a 
"Projects" tab at the top of the window. 

Here is a comparison of standard projects and shells: 

Standard Project Configurable Shell 

Designed for capital construction 
projects, where costs are monitored 
using CBS codes and there are defined 
start and end dates for projects. 

Designed for on-going management of any 
entity, from a project, to maintenance, to 
leasing requirements. Management in these 
shells is not necessarily time-limited. 

Must use the Standard Cost Manager, 
where costs are managed using CBS 
codes. 

Can use either the Standard Cost Manager 
(CBS based) or a Generic Cost Manager. 

Uses Primavera Unifier's Program 
features to group and manage projects; 
no hierarchy function. 

Uses shell hierarchies to group and manage 
projects, maintenance functions, leases, or 
any other type of entity. 

Projects are created entirely in 
Primavera Unifier. 

Shells are designed in uDesigner and 
configured into hierarchies in Primavera 
Unifier. 
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Shell "Types," Shell "Instances," and Sub-Shells 

Shell types are designed in uDesigner. A shell type could be "Building" or "Country. 

Shell instances are created in Primavera Unifier and are based on a shell type. Instances of a 
Building shell type could be different buildings, such as "Olympic Stadium", "Eiffel Tower," or 
"Taj Mahal." Country instances could be "China," "India," or "France." 

Sub-shells do not occur until the administrator builds the shell hierarchy in Primavera Unifier. 
Then shell types can be arranged in shell—sub-shell relationships, such as Country—Building. 
The Country shell would list China, India, and France. The Building sub-shell would list Eiffel 
Tower, Olympic Stadium, and Taj Mahal. 

Dedicated Mailbox for Shells 

External emails are important communications that need to be included in shells. Such emails 
can come from project or shell members or from external users who do not use Primavera 
Unifier. These email communications (and any attachments) can be collected in a central 
repository for the shell, called the Mailbox, so that users can use them in managing and 
documenting the shell. Once such emails reside in the shell's mailbox, users can view them, 
forward them to appropriate members, flag them for review, and reply to them. In addition, these 
external emails can be linked to business process records. 

Note: External emails that have been blind carbon-copied (Bcc'd) are not 
collected by the Mailbox. 

When the application is installed on your system, you need to specify a dedicated email address 
for your company. When you create a shell, the system assigns a unique identifier to that shell. 
The system creates the shell mailbox by combining the dedicated email address for your 
company and the unique identifier for the created shell. 

When the Primavera Unifier Administrator configures the shell instances, s/he can notify all shell 
participants, both within and outside of Primavera Unifier, of this shell email address. 

Cost Management in Shells 

For cost management in a shell, you can choose either to use Primavera Unifier's Standard Cost 
Manager, or to create your own Generic Cost Manager in uDesigner. The generic cost manager 
specifically supports costing for shells that manage business information that is not of a fixed 
duration or cost, such as ongoing leases, building maintenance, or landscape care. 

In the hierarchy of your shells, one shell might use the Standard Cost Manager while another 
might use a generic cost manager. There is, however, a limitation: Primavera Unifier will roll up 
information only from shells that use a generic cost manager; it will skip shells using the 
Standard Cost Manager. 
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Note: There are some limitations to a generic cost manager. For a 
comparison of the generic and Standard Cost Managers, see Generic 
Cost Manager Overview (on page 84). 

Tip: Although roll-ups in a shell will omit information from the Standard Cost Manager, you can 
roll up that information to the Program level, and run a report to capture it. 

Design Requirements for the Shell Manager 

For the Shell Manager to work effectively in Primavera Unifier, you will need to create the 
following components in uDesigner: 

Note: Whether you include Data Elements (in one of the Log nodes for 
an item in the Shell Manager node in uDesigner) or not, Unifier will 
include the "Name" column in the log, by default, at runtime.  

Shell Type 
Attribute form 

Sets up the Shell Manager and defines the shell types, the kind of 
cost manager that will be used in the shells, the number of sub-shells 
that can be created in Primavera Unifier, and enables the mapping 
feature. 

The information from this attribute form appears in Primavera Unifier 
on the Shell Properties window. The attribute data appears on the 
General tab when the user opens a shell from the Shell Manager 
node. 

Log (standard 
or advanced) 

Lists all the records that were created for the manager in Primavera 
Unifier at runtime. 

Standard logs display fields from the manager's attribute form that you 
want to monitor. For example, you might want a log for the Document 
Manager to include the names of all documents and their creators as 
well as their locations. For the Resource Manager, you might want the 
log to include the names of all resources and their current status. 

Advanced logs support data pickers. An advanced log should be 
designed for any shell that contains records that will be displayed on a 
data picker. (For more information on data pickers, see About Data 
Pickers (on page 195).) 

See Designing a Log for a Manager (on page 181). 

Design Flow 

The following table outlines the design steps necessary to launch the manager and create a 
shell. 

1. Create a data 
structure 

You must create two mandatory data elements: 

Shell name (based on the data definition SYS Shell Name) 

Shell number (based on the data definition SYS Shell Number) 
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(Optional) Create a data picker(s). 

See Creating a Data Structure (on page 189). 

2. Launch the 
manager 

See Launching a Manager (on page 158). 

3. Create a 
Shell Type 
Attribute Form 

See the 
instructions 
beginning with 
Starting an 
Attribute or 
Detail Form for 
a Manager (on 
page 161) 

Mandatory fields for the shell attribute form are: 

ID (must begin with us_ and at least one alpha-numeric character, 
allows up to eight characters) 

Shell name 

Shell number 

Shell administrator (uuu_administrator) 

Shell status (uuu_shell_status) 

Description 

 uuu_location 

If the shell status should be automatically updated, include the field 
uuu_au_setup_picker. 

If the shell will be using mapping (i.e., geo-searching is chosen as an 
option for this shell type), the following fields are mandatory: 

Either: 

An address (uuu_address_code) 

Or: 

A latitude (uuu_latitude) and 

A longitude (uuu_longitude) 

If the shell Project Start Date will be automatically populated to the 
Schedule Start Date for the master schedule sheet in the Schedule 
Manager, the following field is mandatory: 

Project Start Date—uuu_project_start_date 

4. Create a log 
for the manager

See Designing a Log for a Manager (on page 181). 

Details Block 

The details block seen in the Shell Manager Standard log will be customizable based on the 
elements added in the Details Block tab, in the Standard log of the Shell Manager (Company 
Workspace > Admin mode > Shell Manager > Log > Standard).  

By default, for new shells as well as existing shells, the following mandatory fields defined in the 
detail form are available in the details block: 

 Shell Name

 Shell Number

 Administrator
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 Hierarchy Path

 Status

The user can add more custom fields that are available in the details form to the details block for 
the new and existing shells. 

Designing Your Own Managers 

You can create your own managers for Primavera Unifier. You can create up to 25 managers. 

In Primavera Unifier, managers are a means to create, consolidate, and monitor such things as 
schedule activities, resource allocations, company assets, or project/shell/company costs. 
Managers generally use a discrete set of functions to control and provide oversight for specific 
purposes, such as document maintenance, scheduling, or asset management. Most managers 
work as nodes in the Primavera Unifier navigator where users can create both the items to 
manage, and an electronic "sheet" where these items can be consolidated and monitored. As an 
example, the Asset Manager is a manager already provided by Unifier where users can gather 
their company assets and monitor their locations, acquisition dates, depreciation over time, etc. 

Much the same as the Asset Manager, you can create your own managers to consolidate and 
monitor any entities you want. You can create your own code system and navigation for the 
manager, and design your own data elements for the business processes the manager will use. 
Once you have created a manager, you can deploy it at the company or project/shell level. 

In most Primavera Unifier managers, you can roll up currency amounts from BP records to a 
sheet, or from one sheet to another. However, in configurable managers, you can roll up not 
only currency amounts, but also quantity amounts. To use this feature, you will need to create 
specific data elements to place on the manager attribute (detail) form. These fields must be built 
on the following data definitions and will serve as "containers" for collecting the values from 
business process line items: 

 SYS BP Currency Amount 

 SYS BP Decimal Amount 

 SYS BP Integer Amount 

Using these data definitions for the fields on your attribute form, you can separately roll up 
currency, decimal, and integer amounts from BP line items to the manager sheet. (For 
information on how to create data elements, see Creating a Data Structure (on page 189).) 

Using Primavera Unifier's snapshot feature, users can take a "picture" of the manager sheet at 
any point in time. This can be useful to expose specific items for particular attention. 

You can design two kinds of managers: Code and Records-based and Code-based. 

 A Code and Records-based manager employs both codes to create a tracking sheet 
and records of individual items. 

 A Code-based manager employs only a sheet to keep track of the values it is monitoring. 

From a Code and Records-based manager, you can drill down from the sheet to individual 
items but from a Code-based manager you cannot drill down from the sheet to individual items. 
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Code and Records-based 

In Unifier, a Code and Records-based manager is where users can enter items and classify 
them into categories to make managing them more efficient. Similar to the Asset Manager, you 
can create categories (called classes) of items in uDesigner, and Primavera Unifier users can 
add records of individual items to these classes and manage them on electronic sheets. Once 
the Unifier user creates an item under a class, it automatically appears on the sheet. 

In Unifier, the [manager] node lists the names of every item class that was created. These 
nodes are where Primavera Unifier users can add items to the class, or modify them. The 
manager node supports multiple levels of data (such as an equipment class and equipment 
items) with drill-down capability. 

In the Sheets node, Primavera Unifier users can create a new sheet (one per code class) and 
specify what should appear on the sheet for the class, create formulas for sheet calculations, 
and roll up currency and quantity values from BPs to the sheet. Once the sheet is created, 
Primavera Unifier will automatically add a row to the sheet whenever a new item is added to any 
class. Primavera Unifier will also automatically refresh the sheet whenever an item is modified. 

From the sheet, users can import and export column data in CSV format to and from other 
applications. 

An example of a Code and Records-based manager might be an inventory or parts manager to 
itemize and keep track of parts for your facilities. In this manager, you could: 

 Categorize parts by class 

 Track inventory on hand in all locations 

 Maintain basic cost information 

 Track parts transactions (bought, sold, repaired, received, shipped, etc.) 

 Monitor the costs generated by each transaction 

Across-Shell Functioning 

Code and Records-based managers can operate across shells. An example would be 
warehouse managers located in various shells. In this scenario, each part could be tracked via a 
business process. The warehouses in the shells would stock parts and procure or replenish 
parts for the business processes across the shell hierarchy. In addition, stock could be moved or 
transferred from one warehouse to another, across shells. From the business processes for 
each part, quantities and costs could roll up to the appropriate warehouse; on-hand quantities 
could be maintained using formulas. 

Such a manager, operating across shells, can accumulate a substantial number of records. With 
such an amount of records, users can easily make mistakes in choosing the correct one to work 
with. In order for the manager to function more efficiently, you should create data pickers to help 
Primavera Unifier users navigate to the correct log of records they want to work with. Using data 
pickers, users can pick records from the company level and from all shells in the hierarchy. 

Using the functions available with data pickers, the sheets for these managers can display rollup 
data from across shells, and users will be able to drill down from the sheet to the business 
process transaction. 
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Note: For more information about data pickers, see About Data Pickers
(on page 195). 

For the manager sheet, rollup data can come only from the following business 
processes. 

At project/shell 
level: 

Cost - Line 
Items with 
Multiple Codes

Line Item, 
Generic 

At company level: 

Line Item, Generic 

For this type of manager to function across-shells, you need to create the following: 

 A data picker for each manager class. When you place this data picker on a business 
process form, users can select a record across shells. 

For this type of manager to roll up costs and quantities across-shells, you need to create the 
following: 

 A data picker for each manager class. With this data picker, users can select a record 
across shells. 

 A configurable manager picker 

 A formula to link the configurable manager picker to the data picker 

Once you have created these pieces, place the data picker and the configurable manager picker 
on the business process whose costs or quantities should roll up to the manager sheet. (If the 
user does not need to see the configurable manager picker, you can place it in a hidden block 
on the form.) 

Code-Based Manager 

In Primavera Unifier, a code-based manager provides users a sheet on which to analyze 
information that is gathered from business processes, or manually entered on the sheet. This 
manager produces no records; the values being monitored appear only on the sheet. When 
designing the sheet, the Primavera Unifier user can specify business processes from which 
column values can be collected. 

In Primavera Unifier, the [manager] node shows the sheets that have been created. Users can 
open these sheets to monitor items and add additional items to the sheets. 

An example of a code-based manager might be a "facilities" manager where users could monitor 
ongoing or preventative maintenance on the company's facilities. In this manager, you could: 

 Define a facilities code structure at the company level or at each building or shell level 

 Design multiple business processes to track and calculate: 

 Maintenance requirements 

 Inspections 
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 Work orders 

 Repairs 

 Costs of facilities, from initial requisition through repairs and enhancements 

 Various code-based managers, such as Facility Condition Index, to monitor the 
condition and usability of the facilities 

Summary of Differences 

The following table itemizes the differences between a code-based manager and a Code and 
Records-based manager. 

Code-Based Manager Code and Records-based Manager 

Uses an attribute form to create the codes 
that will appear on the sheet. 

Uses an attribute (detail) form to define 
code "classes" for categorizing the items 
on the sheet and for collecting item details. 
Provides users a way to drill down to 
specific information from the sheet. 

Uses a single sheet for analyzing 
information about the items being 
managed. These items are added to the 
sheet manually by the user. 

Records do not exist for code-based 
managers; the values collected for a 
code-based manager exist only on the 
sheet. 

Values on this sheet can be gathered from 
business processes or manually entered. 

Uses multiple sheets (one for each class) 
for analyzing information. New items are 
automatically added to the sheet from item 
records created by users filling out an 
attribute (detail) form. This type of 
manager gathers values from Cost and 
Line Item types of BPs for the manager 
sheet. 

The code structure for this type of 
manager is created in Primavera Unifier by 
the administrator. 

The code structure for this type of 
manager is created in uDesigner. 

You must design a picker for the manager. The picker for the manager is based on the 
log design. 

Cannot operate across shell hierarchy Can operate across the shell hierarchy. To 
facilitate this capability, one or more data 
pickers must be designed to help users 
navigate to records within the hierarchy. 
Sheets for these managers will display 
rollup data from across shells, and users 
will be able to drill down from the sheet to 
the business process transaction. 
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Code-Based Manager Code and Records-based Manager 

The manager sheet: 

Is created manually by the user in 
Primavera Unifier 

Shows codes as rows in a flat or tree 
format 

Can show rollup values from company and 
shell BPs at any status; values appear as 
columns on the sheet 

Does not support time-based filtering using 
queries 

The manager sheet: 

Is created manually by the user in 
Primavera Unifier; then automatically 
populated with the information gathered 
from class records 

Shows the records as rows in a flat or tree 
format 

Can show rollup values from company and 
shell BPs at any status; values appear as 
columns on the sheet 

Can update item records directly from 
sheet 

Supports the Primavera Unifier rules 
engine 

Does not support time-based filtering using 
queries 

Design Requirements for a Code-Based Manager 

For a manager to work effectively in Primavera Unifier, you will need to create the following 
components in uDesigner. 

Data elements To roll up quantity amounts to the manager sheet, you 
need to create specific data elements (fields) to place on 
the attribute form for the manager. These fields must be 
built on the following data definitions: 

 SYS BP Currency Amount 

 SYS BP Decimal Amount 

 SYS BP Integer Amount 

Attribute form Defines a code. Primavera Unifier users will see the 
information from this form in the Code Details window in 
Primavera Unifier when they add a row to the manager 
sheet; also appears on the Code Picker on business 
processes where users must choose a code from a list. 

Note: This attribute form does not create a record; the 
information exists only as part of a manager sheet. 
Consequently, you will need to design a code picker for 
this form to populate. 

Code Picker Primavera Unifier populates most pickers with the 
records that you see in the logs on the right pane of the 
screen, and uses the layout of the headings on the logs 
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for the layout of the picker. These logs show the records 
that were created, for the most part, with attribute forms. 
However, attribute forms for code-based managers use 
pickers designed specifically for them because they do 
not create records that will appear on logs; the codes 
exist only as part of a sheet. In these cases, you will 
need to design a picker in the same way you would 
design a log. 

Design Flow 

The following table outlines the steps necessary to design the coding structure and launch the 
manager. 

1. Create a data structure 

See Creating a Data Structure
(on page 189) 

For this type of manager, you must create three 
data elements for the attribute form: 

 One to gather currency values from the line 
items of a business process. Use the SYS BP 
Currency Amount data definition to build this 
element. 

 One to gather decimal values from the line 
items of a business process. Use the SYS BP 
Decimal Amount data definition to build this 
element. 

 One to gather integer values from the line items 
of a business process. Use the SYS BP Integer 
Amount data definition to build this element. 

2. Launch the manager This step initializes the design process for the 
manager. See Launching a Manager (on page 
158). 

3. Create an attribute form See the instructions beginning with Starting an 
Attribute or Detail Form for a Manager (on page 
161).  

Mandatory fields for the attribute form are: 

 Code (uuu_cm[1...25]_code) 

 Code Status (uuu_cm[1...25]_status) 

 Code Name (uuu_cm[1...25]_name) 

4. Create a picker for a 
code-based manager 

See the instructions under Designing a Picker (on 
page 180). 
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Design Requirements for a Code and Records-based Manager 

For a manager to work effectively in Primavera Unifier, you will need to create the following 
components in uDesigner. 

Data elements To roll up quantity amounts to the manager 
sheet, you need to create specific data elements 
(fields) to place on the attribute form for the 
manager. These fields must be built on the 
following data definitions: 

SYS BP Currency Amount 

SYS BP Decimal Amount 

SYS BP Integer Amount 

Attribute form Defines a code class. Primavera Unifier users will 
see the information from this form in the Code 
Details window in Primavera Unifier; also 
appears on the Code Picker on business 
processes where users must choose a code from 
a list. 

Log (standard or advanced) Lists all the records that were created for the 
manager in Primavera Unifier at runtime. 

Standard logs display fields from the manager's 
attribute form that you want to monitor. For 
example, you might want a log for the Document 
Manager to include the names of all documents 
and their creators as well as their locations. For 
the Resource Manager, you might want the log to 
include the names of all resources and their 
current status. 

Advanced logs support data pickers. An 
advanced log should be designed for any shell, 
configurable manager class, or business process 
that contains records that will be displayed on a 
data picker. (For more information on data 
pickers, see About Data Pickers (on page 195).)

Reference process If you include a BP Picker on the form, a 
reference process is necessary to point to the BP 
you want to reference. 
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Data Picker(s) (Optional) If you are designing a Code and 
Records-based manager that will operate across 
shells, data pickers will help Primavera Unifier 
users locate and pick the correct BP records 
within the hierarchy. A data picker filters the 
information that appears on the picker so that 
users do not have to search through a multitude 
of records in the shell hierarchy. 

Design Flow 

Following are the overall steps necessary to design the coding structure and launch a Code and 
Records-based manager. 

 Create data elements for the purpose of populating the sheet from business processes. 
These fields must be included on the attribute form. 

Note: Do not confuse these data elements with those you choose on the 
Options tab when you launch the manager: Those elements work in 
conjunction with the data elements discussed here. The elements 
discussed here serve as "containers" on the sheet for collecting values 
from the data elements you specify on the Options tab, and they must be 
created from data definitions developed especially for these managers. 

 Place a class code field on the detail form for the manager and create a pool of segment 
fields from which to create the code. On the detail form, you must create a concatenated 
formula for this class code field using segments from the pool. When you design this 
field, mark all these fields "editable and required." 

 If the manager sheet will be in a tree format, you must include a navigation code field on 
the detail form and create a concatenated formula for this field. 

The fields selected in the formula of the Navigation code are used for the Navigation tree 
structure. The ordering of data elements, for the tree structure, will be the order that the 
Navigation code data element has formulated.  

Example 

The uuu_cm_navigation_code is fomulated as: Manufacturer<upmManufacturerTXT120> 
+ Material Category<umatCategoryPD> + Material Sub Category<umatSubTypePD> + 
Material Name<uuu_cm5_name> 

In the Formula user interface, you will see: 

Navigation Code = Manufacturer (-) Material Category (-) Material Sub Category (-) 
Material Name   

As a result, the data element ordering in the tree structure, in User mode, will be: 

1) Manufacturer > 2) Material Category > 3) Material Sub > Material Name 

Note: The Advance Log Navigation has no effect in Code-based and Record-based 
Configurable module tree structure. This is governed by uuu_cm_navigation_code. The 
data elements with data definition type "String" will be shown in Formula data element 
selection list. 

The following table outlines these steps with additional details. 
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1. Create a data structure For this type of manager, you must create three 
data elements for the attribute form: 

One to gather currency values from the line items 
of a business process. Use the SYS BP Currency 
Amount data definition to build this element. 

One to gather decimal values from the line items 
of a business process. Use the SYS BP Decimal 
Amount data definition to build this element. 

One to gather integer values from the line items of 
a business process. Use the SYS BP Integer 
Amount data definition to build this element 

(Optional) If you are designing a Code and 
Records-based manager that will operate across 
shells, data pickers will help Primavera Unifier 
users locate and pick the correct BP records 
within the hierarchy. For more information on data 
pickers, see About Data Pickers (on page 195). 

See the instructions beginning with Creating a 
Data Structure (on page 189). 

2. Launch the manager This step initializes the design process for the 
manager. See Starting an Attribute or Detail 
Form for a Manager (on page 161). 

3. Create an attribute form See the instructions beginning with Designing a 
Form (on page 248). 

Mandatory fields for the attribute form are: 

Code (uuu_cm[1...25]_code) 

Code Status (uuu_cm[1...25]_status) 

Code Name (uuu_cm[1...25]_name) 

Any fields that should be used as part of the code.

If the manager sheet is in a tree format, this field 
is mandatory: 

Navigation code (uuu_code_navigation_code) 

 If users should be able to reserve this item, these 
fields are mandatory: 

Allow item to be reserved (uuu_rsv_reservable) 

Allow over-booking (uuu_rsv_overbook) 

4. Create a log See Designing a Log for a Manager (on page 
181). 
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Testing and Publishing a Manager 

When you have completed designing the attribute form for a manager in uDesigner, it must be 
tested in Development environment before it can be deployed in Test, or Production, 
environment.  

Before the manager is tested and published, it is important that you preview all the forms in the 
manager, check them for errors, and change the status to "Complete." 

The process of testing and publishing entails: 

 Checking for errors 

 Changing the status to "Complete" 

 Configuring a component for testing 

 Deploying to the Test environment for testing 

 Bundling designs in Development environment and deploying to Unifier Production 
environment for use 

Launching a Manager 

Before the user can use a manager, you must launch that manager in uDesigner, by using an 
attribute form or a detail form. 

An attribute form or a detail form will enable: 

 You to set up the manager for proper functioning. 

 The manager to collect data. 

 The application to fuction, by arranging or assembling the needed data. 

 The adjustment of data for analyses, calculations, and other tasks. 

Example 

 You can design a cost attribute form with fields that show additional information about a 
CBS code. 

 You can design a fund attribute form with fields that define segments and reference fields 
for fund codes. 

An attribute form or a detail form is: 

 Different from a business process form (BP form) because an attribute form or a detail 
form is not attached to workflows. 

 For collecting information that is not relevant to the steps in a workflow. 

For a company, you can design either an attribute form, or your can design a detail form, but not 
both. 
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You must create an attribute form or a detail form and import the form to the production 
environment before you import any BP forms or other components; otherwise, the system uses a 
default attribute form for the company. 

Once you create an attribute form or a detail form: 

 You can modify the form. 

 You cannot create, or design, a new form. 

For example, this Resource Attribute form, designed in uDesigner ...  

... appears as the General tab of the Create Resource form that the Primavera Unifier 
administrator uses to add a resource to the company's pool of resources ... 

... which in turn, populates the resource picker with the names the user can choose from. 
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Design Requirements for Launching a Manager 

For the managers to work effectively in Primavera Unifier, you will need to create the following 
components in uDesigner: 

Attribute Form 
(In some 
managers, this 
is a detail form.)

Each manager requires at least one attribute form to make it 
operational in Primavera Unifier. See the instructions beginning with 
Starting an Attribute or Detail Form for a Manager (on page 161). 

Formula (For 
the Standard 
Cost Manager) 

For the Cost Manager, you will need to define formulas to create 
codes for funds and company accounts. See Designing a Formula 
for Fund or Account Codes (on page 179). 

Picker (For the 
Standard Cost 
Manager) 

Two attribute forms—Fund Attributes and Account Code Attributes, 
—use pickers designed specifically for them because they do not 
create records that will appear on logs; they exist only as part of a 
fund sheet or cost sheet. For these cases, you will need to design a 
picker in the same way you would design a log. See Designing a 
Picker (on page 180). 

Picker (for a 
Generic Cost 
Manager) 

The attribute form for a Generic Cost Manager will need a picker 
designed specifically because they do not create records that will 
appear on logs; they exist only as part of a fund sheet or cost sheet. 
For these cases, you will need to design a picker in the same way 
you would design a log. See Designing a Picker (on page 180). 

Picker (for a 
code-based 
manager) 

The attribute form for a code-based configurable manager will need a 
picker designed specifically because they do not create records that 
will appear on logs; they exist only as part of a fund sheet or cost 
sheet. For these cases, you will need to design a picker in the same 
way you would design a log. See Designing a Picker (on page 180).

Data Picker(s) 

For: 

A Code and 
Records-based 
manager 

The Shell 
Manager 

(Optional) If you are designing these managers, data pickers will help 
Primavera Unifier users locate and pick the correct business process 
records across manager classes and shells within a hierarchy. 

A data picker filters the information that appears on the picker so that 
users do not have to search through a multitude of records in a 
manager class or shell hierarchy. See Creating a Data Picker 
Definition (on page 200). 

Log (standard or 
advanced) 

Standard logs display fields from the manager's attribute form that 
you want to monitor. For example, you might want a log for the 
Document Manager to include the names of all documents and their 
creators as well as their locations. For the Resource Manager, you 
might want the log to include the names of all resources and their 
current status. Picker logs support data pickers. An advanced log 
should be designed for any configurable manager class, or shell 
hierarchy. (For more information on data pickers, see About Data 
Pickers (on page 195).) For instructions on creating a log, see 
Designing a Log for a Manager (on page 181). 
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Starting an Attribute or Detail Form for a Manager 

The attribute or detail form you design will prepare the manager to collect data, and assemble 
and arrange the data for Primavera Unifier functions. Before you can design the form, you must 
initialize a blank form in uDesigner. This initialization follows different steps, depending on the 
type of manager the form is for. The links below will take you to information on how to start the 
form(s) for whatever manager you are launching. 

 For the Asset Manager (on page 161) 

 For a Code-Based Manager (on page 163) 

 For a Code and Records-based Manager (on page 165) 

 For the Document Manager (on page 167) 

 For the Standard Cost Manager (on page 162) 

 For a Generic Cost Manager (on page 168) 

 For the Planning Manager (on page 169) 

 For the Portfolio Manager (on page 170) 

 For the Resource Manager (on page 171) 

 For the Schedule Manager (on page 172) 

 For the Shell Manager (on page 172) 

For the Asset Manager 

The Asset Manager needs an attribute form to define an asset "class" and its corresponding 
code segments. In Primavera Unifier, users will enter assets to the system according to its class. 
Defining asset classes makes it convenient for users to store assets in categories, such as 
"Buildings," "Equipment," or "Transportation." 

Notes: 

 Be Careful About Status Names! 

 Do not use the same class name that is being used by any Code and 
Records-based configurable manager: Primavera Unifier is unable to 
distinguish class names between managers. The best way to avoid 
redundant class names is to preface the class name with the name 
of the manager it belongs to, such as "Asset—Heavy Equipment" to 
distinguish it from a configurable manager like "Inventory—Heavy 
Equipment." 

To define a class code, you must use a formula to build the code from the segments of data 
elements that were created for your assets (such as location segments: country-state-city). 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Asset Manager. 

3) On the right pane, click New > Asset Class. The Edit Studio window opens. 

4) In the General field, enter a name for the asset class. 
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5) In the Description field, enter a description of the class. 

6) Click Apply, then click the Statuses tab. 

On the Statuses tab, you can specify the statuses you want to make available for the asset 
class. 

Note: Asset class statuses control which assets are displayed on an 
asset class sheet. For example, a user might not want the sheet to show 
assets that are in "Out of Service" and "Decommissioned" status. 

7) To add a status, click the Add button and choose the status from the list that appears. 

To choose multiples statuses, hold down the Ctrl key and click each status you want. 

8) (Optional) Make the status or statuses terminal. 

To make a status terminal, select the status and click the Terminal button. (See "About 
Terminal Statuses" under Statuses Tab (on page 221).) 

9) Click Apply, then click the Options tab. See the table below. 

10) Click OK. 

uDesigner displays the name of the form on the right pane. At this point, you can add the 
content to the form. See Adding Blocks to the Attribute Form (on page 175) and also 
Adding Fields to the Form (on page 304). 

In this field: Do this: 

Show 
Assets in 
Asset 
Picker 
when 
status 
equals

Specify what status the assets in this class should be in before they are 
included on the Asset Picker. This will restrict the picker to show only 
those assets that are at certain statuses, such as "In service," "In 
maintenance," and "Ready for Install." You must specify at least one 
status, and multiple statuses are allowed. 

Enable 
Calendar

Select this checkbox if users should be able to reserve this asset for 
exclusive use. If you select this check box, the form will display a 
Calendar button in the toolbar that the user can use to display a calendar 
and specify dates and times for the reservation, as well as additional 
information that might be necessary for the reservation. 

Note: Primavera Unifier users can reserve assets only from the Quick 
Calendar feature. Assets cannot be reserved using a Reservation type 
business process. 

For the Standard Cost Manager 

The standard Cost Manager needs attribute forms to define the codes for funds, costs, and 
accounts, and to customize CBS details. These codes or accounts can then be used to collect 
company-level costs, such as assets, resources, or facility maintenance. 
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Note: If you do not create an attribute form for the Standard Cost 
Manager, Primavera Unifier will create a default one to support basic 
required information, such as cost and fund codes. 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Cost Manager. 

3) On the right pane, click: 

 New > Cost Attributes to create a cost attributes form 

 New > Fund Attributes to create a fund attributes form 

 New > Account Code Attributes to create a company account code attributes form 

The Edit Studio window opens. 

4) Under the General tab, enter a name for the form and a description. The type is 
pre-populated. 

5) Click OK to save and close the window. 

Once you click OK, uDesigner displays the name of the form on the right pane and 
automatically creates a detail form. At this point, you can add the content to the form. See 
Adding Blocks to the Attribute Form (on page 175) and also Adding Fields to the Form
(on page 304). 

For a Code-Based Manager 

To launch a code-based manager, you need to name the manager and create a pool of data 
elements from which users can build codes and the sheet. Each code becomes a row on the 
sheet. 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Configurable Modules. 

3) Select New > Code. The Edit Studio window opens. 

4) Use the information in the table below to complete the General tab. 

5) Click Apply, then click the Codes tab. 

Configurable managers use codes to organize the information on the tracking sheets. The 
Codes tab is where you create a pool of data elements. Users will pick elements from this 
pool to use as segments of a code. The code can be composed of one or more of these data 
elements. Building a code involves combining values from these data elements; for example, 
designing a field called "Project Identifier" using a code that includes Project, Record No., 
and Location data elements. 

Note: Codes for code-based managers can be created from fields built 
only on string or pull-down data definitions. Be sure you have created 
these fields (data elements) before you create this pool of elements. 

Codes can be up to 250 characters long, including the delimiters (such as dashes or 
underscores). 

Note: Do not include the name of the code in this pool of data elements. 
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The name of the code should not be used in the code itself. 

a. Click the Add button. This adds a new row to the sheet. 

b. In the Code Segments Separator field, select a delimiter. 

The delimiter separates the code segments. For example if you select an underscore (_) 
for the Project Identifier example above, it would appear as Project_Record_Location. 

You can select only one delimiter. 

c. In the Name field, specify each data element you want to add to the pool by clicking the 
down arrow and choosing an element. 

Each data element you include under the Name field can be chosen by the user in 
Primavera Unifier as a segment, separated by the delimiter you specify in Step b. 

d. To add another element to the pool, click Add again and repeat step c. 

6) Click Apply to save the elements; then click the Options tab. 

The Options tab is where you can specify the data elements that should appear on the 
manager sheet. You can add any currency, decimal, or integer type data elements. If these 
elements are present on Cost or Line Item business processes designed for the manager, 
the values from these elements will roll up to the sheet. 

Note: Business processes designed for the Standard Cost Manager roll 
up only currency amounts to the cost sheet. Cost and Line Item BPs 
designed for a configurable manager can roll up other amounts, such as 
quantities, in addition to currency amounts. 

These data elements work in conjunction with the data elements that were created for the 
manager's attribute form using the SYS BP Currency, Decimal, and Integer Amount data 
definitions (see Design Requirements for a Code-Based Manager (on page 153)). These 
data elements serve as containers for collecting the values from the data elements you 
specify here on the Options tab. 

Note: Once you set these fields, they cannot be changed or removed, 
even if you leave them empty. 

To add a data element: 

a. Click the Add button. The Select Data Elements window opens. 

b. Select the currency, decimal, or integer type element you want to include on the manager 
sheet and click Open. 

(To add multiple elements, hold down the Ctrl key while you select the elements.) 

7) Click OK. 

Once you click OK, uDesigner displays the name of the manager on the right pane. 

8) To complete the launch, you need to design an attribute form. Users will use this form to 
create the codes for the manager and build the sheet. 

To start the form: 

a. Switch to Design mode and click the name of the manager in the navigator. 

b. Select New > Attribute Form. The Edit Studio window opens. 
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c. Under the General tab, enter a name for the form and a description. The type is 
pre-populated. 

d. Click OK to save and close the window. 

uDesigner displays the name of the form on the right pane. At this point, you can add the 
content to the form. See Adding Blocks to the Attribute Form (on page 175) and also 
Adding Fields to the Form (on page 304). 

In this field: Do this: 

Name 
Enter a name for the manager. The name can be up to 64 characters 
long and can include alphanumeric characters, spaces, and punctuation 
marks. 

Description 
(Optional) Enter a description of the manager. A description is optional, 
but recommended. 

Type This field confirms that you are creating a configurable manager. 

Sub-Type This field confirms that the new manager is code-based. 

Level 
Specify whether this manager will be at the company level or 
project/shell level. 

Sheets 

Specify how many sheets the user can create for the manager. Multiple 
means the user can create any number of sheets for the manager to 
monitor. Single means the user can create only one sheet for the 
manager per company or per project/shell. 

ID 
Select an ID for the manager. You can create up to 25 configurable 
managers. 

For a Code and Records-based Manager 

A Code and Records-based manager needs an attribute form to define a code "class." Defining 
code classes makes it convenient for users to categorize the information that appears on the 
sheets. 

Note: Be careful about class names. Do not use the same class name 
that is being used by the Asset Manager or by another Code and 
Records-based configurable manager: Primavera Unifier is unable to 
distinguish class names between managers. The best way to avoid 
redundant class names is to preface the class name with the name of 
the manager it belongs to, such as "Asset—Heavy Equipment" to 
distinguish it from a configurable manager like "Inventory—Heavy 
Equipment." 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Configurable Modules. 
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3) Select New > Code and Records. The Edit Studio window opens. 

4) Use the information in the following sections to complete the Edit Studio tabs. 

General Tab 

1) Use the information in the table below to complete the General tab. 

2) Click Apply; then click the Options tab. 

In this field: Do this: 

Name 
Enter a name for the manager. The name can be up to 64 characters 
long and can include alphanumeric characters, spaces, and punctuation 
marks. 

Description 
(Optional) Enter a description of the manager. A description is optional, 
but recommended. 

Type This field confirms that you are creating a configurable manager. 

Sub-Type This field confirms that the new manager is Code and Records-based. 

Level 
Specify whether this manager will be at the company-level or 
project/shell-level. 

Sheets 

Specify how many sheets the user can create for the manager. Multiple 
means the user can create any number of sheets for the manager to 
monitor. Single means the user can create only one sheet for the 
manager per company or per project/shell. 

Records Log 
Specify whether the manager sheet should be a flat list, or a tree that 
will expand to show items within a code class. 

ID 
Select an ID for the manager. You can create up to 25 configurable 
managers. 

Options Tab 

The Options tab is where you can specify the data elements that should appear on the manager 
sheet. You can add any currency, decimal, or integer type data elements. If these elements are 
present on Cost or Line Item business processes designed for the manager, the values from 
these elements will roll up to the sheet. 

Business processes designed for the Standard Cost Manager roll up only currency amounts to 
the cost sheet. However, Cost and Line Item BPs designed for a configurable manager can roll 
up other amounts, such as quantities, in addition to currency amounts. 

These data elements work in conjunction with the data elements that were created for the 
manager's attribute form using the SYS BP Currency, Decimal, and Integer Amount data 
definitions (see Design Requirements for a Code and Records-based Manager (on page 
155)). These data elements serve as containers for collecting the values from the data elements 
you specify here on the Options tab. 
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Note: Once you set these fields, they cannot be changed or removed, 
even if you leave them empty. 

To add a data element: 

1) Click the Add button. The Select Data Elements window opens. 

2) Select the currency, decimal, or integer type element you want to include on the manager 
sheet and click Open. 

(To add multiple elements, hold down the Ctrl key while you select the elements.) 

3) Click OK. 

Completing the launch 

Once you have started the manager's attribute form using the steps above, uDesigner displays 
the name of the manager on the right pane. To complete the launch, you need to design 
attribute forms for the code classes the manager will use. 

1) In the left Navigator, click uDesigner > Configurable Modules. 

2) On the right pane, double-click the manager you want to launch. 

3) In the right pane, select New > Class. The Edit Studio window opens. 

4) Under the General tab, enter a name for the class and a description. The type is 
pre-populated. 

5) Click Apply, then click the Options tab. 

6) (Optional) On the Options tab, in the Enable Calendar field, select the checkbox if users 
should be able to reserve this item for exclusive use. 

If you select this check box, the form will display a Calendar button in the toolbar that the 
user can use to display a calendar and specify dates and times for the reservation, as well as 
additional information that might be necessary for the reservation. 

7) Click OK to save and close the window. 

uDesigner displays the name of the form on the right pane. At this point, you can add the 
content to the form. See Adding Blocks to a Form (on page 271) and also Adding Fields 
to the Form (on page 304). 

For the Document Manager 

Attribute forms for the Document Manager collect data (including the title, name, and issue date) 
related to the documents that users store in the Document Manager. They also collect properties 
related to the folders used to organize documents in the Document Manager. Documents can be 
stored at both the company and project level. One attribute form is allowed for the Document 
Manager, and it specifies properties for both company and project level documents. 

Note: If you do not create an attribute form for the Document Manager, 
Primavera Unifier will create a default one to identify the documents in 
the system. 

1) Click the Company Workspace tab and switch to Administration Mode. 
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2) In the left Navigator, click uDesigner > Document Manager. 

3) Select New > DMS Attributes. 

The Document Manager—Home pane opens, and the Document Manager node in the 
Navigator expands. 

4) In the Navigator, click Folder Properties or Document Properties as appropriate. The 
DMS Properties pane opens, showing a default form. 

At this point, you can add the content to the form. See Adding Blocks to the Attribute 
Form (on page 175) and also Adding Fields to the Form (on page 304). 

For a Generic Cost Manager 

The Generic Cost Manager needs an attribute form to define the codes for costs generated 
under a shell. These codes can then be used to collect shell-level costs, such as assets, 
resources, or facility maintenance. Part of launching this manager is building the cost codes it 
will use from data elements (fields). 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Configurable Modules

3) In the right pane, click New > Generic Cost. The Edit Studio window opens. 

4) On the General tab, enter a name and description for the manager. 

5) Click Apply, then click the Codes tab. 

On the Codes tab, you build the cost codes the generic manager will use for the cost 
functions in the shells your users will be using. These codes are a composite of multiple 
segments that identify the origin of the cost in the accounting scheme. To build the code, you 
must concatenate the accounting segments into one identifier by designing a composite field 
that combines multiple data elements. You will be building the code by combining values 
from text box data elements and specifying a string-type pull-down; for example, designing a 
field called "Fund Identifier" using a formula that includes Fund Name, Fund No., and 
location. 

Cost codes can be up to 250 characters long, including delimiters (such as dashes or 
underscores). 

Note: Do not include the name of the code in this pool of data elements. 
The name of the code should not be used in the code itself. 

a. Click the Add button. This adds a new row to the cost sheet. 

b. In the Code Segments Separator field, select a delimiter. 

The delimiter separates the elements. For example if you select a dash (-) between 
elements for Account Identifier, it would appear as Account-Record-Location. 

c. In the Name field, choose the data element (field) that should be the first segment of the 
cost code. Each data element you include under the Name field will be used as a 
segment, separated by the delimiter you specify in step b. 

d. To add another segment to the code, click Add again and repeat step c. 

e. Click OK. 

Once you click OK, uDesigner displays the name of the manager on the right pane. 
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6) To complete the launch, you need to design the attribute form for the cost manager. 

To start the attribute form: 

a. In the left Navigator, click uDesigner > Configurable Modules. 

b. In the right pane, double-click the generic cost manager you created. 

c. In the right pane, click New > Attribute form.  

d. In the left Navigator, click Detail Form and click New in the right pane.  

e. Under the General tab, enter a name for the form and a description. 

f. Click OK to save and close the window. 

uDesigner displays the name of the form on the right pane. At this point, you can add the 
content to the form. See Adding Blocks to the Attribute Form (on page 175) and also 
Adding Fields to the Form (on page 304). 

For the Planning Manager 

The Planning Manager needs attribute forms to collect summary information about the type of 
plan being considered (such as capital or IT), and to summarize the planning sheet, including its 
name and the date the sheet was last updated. 

Before you can design an attribute form, you need to specify a planning type in the Planning 
Manager. For plans and planning sheets, the "attribute form" is called a "detail form" in 
uDesigner. 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Planning Manager. 

3) On the right pane, click New > Planning. The Edit Studio window opens. 

4) Use the information in the first table below to complete the General tab. 

5) Click OK. uDesigner displays the name of the plan type in the right pane. 

6) Double-click the name of the plan type. The navigator expands to show two additional 
nodes. 

 For a planning item form, click Planning Item > Detail Form. 

 For a planning sheet, click Planning Sheet > Detail Form. 

uDesigner displays the name of the form on the right pane and automatically creates a detail 
form. 

7) To start designing the detail form for the planning sheet, double-click the name of form in the 
right pane. 

At this point, you can add the content to the form. See Adding Blocks to the Attribute 
Form (on page 175) and also Adding Fields to the Form (on page 304). 

8) To start the detail form for the planning item, highlight the form name in the right pane and 
click the Properties button on the tool bar. A window opens, showing a General tab and an 
Options tab. 

The General tab shows the name uDesigner gave to the detail form. 

a. Click the Options tab. 

b. Use the second table below to complete the Options tab. 

c. Click OK. 
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d. To start designing the detail form for the planning sheet, double-click the name of form in 
the right pane. 

At this point, you can add the content to the form. See Adding Blocks to a Form (on 
page 271) and also Adding Fields to the Form (on page 304). 

In this field: Do this: 

Name 
Enter a name for the planning type. The name can be up to 64 
characters long and can include alphanumeric characters, spaces, and 
punctuation marks. 

Description 
(Optional) Enter a description of the item. A description is optional, but 
recommended. 

Type This field confirms that you are creating a planning type. 

Level 
Specify whether this planning type will be at the company-level or 
project/shell-level. 

Attachments 
to overall 
record 

Add and remove attachments to the record. 

Note: For Text type BPs, the user cannot remove attachments. 

Note: To specify that users can attach files to their business process 
workflow e-mail responses, the Administrator must select Enable 
response via email in the business process setup and, in uDesigner 
select the Add Attachments option on the Options tab in the Action Form 
for the business process. 

Attachment 
Source 

Add attachments or line items from the Primavera Unifier Document 
Manager (Primavera Unifier Folders), or from the user's local machine 
(My Computer). 

For the Portfolio Manager 

The Portfolio Manager needs attribute forms to collect summary information about the portfolio, 
including its name and the date the sheet was last updated. 

Before you can design an attribute form, you need to create a portfolio in the Portfolio Manager. 
For portfolios, the "attribute form" is called a "detail form" in uDesigner. 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Portfolio Manager. 

3) On the right pane, click New > Portfolio. The Edit Studio window opens. 

4) Use the information in the table below to complete the General tab. 

5) Click OK. Once you click OK, uDesigner displays the name of the portfolio on the right pane. 
At this point, you should create a detail (attribute) form for the portfolio. 

6) Double-click the portfolio name. 

7) In the Navigator, click the Detail form node. 

8) In the right pane, click the New button. Primavera Unifier displays a form design window. 
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9) Enter a name and description for the form and click OK. Primavera Unifier displays the name 
of the form in the right pane. 

10) Double-click the form name on the right pane. The Edit Studio window opens. 

At this point, you can add the content to the form. See Adding Blocks to the Attribute 
Form (on page 175) and also Adding Fields to the Form (on page 304). 

In this field: Do this: 

Name 
Enter a name for the portfolio. The name can be up to 64 characters 
long and can include alphanumeric characters, spaces, and punctuation 
marks. 

Description 
(Optional) Enter a description of the portfolio. A description is optional, 
but recommended. 

Type This field confirms that you are creating a capital portfolio type. 

Level 
Specify whether this portfolio will be at the company-level or 
project/shell-level. 

For the Resource Manager 

The Resource Manager needs attribute forms to define the roles that will be used for a project 
(such as "accountant," or "electrician") and to collect personnel data for the resources that will fill 
these roles. 

Note: If you do not create an attribute form for the Resource Manager, 
Primavera Unifier will create a default one to support basic information, 
such as the resource name. 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Resource Manager. 

3) On the right pane, click: 

 New > Role Attributes to create a role attribute form 

 New > Resource Attributes to create a resource attribute form 

The Edit Studio window opens. 

4) Under the General tab, enter a name for the form and a description. The type is 
pre-populated. 

5) Click OK to save and close the window. 

Once you click OK, uDesigner displays the name of the form on the right pane and 
automatically creates a detail form. At this point, you can add the content to the form. See 
Adding Blocks to the Attribute Form (on page 175) and also Adding Fields to the Form
(on page 304). 
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For the Schedule Manager 

The Schedule Manager needs attribute forms to define the activities for a project schedule, 
including its start and end dates. 

Note: If you do not create an attribute form for the Schedule Manager, 
Primavera Unifier will create a default one to designate start and end 
dates for the project. 

For the Schedule Manager, you can also "tag" fields in order to map them to fields on business 
processes, shells, spaces, or configurable managers. These tags are created as part of the data 
structure (see Creating a Tag (on page 214)). When you map these tagged fields to fields on 
other forms, users can see schedule information without having to open the Schedule Manager. 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Schedule Manager. 

3) On the right pane, click New > Schedule Attributes. The Edit Studio window opens. 

4) Under the General tab, enter a name for the form and a description. The type is 
pre-populated. 

5) Click the Tags tab. Then click the Add button. The Tag Picker window opens, showing the 
tags that were created in the Data Structure node. 

6) Select the tag to add to the Schedule Activity Tags list, then click OK. 

When you link fields from the Schedule Manager to your Business Process form or other 
component, you can link the tagged fields to: 

 A shell 

 A space 

 A configurable manager 

 A business process 

See Adding Link Elements to a Form for details. 

7) Click OK to save and close the window. 

Once you click OK, uDesigner displays the name of the form on the right pane and 
automatically creates a detail form. At this point, you can add the content to the form. See 
Adding Blocks to the Attribute Form (on page 175) and also Adding Fields to the Form
(on page 304). 

For the Shell Manager 

The Shell Manager uses attribute forms to define shells. In Primavera Unifier, users can create 
different shells, with unique names, and arrange them in a hierarchy so they can manage 
specific business information. Shells with the same name cannot be used in a parent-child, or a 
parent-grandchild arrangement. 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Shell Manager. 

3) On the right pane, click New > Shell. The Edit Studio window opens, showing the General 
tab. 



Launching a Manager

173

4) Use the information in the first table below to complete the fields on this tab. 

5) Click Apply, then click the Options tab. 

6) Use the information in the second table below to complete the fields on the Options tab. 

For information on this option and how to use it, see Adding Link Elements to a Form (on 
page 386). 

7) Click OK. uDesigner displays the name of the shell type in the right pane. 

At this point, you can add the content to the form. See Adding Blocks to the Attribute 
Form (on page 175) and also Adding Fields to the Form (on page 304). 

In this field: Do this: 

Name 
Enter a name for the shell; the name must be unique. Shell names 
can be up to 64 characters long and can include alphanumeric 
characters, spaces, and punctuation marks. 

Description 
(Optional) Enter a description of the shell. A description is optional, 
but recommended. 

Shell Instance 

Specify whether the user can create: 

Multiple shells, which means the user can use this shell attribute 
form to create any number of shells in Primavera Unifier 

Single, which means the user can use this shell attribute form to 
create one shell in Primavera Unifier 
A single shell instance becomes the name of the shell node in 
Primavera Unifier and creates an "anchor" or "root" tab at the top of 
the window. The anchor tab becomes the user's access to the 
sub-shells in the hierarchy. 

Cost Codes 

Specify which type of cost manager the shell should use: CBS based 
(the Standard Cost Manager that is provided for projects) or Generic 
Cost Manager. 

For an explanation of the differences between CBS and generic cost 
codes, see Generic Cost Manager Overview (on page 84). 

Enable GEO 
searching in 
FIND 

Select this check box if you want the user to be able to search for a 
shell by address, latitude, or longitude in the Find window at runtime 
in Primavera Unifier. The Primavera Unifier user will be able to see a 
map view of a shell showing pins on the map for each location of a 
sub-shell. This option is enabled for published designs for both 
business processes and shells.  



Unifier uDesigner User Guide

174

For the Space Manager 

The Space Manager needs attribute forms to define a level (such as a floor) for your facility and 
also the spaces that occupy each level. In Unifier, users will create spaces under each level to 
define each area that should be included for facilities management. You will need to create a 
single form for users to create levels with and multiple forms for users to create space “types” 
with (such as “office” or “lobby area”). In Unifier, users will add spaces to the manager sheet 
according to their type.

To start a level form 

1) Enter User mode and click Space Manager in the navigator. 

2) On the right pane, click New > Level. The Edit Studio window opens. 

3) On the General tab, enter a name and description for the level. 

4) Click Apply, then click the Statuses tab. 

On the Statuses tab, specify the statuses you want to make available for the level. 

5) To add a status, click the Add button and choose the status from the list that appears. 

To choose multiples statuses, hold down the Ctrl key and click each status you want. 

6) (Optional) Make the status or statuses terminal. 

To make a status terminal, select the status and click the Terminal button. 

7) Click OK. 

uDesigner displays the name of the level on the right pane. At this point, you can add the 
content to the form. See Adding Blocks to the Attribute Form (on page 175) and also 
Adding Fields to the Form (on page 304). 

To start a space form 

1) Enter User mode and click Space Manager in the navigator. 

2) On the right pane, click New > Space. The Edit Studio window opens. 

3) On the General tab, enter a name and description for the space and click OK. 

uDesigner displays the name of the space form on the right pane. At this point, you can add 
the content to the form. See Adding Blocks to the Attribute Form (on page 175) and also 
Designing a Formula for Fund or Account Codes (on page 179). 

When you have finished the form design, you must return to the properties window for the 
form and specify an option that can be activated only after you have created the attribute 
form for the space. Proceed as follows: 

a. Click Space Manager in the navigator. 

b. On the right pane, double-click the name of the space attribute form. The navigator 
displays the name of the space you created and the Edit Studio window opens. 

c. Click the Options tab. 

d. (Optional) in the Enable Calendar field, select the checkbox if users should be able to 
reserve this space for exclusive use. 

If you select this check box, the form will display a Calendar button in the toolbar that the 
user can use to display a calendar and specify dates and times for the reservation, as 
well as additional information that might be necessary for the reservation. 
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e. Click OK. 

Adding Blocks to the Attribute Form 

Use the following instructions to add content to the attribute/detail form. The blocks of fields you 
design for the form will appear in Primavera Unifier similar to the following example. 

To add blocks to an attribute form 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner.

3) Open the attribute form as shown in the table below. 

A designer window opens. 

Note: You can add editable data element (Editable) and editable 
required data element (Editable (Required)) in the hidden block. This is 
applicable to all types of BP forms, including attribute forms.  
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To open this form: Do this: 

Shell attribute form 

Asset Class 

Cost Manager 
forms 

1 Click the name of the manager in the left Navigator.  

2 Double-click the name of the attribute form in the right pane. 

3 Click Detail Form in the navigator. 

4 Double-click the name of the form in right pane. 

Resource attribute 
form 

1 Click Resource Manager in the left Navigator. 

2 Double-click Resource Attributes in the right pane. 

3 Click Detail Form in left navigator. 

4 Double-click the name of the form in right pane. 

Role attribute form 1 Click Resource Manager in the left Navigator. 

2 Double-click Role Attributes in the right pane. 

3 Click Detail Form in left navigator. 

4 Double-click the name of the form in right pane. 

Schedule Activity 
attribute form 

1 Click Schedule Manager in the left Navigator  

2 Double-click Activity Detail in the right pane. 

3 Click Detail Form in the navigator. 

4 Double-click the name of the form in right pane. 

Schedule Resource 
Assignment form 

1 Click Schedule Manager in the left Navigator. 

2 Double-click Resource Assignment in the right pane. 

3 Click Detail Form in the navigator. 

4 Double-click the name of the form in right pane. 

Code-based 
manager 

Code and 
Records-based 
manager 

1 Click Configurable Modules in the left Navigator. 

2 In the right pane, double-click the name of the manager. 

3 In the right pane, double-click the name of the form. 

1) In the TabName field, enter a name. This is the title that will appear on the form in Primavera 
Unifier. 

2) Specify the blocks you want on the form as follows: 

a. On the Designer window, click the Blocks button. The Form Blocks window opens. 

b. To add a block to the form, click the Add button. The Block Properties window opens. 

c. Use the information in the second table below to complete the fields in this window. 

3) After defining the block properties, click OK to return to the Design window. Next, you can 
add fields to the form (See Adding Fields to the Form (on page 304)).  

In this field: Do this: 

Name Enter a name for the block (for internal purposes only). 
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In this field: Do this: 

Description Enter a description for the block. This description will appear on the form 
in Primavera Unifier if you choose to make it visible. 

Label Enter the name for the block. This is the name that will appear on the 
form in Primavera Unifier if you choose to make it visible. 

Number of 
Columns 

Enter the number of columns you want on the form. Maximum is 4; 
default is 2. 

Number of 
Rows 

Enter the number of fields that will appear in this block of the form. Each 
field will occupy one row. Maximum is 19 fields (rows); default is 5. 

Once you have specified the number of rows, you cannot modify the 
block properties, but you can manually delete or insert rows in the 
Designer window. 

Show 
Border 

Select the checkbox to enclose the block in a border on the form. This will 
visibly distinguish the fields in this block from other fields on the form. 

Note: Instead of using a border, you can also use empty fields to create 
spaces between rows. 

Show Label Select the check box if you want the block label you entered to appear on 
the form. 

Show 
Description 

Select the check box if you want the description you entered to appear on 
the form. 

Hidden Select the check box if you do not want to display the block on the form in 
Primavera Unifier. 

Use this feature to hide fields that are only used in formulas, or to hide 
deployed obsolete data elements from user view. 

If blocks are marked as hidden, the block label in the Designer window is 
grayed out with a pre-assigned value of "Hidden<Block Name: Hidden>." 

You can add fields with formulas to a hidden block. However, you cannot 
make the fields in a hidden block "required," and you cannot add a 
validation rule to the fields. 

Note: If you need to edit a hidden block, you must deselect this check box 
to "un-hide" the block and click OK. Then make your changes and hide 
the block again. 
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In this field: Do this: 

Label Width Enter the width of the block label as a percentage of the form width. 
Default is 20 percent. 

Label 
Position

Specify where the label should appear on the form—to the left or right of 
the field. Default is left. 

You may need to adjust the label width, label position, and number of 
columns to get the fields to look the way you want. These three attributes 
affect the way the text is justified and where the red asterisk for a required 
field appears. 

Notes (Optional) Use the Notes field to enter details about the design of the 
attribute form. This can be helpful to others in understanding the 
information this block is intended to contain and what that information 
might be used for. 

Note: This field will not be visible on the log. 

Modifying Blocks 

To modify a block 

1) On the Form Designer window, click Blocks. 

2) Select the block you want to modify and click Modify. The Block Properties window opens. 

3) Make your changes and click OK. 

Note: If you are using blocks from a linked template, you can edit only 
the following; all other block properties are set by the template design: 

 Description 

 Show Description 

 Hidden 

 Notes 

Collapse by Default Option in Block Properties  

In the Block Properties window of both a BP form and a manager attribute form, there is a new 
checkbox called Collapse by Default. If the checkbox is checked, the block is collapsed by 
default. If the checkbox is unchecked, the block is expanded by default. 

With the Collapse by Default option, you can avoid scrolling through irrelevant information. 
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The Block Properties are searched during the rendering of a BP form and a manager attribute 
form to determine whether a block is collapsed or expanded at runtime. 

For a block to be collapsed at runtime, the block label and the block borders must be visible. 

This option is applicable only for Standard View of forms.” Collapse by Default is applicable to 
the following forms: Action form, View form, Detail form, and various attribute forms. For 
manager attribute forms, this option is available for the Activity Manager, Configurable Manager, 
Cost Manager, Document Manager, and Space Manager. This option is also applicable to Shell 
attribute forms as well as places where a preview of a manager attribute form is displayed, such 
as a variety of logs.     

Note: If a form has only one block, then the attribute of expand or 
collapse will not be available.  

If you change the default behavior by performing the opposite action at 
runtime, the default expand or collapse option is displayed when the 
page is reloaded. 

Moving or Deleting Blocks 

To move blocks 

1) On the Form Designer window, click Blocks. 

2) Select the block you want to move and click the Move Up or Move Down button. 

3) Click OK. 

To remove blocks 

1) On the Form Designer window, click Blocks. 

2) Select the block you want to remove and click Remove. 

3) Click OK. 

Designing a Formula for Fund or Account Codes 

Fund codes and company account codes are usually a composite of multiple segments that 
identify the exact origin of the fund or account in the accounting scheme. To build the fund or 
account code, you must concatenate the accounting segments into one identifier by designing a 
composite field that combines multiple data elements. You will be building the code by 
combining values from text box data elements and specifying a string-type pull-down; for 
example, designing a field called "Fund Identifier" using a formula that includes Fund Name, 
Fund No., and location. 

Fund and company account codes can be up to 250 characters long, including delimiters (such 
as dashes or underscores). 

Take Extra Care with These Codes!
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 Because fund and account codes are at the company level, they have a significant impact on 
the company's funding and accounting, and therefore, cost sheets. When you import a fund 
or account code attribute form into Primavera Unifier, it immediately creates at least one 
fund/account and one transaction for the fund/account under the funding/account codes 
sheet. 

 Ensure that your codes are correct before the attribute form goes into use. If inaccurate 
codes were put in the form, and you attempt to correct the codes, then the corrected codes 
would affect the new funds or accounts, only. 

To design a formula 

1) Open the attribute form containing the field for which you want to build the formula. 

2) Click Detail Form in the Navigator. The Form Designer window opens. 

3) Click the Properties button on the toolbar. The Elements Properties window opens. 

4) Select the field and click the Formula button. The Formula Creation window opens. 

5) Select a delimiter. 

The delimiter separates the elements. For example if you select a dash (-) between elements 
for Account Identifier, it would appear as Account-Record-Location. 

You must select the delimiter before adding the element to the right pane. You can select 
only one delimiter. 

6) Select an element from the left pane 

7) Click Add Parameter or double click the element. The element moves to the right pane. 

If you select the wrong element, click Undo or Clear All. After you add an element, the 
element list is disabled and the delimiter icon is activated. 

8) Click the delimiter icon to add the element into the formula creation field. 

9) Continue adding other elements following the same procedure. 

10) Click OK to save the formula and close the window. 

Designing a Picker 

Primavera Unifier populates most pickers with the records that you see in the logs on the right 
pane of the screen, and uses the layout of the headings on the logs for the layout of the picker. 
These logs show the records that were created, for the most part, with attribute forms. However, 
the following attribute forms use pickers designed specifically for them because they do not 
create records that will appear on logs; they exist only as part of a sheet you have designed. In 
these cases, you will need to design a picker in the same way you would design a log. 

 Fund 

 Account codes 

 Code-based managers 

 Generic cost managers 

Each company can have only one of each of these pickers. However, you can edit these pickers 
as often as you want. You can design the picker so that it has a specific heading and displays 
the information in a specific order. 
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To design the picker 

1) Click the Company Workspace tab and switch to Administration Mode. 

 For a fund picker, navigate to uDesigner > Cost Manager > [fund attribute form] > 
Picker. 

uDesigner automatically creates a blank picker for this. Select the name of the picker, and 
click Open. The Picker Design window opens. 

 For an account code picker, navigate to uDesigner > Cost Manager > [account code 
attribute form] > Picker. 

uDesigner automatically creates a blank picker for this. Select the name of the picker, and 
click Open. The Picker Design window opens. 

 For a configurable manager picker, navigate to uDesigner > Configurable Modules >
[manager name] > [attribute form] > Picker. 

For this manager, you must launch the picker by clicking New. The Log Page Design 
window opens. 

 For a generic cost manager picker, navigate to uDesigner > Configurable Modules > 
[cost manager name] > [attribute form] > Picker. 

For this manager, you must launch the picker by clicking New. The Log Page Design 
window opens. 

2) To complete the picker design, follow the instructions under Designing a Log for a 
Manager (on page 181). 

Designing a Log for a Manager 

Logs designed for managers are for two purposes: 

 They provide the design for pickers. The fields you use for the log are also the fields that will 
appear on the picker. 

Note: 

The following use pickers designed specifically for them because they do 
not use logs; their "records" exist only as part of a sheet 

 Fund Attribute form 

 Account Code Attribute form 

 Code-Based configurable managers 

 Generic Cost Manager 

 They display fields from the attribute form that you want to monitor. For example, you might 
want a log for the Document Manager to include the names of all documents and their 
creators as well as their locations. For the Resource Manager, you might want the log under 
the Resource node to include the names of all resources and their current status. 

For this reason, the attribute form you design should contain all the elements (fields) you want to 
see on the picker, as well as the manager's log. 

There are two logs for a manager: 
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 One shows a list of every sheet that was created for the manager and is automatically 
created by Primavera Unifier. 

These logs show information about the sheet, such as when it was created, who created 
it, its status, and the date of its last modification. 

 The other one shows information about the following items that were entered in to the 
managers: 

 Individual assets 

 Documents 

 Shells 

 Resources 

 Roles 

 Planning items 

 Levels 

 Spaces 

Whenever a Primavera Unifier user fills in an attribute form (which Primavera Unifier 
displays as a detail form), information about each item (asset, document, resource, 
etc.) will appear in the log. 

For the Shell Manager, Planning Manager, and Code and Records-based Configurable 
Managers: 

 Besides a standard log, you can design an advanced log for these managers. An advanced 
log is designed to create a tree or hierarchy structure for the records. This tree structure 
makes it easier for the Primavera Unifier user to view and select records from the log. 

 An advanced log should also be designed for any manager if it contains business process 
records that will be displayed on a data picker or on a master BP log. For more information 
on data pickers, see About Data Pickers (on page 195). 

Designing a Standard Log 

1) Click the Company Workspace tab and switch to Admin mode. 

2) Open the log as follows: 

To open this 
log: 

Do this: 

Asset Class 

1. Click uDesigner > Asset Manager in the Navigator. 

2. Double-click the name of the asset class in the right pane. 

3. Click Log in the navigator. 

4. On the right pane, click New. 
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To open this 
log: 

Do this: 

Code and 
Records-based 
Manager 

1. Click uDesigner > Configurable Modules in the Navigator. 

2. Double-click the name of the manager in the right pane. 

3. Double-click the name of the attribute form in the right pane. 

4. Click Log in the navigator. 

5. Under the Log node, click Standard. 

6. On the right pane, click New. 

Document 

1. Click uDesigner > Document Manager in the Navigator. 

2. Double-click the name of the attribute form in the right pane. 

3. Click Log in the navigator. uDesigner automatically creates a log 
for the Document Manager. 

4. Double-click the name of the log in the right pane. 

Plan 

1. Click uDesigner > Planning Manager in the Navigator. 

2. Double-click the name of the planning type in the right pane. 

3. For a log for a planning sheet, click Planning Sheet > Log in the 
navigator. Then double-click the name of the log in the right pane. 

4. For a log for a planning item, click Planning Item > Log in the 
navigator. 

 a.  Under the Log node, click Standard. 

 b.  On the right pane, click New. 

Resource 

Role 

1. Click uDesigner > Resource Manager in the Navigator. 

2. Double-click the name of the attribute form in the right pane. 

3. Click Log in the navigator. uDesigner automatically creates a log 
for the resource or role. 

4. Double-click the name of the log in the right pane. 

Schedule 
Manager 
Resource 
Assignment 

1. Click uDesigner > Schedule Manager in the Navigator. 

2. Double-click the Resource Assignment attribute form in the right 
pane. 

3. Click Log in the Navigator. Then click New in the right pane. 

Shell Type 

1. Click uDesigner > Shell Manager in the Navigator. 

2. Double-click the shell type in the right pane. 

3. Click Log in the navigator. 

4. Under the Log node, click Standard. 

5. On the right pane, click New. 
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To open this 
log: 

Do this: 

User 
Administration 

1. Click uDesigner > User Administration in the Navigator. 

2. Double-click the user attribute form in the right pane. 

3. Click Log in the navigator. 

4. Under the Log node, choose Company Users Log or Partner 
Users Log. 

5. On the right pane, click New. 

The Log Page Design window opens. Complete the tabs as described in the following sections. 

General Tab 

1) In the Name field, enter a name for the log. 

2) (Optional) In the Description field, enter text that describes the log. 

3) Click Apply to save changes. 

Layout Tab 

Use the Layout tab to designate what fields from the attribute form should appear on the picker 
and the log. The data will appear in columns. 

To add a column 

1) Click Add. The Column Header Properties window opens. 

2) Use the information in the table below to complete the column layout. 

3) To add another column to the layout, repeat step 2. 

4) Click OK. 

After you add column(s), they will appear as rows on the Design window. You can move the 
columns left or right to create the order you want. To move columns, select the row of the 
column you want to move and click the Move Up button to move the column left, or the 
Move Down button to move the column right. 

In this field: Do this: 

Data 
Element 
Label 

Choose the field you want on the log or picker. The list shows only those 
data elements that were on the attribute form. If you do not see the data 
element you want, go back to the form and add it. When you choose an 
element, uDesigner displays the name of the element in the Data 
Element Name field and also displays the element label in the Column 
Heading field. (You can change the column heading to a heading you 
prefer.) 

Width Enter the width (in pixels) the column should be. The default is 150. 

Alignment 
Choose the positioning of the data within the column, including the 
heading. Select Left, Center, or Right. 
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Sort Tab 

You can determine which column to use as the default sort order for the log and picker. This 
allows you to choose a column to sort by initially. 

1) In the Initial Sort Column field, choose the column to use as the default sort order for the 
log and picker. 

2) In the Sort Order field, choose whether the sort order should be ascending (A-Z) or 
descending (Z-A). 

Find Tab 

In the course of work in Primavera Unifier, users will sometimes need to locate particular items 
among thousands in a log, and also to find particular items from a large picker list, such as a list 
of employees or accounts. To make it easier for users to locate a record, use the Find tab to 
specify field names they can use to search for particular records. 

To specify search criteria 

1) On the Find tab, click Add. The Find Properties window opens. 

2) In the Data Element Label field, select a field (data element) users can use to find a 
record(s). 

For example, you might want users to be able to search for all records that contain a specific 
resource, or schedule activity. 

When you enter a data element label, uDesigner automatically displays the database label of 
the element in the Find Label field. This field is editable. 

3) If you want to change the name of the element to something more meaningful to the user, 
enter the name in the Find Label field. 

4) Click Add to add another data element field to the find criteria, or click OK to close the 
window. 

Designing an Advanced Log 

An advanced log is available only for the Shell Manager, Planning Manager, User 
Administration, and for Code and Records-based configurable managers. This kind of log is 
designed to create a tree or hierarchy structure for the records. This tree structure makes it 
easier for the Primavera Unifier user to view and select records. The following illustration shows 
a manager class log for a parts manager that displays a tree structure created with the 
Navigation tab. 

Data pickers on business processes will also use this advanced log to present records across a 
shell hierarchy, a configurable manager class, or a planning item type. Therefore, the 
instructions here include creating an advanced log for a shell. Because of their "nested" design, 
shells themselves will not display an advanced log. The log will be used to list shell BP records 
on data pickers. 
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To design an advanced log 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the Navigator, do one of the following: 

 Click uDesigner > [the name of the configurable manager you want to design the 
log for]; then double-click the name of the code class in the right pane. 

 Click uDesigner > Shell Manager; then, in the right pane, double-click the name of the 
shell you want to design the log for. 

 Click uDesigner > Planning Manager; then, in the right pane, double-click the name of 
the planning item you want to design the log for. In the Navigator, click Planning Item. 

 Click uDesigner > User Administration; then, in the right pane, double-click the name 
of the attribute form you want to design the log for. 

3) In the Navigator, click Log; then click Advanced. 

4) On the right pane, click New. The Log Page Design window opens. 

5) Complete the tabs as described under Designing a Standard Log (on page 182). 

6) Click the Navigation tab. 

On the Navigation tab, you specify what fields from the manager, space, or shell form you 
will use to make the tree structure. When the manager, space, or shell is imported into 
Primavera Unifier, the Primavera Unifier administrator will configure these fields with a query 
to extract the appropriate records from the database and display them on the picker list. 

7) On the Navigation tab, click the Add button. uDesigner opens the Add Data Element 
window. 

8) In the Data Element field, select the field you want to appear in the tree structure. 

uDesigner shows the label of the element in the Data Element Name field. 

9) To add another field for the tree structure, click Add; otherwise, click OK. 

The Log Page Design window displays the fields you selected for the tree structure. 

10) (Optional) If you want to rearrange the order in which these fields will appear in the tree 
structure, highlight the fields and use the Move Up or Move Down keys until the fields are in 
the order you want. 

Note: If a field in this tree structure is removed from the business 
process or manager's form, the Add Data Element window will show the 
removed field in red. 

Dashboards 

The Dashboards log (Shell > Admin mode > Setup > Dashboards) enables the user to do the 
following:  

 Create

To create a new dashboard for the user. 

 Copy

To copy the existing dashboard for the user. This option is available in gear menu, only. 
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 Delete

To delete the dashboard for the user. 

 Find 

Opens a filter row, corresponding to each column (filter row) so the user can search for 
filtered results. 

The Dashboards log has the following columns: 

 Name

 Description

 Last Modified by 

 Last modified date

The gear menu has the following options.  

 Open 

To open the existing dashboard for further editing. 

 Copy

To copy an existing dashboard. 

 Mark as Default

This option will be seen only when no dashboard has been marked as default. If no 
dashboard is marked as default, then for that shell, the My Dashboard will be the default 
dashboard to been seen on the landing page. 

 Unmark Default

This option will be seen against the dashboard which is marked as default. With this option 
the user will be able to unmark the dashboard as default. 

 Delete 

To delete a dashboard. 

When the user highlights a dashboard, the following tabs are displayed on the right pane: 

 Properties

 The Properties tab lists the details (Name, Description, etc.) of the selected dashboard 
under General Details. 

 Permissions

The Permissions tab lists the users or groups that have permission set on the dashboard. 
The user can click the plus icon to add user permissions. Once the user clicks Save, the 
permission is saved. 

Creating Dashboard Setup 

When the user is creating or editing a dashboard setup, the user will be able to: 

 Provide a name for the dashboard or change the dashboard name. 

 Add tabs to the dashboards (using the plus icon on the left pane) 

 Add blocks to the dashboard (using the plus icon on the left pane) 
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Once blocks are added, the center pane will show a preview to the user on how the dashboard 
will look. 

Adding Tabs in Dashboard 

The user can add tabs using the plus icon. Unifier displays an overlay screen (New Tab) to allow 
the user to enter the tab name. 

By default, no block is present in the newly added tab. 

Adding Blocks in Dashboard 

The user can include the following blocks in the dashboard. 

 Standard

 Custom

 Drill Down

 Analytics

 Portlet

Standard Block 

When adding or editing standard block, the user must provide Source details such as: 

 Data Type

 Report on

Along with the source details, the user must provide the block details: 

 Block Title: Title for Block. 

 Display Type: This drop-down will support following display types. 

 Area Chart 

 Bar Chart 

 Column Chart 

 Line Chart 

 Pie Chart 

 Table 

 Block Length: Values ranging from 1 unit to 6 units which will help determine how much 
space it will occupy on screen. 

 Block Height: Values ranging from 1 unit to 6 units which will help determine how much 
space it will occupy on screen. 

 Show Result 

 Show Totals 

Custom Block 

When adding a custom block, the attributes required will be same as existing functionality, 
except for the block details. 
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Drill Down Block 

When adding or editing a drill down block, the user must provide following Source Details: 

 Title: Name for the Block (mandatory) 

 Data Cube (mandatory) 

 Block Filter Elements 

The drill down details the required attributes will be same as existing functionality, except for the: 

 Block Length 

 Block Height attributes 

Analytics Block 

When adding or editing an analytics block, the user must provide Source details such as the 
URL and Block details. 

Portlet Block 

When adding or editing an portlet block, the user must provide Source details such as the URL 
and Block details. 

Creating a Data Structure 

In Primavera Unifier, electronic forms drive the business processes. They also run the managers 
and shells in Primavera Unifier. In Primavera Unifier, users fill in these forms with the information 
they need to maintain action items, manage document archiving, track workflow tasks and 
milestones, communicate and collaborate with project team members, generate project reports, 
monitor costs, and perform other tasks necessary to run projects and facilities. 

By using uDesigner, you will be designing the forms for these business processes, managers, 
and other components. Every form you design has a data structure that supports it. This data 
structure defines how information is entered, stored, and distributed. 

Note: Before you can design forms, you must create the data structure. 

Data Structure Components 

The data structure is composed of: 

Data Definition (DD): 

Data definition describes how data is entered into Primavera Unifier and stored. The definition 
consists of the Data Type, Data Size, and Input method. Data Definitions govern the behavior of 
Data Elements. 

Data Element (DE): 
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Data Elements is the field that the users see on the forms in Primavera Unifier, such as a text 
box or menu. The behavior of a Data Element is governed by the Data Definition on which it is 
built. 

Status: 

A status indicates the condition or state of a record, line item, or asset. Every record, line item, 
and asset must have a status indication at every step in Primavera Unifier. 

Dynamic Data Sets: 

Dynamic Data Sets are a way of narrowing the number of possible choices a user can make. 
Narrowing the choices makes entering data faster and more efficient for users. Dynamic Data 
Sets dictate how fields behave when the user has multiple-choice options. 

Tags: 

Tags work with linked elements to connect Schedule Sheet Activities with Business Processes, 
Shells, and Configurable Manager. Tags allow a one-to-many relationship between a Data 
Element on the master Schedule Sheet and multiple Data Elements on a form.  

Data Definitions 

Data Definitions describe how data is entered into Primavera Unifier and stored. Data Definitions 
are what Data Elements (the fields for the forms) are built on. There are three kinds of Data 
Definitions: 

 Basic 

 Cost Code 

 Data Picker 

Basic

For use in designing most of the fields on business process forms, attribute forms, managers, 
shells, and other Primavera Unifier components. See Creating a Basic Data Definition (on 
page 199). 

Cost Code

For use in designing the layout of cost code segments. Cost codes (or CBS codes) are used on 
cost BPs that will affect project cost sheets in Primavera Unifier. See Creating a Cost Code 
Definition (on page 200). 

Data Picker

For use with master Business Process logs, Shells, Planning items, and Configurable Managers 
that function across a Shell hierarchy. Data pickers make it easier for users to choose the 
correct record from master business process logs or planning item type that resides across 
shells, a class in a configurable manager that operates across shells, or for auto-creation across 
shells.  Data picker definitions differ from most of the data definitions you will create. For 
information on these definitions, see About Data Pickers (on page 195) and also Creating a 
Data Picker Definition (on page 200). 

Except for Data Pickers, Data Definitions consist of the following components: 

 Data Type 



Creating a Data Structure

191

 Data Size 

 Input method 

Data Type

Whether it is an alphabetical string or a number. 

 String data contains letters, numbers, or special characters. Use string data when the 
criteria for the data being entered must be flexible. For example, an address field might 
contain letters, numbers, and special characters.. 

 An integer is a number, with or without decimals. It cannot contain letters or special 
characters. Use integers for data entry, such as cost or quantity amounts, where you want to 
prevent the user from entering letter characters. 

Data Size

The number of characters for strings. 

Input method

The method used to enter data. The following is a list of Input methods, including their functions: 

 BP Creator 

 Allows users to auto-create new records based on a condition, such as a dollar amount, 
or a time frequency, such as daily or weekly. When a Business Process reaches the 
condition or frequency trigger in a Workflow, the BP Creator element on the form 
automatically creates a new record. 

 Unlike other fields, Data Element fields built on the BP Creator definition are not visible 
on any form unless the auto-creation is manually initiated by the user. Instead, the 
auto-creation is set up in uDesigner and configured by the Primavera Unifier 
administrator. When this is completed, the form will show a text box with a Create button, 
or a hyperlink from the source record to the destination record. 

 Checkbox  

Provides an option that the user can select ("check") or not. "Not checked" is the default 
value. 

Note: Do not use a check box as a required field. Whether or not the 
check box is checked, a workflow assumes the '‘not checked' value and 
allows the record to be sent. 

 Multi-line text 
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Use this element for multiple text lines for entries up to 4000 characters long, such as 
descriptions or remarks. You must also set the Data Size—the maximum number of 
characters. 

 Multi-select input 

Allows the user to make multiple selections from a list. This input method automatically 
uses a comma as a separator between selections. The values for this definition are 
specified in Primavera Unifier when the business process, form, manager, or other 
component is set up. 

 Picker 

Allows users to choose from lists of items. uDesigner and Primavera Unifier are shipped 
with a number of predefined pickers. 

 Pull-down menu 

Provides a list of items the user can choose from but cannot change. The values for the 
pull-down menu choices can be up to 128 characters long and are specified in Primavera 
Unifier when the business process, form, manager, or other component is set up. 
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 Radio buttons 

Use where two values are possible and one must be selected. Values of ‘one' and ‘two' 
are assigned by the system; the default ("true") value is "one." The actual values are set 
in Primavera Unifier when the business process, form, manager, or other component is 
set up. 

Note: Do not use a radio button as a required field. The workflow will 
assume that a "true" value has been entered, even if the user makes no 
choice. 

 Text box 

Use a text box for a one-line alphanumeric text entry field, such as name or address. You 
must also set the Data Size—the maximum number of characters. A text box is usually 
used for smaller text (1 to 64 characters), but could be longer. 

Notes: 

 As you design the data structure, keep in mind that one of its 
purposes is to re-use data definitions throughout the life of many 
business processes, managers, shells, or other components of 
Primavera Unifier. A data definition can be used in many different 
places in the Primavera Unifier interface—for example, for fields on a 
business process form, on a report, or on a cost, scheduling, or 
planning sheet. 

 Be conservative about the number of data definitions you need, and 
be as generic as possible about naming them. Too many definitions 
can be confusing to users and can decrease your efficiency in 
designing forms and other components. If you need a data definition 
for a unique purpose, identify that purpose in the name you give the 
definition. This will make it easily recognizable and distinguish it from 
other, similar data definitions. 

 Unifier has provided a number of data definitions for your use in 
building data elements. You can add other definitions of your own if 
you need them. For a list of the data definitions provided by Unifier, 
see the chapter on data definitions in the Unifier Data Reference 
Guide. Before you begin creating data definitions, review this list of 
definitions that already accompany the product; it will help you 



Unifier uDesigner User Guide

194

understand their function, and it may save you the effort of creating 
new definitions you might not need. 

Data Definitions with Data Set Values 

When working with data definitions that have data set values (for example, pull-downs, or 
drop-downs, multi-select inputs, radio buttons, or selections, and so forth) the status of the data 
set value is important.  

When the status of the data set value is Inactive, the values will not be available for selection 
when you attempt to manually select an option. 

Unifier ignores the status of the data set values, when the values are set by way of one of the 
following methods: 

 Copy

 Auto-populate

 CSV import

 REST

 SOAP

 RAP

 Auto-create

The following explains what happens when an invalid data set value is selected: 

 Copy

If the data set value has been deleted, then the system accepts the data set value that was 
used in the source. 

 Auto-populate

If the data set value has been deleted, then the system accepts the data set value that was 
used in the source. 

 CSV import

If the data set value has been deleted, then the system does not accept the data set value 
(invalid). 

 REST

If the data set value has been deleted, then the system does not accept the data set value 
(invalid). 

 SOAP

If the data set value has been deleted, then the system does not accept the data set value 
(invalid). 

 RAP

If the data set value has been deleted, then the system does not accept the data set value 
that was used in the source (invalid). 

 Auto-create

If the data set value has been deleted, then the system accepts the data set value that was 
used in the source. 
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About Data Pickers 

Data pickers are designed to work with business process logs (including master logs), shells, 
planning items, and configurable managers that function across a shell hierarchy.  

Note: User data pickers are designed for a different purpose. See About 
User Data Pickers (on page 198) for details. 

The purpose of a data picker is to make it easier for users to choose records: 

 From a business process log 

 From a class in a configurable manager that operates across shells 

 From a planning item type that resides across shells 

 For auto-creation across shells 

Note: The data displayed on data pickers is not restricted by 
permissions. Users will see all business processes, manager classes, or 
shells, regardless of their permissions. 

Data pickers are designed in uDesigner and set up to query the database by the Administrator in 
Primavera Unifier. See Data Picker (on page 238) for more information about configuring a data 
picker. In operation, a data picker navigates to a specific business process, shell, planning item, 
or configurable manager and then extracts the records to display on the list by using a query the 
Primavera Unifier administrator sets up. 

Data pickers work differently from the other pickers that Unifier provides. Most pickers display a 
flat list of records for users to choose from.  

A data picker, instead, can display a navigation structure to guide Primavera Unifier users to the 
correct location where a record resides, such as a specific shell, a specific class in a 
configurable manager, a specific planning item, or a specific business process. A data picker 
helps to prevent users from inadvertently choosing the wrong record from a picker list. It is also 
useful for filtering large amounts of records into more manageable lists to choose from. 

Data Pickers Use an Advanced Log or a Picker Log 

To help ensure that the user navigates to the correct record, data pickers work with the 
Advanced Log feature or the Picker Log feature. These features are optional, but highly 
recommended, as they create the tree or hierarchy structures that make data pickers easily 
navigable and more likely to ensure that the user selects the correct record. 

An Advanced Log should be designed for any shell, planning item, or configurable manager 
class that contains records that will be displayed on a data picker. A Picker Log should be 
designed for any business process that contains records that will be displayed on a data picker. 

A data picker with no Advanced Log or Picker Log shows only a flat list of all the records. There 
are no arrows to expand or collapse records.  

A data picker with an Advanced Log or Picker Log displays a tree structure where users can drill 
down to more specific records. Each group can be expanded to reveal lower level items by 
clicking the arrow next to the record. 
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How Data Pickers Work with Shells 

Data pickers are especially useful for auto-creating business processes across a shell hierarchy. 
A data picker can link to a shell picker to display only the shells you specify, which helps to 
prevent users from choosing the wrong shell for auto-creation. You can create a data picker for 
each shell type (such as buildings, regions, or properties). In operation on a business process 
form, a BP Creator element on the form will then know which shell to auto-create the new 
business process in. 

If the newly created business process has the same data picker configuration as the creator step 
or form, then the value in the data picker will be copied over to the new record. If the data picker 
configurations differ, the value will not be copied. For example, business process A in shell 
Building 100 creates business process B. On business process A, the data picker is configured 
to show shell Building 100. However, if the data picker on business process B is configured to a 
different shell, the data picker value will not be copied over. 

Data pickers support both S step (workflow) and BP Creator types of auto-creation. 

To facilitate auto-creation, you need to use uDesigner's formula feature to create a link between 
the data picker and the appropriate shell. For instructions on linking the data picker to a shell, 
see Adding Formulas to Fields (on page 315). 

To select records from across shells 

Data pickers allow users to pick business process records across shells. When you create the 
data definition for each picker, you link it to a specific shell type. When placed on a business 
process form, the picker will show the business process records across the shell hierarchy. 

Using linked elements for the picker log 

If you are using linked elements in your shell hierarchies, you can use the linked element(s) as 
part of the tree structure in an advanced log to group the records under a navigation node. 
Thereafter, if the hierarchy is reorganized, the tree structure will automatically reflect the 
reorganization for the data picker(s) or reverse auto-population. 

How Data Pickers Work With Configurable Managers 

Data pickers work in several ways with Code and Records-based configurable managers. 

To select records from the same class across shells 

Data pickers can aid Primavera Unifier users in picking business process records from the same 
manager class across shells. 

By creating a data picker for a manager class, and placing it on a business process detail form, 
you can allow users to pick records of a class from across shells. When you create the data 
picker definition, you will link the data definition to a specific class. Then, from the definition that 
is linked to a class, you can create data pickers to place on business process forms. 
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To Enable Value Rollups to Configurable Managers 

A manager picker is necessary on any form containing data you want to roll up to the manager 
sheet. The manager picker is the field that implements the rollup. Therefore, to implement cost 
and quantity rollups to a manager sheet, you need to link the manager picker to a data picker on 
the same form. Once you establish this connection, business processes can roll up quantity 
information and line item costs from the data picker, via the manager picker, to the manager 
sheet. 

For instructions on connecting pickers using a formula, see Adding Formulas to Fields (on 
page 315). 

For the manager sheet, rollup data can come only from the following business processes. 

At project/shell level: 

 Cost - Line Items with Multiple Codes 

 Line Item, Generic 

At the company level: 

 Line Item, Generic 

In formulas 

You can use a data picker element in a string formula to create part of a manager code or a 
manager navigation code. 

For auto-population 

You can auto-populate data elements on business process forms across shells from a data 
picker. You can also populate a data picker from: 

 Single-record BP 

 Business Process Picker 

 Upper form of a business process 

 Another data picker 

For reverse auto-population 

You can design reverse auto-population from a data picker back to a configurable manager 
class record at the project/shell or company level. 

During the reverse-auto-population operation, Primavera Unifier will verify that the value is valid 
on the destination form; that is, that the user can manually launch the data picker on the 
destination form and select the same value. To verify this, Primavera Unifier will run the query 
for the data picker on the destination form. 

How Data Pickers Work With the Planning Manager 

Data pickers work in several ways with the Planning Manager. 
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To select records from the same planning type across shells 

Data pickers can aid Primavera Unifier users in picking records from the same planning type 
across shells. 

By creating a data picker for a planning type, and placing it on a business process or shell detail 
form, you can allow users to pick records of a planning type from across shells. When you create 
the data picker definition, you will link the data definition to a specific planning type. Then, from 
the definition that is linked to a planning type, you can create data pickers to place on business 
process or shell forms. 

Using linked elements for the picker log 

If you are using linked elements on your planning types, you can use the linked element(s) as 
part of the tree structure in an advanced log to group the records under a navigation node. 

For auto-population 

You can auto-populate data elements on business process and shell forms from a planning item 
data picker. You can also populate a planning item data picker from: 

 Single-record BP 

 Business Process Picker 

 Upper form of a business process 

 Another data picker 

For reverse auto-population 

You can design reverse auto-population from a data picker back to a planning item type record 
at the project/shell or company level. Or, you can design reverse auto-population from a 
business process back to a planning item attribute form. 

During the reverse-auto-population operation, Primavera Unifier will verify that the value is valid 
on the destination form; that is, that the user can manually launch the data picker on the 
destination form and select the same value. To verify this, Primavera Unifier will run the query 
for the data picker on the destination form. 

About User Data Pickers 

User pickers are common elements in the application. There are several numbers of user 
pickers available for you to choose from, in the application, and you can also design your own 
user pickers, by using the User Picker Data Definition, for your business case. 

Your own user pickers, which you created by using the User Picker data definition, cannot be 
auto-populated or updated by way of reverse auto-population (RAP). 

If you want the user pickers that you created be auto-populated or updated by way of reverse 
auto-population (RAP), then you must use a separate data picker definition that is called the 
User Data Picker. Refer to the Unifier Data Reference Guide for more details about the User 
Data Picker data definition. 

The log displayed for the User data picker is based on the log design prepared in uDesigner. 
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Like other data pickers, the user data pickers are designed in uDesigner and set up to query the 
database by the Administrator in Unifier. They will display all company and partner users 
according to the query the Administrator specifies when setting up the business process or 
configurable manager in Primavera Unifier. 

Note: You can create user data picker elements only if a User Attribute 
form is designed in uDesigner. 

In the Data Picker Configuration window, under the Additional Filter block (see Using Filters
(on page 240) for more details), the Apply User Attributes to the picker log and display 
element from Project/Shell directory option enables you to fetch the User Attributes data from 
the project directory, when User Data Picker is launched.  

The list of users displayed also will be from the project directory. In addition, the value for the 
display element for any auto-populate field or user data picker would be fetched from the project 
or shell directory. 

If the Apply User Attributes to the picker log and display element from Project/Shell 
directory option is selected (checked), then the values will come from the project or shell 
whether the user is trying to fetch data from or apply data to any particular field. 

The Apply User Attributes to the picker log and display element from Project/Shell 
directory option is enabled only if the Filter list of Users/Group based on Project/Shell 
Membership option is selected. 

Creating a Basic Data Definition 

Use basic definitions for designing forms, managers, shells, and other Primavera Unifier 
components. 

To create a basic data definition 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click Data Structure Setup > Data Definitions > Basic. 

3) Click the New button. The Create New Data Definition window opens. 

4) In the Name field, enter a unique name for the data definition. 

 The name can include alphanumeric characters, spaces, dashes, and underlines. 

 The name will be case-sensitive in Primavera Unifier. 

 The name cannot begin the name with a prefix reserved by Unifier: SYS, UUU, or Picker. 

5) In the Data Type field, specify whether the definition will be a string or integer data type. 
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When you specify the data type, uDesigner displays an additional field, Input Type. 

6) In the Input Type field, select the method the user will use to enter the data. 

7) Click OK. 

Creating a Cost Code Definition 

Use Cost Code definitions for designing the layout of cost code segments. Cost codes, or CBS 
codes, are used on cost business processes that will affect project cost sheets in Primavera 
Unifier. 

To create a cost code definition 

1) Click the Company Workspace tab and switch to Administration Mode.

2) In the left Navigator, click Data Structure Setup > Data Definitions > Cost Code. 

3) Click the New button. The Create New Data Definition window opens. 

4) In the Name field, enter a unique name for the definition. 

 The name can include alphanumeric characters, spaces, dashes, and underlines. 

 The name will be case-sensitive in Primavera Unifier. 

 The name cannot begin the name with a prefix reserved by Unifier: SYS, uuu, or Picker. 

5) In the Label field, enter the label you want to appear for this field on forms. 

6) In the Input Type field, select the method the user will use to enter the data. 

7) Click OK. 

Creating a Data Picker Definition 

Use data picker definitions for designing data picker elements to: 

 Work with specific business processes, shells, planning item types and configurable 
manager classes that function across a shell hierarchy.  For more information about data 
pickers, see About Data Pickers (on page 195). 

 Create user pickers that can be auto-populated and updated using reverse 
auto-population. For information about these data pickers, see About User Data Pickers
(on page 198). 

To create a data picker definition 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click Data Structure Setup > Data Definitions > Data Picker. 
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3) Click the New button. The Create New Data Definition window opens. 

4) In the Name field, enter a unique name for the definition. 

 The name can include alphanumeric characters, spaces, dashes, and underlines. 

 The name will be case-sensitive in Primavera Unifier. 

 The name cannot begin with a prefix reserved by Unifier: SYS or UUU. 

 The name cannot include the word "picker." 

5) In the Category field, click Select and choose the component you are creating this picker 
definition for: 

 A business process

 The Shell Manager

 The Planning Manager

 A configurable manager (listed by name) 

 User attributes 

 The Resource Manager 

Note: The role data picker is only available for use on the Resource 
Assignment form in the Schedule Manager. It is used to calculate the 
role rate based on the exchange rate. If hard booked resources are 
allocated, the total cost = (role rate) x (currency rate) x (quantity.) If the 
resources are not allocated, the total cost is manual entry (from a 
formula). Roles displayed in the role data picker will be the complete list 
of company roles that are set up in Primavera Unifier (admin mode.) For 
more information, refer to the Unifier Administration Guide. 

This ties the data picker to a specific business process, configurable manager, planning item, 
shell, or user attribute form. Once you have created this data definition, you can build 
multiple data picker elements to use on that business process, manager, shell, or user. 

6) In the Data Source field, select the source the picker information should come from . 

 For a business process category, choose the business process the data should come 
from (list will not include single-record BPs). 

 For a configurable manager, choose the class the data should come from. 

 For the Shell Manager, choose the shell the data should come from. 

 For the Planning Manager, choose the planning item type the data should come from. 

 For a User Picker data definition, Primavera Unifier will automatically populate the data 
source field with "New User." 

 For a role data picker, choose Role Attributes. 

7) In the Display Element field, select the element (field) whose value should appear on the 
data picker list. 

The list will show only string-type data elements and will not show linked data elements or 
standard elements. 

The Data Element field will show the label of that field. 

8) Click OK. 
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Data Picker Filter Query Condition 

When you are setting up a business process, you can filter the condition for the data picker 
according to:  

 Contains 

 Does not contain 

 Exists in 

 Does not exist in 

 Equals 

 Does not equal 

 is empty 

 is not empty 

The following is an example of query evaluation. The workflow setup follows these policies for 
selecting users. 

Assuming business process BP A has a Data Picker DP1 defined in the Upper Form which 
brings in records from BP B. A query condition in defined on the string attribute Country where 
expected user-defined values are, for example, San Jose, CA. 

Below is the partial list of records for BP B: 

 Record Number: 001 > Country: United 

 Record Number: 002 > Country: United States 

 Record Number: 003 > Country: United Kingdom 

 Record Number: 004 > Country: United States of America 

When the conditions are defined, using Exists in and Does not exist in operator, then: 

Condition/Operator Business Process Form 
(Field value) 

Example of the data source 
used. 

Filtered List in User Mode 

Exists in Country exists in (United 
States of America) 

This will show a list of 
filtered records where 
Country value has records 
where substring from 
'United States of America' 
exists. 

Does not exist in Country does not exists in 
(United States of America) 

This will show a list of 
filtered records where 
Country value has record 
where substring from 
'United States of America' 
does not exists. 

The difference between Contains and Exists in are: 
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Query Condition Filtered List of Records from BP B 

Contains in Empty list of records  

Does not contain 001, 002, 003, 004 , 005 , 006, 007 

Exists in 001, 002 

Does not exist in 003, 004 

The following is another example of query evaluation. 

Data Picker Query Location 

Destination BP where Data Picker is 
placed 

Action Items 

Data source of Data Picker placed in 
Action Items 

Meeting Minutes 

Query condition set for Data Picker Description' field of Meeting Minutes exists 
in Action Items / Upper form / Description 

Runtime query evaluation Case 1: 

 Description field value in Action Items / Upper form: Design Phase 2 

 Meeting Minutes Record R1 has Description field value: Design 

 Meeting Minutes Record R2 has Upper Form / Description field value: Design Phase 2 items 

Then, only R1 will be seen in the list of Data picker records. 

Runtime query evaluation Case 2: 

 Description field value in Action Items / Upper form: Design Phase 2 items 

 Meeting Minutes Record R1 has "Description" field value: Design 

 Meeting Minutes Record R2 has "Description" field value: Design Phase 2  

Then, both R1 & R2 will be seen in the list of Data picker records. 

Notes: 

 If the workflow setup has any of the new operators, the list of data 
pickers that the user sees at runtime retains the stated query 
parameters. 

 The list of records which the BP data picker points to shows a filtered 
list of records based on the query conditions defined using "Exists in" 
or "Does not exists in" operators. 

The "Or" Condition 

In the scenarios mentioned above, you configured Data Picker query to show records where the 
Country was USA. If you wanted to conduct another query to configured Data Picker query to 
show records with title ABCDEF, then the configured Data Picker query would have satisfied 
both of the queries: Country = USA  and Title contains ABCDEF. 
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You can also find records based on an individual query, instead of all queries. That is to state 
that you can apply the "Or" condition between two, or more, query conditions. 

That is to state: If you apply the "or" condition, then the Data Picker shows records which have 
Country as USA (and Title may or may not contain ABCDEF) as well as records that have Title 
as ABCDEF (and Country may or may not be USA). 

Data Elements 

A data element combines a data definition with a field label to become what users see on forms 
in Primavera Unifier. A data element (field) can be a text box, where the user types in 
information; a pull-down menu of choices, such as dates or names; radio buttons, where the 
user must select one of the options presented; or a check box, where the user has the option of 
choosing something or not. Data elements can also be read-only fields containing 
auto-populated or default data. 

When creating a data element, you are defining the name and form label only—the element is 
essentially a container that will not contain values until they are entered by users in Primavera 
Unifier. 

By using uDesigner, you can create a "dictionary" of elements that can be re-used on multiple 
forms for different purposes. 

Note: Be sure you plan your form design in detail before creating the 
elements. Once you have used a data element on a form, we 
recommend you do not change the data definition for the element. 
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Keep in mind that the purpose of the data structure you are creating is to re-use data elements 
throughout the life of many business processes, managers, shells, or other components of 
Primavera Unifier. A piece of data (a field) from one form can be presented in many different 
places in the Primavera Unifier interface—for example, on multiple business process forms, on a 
report, or on a cost, scheduling, or planning sheet.  

Be conservative about the number of data elements you need, and be as generic as possible 
about naming them. Too many elements can be confusing to users and can decrease your 
efficiency in designing business processes. If you need a data element for a unique purpose, 
identify that purpose in the name you give the element. This will make it easily recognizable and 
distinguish it from other, similar data elements. 

Unifier has provided a number of data elements for your use in designing forms. You can add 
other data elements of your own if you need them. For a list of the data elements provided by 
Unifier, see the chapter on data elements in the Unifier Data Reference Guide. Before you begin 
creating data elements, review this list of elements that already accompany the product; it will 
help you understand their function, and it may save you the effort of creating new elements you 
might not need. 

Creating a Data Element 

To create a data element 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click Data Structure Setup > Data Elements. 

3) Click the New button. The New Data Element window opens. 

4) In the Data Element Name field, enter a unique name for the element. 

 The name cannot be longer than 22 characters. The name for currency amount fields on 
payment application detail forms cannot be longer than 21 characters. 

 The name can include alphanumeric characters. 

 The name cannot include spaces or dashes; instead, separate words with an underscore 
(_). 

 The name will not be case-sensitive in Primavera Unifier. 

 The name cannot begin the name with a prefix reserved by Unifier: sys, or uuu. 

5) In the Data Definition Source field, select the data definition you want to build this element 
on. 

If you choose description text, you will need to enter the number of lines you want to allow 
for the text. 

If you choose Image Picker, you will need to specify the height of the image in pixels. (The 
horizontal size of the image is automatically adjusted by the size of the form column.) 

6) In the Form Label field, enter the label you want to appear on the form for this element. 

If you leave this field blank, the data definition name will be used. 

7) (Optional) Use the Description field to enter details about the design of the data element. 

This can be helpful to others in understanding how to use this element. 

8) (For a data element based on the Decimal Amount data definition) In the Decimal Places
field, specify how many decimal places the amount should display in the Primavera Unifier. 
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On some manager sheets and forms, particularly on Payment Application forms, the decimal 
places of the values used in formulas will be limited by the browser. 

You can use this field to limit the number of decimal points Primavera Unifier displays, and 
thereby, make it easier for users to read the value of the amount. If you specify fewer 
decimal places, Primavera Unifier will round the decimal amount. However, this will also be 
the amount actually stored in the data element. If your process needs to maintain an exact 
decimal amount, specify eight decimal places; otherwise, you will lose data. 

The decimal places you specify in this field will affect this decimal amount throughout 
Primavera Unifier operations, logs, formulas, reverse auto-population, email notifications, 
conditional routings, RFB bidder forms, etc. 

Note: The Primavera Unifier administrator has the option of specifying 
the number of decimal places to be displayed on manager sheet 
columns. The decimal amount you specify here will override the decimal 
amount defined for the sheet column. 

9) Click OK to save your changes and exit the window. 

The Data Elements log displays the name and details of the data element you created.  

About Images 

 If you create a data element using the Image Picker data definition, a preview of the form will 
show a "virtual box" to help you judge the look of the form. The virtual box will be the 
maximum size you specify using the Number of Lines field. At runtime, Primavera Unifier will 
render the image as follows: 

 If the image fits the virtual box, Primavera Unifier will display the image as is. 

 If the image is smaller than the virtual box, then the application anchors the image to the 
top-left corner of the box. 

 If the image is larger than the virtual box, then the application adjusts the image to fit the size 
of the box and preserves the aspect ratio of the image. 

Modifying a Data Element 

Once you have created a data element, you can only modify the data definition source and form 
label. You cannot change the data element name. 

Be aware of the following before you modify a data element: 

 If you need to change a data element, it's a good idea to see where it is used first, as the 
changes you make can affect business processes in ways you might not expect. 

 To see where the data element is being used, highlight the data element in the log and click 
the Usage button in the toolbar. uDesigner displays a list of all business processes and other 
forms that are currently using the element. 

To modify a data element 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click Data Structure Setup > Data Elements. 

3) Select the data element and click Open. The Modify Data Element window opens. 
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Note: Rather than search through the entire list of data elements, you 
can use the Find feature to narrow your search by the element's name, 
the data definition it was built on, the form label of the element, or words 
from the element's description. 

4) Select a new Data Definition Source or enter a new name for the Form Label

5) Click OK. 

Dynamic Data Sets 

Dynamic data sets are a way of narrowing the number of choices a user can make on a form 
field. By narrowing a user's choices, they can enter data faster and more efficiently. You can 
also use dynamic data sets as a way of eliminating fields that are not necessary for specific 
situations. For example, instead of asking a user to choose one city among hundreds in a list, 
you can narrow the list of cities by state. Or, instead of asking the user to fill in every field in a 
form, you can "disable" those fields that are not necessary. 

Dynamic data sets are governed by a master element (field) that dictates what some fields in the 
set will show and how others will behave. Data sets are considered "dynamic" because the 
values of the elements in the set change, depending on what the user chooses in the master 
element field. For example, on a form that requires a state and city designation, the list of cities 
changes, depending on the state the user chooses. The state and city elements become a 
dynamic data set, and the master element (state) dictates what cities will appear in the list. 

Dynamic data sets work with pull-down lists and radio buttons. In Primavera Unifier, the 
administrator will populate the pull-down lists, and will also specify the behavior (enabled or 
disabled) of the fields in the data set. 

For example, a form might require both national and international addresses. Some countries or 
states within a country require a postal code with a mail stop extension; others do not. The 
country, state, and postal code fields become the dynamic data set. In this dynamic data set, the 
country is the master element; it dictates which states the user can choose from and whether or 
not the user must enter a mailstop extension.  

Note: Before you create the dynamic data set, be sure you have 
designed all the data elements you need for the set. 

Dynamic data sets are composed of the following: 

 Master Element 

Controls the content or behavior of the other data elements (fields) in the set. 

 Value Set 

Data elements (fields) whose values is controlled by the master element. For example, if the 
master element is "Country," then a value set may be a pull-down list of states. 

 Behavior Set 
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Data elements (fields) whose behavior is controlled by the master element. The master 
element determines if the fields are Required (makes the data element a required field), 
Disabled (the data element is read-only), or Disabled and Clear (the data element is 
disabled and any previously entered text is cleared). For example, if the master field is an 
"Attachments" radio button, the behavior set may include "Web files" and "Emails." Both are 
disabled until you select the "Attachments" radio button. Behavior sets must be editable. 

The value set and behavior set are independent of each other. However, the elements you 
select for a value set cannot be used as part of a behavior set. The master element controls the 
value of one field(s) and the behavior of another (or others). You must have a master element 
for a dynamic data set, but you do not need both a value set and a behavior set. 

For example, you could use the master element and only a value set to create a country and 
state/province dynamic set. 

Or, you can create a data set using the master element and only a behavior set to show or 
disable a field. 

Using Multiple Dynamic Data Sets 

You can include multiple dynamic data sets on a form so long as any single data element is 
used for only one dynamic data set. Multiple dynamic data sets can use the same master 
element, but the data elements in the value sets and behavior sets must be different from those 
in any other dynamic set on the form. 



Creating a Data Structure

209

Creating a Dynamic Data Set 

To create a dynamic data set: 

1) Click the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Data Structure Setup > Dynamic Data Sets. 

3) Click New to open the Properties window. 

4) On the General tab, enter a name and description for the data set. 

Use alphanumeric characters only; no special characters or spaces. 

5) In the Master Data Element field, click the Select button and choose the data element 
(field) that will control the content and behavior of the other data elements (fields) in this set. 
The Select list will show only those data elements that are pull-downs or radio buttons. 

For example, you could use a radio button for "Attachments" as a Master Data Element to 
enable additional options for a user to choose. If the user clicks the Attachments button, 
additional radio buttons become active so the user can choose what type of attachments to 
include. 

 The Status data element, as well as all standard data elements, cannot be used as a 
master data element. 

 Data elements based on the Data Picker data definition cannot be used as the master 
element. 

 You can make the Master Data Element Editable, Editable (Required), or Read-Only in 
uDesigner. 

 Once you have chosen the master data element, uDesigner will show the Data Definition 
and Form Label of the master element. 

6) Click the Value Set tab.  

7) To add the other elements to the data set, click the Add button. 

The Select Value Set Data Element window opens, showing a list of those elements 
available for dynamic data sets—pull-downs or radio buttons. 

The elements you select here are the elements whose values will be controlled by the master 
element. For example, if the master element is "country," then a value set might be a 
pull-down list of states that belong to the country. 

 The elements you select for a value set cannot be used as part of a behavior set. 

 If any field in the value set is marked "required," the master element must also be marked 
"required." 

 Data elements based on the Data Picker data definition cannot be used in a value set. 

8) Select In a Business Process, auto-select the value if there is only one value in the 
Value Set data element so the system auto-selects the data in the Value Set DE, if there is 
only one possible value. See below for more details.  

9) Select the elements and click OK. 

10) Click the Behavior Set tab, then click the Add button. 

The Select Behavior Set Data Element window opens, showing a list of those elements 
available for dynamic data sets. 
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The elements you select here are the elements whose behavior will be controlled by the 
master element. These are the elements that will be either required or disabled by the 
master element, and they must be marked "editable" on the form. 

For example, if the master data element is Attachments, as in the example in step 4, the 
elements whose behavior is controlled would be Text Files, Video Files, and emails.  

Note: Do not use asset codes in a behavior set. 

11) Click OK. 

Before Modifying a Dynamic Data Set 

If you need to change a dynamic data set, it's a good idea to see where it is used first, as the 
changes you make can affect business processes in ways you might not expect. 

To see where the data set is being used, highlight the data set in the log and click the Usage 
button in the toolbar. uDesigner displays a list of all business processes and other forms that are 
currently using the set. 

Note: Be aware that if you change a dynamic data set that is already on 
a form, the changes you make to the set will not cascade to the form. 
You must delete the set from the form, save the form, then insert the 
fields again and click the Dynamic Data Set button. 

Select In a Business Process, auto-select the value if there is only one value in the Value Set 
data element Option  

If this option is selected, then at runtime the Value Set pull-down DE value will get auto-selected 
if it has only single value to select. The same function will apply if the Value Set DE has only 
one value to select. The existing DDS does not have any impact on the existing behavior, unless 
the user changes the selection at DDS setup level. If the Value Set DE has only one value to 
select, then the user will not be able to change or clear this selection. 

In User mode, all of the following BPs that can have DDS on their Upper Form or Detail Form, or 
both, will be impacted by this selection: 

 Company-level workflow and non-workflow BPs 

 Shell-level workflow and non-workflow BPs 

 Action with preview and without preview 

 Auto-population and Reverse Auto-population 

 Email response 

The following BPs will not be impacted by this selection: 

 Copied records of workflow and non-workflow BPs 

 Copied line item of workflow and non-workflow BPs 

 Line Item consolidation 

 Attribute forms of all kinds and types 
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The BP Templates that have been created after the 22.10 release will have auto-selection of the 
Values Set DEs, if the option is selected. The BP Templates created prior to 22.10 will remain 
unchanged; however, you can edit these templates to have auto-selection of the Values Set 
DEs.  

RESTful Web Service

When the user creates, or updates, a BP record through RESTful web service call, if the input 
request-file has a value for the Master Data Element field and if the Value Set pull-down value 
has only one value in the hierarchy of DDS, then the system will auto-select the only value on 
the BP form. If the Value Set DE has only one value to select, then the user will not be able to 
change or clear this selection. 

Statuses 

A status indicates the condition or state of a record, line item, asset, shell, manager, or other 
Primavera Unifier component. 

A record status indicates the position a form is in at any point in a business process, such as 
"approved," "pending," or "closed." Each business process includes at least one, and sometimes 
many, steps during its workflow. At each step, the Primavera Unifier user must apply a record 
status to the form. The status is the action that links two steps in a workflow. The action the link 
takes appears in Primavera Unifier as a choice the user makes on the form. This choice moves 
the task to the next step. 

When designing a business process, you will be specifying what statuses the user can choose 
from at the completion of each step in a workflow. Inactive record statuses are not displayed to 
users. 

A line item status indicates the position of a line item at any point in the business process. 
Unlike a record status, it is not a visible part of a workflow; instead, it is part of the form that 
moves through the workflow. For example, a document BP might bundle several documents 
together for review. Each document in the bundle is represented as a line item and as such, can 
be given a separate status: One document can be approved, while another can be sent back for 
editing. Each line item must be given a status. You can use the Default button to change the 
Default setting of Line Item Statuses for business processes. 
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Asset statuses differ from other statuses. Instead of affecting the disposition of a BP or line item, 
an asset status controls which assets are displayed on an asset class sheet. Plan to include 
statuses that will be appropriate for use in asset management. For example, on your asset class 
sheet, you might want to include the statuses of the portable generators in your facilities. For this 
case, you might need a status of: 

Stored on site To show the number of generators that have been received and 
are stored in one or more of your facilities 

In service To show the number of generators that have been installed and 
are in service in your facilities 

Out of service To show the number of generators that are out of service for any 
reason 

Decommissioned To show the number of generators that have been "retired" or 
decommissioned from service 

Unlike data elements, which will not contain values until they are entered in Primavera Unifier, 
you will be creating "pools" of status values that the user can choose from when they perform a 
task in a workflow or when they add a new asset to the Asset Manager. 

You can include statuses only in the upper portion of a form or in a log, but the status will be 
reflected in the BP log.  

When you create a company, uDesigner automatically creates a list of default statuses. As 
administrator, you can add statuses to this list or modify, activate, and deactivate them. 

Note: You cannot remove a status value after it is created. However, you 
can deactivate it if you no longer want it to be available. 

Adding a Status 

To add a status: 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click Data Structure Setup > Statuses. Under Statuses, choose: 

 Record Statuses to add statuses for records 

 Line Item Statuses to add statuses for line items 

 Asset Statuses to add statuses for assets 

3) Double-click the status list in the log. The Status Definition window opens. 

4) Click the Data Set tab, and at the bottom of the window, click the Add button. 

uDesigner adds a row with a text box in the Value field. 

5) In the Value field, enter a name for the new status. 

Use only alphanumeric and underscore (_) characters for the name; 20 characters 
maximum. 

6) To add another record status, click the Add button. 

7) When you are finished, click OK. 
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Changing the Name of a Status 

To change the name of a status: 

1) Open the Status Definition window and click the Data Set tab. 

2) Under the Value column, double-click the status name and make your changes. 

3) Click OK. 

Activating / Deactivating a Status 

When you add a new status, it automatically becomes active. Deactivating a Line Item or Asset 
Status prevents it from appearing as a selection on a list, but does not affect a status that has 
already been assigned to a workflow or asset already in use. Deactivating a Record Status 
affects a status if the user updates an existing business process record and requires the user to 
select a different status. (Inactive Record Statuses are not displayed to users when they create 
new records.)  

To activate or deactivate a status 

1) Open the Status Definition window and click the Data Set tab. 

2) Highlight the status on the list. When you double click the status, a pulldown menu appears. 

3) Click the down arrow of the pulldown menu and select Inactive or Active. 

4) Click OK. 

You can also activate and deactivate a Record Status on the Statuses tab during creation or 
update of a shell template or business process. 

Rearranging the Order Statuses Appear in Lists 

To rearrange the order in which the statuses will appear on drop-down lists: 

1) Open the Status Definition window and click the Data Set tab. 

2) Highlight the status on the list and click Move Up or Move Down. 

3) Click OK. 
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Tags 

Tags work with uDesigner's linked elements feature to connect schedule sheet activities with 
business processes, shells, and configurable manager. Tags allow a one-to-many relationship 
between a data element on the schedule attribute form and multiple data elements on a form, as 
long as the data elements have the same data definition. This feature lets a user view key 
activity dates, such as milestones, on forms like project "details," without opening the schedule 
activity sheet, as shown in the illustration below. 

Creating a Tag 

1) Click the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click Data Structure Setup > Statuses > Tags.

3) Select Designer Tags, and click Open. The Modify Tag Status window opens. 

The General tab is read-only. 

4) Click the Data Set tab, then click the Add button. uDesigner activates a new row. 

5) In the Value field, add an alphanumeric value. Alphanumeric characters, spaces, hyphens, 
and underscores (_) are allowed. 

6) Click Apply to save the entry. Click OK to close the window. 
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Exporting the Data Structure to Primavera Unifier 

The data structure is included when you export business processes, shells, managers, and other 
components from uDesigner to Primavera Unifier. However, there may be times when 
something—a data definition, data element, or status—requires modifying after it has been 
exported. When this happens, you can export the components again in CSV format. The export 
process, by function, will include all the original definitions, elements, or statuses, as well as the 
new ones. 

To export data definitions 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click Data Structure Setup > Data Definitions. 

3) Click Basic or Cost Codes, depending on the definitions you want to export. The panel on 
the right lists the definitions. 

4) Click the Export button on the toolbar. 

uDesigner converts the definitions into a CSV file and prompts you to save or open the file. 

5) Save the file to the directory from which you want to export it. 

To export data elements 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click Data Structure Setup > Data Elements. The panel on the right 
lists the elements. 

3) Click the Export button on the toolbar. 

uDesigner converts the definitions into a CSV file and prompts you to save or open the file. 

4) Save the file to the directory from which you want to export it. 

To export statuses 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click Data Structure Setup > [Asset Statuses, Line Item Statuses, 
Record Statuses, or Tags]. The panel on the right lists the statuses. 

3) Click the Export button on the toolbar. 

uDesigner converts the definitions into a CSV file and prompts you to save or open the file. 

4) Save the file to the directory from which you want to export it. 

Starting a New Design 

After you create the data structure for a design, you can start the design process. This chapter 
provides an overview and instructions on starting the designs for the components that will be 
used by the users in Primavera Unifier: 

 The shells or projects 

 The configurable managers 

 The business processes 



Unifier uDesigner User Guide

216

 The asset classes 

 The plans 

 The resources 

 The spaces and levels for facilities management 

Starting a new design begins a different process, depending on what you are creating—a 
project/shell, manager, business process, asset class, plan, or spaces and levels. 

 Most of your designs will be for business processes, and for most of these, the design 
routine includes creating the forms and workflows that will dictate how your business 
activities function. For example, a complex business process can dictate how costs move 
through the approval process 

 For other designs, you will create single records to collect company or project information 
necessary for the proper operation of components in Primavera Unifier. 

 For managers, the design process can include creating a pool of resources or classes of 
assets that will be used in Primavera Unifier. 

 For configurable managers, you will be designing the sheets on which users will track 
items and a pool of codes for organizing the items. 

 For shells, you will be designing a pool of shell types that can be organized into a 
hierarchy in Primavera Unifier. 

Before you continue further, it may help to review Business Processes Overview (on page 13). 
That topic contains links to descriptions of each business process type and what it needs, 
design-wise, to operate effectively. What each manager needs to become active in Primavera 
Unifier is described in the topics describing each manager. 
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You will be using uDesigner to build the forms, workflows (where required), and logs that 
constitute a business process or other Primavera Unifier component. What you create in 
uDesigner is what the user will use in Primavera Unifier. 

Overall Steps for Creating a Design 

For business processes, shells, and other components to work effectively in Primavera Unifier, 
you will need to use the following steps to create the designs for them in uDesigner. It is always 
helpful to gather all requirements for the business process, shell, or manager before you begin 
creating data structures or starting the design.  

1. Create a data structure This structure will include the data elements to be 
used on the forms. The data structure must be in 
place before you start the design process. (See 
Creating a Data Structure (on page 189)) 

2. Launch the design This step initializes the design process. (See 
Starting a New Design (Edit Studio) (on page 
219).) 
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3. Design the forms These forms will be used in Primavera Unifier to 
collect and store data for the business process, 
shell, manager, or other component. (See the 
instructions beginning with Designing a Form
(on page 248).) 

4. Create the workflow (for 
appropriate business processes 
only) 

As you design the workflow, you will assign the 
forms you design to each step. (See the 
instructions beginning with Starting a Workflow
(on page 394).) 

5. Specify a reference process (Optional) Reference processes link business 
processes and forms together for the purpose of 
sharing information. They must be included on 
any form that uses a BP picker, line item picker, 
account code picker, or fund picker. Reference 
processes populate the fields on these pickers. 
(See Adding a Reference Process to 
Auto-Populate Data (on page 355).) 

6. Design a log for the business 
process 

This log is what Primavera Unifier users see in 
the right pane of the workspace screen. (See the 
instructions beginning with Creating a Business 
Process Log (Standard or Picker) (on page 
411).) 

Tips on Designing Good Business Processes and Forms 

Users are more willing to use business processes and forms that are well-designed. Design is a 
balance of many factors, and high usability requires thinking "in the shoes" of the users. You can 
greatly enhance your forms' usability by using the following suggestions: 

 Before you begin designing a business process, sketch out the workflow on paper. A sketch 
can help you see where you might need a sub-workflow or a conditional routing, and can 
clarify the soundness of the business process before you solidify it in production. This will 
also show you what kind of forms you will need for each step of the workflow. 

 Before you create your forms, sketch them out on paper. This will help you organize the data 
you want for upper and detail forms, and help you determine exactly how the form will be 
used in the workflow. This can also help you avoid creating form areas that require too much 
scrolling (particularly helpful for log layouts!) 

 Add borders around blocks. They make information stand out clearly and more readably. 

 Use auto-population whenever you can so user's don't have to fill in every field of the form. 

 Plan field labels carefully. If they are too long, they will wrap awkwardly if there is not enough 
room. Make the labels succinct and meaningful. 

 Make tab labels descriptive. A label that reads RFI says little. Instead, use a label such as 
Description or RFI Comments. 

 For log layouts, watch the widths of columns: Too many wide columns means columns on 
the right might be clipped, and the user will have to scroll to see information. Try to keep 
column titles to one line. 
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Starting a New Design (Edit Studio) 

The steps involved in starting a new design differ, depending on what you are creating—a shell, 
manager, business process, asset class, plan, or spaces and levels. For example, for some 
forms, you will have the option of consolidating line items; for others, this will not be an option. 

To begin a new design 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) Click uDesigner in the left Navigator. 

 For a new asset class, click Asset Manager. The Asset Manager log opens. 

 For a new plan, click Planning Manager. The Planning Manager log opens. 

 For a new business process, click Business Processes. The Business Processes log 
opens. 

 For a shell, click Shell Manager. The Shell Manager log opens. 

 For a configurable manager, click Configurable Modules. The Configurable Modules log 
opens. 

3) On the log, click: 

 New and from the list, choose the business process type you want to design. 

 New > Asset Class to start a new asset class for the Asset Manager. 

 New > Planning to start a new plan and accompanying planning sheet for the Planning 
Manager. 

 New > Shell to start a new shell for the Shell Manager. 

 New > Class to start a new class for a Code and Records-based configurable manager. 

The Edit Studio window opens. 

4) Complete the tabs as described in the following sections.  

 General Tab (on page 220) 

 Statuses Tab (on page 221) 

 Options Tab (on page 223) 

 Consolidation Tab (on page 233) 

 Record Properties (on page 236) 

To add a link element to a form, see: Adding Link Elements to a Form (on page 386). 

After Starting the Design 

When you have completed these initial steps in launching a new design, you can begin About 
Business Process Forms (on page 253). 

Starting a Design from an Existing Form 

Once a form has been created in uDesigner, you can quickly start similar form designs by 
copying the first one and making modifications. 

To start a design from an existing form 

1) On the log, select the form to copy and click New > Copy. 
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2) Select the form from the list and click OK. 

General Tab 

The General tab displays different fields, depending on the type of component you are 
designing. These fields and what to enter in them are listed in the following table. 

Note: The General tab is the only tab you will see consistently, no 
matter what design you are starting. The other tabs discussed here may 
or may not appear, depending on the type of design you are starting; 
and they will not appear until you click the Apply button 

1) Use the information in the table below to complete the General tab. 

2) Click Apply. 

If the General 
tab shows this 
field: 

Do this: 

ID The ID code is used to facilitate data base functionality. Enter a code 
of your own creation. The code must start with "ux." 

Name Enter a name for the component. The name can be up to 64 
characters long and can include alphanumeric characters, spaces, and 
punctuation marks. 

Tip: Make the name intuitive for users. For multi-record BPs, always 
make the name plural, such as Vendors, Action Items, RFIs, or 
Design Reviews. For single-records, make the name singular, such as 
"Project Information." 

Description (Optional) Enter a description of the business process or other 
component. A description is optional, but recommended. 

Level Specify whether this is a company-level or a project- or shell-level 
component. 

Behavior Specify whether or not this business process will include a workflow. 

Record 
Instances 

Specify how many records the user can create for the business 
process or other component. Multiple means the user can create any 
number of records. Single means the user can create only one record 
for the component per project/shell. 

Type The field shows the type of business process you selected. 

Sub-Type Choose the business process sub-type, such as Line Items with Fund 
Codes (for a Cost PB), Simple (for a Project/Shell Creator BP), or Line 
Items with Both CBS and WBS Codes.  

Classification Choose the sub-type classification, such as Base Commit, General 
Spends, or Lease (for a Cost BP), or Projects or Shells Only, or Shell 
and Sub-Shells (for a Project/Shell Creator BP). 
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If the General 
tab shows this 
field: 

Do this: 

Configurable 
Managers 

If you are designing a business process for a configurable manager, 
click Select and choose the manager. 

You can select multiple managers for these business processes. 

Note: Always click the Apply button when you have completed the 
General tab. Other tabs may not appear until you do so. 

Statuses Tab 

On the Statuses tab, specify the statuses you want to make available for the records. A status 
indicates the condition or state of a record at any point in its life cycle. (For more information 
about statuses, see Statuses (on page 211).) These are the statuses the user will apply to this 
record as it moves through a workflow, or during its use in Primavera Unifier. 

Statuses will vary, according to the type of record it is. For a cost record, the user might need 
"estimate pending," "approved as noted," and "approved" statuses. For a simple BP, the user 
might need only "open" and "closed" statuses. For an asset class record, the status controls 
which assets are displayed on an asset class sheet, and could include statuses such as "Out of 
Service" and "Decommissioned." 

Notes: 

Statuses are necessary for a non-workflow business process to 
designate the record's final disposition—to keep it active and editable, or 
to close it to any further activity. By default, all existing statuses for a 
non-workflow business process are defined as Active and the Inactive 
column is blank. If you want to deactivate a status, select the applicable 
Status, and click the Inactive button. 

Scope Management uses only the following pre-defined statuses: 

 Not Started 

 In Progress 

 Complete 

 Not Applicable 

To include a status 

1) To add a status, click the Add button and choose the status from the list that appears. 

To choose multiple statuses, hold down the Ctrl key and click each status you want. 
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Notes: 

 For Setting a Default Status: To make entering line items easier for 
the user, you can set a default status, such as "Pending," for new 
line items. To do so, select the status and click the Default button. 

 For Terminal Record Statuses: You can use a terminal record status 
to trigger certain functions outside the scope of the business process 
or to make external data easily accessible from the business process 
or form (see table below). 

The statuses for records must include at least one terminal status; otherwise, the workflow 
cannot be completed. To make a status terminal, select the status and click the Terminal
button. 

2) Click Apply or OK. 

About Terminal Statuses 

A terminal status indicates the end of a business process, usually on a workflow. A terminal 
status for a record has a significant affect in that it can trigger an automatic action in Primavera 
Unifier. You can use a terminal record status to trigger certain functions outside the scope of the 
business process or to make external data easily accessible from the business process. You can 
define more than one terminal status.  

A terminal status on this: Can do this: 

Change Commit BPs 

Update SOV sheet and SOV line items. If you use this 
feature, users will be able to access the SOV directly 
from the change commit form. 

On change commit BPs linked to a general spends SOV, 
a terminal status is not necessary for updates. It is 
necessary, however, on a change commit linked to a 
payment application BP. 

Base Commit BPs 

Create an SOV sheet and SOV line items.  If you use 
this feature, users will be able to access the SOV directly 
from the base commit form. 

On base commit BPs linked to a general spends SOV, a 
terminal status is not necessary for updates. It is 
necessary, however, on a base commit linked to a 
payment application BP. 

Commit and Spends BPs 

Automate project fund consumption or appropriation. On 
Commit BPs, it can also update an SOV sheet. On 
Spends BPs, it can update the SOV. If you use this 
feature, users will be able to access the SOV directly 
from the commit or spends form. 

Payment application BPs 
Allow users to accept line item history directly from the 
record. 
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A terminal status on this: Can do this: 

Resource Booking BPs 
Assign (hard book) a resource and update the booking 
sheet. 

Timesheet BPs 
Roll up time and monies to the master timesheet, as well 
as the project cost sheet. 

Options Tab 

For some components, uDesigner displays an Options tab. The Options tab displays different 
fields, depending on the type of design you are starting. These fields and what to enter in them 
are listed in the following table. 

Note: If you are creating a form with multiple tabs, the options you set 
here will apply to the line items for all the tabs. 

The following explains the actions that you can take in each of the Options tab fields: 

Add All SOV Lines

The Payment Application Grid will display all SOV lines when this box is checked. 

Add only edited SOV Line Items

The Summary Payment Application Grid will display only those SOV lines which have been 
edited and saved. By default, this option is not selected for use.  

Add Company Records to filtered list when line item status equals

If this BP type filters company records into a list, use this field to specify that when the line 
item reaches the status you designate here, Primavera Unifier should add the selected 
company record to the list. 

Allow Future Cost Adjustment

Select the check box if you want the users to be able to adjust the costs. To allow the users 
to forecast their anticipated commits, select Label for Yet to Buy. To allow users to forecast 
contingency spending, select Label for Contingency. 

Allow Commitment based Funding and Assignment

Select If this is a Base Commit BP, select this checkbox to enable funding on individual base 
commit records. If you select this, you must also select the Create SOV checkbox. 

If you select this checkbox, be sure you also enable fund assignment on the forms on which 
you want to allow access to the Commitment Funding sheet. 

Display 'Total Amount' sum of line items at bottom of System Defined tab 

Select the check box if you want users to be able to see the total amount of the sum of the 
line items at the bottom of the system-defined tab. 

Allow public bidding (no pre-defined bidders)
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Select the check box if you want users to be able to send bid invitations to the vendors on 
your company's master vendor list (vendor master list). 

Display bid responses before RFB Due Date 

If you select this option, then at run time the Proposal column in the Proposal Management
tab will have the View link to view the submitted bid response. 

If you do not select this option, then the Proposal column would be available only after the 
RFB due date. 

Note: The above is applicable to the Private Bids, only. The above is not 
applicable to the Public Bids. 

Referenced Line Item BP to filter bidders 

Select the available BP data picker elements on the upper form. 

Auto populate this vendor picker with value from winning bid picker

To indicate which Vendor Picker to auto-populate whenever a winning bidder is picked in the 
upper form. The option would list all the BP Pickers and Data pickers referencing to master 
vendor list or BPs added in the upper form of the RFB BP.  

Select from a list of vendor picker elements on the upper form. The option would list all the 
BP Pickers and Data pickers referencing to master vendor list or BPs that have been added 
in the upper form of the RFB BP. 

The BP pickers which reference to the Vendor BP and also the data pickers which reference 
to the master vendor list are displayed here. You can select the BP which the user can 
auto-populate, based on the selection made, or the value in winning bid picker.  

Data Picker Configuration > Contract Awarded To 

If a condition is defined for the selected picker, which is selected for auto-populate based on 
the winning bid selection. Once selected, Unifier ignores the existing conditions. 

When the user selects a BP Picker for auto-populate based on winning bid picker selection; 
the application ignores the condition setting: 

 When the condition for the BP Data Picker is set to as not equal to “Active,” 
and the vendor record status is equal to “Inactive.” 

 When the condition for the BP Data Picker is set to as vendor name not equal 
to “Oracle,” but the selected vendor record  has vendor name equals to 
“Oracle.”  

Reset the values of these fields of the Requestor Detail Form when line items are viewed 
by a bidder.

Resetting just a field of formula data entry type will not reset the field value. The fields used 
in the formula definition must be added to the list of fields that are to be reset.  

Click Select to open the list of data elements from the Requestor Detail Form. Select the 
fields for which the requestor wants to reset the values. 
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The list of DEs from the Requestor Detail Form will not include Pickers. At runtime, when the 
bidder views the Request for Bid record, the Line items that are seen in the Requestor 
Package, and the Line Items (when the Bidder is creating the bid) will not display values for 
fields that have been reset. For example, if the Amount (Unit Price multiplied by Quantity) 
must be hidden from the bidder's view, then adding the Amount field to the list will not hide 
the value from the bidder. In such a case, either the Unit Price or the Quantity must be added 
to the list of Reset DEs. 

When a bidder logs into the Bidder Portal, the fields that are selected in uDesigner 
(Company Workspace > Admin mode > uDesigner > Requests for Bid - Home > Options tab 
of the Request for Bid BP) will have blank values. 

Example 

If the Amount (which is Unit Price multiplied by Quantity) must be hidden from the 
bidder's view, then adding the Amount field to the list will not hide the value from the 
bidder. In such a case, either the Unit Price or the Quantity must be added to the list 
of Reset DEs. 

When you click Select, a list of all of the data elements from the Requestor's Detail Form 
will be displayed in the Data Elements from the Requestor Detail Form window. The 
page title will be: Reset the values of these fields in line items when viewed by a 
bidder. 

The list displayed will not contain picker data elements, for the detail form. 

At runtime, when the bidder views the Request for Bid record, the line items that are seen 
in the Requestor Package, and the Line Items when the bidder is creating the bid, will 
not have values for the fields. 

Total Amount Changes 

If the design of the Requests for Bid business process has fields hidden from the bidder's 
view, then the following is applicable: 

The Line Item tab in the "Requestor Package" will not have the Filtered Total amount.  

The "Total Amount" seen in the Line Item tab will only total the sum of the Amount fields 
per page regardless of the number of pages existing in the tab.  

Example 

If there are 10,000 line items, and the pagination has been set to 200 items per page, 
then the Total Amount will only show the sum of the 'Amount' field for 200 items. 

For users who can access the option: Do not copy the values of these Bidder Detail Form 
fields from Requestor Detail Form

This field is incorporated in Unifier 21.4. The values of the fields selected in the will be 
hidden from the bidder. The customers who have leveraged the option of "Do not copy the 
values of these Bidder Detail Form fields from Requestor Detail Form" introduced Unifier 20 
(above) will see the following changes in the bidder portal: 

 The line Items seen in the Requestor Package > Standard tab will have blank values for 
fields. This is applicable to all the previously submitted and closed bids RFB records.  
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 If a bidder has already started creating the bid package post acceptance of the bid 
invitation, and in between the design has changed in uDesigner, then the line items in the 
"Your Proposal" tab will still show the values in the fields that were not meant to be 
copied over. The Bidder line items are inserted from the Requestor Line Items into the 
database, once the bidder accepts the bid invitation. Subsequently, the line item values 
are fetched from the database. Changes made in uDesigner will not get reflected in the 
line items that are already coming from the database; however, if the bidder is creating 
new line items, then the uDesigner options will be applicable. 

 If there have been no changes in the design post-upgrade, all of the data elements 
mentioned in the uDesigner will continue to be preserved while the bidder is creating new 
line items in the "Your Proposal" tab. The data element may have existed only in the 
Bidder detail form.  

 The undo accept behavior post-upgrade, if the bidder decides to withdraw the bid 
participation and does an Undo Accept, then all the line items that may have existed in 
the line item tab of "Your Proposal" will be deleted. The next time that the bidder chooses 
to accept the bid invitation, the new line items that will get inserted into the "Your 
Proposal" tab will retain the latest designs in the uDesigner. 

Enable Map View Feature

Select the check box to enable the map feature for Line Item, Simple, Text, Document, and 
some Cost business process records and logs. You can view location maps for projects or 
facilities. The map feature uses addresses or latitude and longitude coordinates (the data 
elements which you must include on the design of the BP form.  

Allow adding users/groups in Primavera Unifier User mode

Use this option for automatic email notifications when a non-workflow record is created or 
modified. Select this check box if you want the user to be able to add users or groups to the 
email. If you check this box, the form will display an additional area at the bottom where the 
Primavera Unifier user can choose additional users or groups to notify. (This area is 
pre-defined in Primavera Unifier and will not be visible in uDesigner when you design the 
form.) 

Automatic Update of YTB should add the amount instead of subtracting

Select the check box if you want to enable a Base Commit, Change Commit, or Generic cost 
type business process to generate a data source of "Unaccepted" for use in the logical data 
source called Forecasts (Unaccepted) in the cost Sheet. This option will add scope to the 
YTB. 

Auto-populate on Payment Application

If the BP is a Payment Application, select this check box to auto-populate the Payment 
Application with the line items from both Base Commits and Change Commit BPs. This 
option is available on the:  

 SOV type Payment Applications 

 SOV type Summary Payment Applications (Base Commits BP) 

 SOV line item type individual commit line items 

See Auto-populate on Payment Application from a Base Commits BP (on page 357). 

The runtime auto-populate occurs for the: Summary lines and Costed lines. 
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Company Business Process Records Picker

If the BP is a line item type that will filter company records into a smaller list, select the picker 
you want to appear on the form. Users will use this picker to filter the records for the project 
list. For example, if this BP will filter vendor names for a project vendor list, you would select 
the vendor picker you created for this BP. 

Consume funding when terminal status equals

If the BP is a general spends type and you want the BP to automate project fund 
consumption, select the check box. When the BP reaches its terminal status (the last status 
in the workflow), the fund is consumed. Specify which funds to consume by selecting the 
appropriate terminal status (for more information, see Statuses Tab (on page 221)). For new 
cost business processes, the list of available statuses should be limited to those marked 
Active. If a terminal status is subsequently marked Inactive, an error message should be 
displayed during completion of the business process. 

Cost Rollup

If the BP is a timesheet, use this field to designate that the costs should be rolled up to the 
Cost Manager; otherwise, the timesheet will not roll costs up to the company/project cost 
sheets and actuals sheet. 

These rolled-up costs will be reflected in the Resource Actuals column on the Cost Sheet. 

Create Commitment Summary

If the BP is a base commit line item type with multiple codes, select this check box if you 
want the BP to automatically create a commitment summary. Select the Commitment 
Summary Type and the Commitment Summary Line Items that should be included on the 
summary. Specify which line items to use on the summary by selecting the appropriate In 
terminal status (see Statuses Tab (on page 221)). 

Create Project/Shell when record reaches terminal status

If this is a Project/Shell Creation BP that should create a new project or shell, select this 
check box. 

If the sub-type is Simple, when the BP record reaches the terminal status you specify here, 
Primavera Unifier will automatically create a new project or shell. You can specify multiple 
terminal statuses for the record. 

If the sub-type is Line Item, you must specify both a terminal status for the record and a 
status for the line item before a new project/shell can be created. You can specify multiple 
record statuses, but only a single line item status. 

(See Statuses Tab (on page 221).) 

Create SOV

Select the check box if you want to automatically create an SOV from the BP. Especially for 
use on Base Commit BPs (Base Commit - Line Items with CBS Codes). 

Select the SOV Type and the SOV Line Items that should be created. The options available 
for the SOV Type are: 

 General Spends 

 Payment Applications 
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 Summary Payment Applications 

If the user selects the SOV Type, "Summary Payment Applications," the SOV Line Items 
drop-down list will be auto-populated with the value: Individual commit line items. 

Note: The user will be unable to select any other option or to deselect 
this option. 

Specify which line items to create by selecting the appropriate terminal status (for more 
information, see Statuses Tab (on page 221)). For new cost business processes, the list of 
available statuses should be limited to those marked Active. If a terminal status is 
subsequently marked Inactive, an error message should be displayed during completion of 
the business process. 

Select Auto-populate on Payment Application to auto-populate specific fields on the 
Payment Applications Detail form from the Base Commits BP. 

Click the Select button and choose the payment app fields (Data Elements) you want to 
populate. For more information, see Auto-populate on Payment Application from a Base 
Commits BP (on page 357). The runtime auto-populate occurs for the: Summary lines and 
Costed lines.  

To allow commitment funding on the Base Commits, select Allow Commitment based 
Funding and Assignment. 

Note: For any given project, there can be only one Base Commit type of 
business process that can generate a Schedule of Values (SOV) for 
payment. If you try to deploy another Base Commit BP in the same 
project, with the intent to generate SOV for payment, then the system 
will prevent you from deploying the business process in uDesigner.  

Create Snapshots automatically whenever status changes to

If the BP is a line item type with multiple codes, select this check box if you want Primavera 
Unifier to automatically take a snapshot of the BP when it reaches a specific status. Click the 
down arrow and select the status. 

Disable manual fund assignment when record workflow is closed

Select this check box if funds should not be manually assigned after the workflow is closed 
(reaches the end step). 

Note: This option does not disable automatic fund assignments. 
However, it does override any manual fund assignments on an action 
form at the end step of a workflow. 

Disable manual fund assignment when record reaches terminal status

Select this check box if funds should not be manually assigned after the record reaches a 
terminal status. (This is for non-workflow Cost BPs.) 

Note: This option does not disable automatic fund assignments. 

Display "Total Amount" sum of line items at bottom of Standard tab
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If the BP is a line item type, select this check box if you want Unifier to automatically sum the 
line items and display the total at the bottom of the Standard tab. 

Note: This option is not available for Lease business processes. 

Enable Calendar

Select this checkbox if users should be able to reserve this business process record for 
exclusive use. If you select this check box, the form will display a Calendar button in the 
toolbar that the user can use to display a calendar and specify dates and times for the 
reservation, as well as additional information that might be necessary for the reservation. In 
addition, the data picker(s) created for a Reservation type business process will include this 
business process on the picker list. 

Enable Cost Sheet Forecasting

Select the check box if you want to enable a Base Commit, Change Commit, or Generic cost 
type business process to generate a data source of "Unaccepted" for use in the logical data 
source called Forecasts (Unaccepted) in the cost Sheet. This option will subtract scope from 
the YTB. 

Enable for Portal

Select the check box if you want this business process to be available for use in the 
Self-Service Portal. 

The portal is available only for Simple type BPs that are: 

 At the company level 

 Non-workflow 

 Multi-record 

Enable Map View Feature

Select the check box to enable the map feature for Line Item, Simple, Text, Document, and 
some Cost business process records and logs. With this feature, Primavera Unifier users can 
view location maps for such things as projects or facilities. The map feature uses addresses 
or latitude/longitude coordinates—data elements which you must include on the design of the 
BP form. 

Enable design for Mobile Form Factor

If you have enabled a business process for mobile application, and you do not want your 
users to see the standard web application form in the native application, then you have the 
option to selectively add data elements to the form. You can do this by using the Enable 
design for Mobile Form Factor in the Options tab of the business process design.  

Applicable to all of the BPs that are currently supported in the native mobile application, this 
option will enable lightweight forms in the native mobile applications. 

This option, when selected, will render the Mobile Form Data elements in a single stacked 
column. Blocks will not be rendered. 

You can enable or disable this option whether the BP design is published, or not. 

When this option is enabled for the user, upon error check, all of the existing validations for 
the required fields, Dynamic Data Set (DDS) definitions, and so forth will take place. 
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Enforce against CBS Budget using Budget Remaining Balance

Select the check box if Unifier should fulfill payment for the CBS line items on a Base 
Commit BP against the individual line item budgets using the remaining balance of each. 

Fund Picker to show only allocated funds

For cost BPs of sub-type Line Items with Fund Codes or Line Items with Both CBS and 
Fund Codes, use this field to limit the funds shown on the picker to only those funds that 
have been allocated to the project; otherwise, the picker will list all the active fund codes at 
the company level. 

Hard Booking Status(es)

If the BP is a resource booking, use this field to specify that, when the resource reaches one 
(or more) terminal statuses, Primavera Unifier should consider the resource to be assigned 
and no longer available to other bookings (see Statuses Tab (on page 221)). 

Note: If you specify other terminal statuses for a resource, but you do 
not include them as "hard-booked" statuses here, the resource booking 
will be considered "rejected." 

Record Editor

Specify the business process form that Primavera Unifier should display for a record editor 
who has been given the ability to modify a record at any step. This form will differ from the 
form the step assignee will see. This form will be for editing purposes only and the edits will 
be recorded in the audit log. The editor will not be able to send the form on to the next step 
or perform other actions, such as transferring ownership of the business process. 

In addition, this editing form will not perform any rollups. Rollups, if any, will occur only when 
the step assignee sends the record on. 

This form must be specified before the administrator can designate editors for the record. 

Reference against company-level commit

If your company is using blanket purchase orders, select the check box to allow users to 
choose a blanket PO to reference against. If you want the BP to verify that the amount is not 
exceeding the remaining balance of the referenced BPO, select the Enforce against 
company-level commit amount check box. 

Remove Company Records from filtered list when line item status equals
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If this BP type filters company records into a list for a specific project, use this field to specify 
that, when the line item reaches the status you designate here, Primavera Unifier should 
remove the line item information from the list. 

Reservations in these statuses are confirmed

If the BP is a reservation, click the Select button and specify the status or statuses that will 
designate that these reservations are confirmed. 

At runtime in Primavera Unifier, reservations that are in any of these statuses will be 
considered confirmed and will affect the object's calendar, its availability and overbooking 
status. 

Reservations in these statuses are canceled

If the BP is a reservation, click Select and specify the status or statuses that will designate 
that these reservations are canceled. 

At runtime in Primavera Unifier, reservations that are in any of these statuses will be dropped 
from the calendar. 

Resource Assignment

If the BP is a schedule type, use this field to specify that, when the resource reaches the 
status you designate here, Primavera Unifier should add the resource to the Master 
Schedule Sheet. 

Rollup Status(es)

If the BP is a timesheet, use this field to designate that, when the resource reaches a specific 
status(es), Primavera Unifier should roll up the hours and costs into other cost sheets. 

Show Assets in Asset Picker when status equals

If the BP is an asset class, use this field to specify that, when the asset reaches the status 
you designate here, Primavera Unifier should list the asset on the Asset Picker. You must 
specify at least one status, and multiple statuses are allowed. 

Straight Line Payment Schedule

The Lease BP automatically generates a Regular Payment Schedule to allow users to view 
future lease payments. These reports use the start and end dates, frequency, and amount to 
calculate the payments; and these fields are displayed on the report. 

This option is useful if your leases must allocate payments for multiple tenants of a property 
and you want to see the amount allocated for each property. 

Use this option to add additional fields to the report. 

Click Select and choose the fields you want to appear on the Regular Payment Schedule. 
The Select list displays fields from the upper form of the lease business process and the 
lease payment lines. These fields will be appended to the right side of the schedule in 
Primavera Unifier. 

Note: You cannot specify these fields until you have designed the upper 
form for the lease. You will need to return to this tab after you have 
designed the form. 

Update filtered list of Company Records when terminal status equals
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If this BP type filters company records into a list, then use this field to specify that, when the 
BP reaches the status you designate here, Unifier should update the record information on 
the list. 

Update SOV

Select the check box if the BP is a Change Commit or Payment Application. Select the SOV 
Type (such as Payment Application or General Spends) and the SOV Line Items that should be 
updated. Specify which line items to update by selecting the appropriate terminal status. If the 
selected terminal status is subsequently marked Inactive, an error message should be displayed 
during completion of the business process. 

Note: The SOV Type must match the SOV of the referenced Base 
Commit, and the SOV Line Items must match the setting of the 
referenced Base Commit. 

Update Commitment Summary

If the BP is a Change Commit Line Item type with Multiple Codes, select this check box if you 
want the form to automatically update the commitment summary.  Select the Commitment 
Summary Type and the Commitment Summary Line Items that should be included on the 
summary. Specify which line items to update by selecting the appropriate terminal status
(see Statuses Tab (on page 221)). 

Use this process as RFB master vendor list (vendor master list)

Select the check box if you want to use this form as a master list of vendors for RFB 
business processes. 

When you open a Cost Type-Line Items with CBS and WBS Code Business Process and click 
on the Options tab, you can see the following:  

Settings block 

 Classification (For example: Generic - Line Items with CBS and WBS Codes) 

 Enable Map View Feature 

To enable the map feature for Line Item, Simple, Text, Document, and some Cost 
business process records and logs. 

With this feature, Unifier users can view location maps for projects or facilities. 

The map feature uses addresses or latitude and longitude and coordinates data elements 
which you must include on the design of the BP form. 

 Record Editor 

 Edit Form 

The "Allow adding users/groups in Unifier User mode" option is used for automatic email 
notifications, when a non-workflow record is created or modified. Select this option if you want 
the user to be able to add users or groups to the email. If you select this option, the form will 
display an additional area at the bottom where the user can choose additional users or groups to 
notify. 
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Note: This area is predefined in Unifier and will not be visible in 
uDesigner when you design the form. 

Consolidation Tab 

For some business processes, uDesigner displays a Consolidation tab, where you can 
consolidate the line items from multiple records into a single record. When you consolidate line 
items, you can also opt to copy the line item attachments. In addition, you can consolidate line 
items according to their status so that you can exclude those line items that are not necessary, 
such as line items that are closed or rejected. 

For example, over a period of time, a project might incur 15 change order requests for a cost 
estimate that could change the scope of the contract. Ultimately, management might want to 
issue a change order that encompasses the scope of all 15 change order requests. Using the 
consolidation feature, the final change order would copy the line items from the change order 
requests and would encompass the scope and costs of all 15. 

Company and project/shell level BPs are distinct. At the company level, you can consolidate line 
items only from other company-level BPs. At the project/shell level, you can consolidate line 
items only from other project/shell level BPs. The following table shows the consolidation 
relationship between business process types. 

The Consolidation tab will only appear for the following business process types: 

 Cost (except for General Spends, Payment Applications and Summary Payment 
Applications) 

For the Consolidation of Base Commits and Change Commits BPs: 

 The user is able to consolidate into the Summary Payment Applications SOV type BP. 

 The Summary Payment Applications SOV type BP can be selected as source of 
consolidation into other BPs. In this case, at runtime, the Summary line item is 
consolidated without the Costed amount and Quantity breakdown details. 

 Advanced Document 

 RFB (Request for Bid) 

 Line Item 
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Notes: 

 To consolidate line items, you must allow the user to add, remove, 
and copy line items on every form you want to include in the 
consolidation. To do this, see the instructions on completing the 
Options tab for an Upper form. 

 At runtime, Unifier uses the new Standard Data Element 
"uuu_li_consolidated" (Field Label: Consolidated), to automatically 
capture whether a line item has been consolidated, or not, on the 
source record. 

 A Line Item BP in draft mode is not available for consolidation. The 
Line Item BP remains in draft mode, and the application prevents the 
user from consolidating the Line Item BP, if the user does not either: 

 Save the consolidated Line Item BP  

 Send the consolidated Line Item BP to the next Workflow step 

1) On the Edit Studio window, click the Consolidation tab. 

The Consolidation tab displays any business processes that have already been selected for 
consolidation. 

2) In the Line Item Consolidation area of the window, use the information in the following 
table to complete the fields. 

In this field: Do this: 

Do not allow consolidation from 
[business process] 

This field will display the name of the business 
process you are designing. 

Select this check this box if you do NOT want users 
to consolidate line items from this business 
process. If you select this check box, the business 
process will not appear in the list of BPs from which 
users can choose line items to consolidate. 
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In this field: Do this: 

Previously consolidated lines are 
available when terminal status 
equals 

By default, once a Primavera Unifier user copies a 
line item for consolidation, that line item is no 
longer available for other consolidations. 

Use this field to override the default and specify 
that, once the consolidated business process 
reaches a terminal status, the line items from the 
source BP(s) will be available again. For example, 
if a Change Order that has contributed line items to 
a consolidated BP reaches a "rejected" status, then 
all the line items on the Change Order will be 
available so you can consolidate them again in 
another business process. 

Click Select and choose the BP status at which the 
line items can again be available for consolidation. 
You can select one or more statuses marked 
"terminal." (The list of statuses on this window 
shows a blank first line. You can use this blank line 
to clear any previous status selections.) 

Note: Line items will also be available again for 
consolidation if the line item is deleted from the 
consolidated business process or is terminated. 

1) In the Consolidation Setup area of the window, click the Add button. The Select Business 
Process window opens. 

2) Select the business process that contains the line item(s) you want to consolidate and click 
OK. uDesigner displays the business process in the list. 

3) Highlight the business process that contains the line item(s) you want to set up for 
consolidation. 

4) Use the information in the following table to complete the fields and click OK when finished. 

In this field: Do this: 

Exclude records with 
status 

(Optional) Use this field to exclude line items from the 
consolidation according to their status. 

Click Select and choose the status or statuses you want to 
omit from the consolidation. (The list of statuses on this 
window shows a blank first line. You can use this blank line 
to clear any previous status selections.) 

Data element to show 
consolidated line source 

Use this field to specify a data picker (if the BP form includes 
one). At runtime the data picker will be populated with 
information from the record from which the line item 
originated. This data picker will make it easier for the user to 
see exactly which record the consolidated line item comes 
from. 
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In this field: Do this: 

Prevent consolidating the 
same line item across 
multiple records 

Select this check box to prevent the Primavera Unifier user 
from consolidating line items that have already been 
consolidated. Primavera Unifier will ensure that line items 
can be consolidated only once across all the business 
process records (and under all shells). 

Note: Select this check box to prevent the Primavera Unifier user from consolidating line 

items that have already been consolidated. If this option is selected, the line Items 

cannot be edited, later. Primavera Unifier ensures that the line items can be consolidated 

only once, across all the business. 

Auto-update 
consolidated line items 

This option is available only if you check the Prevent 
consolidating the same line item across multiple 
records option. 

Select this check box if you want the destination line item 
(the one on the consolidated BP) to be updated whenever 
the source line item changes. Exception: Even if this 
auto-update option is checked, the line item on the 
consolidated BP will not be updated with any new 
attachments that have been added to the original line item. 

Line items on the consolidated BP will be read-only if you 
choose this option. 

Updates will not occur if the consolidated line item BP 
reaches a terminal status or if the line item is deleted on the 
source (the originating) business process. 

You cannot use this auto-update option if a cost line item 
contains a YTB (Yet to Buy) data source, or an AFC (Allow 
for Change) data source. 

Primavera Unifier will not update fund codes and amounts 
on line items consolidated from Cost business process 
sub-types of Line Items with Fund Code or Line Items with 
Both CBS and Fund Code. 

Record Properties 

You (the designer) can hide tabs that can be seen in all business processes (company, shell, 
and project levels), in user mode. To do so, you can use the Record Properties tab.  

The Record Properties tab enables you to hide the properties tabs form an upper form or detail 
form, or both. All business processes (at company, shell, and project levels) have Record 
Properties tab in their properties window.  
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Hide Upper Form Properties 

This block in the Record Properties tab enables you to hide the following tabs from a selected 
BP record properties (upper form): 

 Attachments

 Comments

 Linked Records

 Linked Mail

 Workflow Progress

 Audit log

 Reference Records

By default, these options are not checked. You can select one or multiple check boxes in order 
to hide additional tabs seen in business process record at run time. 

Based on your selection, the upper form properties seen will be applicable to the following types 
of BPs (at company, shell, and project levels): 

 Text BP 

 Simple BP  

 Line item type BP 

 Cost type BP 

 RFB BP - Requestor Forms 

 Time Sheet BP 

 Document type BP 

Example 

If the Attachments tab in property (under Hide Upper Form Properties) is checked, then the 
Attachments tab will not be visible when the user accesses the BP record from browser or 
through mobile app; however, the user is still allowed to: 

 Add attachments using the CSV import or Restful services methods. 

 Retrieve attachments using getCompleteBPRecord call even though the tab is hidden 
from the user interface. 

Note: When the Upper Form properties that are checked in uDesigner, 
the corresponding tabs will be hidden at run time in business process 
record. The visibility of tabs are applicable to the user interface only. 

Additional information regarding the Hide Upper Form Properties: 

In Document type BP, the Attachments option will not be available in the Upper Form 
Properties. 

Hide Detail Form Properties 

This block in the Record Properties tab enables you to hide the following tabs from a selected 
BP record properties (detail form): 

 Attachments

 Linked Records
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These additional tabs are available for each line item tab selected in the record at run time. By 
default, these options are not checked. You can select a check box to hide the additional tab 
seen for the line items per line item tab at run time. 

Based on your selection, the detail form properties seen will be applicable to the following types 
of BPs (at company, shell, and project levels): 

 Line item type BP 

 Cost type BP 

 RFB BP - Requestor Forms 

 Time Sheet BP 

 Document type BP 

Note: When the Detail Form properties that are checked in uDesigner, 
the corresponding tabs will be hidden at run time in the business process 
record. The visibility of tabs are applicable to the user interface only. 

Additional information regarding the Hide Detail Form Properties: 

 The Linked Mail option will not be seen for the company level business process. 

 The Workflow Progress option will not be seen for the non-workflow BPs. 

 The Attachments option will not be available for the Document type and text type BPs. For 
the Document type BP additionally 

 The Attachments and Linked Records properties will be disabled for the Payments with 
SPA type BP standard tab. 

 The Record Properties tab will be editable in the published designs. You can change the 
visibility of the tabs, in the design, both for unpublished and published designs. 

 In the RFB BP, the record tabs restrictions will be applicable to requestor forms, only. 

 The Hide Requestor Detail Form Properties section will show detail forms that are defined 
in requestor, only. 

 The selected tabs will be hidden only when the requestor is accessing the records in user 
mode. 

 The bidders will always see both the Attachments and the Linked Mail tabs, when they 
receive the bids--whether the bidders are viewing requestor or bid form. 

 In the Detail Form Properties for the system-defined tab, the Attachments option will be 
disabled since "attachment" is a line item in the Document type BP. You cannot hide 
attachments from the system-defined line item tab. 

Data Picker 

Data pickers work with the master business process logs, shells, and configurable managers 
that function across a shell hierarchy. The purpose of a data picker is to make it easier for the 
user to choose records: 

 From a master business process log 

 From a class in a configurable manager that operates across shells 

 For auto-creation across shells 
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In operation, a data picker navigates to a specific business process, shell, or configurable 
manager, and then extracts the records to display on the list by using a query the Unifier 
Administrator has set up. 

Data pickers, including user data pickers, must be configured to examine and extract the records 
that should appear on the picker list. To do this, you need to create a database query. 

Once you have set up the query or queries for a data picker, and the picker is active in Unifier, 
the queries will be launched whenever: 

 The user clicks the data picker field on a form 

 The business process or line item is auto-created 

 A record is created or updated through integration (both CSV and Web Services) 

 The data picker is updated via reverse-auto-population 

In addition to setting up queries to extract records for the picker, you can configure the picker to 
filter the records that the query returns so that only certain records appear on the picker. This is 
particularly convenient, for example, if the form contains a user data picker that automatically 
assigns users to a business process as it is created. 

For more information on data pickers, see About Data Pickers (on page 195) and About User 
Data Pickers (on page 198) in this guide. 

Configure Data Picker 

To configure a data picker: 

1) Go to Company Workspace tab, switch to the Admin mode, and click the uDesigner node 
to expand. 

2) Click the Business Processes sub-node to open the Designer-Business Processes
window. 

3) Click to select your BP (the BPs have been imported into your company) and click Open to 
open the window with the BP Description. 

4) From the toolbar, click Open to expand the options and click Data Picker to open the Data 
Picker Configuration window. This window has two panes. The left-hand pane lists a 
hierarchy of the data elements. The right-hand pane displays the details of the query 
conditions for a selected data element. The query will search the database and extract the 
records to display on the data picker. The query will filter the records returned from the 
database according to a condition or conditions you specify. The condition(s) will "test" a 
field on the form to see if it passes or fails the criteria. If the field passes the criteria, Unifier 
will include it on the data picker. 

5) Select a data picker from the left-hand pane to see the Query Condition block on the 
right-hand pane. 

6) Click Add to open the Add Query Condition window. This window displays the following 
fields: 

 Data Element

 Condition
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7) Click the Data Element drop-down and select the field on the business process that you 
want to test with the condition. Depending on your selection, the fields in the Add Query 
Condition window will change. That is to state that the remaining fields on this window vary, 
depending on the data element and the condition you specified. The query will search the 
database and extract the records to display on the data picker. The query will filter the 
records returned from the database according to a condition or conditions you specify. The 
condition tests a field on the form to see if it passes or fails the criteria. If the field passes the 
criteria, Unifier will include it on the data picker. For example, the condition might be that the 
status field on the shell must be "Active." The window expands to show an active Condition 
field and additional fields where you can specify the query criteria. 

Note: If any field in the query or queries is subsequently removed from 
the configurable manager attribute form, the entire query operation will 
be ignored. That is, if one query fails because a field was removed from 
the design, Unifier will ignore all the queries. If a field has been removed 
from a design, you must amend the query. 

8) Click the Condition drop-down and select the condition the value in the field must meet.  

9) If applicable, provide other values. 

10) Click OK. 

To include additional query conditions, repeat the steps above. You can select an added query 
condition and select the Show results matching any condition to include other available 
conditions. 

To modify a data picker, select the data element in the Query Condition block on the right-hand 
pane, and click Modify. 

To remove a data picker, select the data element in the Query Condition block on the 
right-hand pane, and click Remove. 

Using Filters 

In a user data picker (see About User Data Pickers (on page 198) for more details), the Data 
Picker Configuration window, you have the option of setting filters, under the Additional Filter
block. This filtering option appears on configurable manager attribute forms that contain user 
data pickers. This option will filter the list of groups or users that appear on the picker. Use the 
instructions in the table below to filter the returned records. Use the information included in the 
following tables to determine filtering: 

Additional Filter
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Filter list of 
Users/Groups based 
on Project/Shell 
Membership

Select this checkbox if you want to filter the list of users on the 
picker to show only those with project or shell membership. 

In operation, Unifier will auto-populate and 
reverse-auto-populate the data picker with all users or groups, 
regardless of this checkbox. However, at runtime, Unifier will 
filter the picker for the user if you select this checkbox. 

Note: If you select this option, the rest of the filtering options 
will be disabled. 

Apply User 
Attributes to the 
picker log and 
display element 
from Project/Shell 
directory

Select this option to enable the system to apply the user 
attribute values of the project or shell directory to picker log, 
display element of the data picker, auto-population, and reverse 
auto-population fields that use this data picker as their source. 
The system uses the same user attribute values in both the 
CSV file and the Web Service integration. 

Group Membership Select the group from which you want to specify a user or 
users. The drop-down list shows all the groups that are at the 
company level. 

Project/Shell Membership

Add user to 
Project/Shell.

Note: To use this option, the user data picker must be on the 
upper form, not the detail form. 

Select this option if you want Unifier to add these users to the 
shell membership. 

Add user as a 
member to the 
selected group.

Note: To use this option, the user data picker must be on the 
upper form, not the detail form. 

Select this option if you want to also add these users to the 
group under the shell. 

BP Line Item Data Picker 

The BP Line Item Data Picker (upon configuration) can reference any BP Data Picker available 
in the BP design.  

If BP Line Item Data Picker is added in detail form, it can be referenced to any of the BP Data 
Pickers added in the upper as well as detail forms of BP design.  

If BP Line Item Data Picker is added to the upper form, it can be referenced to only those BP 
Data Pickers which are added in the upper forms of BP design.  
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Note: You cannot assign same Line item Data Picker to more than one 
BP Data Picker. 

If a BP Data Picker is moved to the line item after being associated to Line Item Data Picker and 
Line Item Data Picker is defined in upper form then completing the BP throws an error. BP Data 
Picker cannot be placed in detail form if the associated Line item Data Picker is in upper form. 

To configure a BP Line Item Data Picker:  

1) Go to the Company Workspace tab and switch to Admin mode. 

2) Click uDesigner > Business Processes. The Business Process window opens displaying 
the BPs. 

3) From the right pane, open a BP. 

4) Click Open > Data Picker. The Data Picker Configuration window opens. 

5) In the left pane, click a data element. 

6) In the right pane, select Allow Line Item Referencing to enable you to refer to specific line 
items. 

Note: You should be able to select this option only if the data source (source BP) of the BP 
Data Picker has line items. 

The line items are: 

 Destination Element- Select the data element (of Data Definition "BP Line item DP") 
that should be populated. The list displays all the BP Line item data pickers that are 
added to the upper or detail form of the BP design, depending on the position of the Line 
Item Data Picker. If DP is added to the detail form and the Line Item Data pickers added 
in the upper form are linked, then an error is displayed. 

Note: Once the Business Process having this data picker configuration is published, 
destination element changes to read-only. You cannot change the Line Item Data Picker 
Data Element after design is published. This is to avoid showing incorrect data in line item 
data picker at run time. 

 Source Element- Select the field in the referenced line items. The list displays all the 
fields in line items of the data source (Source BP) of the BP Data Picker.  

Note: Source Element does not show linked data elements and standard data elements. 

 Source BP- This field is auto-populated with Source BP name once you select Allow 
line item referencing. If the Source BP design is in Draft status, an error is displayed 
during error check.  

 Source Referencing Element- Select the field or picker on the referenced line item that 
should be updated with the ID of the record from which the line item was selected. This 
displays a list of BP Pickers, BP Data Pickers, and BP Creators on the Reference 
Process BP that have a type of the current BP. 

Note: At runtime, if you use a BP Line Item Data Picker to select a line item and send the 
record forward, the source referencing element will be updated to show the ID of the record 
from which you picked the line item. At runtime, if you delete the line item that updated this 
source referencing element, or clear the line item picker, the system clears the field. 
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7) All Line Item tabs (not QBTs) of the source BP should be listed in the Query Conditions for 
the Line item Data Picker. 

8) Query Condition for Line Item Data Picker should show all line item tabs of the source BP in 
the left pane. In the right pane you should be able to define query conditions based on data 
elements defined in that line item tab. 

9) If the Hide option is selected, the Line Item tab will not be displayed at run-time for selection. 
You cannot hide all tabs in the configuration. At the least one tab should be visible. 

10) Define queries for each Line Item in the same way that queries are defined for Data Pickers. 

11) On selecting a Line item from the list, you can define the Query condition for the particular LI. 
On clicking Add, the Add Query Condition window is displayed. 

12) In the Data Element field, all the Data Elements for the specific Line Items are available for 
selection. The values in the Condition field are dependent on the data element selected. 

13) In Values, if Dynamic is selected, in Data Source, all existing data sources of Data Pickers 
such as Destination BP Upper Form, or Detail Form, or Single record BPs, or Shells are 
selected. 

Note: You cannot change Line Item Data Picker DE itself in the Data Picker Configuration 
once the design is published and there are records at runtime. If you change to a different 
Line Item Data Picker DE in the destination element or deselect Allow Line Item 
Referencing, Unifier displays the message: "Cannot change Line Item Referencing 
Destination Element <Line item Data Picker DE> in published Data Picker configuration <BP 
Data Picker DE>." BP Data Pickers that are linked to Line item data pickers cannot be reset. 

Data Elements 

The Data Elements Configuration window enables you to setup for both unique (Unique) and 
auto sequence (Auto Sequence) Data Elements. To access the Data Elements Configuration
window: 

1) Go to the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click the uDesigner node to expand, click the Business Processes
sub-node to open the Designer-Business Processes window. 

3) Click to select your BP (the BPs have been imported into your company) and click Open to 
open the window with the BP Description. 

4) From the toolbar, click Open to expand the options and click Data Elements to open the 
Data Elements Configuration window. The window displays the following tabs: 

 Unique

 Auto Sequence

The following explains details about each tab. 

Unique Tab 

Business processes can have values specified on the upper form only that enable unique values 
in fields. This feature is available for Company level and project/shell level, and can be used on 
workflow and non-workflow business processes. 
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You can configure unique value validation on data elements on business process upper forms. 
For example, if a business process has a field called Invoice, and you need to enforce that each 
invoice number is a unique string, you can configure this field to have a unique value. If the user 
attempts to enter a string that is not unique (has been entered on another business process), the 
user will get a warning message that an alternate value must be entered. 

You can use up to five data elements on a business process upper form that enable unique 
values. This feature is available only on upper forms. 

Note: You can specify that a field that has been configured for 
auto-sequencing also have a unique value. 

Field value uniqueness is validated when: 

 Records are created through integration (CSV or Web Services) 

 Auto-population occurs 

 A business process is routed 

 Reverse auto-population occurs 

To configure the unique values for your data element: 

1) Go to the Data Elements Configuration window and click the Unique tab. 

2) Click Add to open the Select Data Element with Unique Value window. 

3) Select a data element to configure for unique values (Data Element drop-down). The text 
string data elements from the business process Upper Form are listed. 

Note: The unique value option is not available on Detail Forms. 

4) Select a level (Company or Project/Shell). 

If you select Company, the system enforces unique values in the selected data elements on 
all records in the entire company. 

If you select Project/Shell, the system enforces unique values across all records in the 
current project or shell. 

5) Click OK. 

6) Click Apply and then OK. 

To modify the unique values: 

1) Go to the Data Elements Configuration window and click the Unique tab. 

2) Click the data element that you want to modify, to select. 

3) Click Modify to open the Select Data Element with Unique Value window. 

4) Modify the fields that you want. 

5) Click OK. 

6) Click Apply and then OK.  

To remove the unique values: 

1) Go to the Data Elements Configuration window and click the Unique tab. 

2) Click the data element that you want to remove, to select. 

3) Click Remove. 
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Note: Data elements that are removed from the design in uDesigner are 
listed in the Data Elements Configuration window in red and can be 
selected and removed. 

Auto Sequence Tab 

Business processes can have values specified on the upper or lower form that enable 
auto-sequencing. This feature is available at company, shell, and project levels and can be used 
on workflow and non-workflow business processes. 

You can configure auto-sequencing for certain data elements on a business process form. This 
is in addition to the standard business process numbering, and allows you to number up to two 
fields on a upper form, and two fields on a lower form. For example, you can specify that a 
Name field uses auto-sequencing in order to number business processes that have similar 
names. 

The data elements that support auto-sequencing use the SYS Auto Sequence data definition 
configured in uDesigner. You can use up to two data elements on a business process upper 
form and lower form that enable auto-sequencing. 

Auto-sequencing generation occurs when the user clicks: 

 Send on workflow business processes 

 Save on non-workflow business processes 

 Finish Editing on non-workflow business processes for line items 

 Apply or OK for line items 

Note: The new records will pick up the new start value. 

To configure the auto-sequencing for your data element: 

1) Go to the Data Elements Configuration window and click the Unique tab. 

2) Click Add to open the Select Data Element for Auto Sequence window. 

3) Select a data element to configure for auto-sequencing (Data Element drop-down).  

 All upper and lower form data elements of the type String and that were created using 
the SYS Auto Sequence data definition are listed. 

 The upper form data elements are distinguished by the list format Upper Form or <data 
element>. The detail form data elements are listed by the data element names only. 

4) Select a level (Company or Project/Shell). 

If you select Company, the system generates the auto-sequencing across all records in the 
entire company. 

If you select Project/Shell, the system generates the auto-sequencing across all records in 
the current project or shell. Per Record indicates data elements at the line item level (detail 
form). 

5) In the Start field, specify that the start date is a numeric value. The default start number is 
0001. This value is required. The sequence number generated for the field will start with this 
number. 
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6) From the Format block, click Create to open the Formula Creation window. You can 
specify the format for the auto-sequencing in this window. 

The Formula Creation window shows a list of String type data elements available from the 
form, and an additional system-defined data element, SYS Sequence Counter. This counter 
represents the value you entered in the Start field on the Add Auto Sequence Data 
Element window. You must use this counter when you build your formula for 
auto-sequencing. 

7) Choose Delimiter, then choose a data element from the list, and click Add Parameter. Add 
the delimiter, then choose the SYS Sequence Counter and click Add Parameter to build a 
formula to increment the auto-sequence counter. Build the formula by using the data 
element, the delimiter, and the SYS Sequence Counter in combination. The SYS 
Sequence Counter can appear first or last in the formula. For example: 

Data Element 1 - SYS Sequence Counter. 

If the data element is a document name, an example of the resulting auto-sequenced data 
element could be Building Specification-0001 

After the auto-sequence value is generated by the system, it cannot be modified, however 
you can modify the auto-sequencing configuration. See the procedure below. 

Note: An auto-sequence value will not be generated if any of the data 
elements that are part of the formula you specify do not have values. 
This includes the SYS Sequence Counter value. 

8) Click OK. 

9) Click Apply and then OK. 

To modify auto-sequencing configuration: 

1) Go to the Data Elements Configuration window and click the Auto Sequence tab. 

2) Click the data element that you want to modify, to select. 

3) Click Modify to open the Select Data Element for Auto Sequence window. 

You can modify the Level, Start, and Format as needed. Changing these values affects new 
records only. Existing auto-sequenced records are not changed. Any changes will take affect 
based on level selected before the change. 

 If Company is the initial level and data was created, and the level is changed to 
project/shell, the format will be the only value that will take affect 

 If project/shell is the initial level and data was created, changing the start value will affect 
the sequence created under new project/shells 

 Changing the format will affect existing and new project/shells. 

 If you change the level to Company then the sequence number will be created across 
project/shells and any modification to the start value will be ignored. 

 For data elements on the detail form, you cannot modify the level; the only level 
applicable is per record. 

You cannot remove auto-sequencing data elements unless the data element has been 
previously removed from the design in uDesigner. Data elements that are removed from the 
design in uDesigner are listed in the Data Elements Configuration window in red, and can be 
removed. 
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4) Click OK. 

5) Click Apply and then OK.  

To remove auto-sequencing configuration: 

1) Go to the Data Elements Configuration window and click the Auto Sequence tab. 

2) Click the data element that you want to remove, to select. 

3) Click Remove. 

When setting up auto-sequencing, you have the option of defining how the sequencing can be 
incremented:  

 Based on the unique value of the combination of the values in the formula 

 Not based on the unique value of the combination of the values in the formula 

When the Generate number based on unique values of the parameters used in the format
option is selected in uDesigner, the usere can increment the auto-sequencing pattern. For 
example, in your documentation, for your electrical designs, you can select to generate one of 
the following auto-sequencing formats, or patterns: 

Discipline + Doc Type + <seq no> which would result in: 

 Electrical-Design-00001 

 Electrical-Feasibility-00002 

Discipline + Doc Type + <seq no> which would result in: 

 Electrical-Design-00001 

 Electrical-Feasibility-00001 

In the Select Data Element for Auto Sequence window, you can click to select the Generate 
number based on unique values of the parameters used in the format option (unchecked by 
default) when there are more than one parameter in the auto-sequence definition (the definition 
should have a parameter other than just the SYS_Sequence_Counter). This option is available 
for BPs, and it can be changed at any time including when the design is published. 

The first time that you select this option, the sequence numbering will start from the value 
specified in the Start field of the Select Data Element for Auto Sequence window. 
Subsequently, the numbers will get incremented based on the last generated number. 

If you deselect this option (not to generate the number based on values in the parameters), then 
the sequence will continue from the previously generated number, unless the value in the 'Start' 
field has changed. For example: Document Number = Company > Discipline > Report Period > 
SYS_Sequence_Counter 

Unifier ignores the parameter values when a sequence number is incremented. For example: 
Architectural and architectural will be treated the same. 
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Note: Unifier ignores spaces in the values of the parameters. 

Gaps in Generated Business Process Record Number 

Business Process (BP) record number is sequentially generated when you create a new record. 
The newly generated record number is locked so that other records (being created at the same 
time) cannot use that number. If the BP record cannot be created for any reason (for example, 
Cost Sheet rules or validations that exist at the SOV level), then Unifier only voids the generated 
record number and does not reset the record numbering sequence to allow another BP record to 
pick up that generated number. This operation generates gaps in BP record number generation.  

Designing a Form 

All Primavera Unifier components (business processes, shells, managers, asset classes, plans, 
etc.) are presented to the user as forms. In Primavera Unifier, these forms drive the business 
processes and contribute most of the data that will be used in Primavera Unifier. Forms differ 
according to their purpose. Most forms will become attached to the steps in a workflow; others 
define and create Primavera Unifier components such as asset classes, plans, resources, shells, 
and managers.  
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For most business processes, forms will become attached to the steps in a workflow for the 
purpose of exchanging information. As part of the workflow, users will use these forms to 
collaborate as a team to complete the business process. The users will fill in the workflows with 
the "who, what, where, and when" information, as well as other information they will need to run 
the project—to maintain action items, manage document archiving, track workflow tasks and 
milestones, communicate and collaborate with project team members, and generate project 
reports. The form you create in uDesigner is what the user will use in Primavera Unifier.  

Design Approach for a Workflow Business Process 

Many forms use workflows; a good design approach is to outline the workflow first to understand 
what kind of forms you will need at each step. Once you have a good understanding of the 
workflow and what forms will be necessary, you can create the forms and then assign them to 
the appropriate steps as you create the workflow. 
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View vs. Action Forms in a Workflow 

Part of understanding the workflow is considering each phase of a step. For most steps, there 
will be a "viewing" phase and an "action" phase. As a business process arrives at each step in a 
workflow, Primavera Unifier notifies the appropriate users if they are involved in the step. When 
they open the notification, Primavera Unifier displays a view-only form of the step's task. Each 
user can choose to accept or decline the task implicit in this form. If the user declines the task, 
the step ignores the user. If the user accepts the task, the form becomes an action form where 
the user can enter or edit information and attach comments, line items, or documents, and 
forward the form on to the next step in the workflow. 
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You will be designing the "view" and "action" forms for each step in a workflow. In the example 
below, the view phase is the first half of the step, marked in red, and the action phase is the 
second half of the step, marked in green. The toolbar options change from Accept and Decline 
to Send and Save. Clicking Send on the action form will route the record to the recipient in the 
view phase once more, for acceptance or rejection. 
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What Users Can Do 

On a view form On an action form 

 Accept the task 

 Decline the task 

 Print the form 

 Terminate the record 

 Send email 

 Transfer ownership of the record 

 Add an assignee to the current step 

 Copy users to the current step 

 Audit the progress of the record 

 Undo the task acceptance (decline the 
task) 

 Select the step's next action 

 Add or edit form content 

 Save a draft of the record 

 Terminate the record 

 Transfer ownership of the record 

 Display the view form of the BP 

 Audit the progress of the record 

 Spell check the record content 

 Add attachments, line items, etc. 

 Send the form to the next step 

Overall Steps in Designing a Form 

Here is an overview of the steps involved in designing a form: 

Note: It's a good idea to have a draft of each form at hand; this will make 
creating the form easier. 

1) Designing an Upper Form (on page 257). 

 Name the form. 

 Specify what the user can do with this form. 

 Add content to the form (blocks and data fields). 

 Include formulas for appropriate fields. 

 Auto-populate fields, if appropriate. 

 Add linked elements from shell attribute forms, single record BPs or activity sheet. 

2) Designing Detail Form (on page 291), if appropriate. Include optional features: 

 Adding an Item Log to a Detail Form (on page 291) 

 The information entered into this list appears at the bottom of a form. 

 Starting Detail Forms for Multiple Tabs 

 These tabs are an effective way to organize business data into separate line item lists. 

 Adding a Text Entry Area to a Form (on page 354) (for a Text business process) 

 The information entered into this form, such as meeting minutes, appears at the bottom 
of the form. 

 Adding a Response List to a Text Business Process (on page 354) (for a Text 
business process) 
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 The information entered onto this list, such as text comments or file attachments, appears 
at the bottom of the form 

 Selecting Fields for an Email Notification (on page 338) 

 Select fields to include on email notifications to employees who are out of the office 
regarding workflow tasks.  

 Selecting Fields for Unifier on Mobile App (on page 339) 

 Select fields to include on mobile devices for users who are working out of the office. 

 Auto-Creating a Record or Line Item from a Form (on page 359) 

 Automatically create a new record or line item based on a condition, such as a dollar 
amount; a frequency, such as a daily or weekly time frame; or both a condition and a 
frequency. 

 Adding a Reference Process to Auto-Populate Data (on page 355) for any form that 
uses a BP picker or line item picker. 

 Reference processes populate the fields on the picker. 

 Other features, such as maps, Validating Field Values (on page 322), Adding 
Formulas to Fields (on page 315), Updating Records Using Reverse 
Auto-Population (on page 328), and Auto-Populating Fields (on page 324) linking 
fields from Shell Attribute forms, or single record Business Processes. 

About Business Process Forms 

There are two types of Business Process (BP) forms: 

 Workflow 

 Non-workflow 

Workflow Business Process Form 

The workflow BP has three sections: 

 Upper Form 

 Workflow 

 Content 

Upper Form

The Upper Form section of a Workflow BP form contains the basic information the form is 
managing, such as the name of a record and its description, who created the record and when, 
and so on. It also contains general data entry, informational, summary, or reference fields. 

Workflow (Task Details) 

The Workflow or Task Details section of a Workflow BP form shows the details of the step the 
form is currently on, including the last person who took action on the form, the status of the step, 
the due date for the task, and any notes that have been included at this step. Depending on how 
the workflow has been set up, the next assignee(s) for the task may be pre-determined (as in the 
example above), or the user may need to specify the next assignee or send a copy of the form 
to another user. 



Unifier uDesigner User Guide

254

Content (Lower Form) 

The Content or Lower Form section of a Workflow BP form shows information that has already 
been attached to the form, such as a line item, a document, or response comments for an RFI. 
The information displayed in this part of the form is entered by way of a Detail Form that the user 
completed when the user accepted the task. 

Non-workflow Business Process Form 

In terms of the form construction, the non-workflow BP form is similar to the workflow BP; 
however, the non-workflow BP form allows you to toggle between Read-only and Edit modes. 

What Goes on a Form 

Forms are composed of blocks and fields. Each block can contain one or more fields which you 
can fill with data elements.  

Data Elements (DEs) 

A Data Element (DE) can be: 

 A text box, where the user types in information. 

 A drop-down (pull-down) menu of choices (also known as a picker) such as dates or names. 

 Radio buttons, where the user must select one of the options presented. 

 A check box, where the user has the option of choosing something or not. 
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Refer to the Unifier Data Reference Guide for a list of these elements, along with a description of 
what they do and where to use them. 

You can also add new elements as your company requires them. (For instructions on creating 
new data elements, see Creating a Data Element (on page 205) in this guide. 

Pickers 

Unifier contains a substantial number of pickers. These pickers are important elements for forms 
and a basic understanding of them will help you know where to include them on your forms. 
Refer to the Unifier Data Reference Guide for a list of these pickers, along with a description of 
what they do and where to use them. 

About Upper Forms 

Business processes must contain an upper form. This part of the form holds the basic 
information the business process is managing, such as the name of a record, its status, a 
description of the business process or step, who created the record and when, and so on. It also 
contains general informational or reference fields.  

For business processes with workflows, you can design multiple upper forms—a different one for 
each step in the workflow, if necessary. Different upper forms are often necessary to 
accommodate cases where fields on the form must change from enabled to disabled, or where 
some fields should appear or not appear, depending on whether or not they are relevant to the 
step. 

Note: If your business process includes multiple workflow schemas, the 
number of different upper forms can increase in proportion to the number 
of steps in every schema. The one constant, however, is that the upper 
form at the end step of all schemas must be the same. 

About Detail Form 

Unifier provides detail forms in cost, line item, Request for Bid, schedule, resource, and 
document management business processes, as well as asset classes, plans, shells, and 
configurable managers. Users use them to enter information for these elements, such as line 
item details for a business process, new plan information for the Planning Manager, or new 
activity information for schedules. For shells, detail forms are for creating new sub-shells in a 
hierarchy. For configurable managers, they are for entering new items onto the manager's 
tracking sheet. 

Detail forms can also be used to create multiple tabs for organizing line item 
information. See Organizing Data with Multiple Tabs (on page 294). 

A detail form opens as a separate window in Primavera Unifier, where users enter or modify 
information. The fields on the detail form, and the information the users enter, are then 
displayed: 

 At the bottom of the form. 
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 On a line item list, attached document, or response area. 

 Other parts of the Primavera Unifier interface, such as a planning item log or a schedule. 

Primavera Unifier automatically creates a detail form whenever you create these types of 
business processes, generic managers or other components, except for document BPs: Detail 
forms are optional for document BPs. 

Action Forms and View Forms 

Action Form  

The Action form is the version of the business process form that opens when the recipient 
accepts the task implicit in the form. As a business process arrives at each step in a workflow, 
Unifier notifies the appropriate users if they are involved in the step. When the users open the 
notification, the application displays a view-only form of the step task. If the user accepts the 
task, the form becomes an action form where the user can enter or edit information and attach 
additional documents.  

View Form 

The View form is the read-only version of a business process form that appears when the 
recipient first opens the form. The fields cannot be edited. A View form may also be used when 
the designer does not want the user to be able to change the data on the form. 

Note: Business process forms can only be printed from a View form. 

To accommodate both view-only and action forms for a workflow step, you will need to create 
both forms and then specify which form should be used at the step's entry and which form 
should be used when the user accepts the task (see Adding Steps to the Workflow (on page 
396)). 

A quick way to create the action and view-only forms is to copy one form from another and 
change the fields to "editable," "required," or "read-only" as necessary. You can also add or 
remove fields as appropriate for the form. 

You (the designer) can create a View form so that based on the user persona, the data that is 
seen in the form can be controlled at runtime.  

For a non-workflow business process can have multiple view forms. This is so you can create 
multiple view forms and for each of the view forms you can decide what data can be put in the 
form. 

Note: Previously, a non-workflow business process had only one form 
that held all the data. This form was the Action form.  

A non-workflow BP design (in uDesigner) will be similar to a workflow BP design, except that a 
non-workflow BP can only have one Action form and there will be no workflows. 

You can create View forms for: 

 Non-workflow BPs regardless of the Type 

 Non-workflow BPs existing at both Project and Company Level 
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 Non-workflow BPs of both Single Record and Multiple records 

Note: Unifier validations are applicable to all of the above. 

If you have any custom data elements in the View form, those custom data elements must be 
added to the Action form. 

Designing an Upper Form 

An upper form is the upper portion of a business process form. The upper form contains the 
basic information that the form is managing, such as the name of a record and its description, 
who created the record and when, and so on. The upper form also contains general data entry, 
informational, or reference fields for the business process form.  

For certain business process types, the upper form can also show a consolidation of the line 
items from a detail form. 

Note: You can define validation rules on an upper or detail forms; 
however, when you want to set validation rules for the Currency Amount 
or Decimal Amount data elements, Oracle recommends that you use 
conditions such as data element less than 0.001 (or greater than -0.001) 
instead of using zero, in the validation rule definition. The conditions 
such as the data element equal to zero can be set on the Integer type 
data elements.  

You can define validation rules on an upper or detail forms; however, when you want to set 
validation rules for the Currency Amount or Decimal Amount data elements, Oracle recommends 
that you use less than 0.001 (or -0.001) and do not use zero, for the amount in each data 
element.  

To design an upper form: 

1) Click the Company Workspace tab and switch to Admin mode. 

2) From the left Navigator, click uDesigner > Business Processes. 

3) Open the business process for which you want to create the upper form. 

4) From the left Navigator, click Upper Forms. The Forms log or window or pane opens. 

5) On the Forms pane, click the New menu option and choose Manual. The Form Design
window opens showing the General tab and Options tab. 

You can design an upper form by way of selecting the other options listed in the New menu 
option and: 

 Creating an upper form from a copy of another business process form. 

To do so, click New > Copy From to open the BP Upper Forms window. Select a BP 
that you want to copy its upper form, from the list, and click Copy menu option. 

 In the General tab, enter a valid upper form name in the Name field, provide a 
brief description, and specify whether this will be an action form (Action Form) 
or a read-only view form (View Form). 
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 In the Options tab, select the required actions and click OK after you finish 
selecting the options for Attachments to overall record, Source, Publish to 
Document Manager, Document Manager Attributes, and Additional fields. 
You can see your copied upper form on the Forms pane. 

 Creating an upper form from a snapshot of another form in the business process. 

To do so, click New > From Snapshot to open the Select Snapshot window. Select a 
BP snapshot that you want to copy its upper form, from the list, and click Open menu 
option. In the General tab, enter a valid upper form name in the Name field, provide a 
brief description, and specify whether this will be an action form (Action Form) or a 
read-only view form (View Form). For more information about snapshot, see Restoring a 
Version of a Design (on page 375). 

6) On the General tab, enter a name (required field) and description for the new upper form. 

7) Specify whether this will be an action form (Action Form) or a read-only view form (View 
Form). 

8) Click the Options tab. 

This tab displays different options, depending on the form you are creating and whether it is 
a view form or an action form. For more information, see the Upper Form Options topic and 
subtopics. 

For view forms, the Options tab appears only on line item type and cost type BPs. 

9) Use the following information to complete the Options tab and click OK when finished. 

uDesigner displays the name of the form on the Forms pane. To complete the form, use the 
instructions in the following sections: 

 Adding Blocks to a Form (on page 271) 

 Adding Fields to the Form (on page 304) 

 Adding Link Elements to a Form (on page 386) 

If the Options tab shows the following fields, proceed to select the check boxes as described for 
each field, below: 

Allow linking Mailbox

Select the check box if you want the user to link Mailbox messages to the form. 

Attachment Source

Add attachments or line items from the Primavera Unifier Document Manager (Primavera 
Unifier Folders), or from the user's local machine (My Computer). 

Attachments to overall record

 Add, remove, and copy attachments to line items (see Attachment Source below). 

 Also, for Document Type business processes only, the ability to Append Line Items Folder 
Structure to AutoPublish Path. This means that if a Document Type business process has 
a folder structure, the automatic publishing path specified in uuu_dm_publish_path is 
appended to the path designated by that folder structure. For example, if the Document Type 
business process has the folder structure State/County/City, and the automatic publishing 
path is Street/Builder, the complete path would be:Street/Builder/State/County/City. 

Comments
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 Add comments to the record 

 Mark comments as "final," and therefore, not changeable 

Funding Options

 For General Spends and Payment Applications, you can specify these options: 

 View Fund Assignment to allow users to view funding assignments. 

 Allow Fund Assignment to allow users to assign funds. To assign funds, the user must 
also be able to view fund assignments. If you give the user fund assignment permission 
here, the user will be able to assign funds when the record reaches a terminal status, 
even if the record has not reached the end of the workflow. 

 For Base Commits and Change Commits, you can fund by contract by specifying these 
options: 

 Allow Viewing of Fund Information to allow users to view funding information. 

 Allow Funding to allow users to create and access Commitment Funding sheets. 

 In all cases where funding is available, a Funding button appears on the form toolbar at 
runtime. 

Send bid invitations and allow bid receipt

If this is an RFB, use this feature on the Requestor form you create for the workflow step that 
makes the form available to bidders. This field should appear on the Requestor action form 
only; not the Bidder action form. See Request for Bid-type (RFB-type) BP Upper Forms
(on page 281). 

Use Master Vendor list filtered at Project level

If you have designed a BP that filters the company's vendor list (Master Vendor List/Vendor 
Master List) into a sub-set of vendors, you can use this feature on the Requestor form. This 
option bypasses the company's master vendor list and uses the project vendor list instead. 

Note: For an RFB that goes out for public bidding, Primavera Unifier will 
ignore this option and use the company's master vendor list. 

Do not allow viewing received bids

Use this option to: 

 Hide the Show Bids button, and thereby, prevent anyone (including the requestor) from 
viewing the received bids. 

 Satisfy a business need where you do not want anyone to view the received bids unless 
a specific condition is met; for example, that bids must be received from a certain number 
of bidders. 

Line Items

Note: For some line-item type BPs, the line items can be grouped under
multiple tabs. To specify the options for the line items under each tab, 
click the name of the tab on the left and specify the options on the right. 

If the tab should be hidden (for example, if the user should not see the tab at a particular step in 
the workflow), select the Hide current tab check box. 
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The following sections explain the specific selections. 

For Document Business Processes 

Add, remove, and copy line items 

Modify the line item status 

Modify line items, unless the line item has a specified status 

For Line Item Business Processes 

Add, remove, and copy line items 

Add attachments to line items 

Add summary line item amounts 

Note: If you select this checkbox, a summary of line item amounts will 
become an automatic column (titled "Sm") on the line item log. This 
column may or may not be empty, depending on whether or not there 
are any amounts to summarize. 

Modify the line item status 

Modify line items, unless the line item has a specified status 

For Cost Business Processes 

Add, remove, and copy line items 

Allow modify line items: If compatible with the Cost BP classification, modify line items at any 
time during the workflow before the end step is reached 

Add attachments to line items 

Add summary line item amounts 

Generate Payment Schedule (for Lease BPs) 

Costed Amount must be equal to the line item Amount (Base Commits and Change Commits 
BPs with Schedule of Values (SOV) Summary Payment Applications type) 

In the form design Properties window, Options tab (in the Line Items block), the Display line 
item group total amount option is made available for the Line Item tab in Action Forms (in 
Cost type and Line Item type of BPs.  

Note: For SPA type BPs, and the classic payment application BP, the 
Display line item group total amount option is not available for the 
standard tabs. 

The Display line item group total amount option is enabled and unchecked by default. 

You (the designer) can select the Display line item group total amount option: 
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a) To allow the display of the line item total amount by each group. 

b) When the Allow Add/Remove/Copy line items option is not selected. 

In case of the Line Item type BP, if the Amount data element is not a part of the Detail Form
design, and if the Display line item group total amount option is selected, then when 
completing the business process, Unifier will display the following message: Deselect the 
option 'Display line item group total amount' in form <upper form name> as 
the amount data element is not added to the detail form <detail form name>. 

The Display line item group total amount option is available in view forms. Use this option to 
show the group totals in a view form. By default, the Display line item group total amount
option is not selected. 

For Base Commits and Change Commits Business Processes (SPA of SOV Type) 

The following additional options are available for the Line Items > Standard: 

 Allow Cost Breakdown 

The Upper Forms must have the Allow Cost Breakdown option selected in order to allocate 
costs to a given line item. 

This option allows the user to: 

 Add/remove/copy cost distribution details with cost code allocations to a line item in 
Unifier User mode. 

 Add the remaining quantity, or cost, with a cost code allocation to a line item in Unifier 
User mode. 

 Costed Amount must be equal to the line item Amount 

Ensures that the sum of amounts of distribution lines equals the summary line amount 
(Unifier User mode). 

The Allow Add/Remove/Copy line items option allows user to add the Summary line item, only.  

The Allow Modification of line item option allows user to modify the Summary line item, only. 

If the user does not check the Allow Modification of line item option, but the user selects the 
Allow Cost Breakdown option , then: 

 The Costed line items, added in the Cost distribution grid, modify the Line item at the 
Summary level. 

 The editable fields, at the Summary line item, cannot be modified. 

Additional Information: 

 You are able to hide the Standard detail tab; however, you must keep one tab (at least) 
unhidden in a Business Process that supports multiple tabs. 

 After you deploy a Base Commits BP of Summary Payment Applications SOV type, you 
cannot modify the SOV type in uDesigner. 

 You are not allowed to place the Unit Cost Contract (uuu_unit_cost_contract) data 
element in the Upper Forms for Base Commits, or Change Commits, type BPs with SOV 
type "Summary Payment Applications." 
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 An error will occur after clicking Unit Cost if you do not include the Item Unit Cost and Item 
Quantity (uuu_unit_price and uuu_Quantity) fields in the Detail Form design. 

For Payment Application Business Processes 

The following additional option is available for the Line Items > Standard: 

Costed line item total must be equal to the line item total 

 If this option is selected, then the total amount for the editable Amount fields, from all the 
paid Costed line items, equals the total amount at the Summary line item level, at runtime. 

 For the Payment Application BP that the DE Reference ID (refid) is set to point to a Base 
Commits BP of Summary Payment Applications type, you can include the DEs for Cost 
Code/Code Name on the Standard detail tab. 

For Payment Application Business Processes: Line Items with CBS Code 

The following options could vary between the various forms that are used in the Workflow. At 
runtime, the respective form properties will be retained.  

Note: The form design must include DE Reference ID (refid) set to point 
to a Base Commit BP of SOV type Summary Payment Application. 

The following options can vary between the various forms that are used in the Workflow. At 
runtime, the system displays the respective form properties 

Attachments to overall record  

 Add Attachments 

 Remove Attachments 

Line Items > Standard 

 Hide current tab 

 Allow Add/Remove line items 

 Allow attachments to line items 

 Allow Modification of line items 

This option enables the user to edit the line items once they are created. 

 Allow viewing of Costed line items 

By selecting, or deselecting this option the user can control the visibility of the costed line 
items. Also, the user will have the option to edit the costed line items. This option, when 
selected, enables viewing of costed line items.  

 Allow Modification of Costed line items 

By selecting, or deselecting this option the user can control the editability of the costed 
line items. This option is only available if the Allow viewing of Costed line option is 
selected. 

 Total the Cost Breakdown values to the line item 
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This option (in conjunction with the Summary Total property defined for a field in the detail 
form) will roll up the costed lines total to the corresponding line item field. See Defining 
Summary Totals (see "Defining Totals (Payment Application Grid and Summary 
Payment Application Grid)" on page 340).  

 Costed line item total must be equal to the line item total 

When selected, this option enables the user to perform validations for totals. The existing 
selected option, for the Costed line item total, must be equal to the line item total. 

Runtime Record Behavior

The runtime record behavior for Payment Application business processes of Summary Payment 
Application of SOV type are as follows: 

uDesigner Option Runtime Record Behavior 

Allow Add / Remove / Copy Line items - 
Checked 

Allow Modification of Line items - Checked 

Allow viewing of Costed line items - 
Unchecked 

Allow Modification of Costed line items - 
Unchecked 

Users will be able to: 

 Add new line items 

 Modify the existing line items 

Users will not be able to: 

 View the Costed line items 

 Modify the Costed line items 

Allow Add / Remove / Copy Line items - 
Unchecked 

Allow Modification of Line items - Checked 

Allow viewing of Costed line items - 
Unchecked 

Allow Modification of Costed line items - 
Unchecked 

Users will be able to: 

 Modify the existing line items 

Users will not be able to: 

 Add new line items 

 View the Costed line items 

 Modify the Costed line items 

Allow Add / Remove / Copy Line items - 
Checked 

Allow Modification of Line items - Checked 

Allow viewing of Costed line items - 
Checked 

Allow Modification of Costed line items - 
Unchecked 

Users will be able to: 

 Add new line items 

 Modify the existing line items 

 View the Costed line items 

Users will not be able to: 

 Modify the Costed line items 

Allow Add / Remove / Copy Line items - 
Checked 

Allow Modification of Line items - Checked 

Allow viewing of Costed line items - 
Checked 

Allow Modification of Costed line items - 
Checked 

Users will be able to: 

 Add new line items 

 Modify the existing line items 

 View the Costed line items 

 Modify the Costed line items 

Allow Add / Remove / Copy Line items - Users will be able to: 
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uDesigner Option Runtime Record Behavior 

Unchecked 

Allow Modification of Line items - 
Unchecked 

Allow viewing of Costed line items - 
Checked 

Allow Modification of Costed line items - 
Checked 

 View the Costed line items 

 Modify the Costed line items 

Users will not be able to: 

 Add new line items 

 Modify the existing line items 

Allow Add / Remove / Copy Line items - 
Unchecked 

Allow Modification of Line items - 
Unchecked 

Allow viewing of Costed line items - 
Checked 

Allow Modification of Costed line items - 
Unchecked 

Users will be able to: 

 View the Costed line items 

Users will not be able to: 

 Add new line items 

 Modify the existing line items 

 Modify the Costed line items 

For Request for Bid (RFB) Business Processes 

Add, remove, and copy line items 

Add attachments to line items 

Modify line items only 

For Schedule Business Processes 

Add, remove, and copy line items 

Add attachments to line items 

Add summary line item amounts 

For Resource Bookings and Time Sheet Business Processes 

Add, remove, and copy line items 

Add attachments to line items 

Add summary line item amounts 

For Lease Business Processes 

Add, remove, and copy line items 

Add attachments to line items 
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Add summary line item amounts 

For Project/Shell Creation Business Processes 

Add, remove, and copy line items 

Add attachments to line items 

Add summary line item amounts 

Modify the line item status 

Note: Check this check box, otherwise, the user will not be able to 
change the line item status at runtime in Primavera Unifier. 

For Modifying Line Items 

Unless the line item has a specified status, you can allow users to add an attachment to the 
record only and prevent the users from adding attachments to line items. 

Check the following items on the Options tab: 

 Attachments to overall record: Add and (optional) Remove attachments 

 Line Items: Allow Modify Line Items, except when there is a specified status. 

For Modifying Line Items (Bidder) 

Applicable to bidder line items in an RFB type business process (both private and public bids), 
since a created bid, or a revised bid, can have multiple line items and those line items can have 
information, or updates, instead of creating, or updating, each line item manually (from Grid View 
or Form View), Unifier allows the bidder to update the fields in the multiple line items, or to add 
attachments, by using a CSV template to import the updated line items into the bid request. As a 
result, at runtime, the user can use the Export and Import options in order to export and import 
multiple line items.  

This enhancement enables the bidder to create or update line items in bulk using CSV import 
during the creation or update of their bids. There will be an additional Export and Import options 
available in bid request record when creating or revising bid.  

The Export option has two sub-options: 

 Export Line Item Template

Use to export the CSV template with all the data elements that are in bidder detail form. 

 Export All Line Items

In this scenario: 

 The existing bid line items are those line items that are received from a requestor, and the 
line items that are saved by bidder. 

 A new bid line items are those line items that are newly created by the bidder. 
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This is related to the Bidder: Request for Bid type (RFB-type) BP Upper Forms-Action Form 
(AF). Go to the Company Workspace > Admin mode > uDesigner > Business Processes > 
open RFB BP> Bidder > Upper Forms > select form > Properties > Options tab. See 
Request for Bid-type (RFB-type) BP Upper Forms (on page 281) (Bidder: Request for Bid 
type (RFB-type) BP Upper Forms-Action Form (AF)) for fields. 

Line Items block 

Left pane 

Names of the line items. 

Right pane: 

 Allow Add/Remove/Copy line items

 Allow attachments to line items

 Allow modifying line items

 Allow attachments to the saved line items

Prior to upgrading to the Unifier 20.9 release: 

 If the Allow attachments to line items and the Allow modifying line items only were 
checked, then from the 20.9 release Unifier will automatically check and enable the Allow 
attachments to the saved line items. 

 If the Allow attachments to line items was checked and the Allow modifying line items 
only was not checked, then from the 20.9 release Unifier will automatically deselect and 
disable the Allow attachments to the saved line items. 

 If the Allow attachments to line items was not checked and the Allow modifying line 
items only was checked, then from the 20.9 release Unifier will automatically uncheck and 
enable the Allow attachments to the saved line items. 

 If the Allow attachments to line items was not checked and the Allow modifying line 
items only was not checked, then from the 20.9 release Unifier will automatically uncheck 
and disable the Allow attachments to the saved line items. 

Note: The above applies to the published RFB designs. 

If you do not check the Allow modifying line items, then the Allow attachments to the saved 
line items will be unchecked and disabled. The Allow attachments to the saved line items
will be enabled only when the Allow modifying line items is checked. 

When you select the Allow attachments to the saved line items option, the user will be able to 
add, revise, or remove attachments (when updating the line items both from the user interface or 
CSV import). 

When the Allow attachments to line items option (under the Allow Add/Remove/Copy line 
items option) is checked, the user can add attachments to both: 

 The new line items created by the bidder. 

 The existing line items coming from requestor. 

Notes: 

- After the upgrade to 20.9, the bidders can add, revise, or remove 
attachments only when the Allow attachments to the saved line items 
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option is selected. 

- Unifier does not support the inclusion of the image picker field in the 
CSV import. 

Creating Templates for Upper Forms 

For most companies, the upper forms in business processes contain many of the same fields. It 
can be difficult to ensure that forms are consistent, with fields in the same location for similar 
forms. To make creating upper forms easier, and reduce the chances of errors when 
modifications are made, you can create templates for upper forms so that you do not have to 
design and edit each one manually. When you add blocks from a template to an upper form, the 
template becomes linked to the upper form so that any changes you make to the template can 
be quickly and automatically "pushed" to the upper form. 

A template provides only a layout of fields for the upper form. Once a template layout is on the 
form design and linked to the template, you can use all the design features for the fields, such as 
formulas, auto-population, and dynamic data sets; but you: 

 Cannot add, remove, or rearrange the template fields. 

 Cannot move fields into or out of the template block. 

 Cannot link template elements. 

The procedure that follows explains how to create a template. For information on how to use 
these templates to design an upper form, see Adding Blocks to a Form (on page 271). 

Creating a template 

You can create a template manually, from a snapshot of the template, or copy a template from 
another business process. 

Template "Cans" and "Can'ts"

 When you are creating a template, be aware of the following: 

 The template provides only a layout of fields for the upper form. 

 You can make fields in the template editable, required, or read-only. 

 You cannot create dynamic data sets in a template. 

 You cannot link elements in a template. 

 You cannot validate the fields in a template. 

 You cannot see a preview of the template design. 

 You cannot use any of the functions that are available on the layout properties, such as 
formulas or auto-population. 

To create a template manually 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) Click uDesigner > Business Processes in the left Navigator. 

3) Open the business process for which you want to create a template and click Templates > 
Upper Forms in the Navigator. 

4) From the New menu, choose Manual. A Form Design window opens. 
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5) Enter a name and description for the template. 

The name must be unique. A description is optional, but recommended. 

6) Click OK. uDesigner displays the name of the template on the right pane. 

7) Double-click the template name to open the design window. The Form Designer window 
opens. 

8) Create the template using the instructions under Adding Blocks to a Form (on page 271) 
and also Adding Fields to the Form (on page 304). 

To create a template from a snapshot 

These steps assume that a snapshot has been made of a previous template design. 

1) Open the business process for which you want to create a template and click Templates > 
Upper Forms in the Navigator. 

2) From the New menu, choose From Snapshot. The Select Snapshot window opens, 
showing snapshots that have been taken of the template. 

3) Select the snapshot from the list and click Open. A Form Design window opens. 

4) Enter a name and description for the template. 

The name must be unique. A description is optional, but recommended. 

5) Click OK.

uDesigner copies the layout of the snapshot to the template you are designing. At this point, 
you can edit the template by adding, removing, and rearranging fields on the form. To edit 
the template, use the instructions under Adding Blocks to a Form (on page 271) and also 
Adding Fields to the Form (on page 304). 

To copy a template from another business process 

1) Open the business process for which you want to create a template and click Templates > 
Upper Forms in the Navigator. 

2) From the New menu, choose Copy From. The BP Template Forms window opens, showing 
a list of the upper form templates that have been created for this business process. 

3) Select an upper form from the list and click Open. A Form Design window opens. 

4) Enter a name and description for the template. 

The name must be unique. A description is optional, but recommended. 

5) Click OK. 

uDesigner copies the layout of the template to the template you are designing. At this point, 
you can edit the template. To edit the template, use the instructions under Adding Blocks to 
a Form (on page 271) and also Adding Fields to the Form (on page 304). 

Using a Template in a Design 

Once you have created a template, you can add it to the design of the upper form when you add 
blocks to the form. Adding block layouts from a template automatically links the form to the 
template. 
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To add a template layout to an upper form 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Business Processes. 

3) Open the business process. 

4) On the Form Designer window, click the Blocks button. The Form Blocks window opens. 

5) Click the Add from Template button. The Upper Form Templates window opens, showing a 
list of the templates available for this business process. 

6) Select the template you want to use and click the Select button. 

uDesigner adds the template block(s) to the bottom of the design and links the form to the 
template. 

7) On the Form Blocks window, click Close. 

uDesigner returns to the Form Designer window. Once a template layout is on the form 
design and linked to the template, you can use all the design features for the fields, such as 
formulas, auto-population, and dynamic data sets; but you: 

 Cannot add, remove, or rearrange the fields in the block. 

 Cannot move fields into or out of the block. 

 Cannot link elements. 

Note: 

If you do not want to keep this block linked to a template for automatic 
design updates, you can unlink it (see Unlinking an Upper Form From 
a Template (on page 270)). Once unlinked, the fields in this block will 
behave as any other field you manually add to the form. 

Updating an Upper Form Using a Template 

Once a template has been used in the design, you can make changes to that template and push 
those changes to any upper form that is linked to the template. 

To push template changes to upper forms 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Business Processes. 
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3) Open the business process with the upper form(s) you want to update and go to Templates 
> Upper Forms in the Navigator. 

4) On the right pane, select the name of the template you want to use to update the form(s). 

5) Click the Update Forms button. uDesigner will ask you to confirm the update. Click Yes. 

uDesigner updates all upper forms in the business process that are linked to this template. 
Here is what the template will update: 

 Any block label name, width, or position change 

 Show or hide setting for the block border or label 

 Blocks added to the template will be added at the end of the form 

 Field positions, to reflect a change in the template (however, field settings, such as 
editable or read-only, will not be updated) 

 Fields added to the template will be added to the form and will reflect the editable, 
required, or read-only settings from the template. 

Note: This is an "all or nothing" operation. If uDesigner finds any errors, 
it will not update any of the upper forms. For example, if the template 
does not exist in an upper form, or if you have added a field to the 
template that already exists on the form, the update will fail and 
uDesigner will display a window listing the errors. 

Unlinking an Upper Form From a Template 

When you unlink a form from a template, uDesigner leaves the block on the form design; 
however, the fields in the block are now available for any of the field functions, such as formulas 
or auto-population. 

To unlink the form from a template 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Business Processes. 

3) Open the business process with the template you want to unlink and go to Templates > 
Upper Forms in the Navigator. 

4) On the right pane, select the name of the template you want to unlink from the form. 

5) Click the Usage button. The Template Usage window opens, showing a list of all the upper 
forms the template is linked to. 

6) Select the upper form you want to unlink and click the Unlink button. 

7) Click Close Window. 
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Adding Blocks to a Form 

Use the following instructions to add blocks to an upper form, detail form, or template. The 
blocks of fields you create for the form will appear in Primavera Unifier similar to the following 
example.  

To add blocks to a form 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner. 

3) Open the business process. 

4) In the left Navigator, choose Upper Form or Detail Form. 

5) On the Forms pane, double click the name of the upper (or detail) form you started. A 
designer window opens. 

6) In the Tab Name field, enter a name. This is the title that will appear in the upper or detail 
form in Primavera Unifier. 
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7) On the Form Designer window, click the Blocks button. The Form Blocks window opens. 

8) To add a block to the form, click the Add button. The Block Properties window opens. 

9) Use the information in the table below to complete the fields in this window. 

10) After defining the block properties, click OK to return to the Design window. Next, you can 
add fields to the form (see Adding Fields to the Form (on page 304)). 

In this field: Do this: 

Name 

Enter a name for the block (for internal purposes only). 

If you are modifying a block from a template, do not change the name. 
Forms are linked to templates via this name. If you change the name, 
the link from the template to any forms using it will no longer work. 

Description 
Enter a description for the block. This description will appear on the form 
in Primavera Unifier if you choose to make it visible. 

Label 
Enter a name for the block. This is the name that will appear on the form 
in Primavera Unifier if you choose to make it visible. 

Number of 
Columns 

Enter the number of columns you want on the upper form. Maximum is 
4; default is 2. 

Number of 
Rows 

Enter the number of fields that will appear in this block of the form. Each 
field will occupy one row. Maximum is 19 fields (rows); default is 5. 

Once you have specified the number of rows, you cannot modify the 
block properties, but you can manually delete or insert rows in the 
Designer window.  

Show Border

Select the check box to enclose the block in a border on the form. This 
will visibly distinguish the fields in this block from other fields on the form.

Instead of using a border, you can also use empty fields to create 
spaces between rows. 

Show Label Select the checkbox if you want to block label to appear on the form. 

Show 
Description 

Select the checkbox if you want to description to appear on the form. 
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In this field: Do this: 

Hidden 

Select the checkbox if you do not want to display the block on the form in 
Primavera Unifier. 

Use this feature to hide fields that are only used in formulas, or to hide 
obsolete data elements. 

If blocks are marked as hidden, the block label in the Designer window is 
grayed out with a pre-assigned value of "Hidden<Block Name: Hidden>" 

You can add fields with formulas to a hidden block. However, you cannot 
make the fields in a hidden block "required," and you cannot add a 
validation rule to the fields. 

Note: If you need to edit a hidden block, you must deselect this 
checkbox to "un-hide" the block. Then make your changes and hide the 
block again. 

Label Width 
Enter the width of the block label as a percentage of the form width. 
Default is 20 percent. 

Label 
Position 

Specify where the label should appear on the form—to the left or right of 
the field. Default is left. 

Note: You may need to adjust the label width, label position, and number 
of columns to get the fields to look the way you want. These three 
attributes affect the way the text is justified and where the red asterisk 
for a required field appears. 

Notes 

(Optional) Use the Notes field to enter details about the design of the 
block. This can be helpful to others in understanding the information this 
block is intended to contain and what that information might be used for. 

Note: This field will not be visible on the log. 

Upper Form Options 

For each type of BP, there are two types of Upper Forms sub-nodes. On Upper Forms
sub-node is under the Templates node, and the other Upper Forms sub-node is under the 
Requestor node. Both Upper Forms have the same tabs and fields. The following explains the 
Upper Forms sub-node that is under the Requestor node.   

The upper form design has the following tabs:  

 General tab (Company Workspace > Admin mode > uDesigner > Business Processes > 
open a BP > Upper Forms > select a form > Properties > General tab) 

 Options tab (Company Workspace > Admin mode > uDesigner > Business Processes > 
open a BP > Upper Forms > select a form > Properties > Options tab), except for the RFB: 
Options tab (Company Workspace > Admin mode > uDesigner > Business Processes > 
open RFB BP> Templates or Requestor or Bidder > Upper Forms > select form > 
Properties > Options tab). 
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Note: The following applies to both workflow and non-workflow type 
BPs. 

The General tab has the following fields: 

In the General tab, enter a valid upper form name in the Name field, provide a brief description, 
and specify whether this will be an action form (Action Form) or a read-only view form (View 
Form). 

 Name (contains the name of the upper form) 

 Description (contains a brief description for the upper form) 

 View Form (indicating a read-only view form) 

 Action Form (indicating an action form) 

The Options tab has the following fields, based on the following BP types: 

 Cost 

 Document 

 Test 

 Line Item 

 Simple 

 RFB 

 Resource 

 Resource Booking 

 Timesheet 

 Project/Shell Creation 

 Simple 

 Line Item 

The following explains the Options tab for each BP type, above. 

Upper Form Options for Cost BP 

The fields in the Options tab of a Cost BP upper form are distributed according to:  

 Upper Form for Cost BP  (Creation) 

 Upper Form for Cost BP (Modify) 

 Upper Form for Cost BP (View Form) 

Upper Form for Cost BP  (Creation) 

The Option tabs fields are distributed in blocks, as explained below: 

Attachments block 

 Add Attachments to record

 Remove Attachment from record

Source for Record and Line Item Attachments

 Document Manager
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 My Computer

 Republish if Publish Path is different from current Location

This option is not available for the Text-type BPs (since these types of BPs do not support 
attachments), and RFB BPs bidder upper action form. 

 Move

 Copy

Document Manager Attributes for Record and Line Item Attachments

 Update attributes for already published documents

Line Items block 

Left pane 

Names of the line items. 

Right pane: 

 Hide current tab

 Allow Add/Remove/Copy line items

 Allow attachments to line items

 Allow adding of summary line items

 Allow Cost Breakdown

 Costed Amount must be equal to the line item Amount

 Allow Modification of line item

Funding Options block 

 Allow viewing of Fund Information

 Allow Funding

Additional block 

 Allow linking uMail

Upper Form for Cost BP (Modify) 

Attachments

 Add Attachments to record

 Remove Attachment from record

Source for Record and Line Item Attachments

 Document Manager

 My Computer

 Republish if Publish Path is different from current Location

This option is not available for the Text-type BPs (since these types of BPs do not support 
attachments), and RFB BPs bidder upper action form. 

 Move

 Copy

Document Manager Attributes for Record and Line Item Attachments

 Update attributes for already published documents
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Line Items block 

Left pane 

Names of the line items. 

Right pane: 

 Hide current tab

 Allow Add/Remove/Copy line items

 Allow attachments to line items

 Allow adding of summary line items

 Allow Cost Breakdown

 Costed Amount must be equal to the line item Amount

 Allow Modification of line item

Funding Options block 

 Allow viewing of Fund Information

 Allow Funding

Additional block 

 Allow linking uMail

Upper Form for Cost BP (Action Form) 

Attachments block 

 Add Attachments to record

 Remove Attachment from record

Source for Record and Line Item Attachments

 Document Manager

 My Computer

Publish to Document Manager

 Republish if Publish Path is different from current Location

This option is not available for the Text-type BPs (since these types of BPs do not support 
attachments), and RFB BPs bidder upper action form. 

 Move

 Copy

 Automatically select all existing Record and Line Item Attachments for 
Republish

Document Manager Attributes for Record and Line Item Attachments

 Update attributes for already Published Documents

Line Items block 

Left pane 

Names of the line items. 

Right pane: 

 Hide current tab
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 Allow Add/Remove/Copy line items

 Allow attachments to line items

 Allow adding of summary line items

 Display line item group total amount

 Allow Modification of line item

Funding Options block 

 Allow viewing of Fund Information

 Allow Funding

Additional block 

 Allow linking uMail

Upper Form for Cost BP (View Form) 

Attachments block 

No fields in this block. 

Line Items block 

Left pane 

Names of the line items. 

Right pane: 

 Hide current tab

 Display line item group total amount

Funding Options block 

 Allow viewing of Fund Information

 Allow Funding

Upper Form Options for Documentation BP 

The fields in the Options tab of a Document BP upper form are distributed according to:  

 Upper Form Options for Documentation BP With Folders 

 Upper Form Options for Documentation BP Without Folders 

 Upper Form Options for Documentation BP Without Folders (View Form) 

Upper Form Options for Documentation BP With Folders 

Attachments block 

Source

 Document Manager

 My Computer

Publish to Document Manager

 Republish if Publish Path is different from current Location

 Move
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 Copy

 Automatically select all existing Record and Line Item Attachments for 
Republish

Document Manager Attributes

 Update attributes for already Published Documents

Line Items block 

Left pane 

Names of the line items. 

Right pane: 

 Hide current tab

 Add/Copy line items

 Allow Modification of Line Item, except when status is: You can select a status based 
on your need. 

 Allow Line Item Status to be modified

 Add Attachments

 Append Line Item Folder Structure to Auto Publish Path

 Make Attachment to a Line Item mandatory

 Allow comments

 Remove Line Items

 Remove Attachments

 Allow marking of comments as 'Final'

Additional block 

 Allow linking uMail

Upper Form Options for Documentation BP Without Folders 

Attachments block 

Source

 Document Manager

 My Computer

Publish to Document Manager

 Republish if Publish Path is different from current Location

 Move

 Copy

 Automatically select all existing Record and Line Item Attachments for 
Republish

Document Manager Attributes

 Update attributes for already Published Documents

Line Items block 

Left pane 
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Names of the line items. 

Right pane: 

 Hide current tab

 Add/Copy line items

 Enforce validations on Detail form: Selecting this option will enable uploading 
the attachments in bulk during runtime, only by way of the Grid View. 

 Allow Modification of Line Item, except when status is: Must select a status 

 Allow Line Item Status to be modified

 Add Attachments

 Append Line Item Folder Structure to Auto Publish Path

 Make Attachment to a Line Item mandatory

 Allow comments

 Remove Line Items

 Remove Attachments

 Allow marking of comments as 'Final'

Additional block 

 Allow linking uMail

Upper Form Options for Documentation BP Without Folders (View Form) 

Attachments block 

Source

 Document Manager

 My Computer

Publish to Document Manager

 Republish if Publish Path is different from current Location

 Move

 Copy

 Automatically select all existing Record and Line Item Attachments for 
Republish

Document Manager Attributes

 Update attributes for already Published Documents

Line Items block 

Left pane 

Names of the line items. 

Right pane: 

 Hide current tab

Additional block 

 Allow linking uMail
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Upper Form Options for Line Item BP 

The following explains the options for: 

 Upper Form Options for Line Item BP (Action Form) 

 Upper Form Options for Line Item BP (View Form) 

Upper Form Options for Line Item BP (Action Form) 

Attachments block 

 Add Attachments to record

 Remove Attachments from record

Source for Record and Line item Attachments

 Document Manager

 My Computer

Publish to Document Manager

 Republish if Publish Path is different from current Location

 Move

 Copy

 Automatically select all existing Record and Line Item Attachments for 
Republish

Document Manager Attributes for Record and Line Item Attachments

 Update attributes for already Published Documents

Line Items block 

Left pane 

Names of the line items. 

Right pane:  

 Hide current tab

 Add/Copy/Group line items

 Allow attachments to line items

 Allow adding of summary line items

 Display line item group total amount

 Allow Modify Line Item, except when status is: Must select a status. 

 Allow Line Item Status to be modified

 Remove Line Items

Additional block 

 Allow linking uMail

Upper Form Options for Line Item BP (View Form) 

Attachments block 

No fields are in this block. 
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Line Items block 

Left pane 

Names of the line items. 

Right pane: 

 Hide current tab

 Display line item group total amount

Upper Form Options for RFB BP 

The following explains the options for:  

 Upper Form Options for RFB BP (Action Form) 

 Upper Form Options for RFB BP (View Form) 

Upper Form Options for RFB BP (Action Form) 

Attachments block 

Attachments

 Add Attachments to record

 Remove Attachment from record

Source for Record and Line Item Attachments

 Document Manager

This option is not available for Request for Bid (RFB) Bidder type BP upper form. 

 My Computer

Publish to Document Manager

 Republish if Publish Path is different from current Location

When the user selects Document Manager, the Republish if Publish Path is different 
from current Location sub-option becomes available. 

This option is not available for the Text-type BPs (since these types of BPs do not support 
attachments) and for Request for Bid (RFB) Bidder type BP upper form. 

 Move

 Copy

 Automatically select all existing Record and Line Item Attachments for 
Republish

Document Manager Attributes for Record and Line Item Attachments

 Update attributes for already published documents

Line Items block 

Left pane: 

Names of the line items. 

Right pane: 
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 Hide current tab

 Allow Add/Remove/Copy line items

 Allow attachments to line items

 Allow modifying line items only

Upper Form Options for RFB BP (View Form) 

Attachments block 

No fields in this block. 

Line Items block 

Left pane 

Names of the line items. 

Right pane: 

 Hide current tab

Bids block 

 Do not allow viewing received bids

Proposal Management after bid closure block 

 Hide Proposal Management tab  

Proposal Management (Private Bids) 

The Proposal Management tab settings are applicable only to the Private Bids. The Proposal 
Management tab settings are not applicable to the Public Bids. 

Proposal Management prior to bid opening block 

Manage vendors (includes adding or removing vendors)

Enables the user to access the Proposal Management tab before the option Send bid 
invitations and allow bid receipt is selected. The user has access to Add and 
Remove which are enabled in the Proposal Management tab. 

Do not allow modification of vendors

This option prevents the user from making changes (add or remove) to the list of vendors 
on the Proposal Management tab. If you select the Manage vendors (includes 
adding or removing vendors) option, this option will be selected automatically. 

Use the Master Vendor List filtered at project level

To display the vendor list at project-level, when the user clicks the Add option on the 
Proposal Management tab. If you select the Manage vendors (includes adding or 
removing vendors) option, this option will be selected automatically. 

Proposal Management during bidding block 

Send bid invitations and allow bid receipt

To display the Send bid invitation and allow bid receipt option on the Proposal 
Management tab. 
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If you select this option, then all of the options on the Proposal Management tab will be 
available to the user. 

If you select this option, the Manage vendors (includes adding or removing vendors)
option, and the Do not allow modification of vendors option, then the user will not 
see the add or the remove options on the Proposal Management tab. 

Do not allow modification of vendors

This option prevents the user from making changes (add or remove) to the list of vendors 
on the Proposal Management tab. The Send Invitation, Actions (Send Mail and 
Send Password), Refresh, and Find on Page options will be available. 

Use the Master Vendor List filtered at project level

To display the vendor list at project-level, when the user clicks the Add option on the 
Proposal Management tab. If you select the Manage vendors (includes adding or 
removing vendors) option, this option will be selected automatically. 

Proposal Management after bid closure block 

Hide the Proposal Management tab

To hide the Proposal Management tab, similar to the Do not allow viewing received 
bids (under the Bids block). 

Add all Record Attachments of the winning bid to Requestor's Record Attachments

To add all of the record attachments of the winning bid to the requestor's record 
attachment. 

Add only Line items Attachments from the winning bid to the Line Items of Winning 
Contract

To add all of the winning bid line items attachments to the line items of the second tab. 

Additional block 

Allow linking uMail

Upper Form Options for RFB BP Action Form (Bidder) 

The upper form options for RFB BP Action Form (Bidder) are as follows:  

Attachments block 

Attachments

 Add Attachments to record

 Remove Attachment from record

Source for Record and Line Item Attachments

 Document Manager

This option is not available for Request for Bid (RFB) Bidder type BP upper form. 

 My Computer

Document Manager Attributes for Record and Line Item Attachments

 Update attributes for already published documents

Line Items block 

Left pane 
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Names of the line items. 

Right pane:  

 Allow Add/Remove/Copy line items

 Allow attachments to line items

 Allow modifying line items

 Allow attachments to the saved line items

Requestor: Upper Forms (Form Designer - Upper Form) 

To access the Upper Forms for Requestor:  

1) Go to your company tab (Company Workspace) and switch to the Admin mode. 

2) In the left Navigator, click uDesigner node to expand. 

3) In the left Navigator, click Business Processes node to expand. 

4) In the log, click to select the request for bid BP. 

5) In the left Navigator, click the selected request for bid BP node to expand. 

6) In the left Navigator, click the Requestor node to expand, click the Upper Forms sub-node, 
select a form, and click Open from the toolbar options. 

The following lists the fields for the Upper Forms for Requestor: 

General block 

Field Name Description 

Record 
Number

This is a read-only field that Unifier populates when you send the form 
to the Approval step. 

Title This is a required field - Enter a name for the bid record. 

Project 
Number

This field is auto-populated from the project. 

Project Name This field is auto-populated from the project. 

Due Date This is a read-only field. This field is pre-populated from the workflow 
setup.  

Status This read-only field is blank while on the Creation step. The status will 
change when the task is accepted on the next step in the workflow. 

Bid Package Details block 

Field Name Description 

Bid Package 
Revision 
Number

This is a required field - Enter the revision number of the bid package. 

RFP Due Date This is a required field - Use the calendar icon to select the date the 
RFB is due. 
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Bid Sponsor To select the bid sponsor from the list that becomes available when 
you click the Select button. 

Sponsor 
Phone

To enter the sponsor's phone number. 

RFB Initiate 
Date

To capture the date when the first ever invite for the bid was sent out. 
Enables the user to determine how much time the bidders had before 
submitting their bids. 

Whether the DE being present on any of the upper forms, or not, once 
the first invitation is sent out system should capture the date and time 
of the invitation sent out on this DE. 

If this DE is added on any of the upper forms the value would be 
reflected. 

The DE will automatically get added in read-only mode. 

Order 
Delivery Date

This is a required field - Use the calendar icon to select the date a 
date for the order delivery. 

Question Cut 
Off Date

This is a required field - Use the calendar icon to select the cut off date 
for questions about the bid requirements. 

Sponsor 
Email

To enter the sponsor's email address. 

Bidders 
Count

This is a read only field. Initially the value is 0. 

Bid Count This is a read only field. Initially the value is 0. 

Bid Priority This is a required field - Select a value from the field's drop-down 
menu. 

Bid Scope block 

To capture detailed description and requirements of the overall bid package. All bidders can see 
this. 

Field Name Description 

Bid Scope To enter a detailed description of the overall Bid Package and 
requirements. This will be visible to all Bidders. 

Instructions block 

To capture detailed instructions in order to assist the bidders with completing and submitting the 
bid package. 

Field Name Description 

Bid Package 
Instructions

To enter detailed instructions to assist bidders in completion and 
submittal of Bid Package. 

Vendor Requirements block 
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To capture detailed qualifications, or criteria, that needs to be satisfied by the vendor in order for 
the bid to be evaluated. 

Field Name Description 

Qualifications To enter any qualifications or other criteria that needs to be satisfied 
by vendor in order for bid to be evaluated. 

Certifications To enter any required certifications. 

Insurance 
Coverage

To enter the insurance qualifications that you expect the vendor to 
carry. 

Bidder Meeting Details block 

Field Name Description 

Location To enter a where you can meet with the bidder; e.g., teleconference, 
virtual meeting space, or physical address. 

Date and Time To enter a date and time for the meeting. 

Dial-in 
Instructions

To enter the instructions to call into the meeting. 

P6 Activity To select a P6 activity to associate with this record. 

P6 Planned 
Cost

This is a read-only field. 

P6 Planned 
Start

This is a read-only field. 

P6 Planned 
Finish

This is a read-only field. 

Hidden block 

To include fields that must be hidden. 

Field Name Description 

Publish Path To enter publishing path within Unifier. 

The following lists the fields for the Item Logs (Log Items tab) for Requestor:  

General block 

Field Name Description 

Cost Code This is a required field -Enter the cost code for this line item. You can 
either enter it directly or use the cost code picker. 

Short 
Description

This is a required field - Enter a brief description for the line item. 



Designing a Form

287

Code Name This read-only field is auto-populated from the cost code. 

Item Unit Cost This is a required field - Enter the price of the item specified on the line 
item. 

Item Quantity This is a required field - Enter the number of items specified on the 
line item. 

Unit of 
Measure

To select the Unit of Measure for the item specified on the line item 
line item. 

Amount This read-only field is auto-calculated using the formula (Item Quantity 
X Item Unit Cost). 

Upper Form Options for Simple BP 

The following explains the options for: 

 Upper Form Options for Simple BP (Action Form) 

 Upper Form Options for Simple BP (View Form) 

Upper Form Options for Simple BP (Action Form) 

For BP types that do not have line items (for example: Simple, Project/Shell Creation, Resource, 
and Resource Booking), the Options tab has the following actions (Select Actions):  

Attachments to overall record block 

 Add Attachments

 Remove Attachments

Source

 Document Manager

 My Computer

Publish to Document Manager

 Republish if Publish Path is different from current Location

 Move

 Copy

 Automatically select all existing Record and Line Item Attachments for 
Republish

Document Manager Attributes

 Update attributes for already Published Documents

Note: There are no line items for the Simple-type BP. 

Upper Form Options for Simple BP (View Form) 

There is no Options tab in the upper form of the Simple BP (View Form) 
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Upper Form Options for Text BP 

For BP types that do not have line items (for example: Simple, Project/Shell Creation, Resource, 
and Resource Booking), the Options tab has the following actions (Select Actions): 

Attachments to overall record block 

 Add Attachments

 Remove Attachments

Source

 Document Manager

 My Computer

Document Manager Attributes

 Update attributes for already published documents

Additional block 

 Allow linking uMail

Project/Shell Creation-Type Upper Forms 

For BP types that do not have line items (for example: Simple, Project/Shell Creation, Resource, 
and Resource Booking), the Options tab has the following actions (Select Actions): 

Project/Shell Creation-Type BP Upper Forms-Action Form (AF) 

Attachments to overall record block 

 Add Attachments

 Remove Attachments

Source

 Document Manager

 My Computer

Document Manager Attributes

 Update attributes for already published documents

Note: There are not line items for the Project/Shell Creation-type BP. 

Additional block 

 Allow linking uMail

Project/Shell Creation-Type Upper Forms-View Form (VF) 

There is no Options tab. 

Resource-Type BP Upper Forms 

For BP types that do not have line items (for example: Simple, Project/Shell Creation, Resource, 
and Resource Booking), the Options tab has the following actions (Select Actions): 
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Resource-Type BP Upper Forms-Action Form (AF) 

Attachments to overall record block 

 Add Attachments

 Remove Attachments

Source

 Document Manager

 My Computer

Document Manager Attributes

 Update attributes for already published documents

Note: There are not line items for the Resource-type BP. 

Additional block 

 Allow linking uMail

Resource-Type Upper Forms-View Form (VF) 

There is no Options tab. 

Copying Upper Forms 

To copy Upper Forms from another Business Process: 

1) From the New menu, choose Copy From. The BP Upper Forms window opens, showing a 
list of upper forms for all the BPs in uDesigner (in both draft and complete mode). 

2) Select the upper form you want to copy from the list and click Copy. The Form Design 
window opens. 

3) On the General tab, you can change the name of the upper form and add a description for 
the form. 

4) Specify whether this will be an action form or a read-only view form. 

5) Click the Options tab. Then follow the instructions for the Options tab above. 

Notes: 

 If you copy an upper form that uses a template, the upper form you 
are starting will be linked to that template, and any changes made to 
that template will also appear on this upper form. Any data elements 
that are not compatible with the business process you are designing 
will be dropped. 

 Also note for RFBs—If you copy an upper form that uses a template 
from a Requestor form to a Bidder form, the Bidder upper form will 
also be linked to the template. 
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Modifying Blocks 

To modify a block 

1) On the Form Designer window, click Blocks. 

2) Select the block you want to modify and click Modify. The Block Properties window opens. 

3) Make your changes and click OK. 

Note: If you are using blocks from a linked template, you can edit only 
the following; all other block properties are set by the template design: 

 Description 

 Show Description 

 Hidden 

 Notes 

Collapse by Default Option in Block Properties  

In the Block Properties window of both a BP form and a manager attribute form, there is a new 
checkbox called Collapse by Default. If the checkbox is checked, the block is collapsed by 
default. If the checkbox is unchecked, the block is expanded by default. 

With the Collapse by Default option, you can avoid scrolling through irrelevant information. 

The Block Properties are searched during the rendering of a BP form and a manager attribute 
form to determine whether a block is collapsed or expanded at runtime. 

For a block to be collapsed at runtime, the block label and the block borders must be visible. 

This option is applicable only for Standard View of forms.” Collapse by Default is applicable to 
the following forms: Action form, View form, Detail form, and various attribute forms. For 
manager attribute forms, this option is available for the Activity Manager, Configurable Manager, 
Cost Manager, Document Manager, and Space Manager. This option is also applicable to Shell 
attribute forms as well as places where a preview of a manager attribute form is displayed, such 
as a variety of logs.     

Note: If a form has only one block, then the attribute of expand or 
collapse will not be available.  

If you change the default behavior by performing the opposite action at 
runtime, the default expand or collapse option is displayed when the 
page is reloaded. 
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Designing Detail Form 

Detail forms open as separate windows in Primavera Unifier, where users enter or modify 
information, such as line item details for some business processes, new plan information for 
planning items, new activity information for schedules, or a new item for a manager attribute 
form. The fields on the detail form, and the information the users enter, are then displayed on a 
line item list at the bottom of the form, or other area of the Primavera Unifier interface, such as a 
planning item log or a schedule. 

Once a detail form is in use in Primavera Unifier, you cannot delete it. You can add elements to 
the form in uDesigner, but you cannot delete the original elements, nor can you hide them. 

At run time, the detail form creates a tab at the bottom of the form that contains a line item list. 

uDesigner automatically creates one blank "standard" detail form whenever you start these 
types of business processes. You will need to design this detail form (see Starting a Standard 
Detail Form (on page 295)). To this standard detail form, you can add a line item list (see 
Adding an Item Log to a Detail Form (on page 291)). 

Note: You cannot delete this Standard detail form, nor its line item list. 

For Base Commits and Change Commits BP of Summary Payment Applications type, the Data 
Elements (DEs) for the following are not available to be included in the Standard detail tab: 

 Cost Code/Code Name, 

 Commit Line Item Picker 

 Work Package picker 

 Standard elements of CBS type BP, for example, CBS_cost_type and CBS_cost_attribute. 

Adding an Item Log to a Detail Form 

You can add an item log to the form for line item, document, and cost type business processes. 

Item logs appear in the lower section of the form. When the user adds line items to a record, 
they appear in this log. In addition, to organize the details of your business process, you can 
create multiple tabs, up to eight, to collect and organize items into categories. 

When a user opens a new cost or line-item business process, Primavera Unifier automatically 
opens a "standard" item log using the naming convention "Standard - Line Item List." (This name 
can be changed if you wish.) In addition, some features of the line item list are added by default. 
For cost BPs, these include the number of items, pagination, number of lines to be displayed per 
page, transaction currency, and total amount. 

When a user opens a document business process, Primavera Unifier also opens a line item list; 
however, the list behaves differently, depending on whether or not the user activates the detail 
form. If the detail form is not activated, the Line Item list serves as a document attachment area, 
where users can attach documents or folders. If the detail form is activated, the user can add 
documents as line items.  

Designing the line item list consists of specifying the data elements you want to display for each 
line item that a user adds. Columns correspond to the data elements you placed on the detail 
form. 
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Designing the List 

To design the item log: 

1) Open the business process form for which you want to add an item log and click Item Logs 
in the navigator. The Item Logs log opens. 

2) Select a tab from the log and click Open. 

3) Complete the tabs as described in the following sections. 

Specifying the Layout 

Use the Layout tab to designate what data from the line item list should appear on the log. The 
data will appear in columns on the log. 

Note: For Cost-Type, multiple-tab Forms, If you include an "amount" 
field on the log for a line item list for a tab, a total of the line item 
amounts will appear at the bottom of each numeric column on the form. 

1) In the Tab Name field, enter the name you want to appear for the tab on the form. 

2) To add a column to the list log, click the Add button. The Layout Header Properties window 
opens. 

3) Use the table below to complete the fields in this window. 

4) Click Apply. 

uDesigner displays the columns on the Layout window. 

5) (Optional) To change the order of the columns on the list, use the Move Up and Move Down
buttons. These buttons move the columns left or right, respectively, on the line item list. 

6) To add another column to the layout, repeat steps 2 through 4. 

7) Click Apply. 

Note: One additional column may appear on the log. When you started 
the upper form, you filled in an Options tab. On this tab, under Line 
Items, if you selected the checkbox Add summary line item amounts, 
a summary of line item amounts will become an automatic column on the 
log, titled Sm.

In this field: Do this: 

Data Element Label Select a Data Element Label from the list of available data 
elements. This is the name that will appear as the field name 
on the form. 

The list is generated from the detail form. If you do not see the 
data element you want, go to the detail form and add it. The 
Data Element Name field shows the database name of the 
data element you chose. 
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In this field: Do this: 

Column Heading Enter the column heading you want to appear on the line item 
form. The field is pre-populated with the data element label, 
but you can edit it. 

Width Enter the width (in pixels) of the column. The default is 150 
pixels. 

Alignment Choose the positioning of the data (and column heading) 
within the column: Left, Center, or Right aligned. 

Sorting the List by Column Order 

You can determine which column to use as the default sort order for the line item list log. This 
allows you to choose a column to sort by initially. 

1) Click the Sort Order tab. 

2) In the Initial Sort Column field, choose the field by which you want to sort the list. 

3) In the Sort Order field, choose whether the sort order should be ascending (A-Z) or 
descending (Z-A). 

4) Click Apply. 

Specifying Search Criteria for the Find Feature 

Primavera Unifier users will sometimes need to locate particular line items in a business 
process, often for the purpose of task management or milestone tracking. To make it easier for 
users to locate a line item, use the Find tab to specify field names on the form that they can use 
in their search. The user can also narrow a search by using operators on the fields, such as 
"contains" or "equals." 

To specify search criteria 

1) Click the Find tab, then click Add. The Find Properties window opens. 
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2) In the Data Element Label field, select a field (data element) users can use to find a line 
item. 

When you select a data element label, uDesigner automatically displays the database label 
of the element in the Find Label field. This field is editable. 

3) If you want to change the name of the element to something more meaningful to the user, 
enter the name in the Find Label field. 

4) Click Apply. 

5) To add another element for searching, repeat steps 2 through 4. Then click OK. 

6) On the Line Items window, click OK. 

Organizing Items Under Tabs 

If your business process generates many line items, you can create tabs along the bottom of the 
form for organizing data into categories for quick retrieval. You can create up to eight tabs for a 
form. In uDesigner, a tab is composed of a detail form and a line item list. When you create the 
tabs with the detail forms, uDesigner automatically creates a blank line item list for each detail 
form. 

Specifying the Tab Order 

Once you have designed the line item lists for each tab, you can specify the order in which you 
want the tabs to appear across the bottom of the form in Primavera Unifier. 

To specify the tab order: 

1) Open the business process form and click Item Log in the Navigator. 

2) Click the Tab Order button on the tool bar. The Tab Display Order window opens. 

3) Select the tab name and click the Move Up (Left) or Move Down (Right) button to move the 
tabs into the order you want them to appear on the form. 

4) Click OK. 

Organizing Data with Multiple Tabs 

You can use detail forms to create multiple tabs on a business process. These tabs are an 
effective way to organize the details of your business process. For example, for a lease 
management type of business process, you could create tabs to group lease details for easy 
tracking, such as Payments Setup, Options, Contacts, Clauses, and Insurance. 

Business processes that support multiple tabs include: 

 Any line item-type business process 

 Cost business processes of the following types: 

 Line Item with CBS Code 

 Line Item with Company Account Code (Generic only) 

 Line Item with Multiple Codes (Generic and Lease) 

You will need to design a detail form for each tab. In addition to the "standard" detail form, you 
can design up to seven additional detail forms to create a total of eight tabs. Once you create 
the tabs with the detail forms, you can design the line item lists for them. 
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Multiple Tabs on Cost BPs—Line Items with CBS Codes. 

 You can place CBS codes on the standard tab only. 

 Line items on non-standard tabs are not eligible for funding. 

 Amounts from non-standard tabs can be rolled up to the upper form of the business process. 

 Users can consolidate line items on non-standard tabs. 

 You can place any picker on non-standard tabs, except for the CBS Picker, CBS Code 
Picker, Fund Picker, Generic Cost Code Picker, or any configurable manager picker. 

Multiple Tabs on Cost BPs—Payment Application classification. 

 Users cannot consolidate line items on non-standard tabs. 

 Users can copy line items only onto non-standard tabs. 

 Users can use the Grid View to add line items on non-standard tabs. 

Multiple Tabs on Cost BPs—General Spends classification. 

 Users cannot consolidate line items on non-standard tabs. 

Starting a Standard Detail Form 

To start the detail form: 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner. 

3) Open the business process, manager, or other component for which you want to design the 
detail form. 

4) In the Navigator, click Detail Form. The Forms pane opens, showing the standard detail 
form uDesigner automatically launched. 

uDesigner displays the name of the form on the right pane. To complete the form, use the 
instructions under Adding Blocks to a Form (on page 271) and also Adding Fields to the 
Form (on page 304). 

Starting Detail Forms for Multiple Tabs 

To launch an additional detail form to create a new tab 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner. 

3) Open the business process for which you want to design another tab. 

4) In the Navigator, click Detail Form. The Forms pane opens, showing the standard detail 
form uDesigner automatically launched. 

5) On the right pane, choose New > Manual. The Form Design window opens. 
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Note: If you prefer, you can create the form from a snapshot of another 
form. To do so, choose New > From Snapshot, then follow the 
instructions under Restoring a Version of a Design (on page 375). 

6) On the General tab, enter a name and description for the detail form, and click OK. 
uDesigner includes the name of the new detail form on the list in the right panel. 

7) To create additional tabs (up to fifteen total), repeat steps 3, 4, and 5.  

 uDesigner displays the name of the form on the right pane. To complete the form, use the 
instructions under Adding Blocks to a Form (on page 271) and also Adding Fields to 
the Form (on page 304). 

 For each of the detail forms you start, uDesigner automatically creates a blank line item 
list. To design the line item lists, see Adding an Item Log to a Detail Form (on page 
291). 

An Extra Step for Multiple-Tab Forms 

Designing forms with multiple tabs requires that you return to the properties window for the 
upper form and specify options that can be activated only after you have designed the detail 
forms for this component. 

To specify upper form options for line item tabs 

1) Open the business process that contains the multiple tabs. 

2) In the Navigator, click Upper Forms. The Forms pane opens. 

3) On the Forms pane, select the name of the upper form and click the Properties button. The 
Form Design window opens. 

4) Click the Options tab. 

 For View forms, Unifier lists tab names on the left side of the Options > Select Actions > 
Line Items pane. When you click a tab name, the available option for that tab is Hide 
current tab.   

 For Action forms, more options are available. The Line Items section shows the names of 
the tabs that have been created, and the list of the available Line Items options. 

Note: If a standard tab is hidden in the design, then it will not be 
displayed at runtime. The standard tab name will be dependent on the 
tab name specified in the Line item list of Item logs. 

a. Click the tab name on the left, and specify the line item options on the right as follows: 

If the tab should be hidden (for example, if the user should not see the tab at a particular 
step in the workflow), select the Hide current tab check box. 

Select other check boxes if you want to allow users to: 

 Add, copy, and remove line items 

 Add attachments to line items 

 Add summary line item amounts 

 Modify line items Modify the statuses of line items 

b. Click OK. 
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Mapping Line Items from References during BP Creator Auto-Creation 

During auto-creation using a BP Creator, you can copy line items from a source (referenced) 
business process onto an auto-created (destination) business process, when: 

 BP Creator is on the upper form, source (reference) is a picker on the upper form. 

 BP Creator is on a detail tab, source (reference) is a picker on the upper form. 

 BP Creator is on a detail tab, source (reference) is a picker on the same detail tab. 

For example: 

An Asset business process references a Motor Template in a line item (via a BP Picker, BP 
Data Picker, or a BP Creator.) The line item auto-creates another business process, Motor 
based on the Motor Template (via a BP Creator.) In doing so, all line items from the Motor 
Template's detail tabs are copied onto Motor's detail tabs. 

In addition to being able to copy line items from detail tabs of a parent business process record 
to the detail tabs of an auto-created business process record, you can copy line items from tabs 
of another business process record that is referenced by the parent business process record to 
the selected tabs of the auto-created business process record. 

uDesigner Auto-creation Configuration 

Upper and Detail configuration windows display a tabbed Business Processes section with two 
tabs: 

 Current 

 Referenced 

 The purpose of this tab is to specify source and destination tabs for the referenced 
business process. 

 The Referenced tab has four columns for Row, Source, Source Tab Name, and 
Destination Tab Name. 

 Use the Add and Remove options to add or remove mappings in rows. 

In the Source list of Detail Configuration, select current business process name, or any BP 
picker or data picker on the upper or detail form of the business process. (Note Upper 
Configuration will display only those from the upper form.) In the Source Tab Name list, select a 
tab from the referenced business process. Destination Tab Name provides a list of all tabs in the 
business process being created (see Auto-create Records field). These are the same as the 
values in Destination Tab Name in Current tab. Select any tab in which the line items from the 
referenced business process will be created. 

In the Source Tab Name list, select a tab from the referenced business process.  

 Destination Tab Name provides a list of all tabs in the business process being created (see 
Auto-create Records field). 

 These are the same as the values in Destination Tab Name in Current tab.  

 Select any tab in which the line items from the referenced business process will be created.  

To configure line item mapping in upper or detail form 

1) Click the Company Workspace tab and switch to Administration Mode. 
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2) Navigate to uDesigner > Business Processes node Navigator. 

3) Open your line item type business process in which you want to set up line item mapping 
from a referenced business process to an auto-created business process.  

4) In the Auto-creation Processes, Upper or Detail log, click New to configure auto-creation on 
the selected BP Creator field placed on the upper or detail form.  

5) Complete line item mapping in the Referenced tab, associating tabs in the source business 
process to tabs in the destination business process. 

Creating Query-based Tabs and Summary Elements 

A query-based tab (QBT) is a mini business process log within a business process form that 
displays a filtered list of specific business process records in the tab line item list.  

You can create multiple detail forms for a Document type, Line Item type, and Cost type 
business processes, in uDesigner. Each advanced Document-type business process enables 
you to include/create up to fifteen tabs, including the query-based tabs.  

Note: The first detail form in Document type business process must be 
used to define a Document-type standard tab that has folder structure, 
only. The subsequent detail forms must be used to define either the Line 
Item type, or the query based tabs. 

You are required to add a Reference Picker in the Upper Form of a business process that the 
user wants to run the query. 
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You can use a query-based tab to: 

 View a filtered list of business process records associated with the parent business process.  

 Create a new business process from the QBT. 

 Copy a business process either with or without attachments. 

 Search for business process records based on user-entered criteria. 

For example, a contract's QBT can display all change orders issued against that contract. 
Another QBT on the same contract record can display all invoices against it. The records 
displayed in the QBT's line item list are from the same level (project or company.) 

Business Processes that do not support query-based tabs include Simple, Resource, Text, RFB, 
and Project/Shell Creation. 

Under the corresponding business process, Query Items has two sub-nodes: 

 Query Tabs define the query-based tabs that will be added to the business process. You can 
create Query tabs as long as the maximum number of tabs (fifteen) has not been reached.  

 Summary Elements define the summary data elements to be added to the Upper Form of the 
business process. They specify the type of summary information 
(Average/Count/Total/Maximum/Minimum) that will be shown from the selected Query tab, 
for example, the total amount of records, or the count of records in the tab. 

The Item Log accommodates both detail form line items lists and query items. The Items log 
contains: 

 Type column to help distinguish between Detail Forms and Query Items.  

 Tab Name column appears before Name column.  

Required References 

You must define references in the source business process from which you want to display 
information. For example, if Meeting Minutes is the destination business process in which you 
want to display Action Items data, then: 

 Action Items (the source business process) must have: 

 A Meeting Minutes reference defined in its Reference Processes.  

 A business process picker on the Upper form that you can use to select the Meeting 
Minutes record in which you want to show Action Items data. 

Query-based Tabs 

The Query Tabs enable you to define the query-based tabs (QBTs) that you want to be added 
to a business process. 

You can define query conditions in uDesigner (Company Workspace > Admin mode > 
uDesigner > Cost type business process > Query Items > Query Tabs. 

1) Navigate to Company Workspace > Admin mode > uDesigner node > Business 
Processes node. 

2) From the Designer - Business Processes - Current View window/log, find an existing 
Cost-type business process in Draft status and open. 
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3) In the opened business process, on the toolbar, click the Status drop-down list to validate 
status. If the business process status is Complete, you can click Draft so you can edit the 
business process forms. 

4) (Optional) Click Detail Form, on the left-hand Navigator, to open the Detail Form - Current 
View window/log. The log lists previously created tabs. You are allowed fifteen tabs, 
including the query-based tabs.  

5) Click Query Items node, on the left-hand Navigator, to expand and click Query Tabs to 
open the Query Tabs - Current View window/log. The system allows you to create a total of 
fifteen Query-based Tabs (QBTs) on a business process.  

6) From the menu, click New to open the Select Business Process window. 

7) Under the Select Business Process/Attribute field click the drop-down list to see all the 
available business processes. 

8) Select the source business process and click OK to open the Query Tab window, General 
tab. 

9) Enter values in the Name and Description fields. 

10) Click the drop-down list of the Reference Picker and select a reference for the source 
business process. 

11) Click Apply and then OK. 

12) From the left-hand Navigator click Item Logs to open the Line Item List - Current View
window/log. 

13) Click to select the name and click Open. The Query items window opens which has two 
tabs: General and Query. The General tab shows the tab name (Tab Name). 

14) Click the Query tab and define the query by following these steps: 

Note: You can add one query per QBT, only. 

1. Click Add to open the Query Condition window. 

2. Under Add Query Condition, the Data Source is displayed. This is the name of the 
business record from which you want to pull data and show in the destination record. 

3. Click the drop-down list of the Data Element and select a data element from the Upper 
Form of the source business process. For example, you can select Status to show all 
source records of that type in a particular status. In the Values section, select either: 

a. Dynamic: This option requires a Data Source and a Data Element selection. 

Or 

b. Constant: This option requires that you select a data definition from the list of available 
data definitions. 

4. When finished, click OK to go back to the Query items window. 

15) Click Apply and then OK to save your query. 

Summary Elements 

If you want summarized information from the query tab displayed in the upper form, define the 
summary data elements and then add them to the upper form of the business process.  

To define Summary Elements: 
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1) Click the Summary Element node (beneath the Query Tabs node). The Summary Element 
log opens. 

2) Click the New button in the log toolbar. The Summary Element window opens. 

3) Enter an Element Name. The Summary Element Name is concatenated from the Element 
Name you enter and the Summary Type you select, with a system-defined prefix. Unifier only 
allows alphanumeric characters. 

4) Enter a Form Label. You will add this element to the upper form.  

5) Select a Summary Type. Available options are Average, Count, Total, Maximum, and 
Minimum. The interface changes dynamically for the type selected.  

6) Select the Query Tab on which you want to display this information.  

7) Click OK when done.  

To add Summary Elements to the Upper Form: 

1) Open the Destination business process Upper form.  

2) Select a cell into which you will add the Summary Element. 

3) Click the Summary button on the Upper form toolbar. The Summary Element Picker opens.  

4) Select a Summary Element and click OK. 

5) Click Save.  

6) Click Close Window.  

7) Follow the same steps to add the Summary Element to any other Upper forms on which you 
want to include the Summary Element. 

8) When finished designing the business process, change the Status to Complete. 

9) Click Deploy to make the business process available in Unifier. 

Adding a Grid Summary to a Detail Form 

You can add line item grid summary to a line item business process and use it to track and 
display, for example, the number of hours performed on a project on a daily basis. You can 
configure the summary to display Total and average amounts. Summary is allowed only for 
numeric data elements. 

 To configure a grid summary on a detail form 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner. 

3) Click the Business Processes node. The Business Processes log opens. 

4) Open the cost or line-item type business process for which want to configure a Summary for 
Total Amount and/or Average Amount. 

You can use the Find feature to locate the business process in the Business Process log. 

5) In the Navigator, click Detail Form. The Detail Form log opens. 

Select the detail form to which you want to add the grid summary and either double-click or 
click click the Open button. 

6) Open the Detail form by either selecting it and clicking the Open button, or by double-clicking 
the form. The Detail form opens.  
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In the Detail form tool bar, click the Properties button. The Elements Properties window 
opens. 

7) Select an element for which you want to add a summary 

8) Click the Summary button.The Summary dialog box opens.  

9) Select the options you want to use; you can use both average and total summary selections, 
or just one selection, for the grid summary. 

 Display on Total Line — Use this selection to create a summary row at the bottom of the 
line item grid at run time. 

 Display on Average Line — Use this selection to create an average row at the bottom of 
the line item grid at run time. 

 Show Negative Numbers as — Use this selection to define the negative number format. 

 Click the OK button to save your selections. 

 You will see your selections for the numeric data element in the Summary column on the 
far right of the Elements Properties window. 

At run time, you will see real time updates in the Grid View at the bottom of the window.  

Copying a Detail Form 

You can copy an existing detail Form and create a new detail form.  

To copy an existing workflow: 

1) Go to your Company Workspace (Admin mode). 

2) Click to expand the uDesigner module. 

3) Go to your business process. 

4) Click Detail Form sub-node to open the Detail Form log. 

5) From the menu, click Copy and select Copy From to open the BP Detail Forms window 

In the BP Detail Forms window you have the following menu options that enable you to copy a 
detail form or find a detail form that you want to copy: 

 Copy

Use this option after you select the detail form that you want to copy to the destination BP 
design. You can copy one detail form at a time, only. 

 Find

Use this option to find and search for detail forms based on Business Process, Form Name, 
and Description fields. 

 Close Window

To close the window. 

In the BP Detail Forms window you have the following columns that provide details for each 
available detail form: 

 Business Process
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This column displays a list of BPs which support line item tabs. The BPs can be 
Company-level or the Project-level BPs. In addition, the BPs have matching type. That is to 
state, a Cost-type BP can receive detail forms from another Cost-type BP. The source of the 
BP design can be in draft (Status = Draft) or complete (Status = Complete). Published detail 
forms are also listed. 

Note: The query-based tabs (QBT) are not listed. So if a BP has five tabs (three 
non-standard, one standard, and one QBT), the list will include only the non-standard tabs. 

 Form Name

The name of the detail form. 

 Description

The description of the detail form, if available. 

When creating a new detail form by using a copied one, the following data will be copied from 
the source detail form: 

 All detail form elements (custom, linked, and standard). 

 Tooltips, if any.  

 Detail form properties such as auto-population, reverse auto-population, and so forth. 

 Data pickers and the pickers part of the design.  

Note: The references for all the pickers must be established in the destination BP after 
copying is complete. Also, the referenced BPs will not be copied. 

When copying an existing detail form (from a Business Process (BP) form) and creating a new 
detail form: 

 If the destination BP has a detail form with the same name as the one copied, then Unifier 
adds the words "Copy of" to the beginning of the detail form name. 

 If the destination BP has 15 tabs, then Unifier displays: "Up to fifteen detail forms or query 
based tabs can be defined per business process." 

 If the destination BP has a data picker, and the data picker has a picker configuration, then 
Unifier retains the data picker query conditions of Q3, Q4, and Q5 in the destination BP. 

You can copy an existing detail form (from a Business Process (BP) form) and create a new 
detail form. This is similar to a copying and existing Upper Form (from a Business Process (BP) 
form) and creating a new Upper Form. When creating a new detail form by using a copied one, 
Unifier alerts the user when any Data Element (DE) specific to the process is missing in the 
form.  

Moving or Deleting Blocks 

To move blocks 

1) On the Form Designer window, click Blocks. 

2) Select the block you want to move and click the Move Up or Move Down button. 

3) Click OK. 

To remove blocks 

1) On the Form Designer window, click Blocks. 
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2) Select the block you want to remove and click Remove. 

3) Click OK. 

Adding Fields to the Form 

Once you have created the blocks for the form, you can insert fields in the blocks. 

To insert fields, you will be choosing data elements from the following lists: 

 Custom Data Elements 

 Standard Data Elements (Not applicable for Document Manager > Folder Properties or 
Document Properties)  

 Linked Elements 

You can also auto-populate these fields from outside elements (see Auto-Populating Fields
(on page 324)).  

To add custom or standard elements to the form 

The Standard elements are not available for:  

Note: The standard elements do not support reverse auto-population 
(RAP).  

 Planning items 

 Planning sheets 

 Asset classes 

 Folder properties 

 Document properties 

 Shells 

1) In the Upper Form (or Detail Form) Design window, select an empty cell; then do one of the 
following: 

 To add a custom data element, click the Add Custom button. 

 To add a standard data element, click the Add Standard button. 
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 To add a linked data element, click Linked. See Adding Link Elements to a Form (on 
page 386). 

One of the following windows opens: 

2) Highlight a data element from the list and click the Select button on the toolbar. uDesigner 
adds the data element to the selected cell on the form and enters a check mark on the picker 
window in the Used column beside the data element. 
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To add multiple data elements at once, press the Ctrl key and click the element names. 

Tip: Be sure there are enough empty cells to accommodate all the 
elements you have chosen. If you are short on cells, click the Insert 
Row button on the Designer window toolbar to add cells to the form. 
Then select the data elements. 

The Data Element Picker window remains open, but uDesigner brings the Form Designer 
window to the front. 

3) To add more elements to the form, select another cell on the Form Designer window and 
repeat step 2. 

4) When you have added all the fields to the form, click Close Window to close the element 
picker. 

5) To exit the designer window, click Close Window. 

To find a specific data element 

The list of data elements designed for your company can be large. To quickly display the 
element you want to use, you can use the Find feature at the top of the window. You can search 
for a data element by the element name, its form label, or its data definition. You can narrow 
each of these search options by using operators on the fields, such as "contains" or "is empty." 

Note: Only the Custom Data Elements window includes a Find feature; 
the Standard Data Elements window does not. 

1) In any of the search fields—Data Element, Form Label, or Data Definition—click the 
underlined operator and choose the operator you want to use to narrow the search. 

2) If you have chosen any operator except "is empty" or "is not empty," enter the text the 
operator should look for. 

3) Click Search (or press the Enter key on your keyboard). uDesigner will list all the elements 
that meet the search criteria you entered. 

How this Find Window Works

When you open the Custom Data Elements window, uDesigner assumes you will want to search 
for elements and displays the Find feature at the top of the window. You can close the Find area 
of the window at any time by clicking the x in the upper-right corner, and reopen it by clicking the 
Find button. 

When you use the Find feature, uDesigner displays the elements it finds. If you close the Find 
area thereafter, the list will return to normal, showing all data elements. If you open the Find 
feature again, it will clear the list, assuming that you are going to enter more search criteria. 

To sort the list 

The list of data elements shows: 

 The name of the data element 

 The label of the element that appears on the form 

 The data definition on which the data element is built 
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 Whether the element was shipped with Primavera Unifier (Pre-Defined), or was created 
by your administrator 

To make finding a data element easier, you can sort the list by any of the columns. For example, 
if you are more familiar with the elements by their form labels, you can sort the list alphabetically 
by the Form Label column; or if you are looking for a picker, you might sort the list alphabetically 
by the Data Definition column. 

To sort the list by a column order, click the column heading. uDesigner displays the list in 
alphabetical order by that column. To see the list in reverse-alphabetical order, click the column 
heading a second time. 

To move data elements 

Once you have added elements to the fields on the form, you can drag and drop the elements 
from one location to another and one block to another block. To do so, position your cursor over 
the name of the field, right-click, and drag the field to its new location. 

Note: You cannot move an element into a cell that is already occupied 
by another element. To make room for rearranging elements, insert an 
extra row. When you are through moving elements around, delete the 
extra row. 

To preview the form 

Once you have defined the form, you can preview it to see how it will look in Primavera Unifier. 
On the open form in the Designer window, click Preview. uDesigner displays the form in a new 
window. 

Note: The layout and the interface seen in the preview depends on the 
availability of the Standard View for the selected business process. If the 
Standard View is not supported, them the preview will be seen in the 
Classic View.  

To preview the log 

The Preview option is available both in Standard and Picker logs (uDesigner > Log > 
Standard and uDesigner > Log > Picker).  

Enhancing the Field's Behavior 

Once you have added a field to a form, you can enhance the behavior of the field by: 

 Adding a Note to a Field (on page 320) 

 Making Fields Required, Editable, or Read-Only (on page 313) 

 Adding Formulas to Fields (on page 315) 

 Validating Field Values (on page 322) 

 Auto-Populating Fields (on page 324) 

 Erasing or Resetting Field Values During a Workflow (on page 323) 

 Adding a Reference Process to Auto-Populate Data (on page 355) 

 Adding a Reference Process to Auto-Populate Data (on page 355) 
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 Linking Elements in Shell Hierarchies for Easy Restructuring (on page 334) 

 Viewing Details About Form Fields (on page 336) 

 Making a Field a Hyperlink (on page 334) 

Adding More Functions to the Form 

For some business processes, you must add additional pieces to the form for users to use in 
collaborating on a task. For example, you might need to organize business process line items, 
by creating multiple tabs for the forms to make it easier to locate business details. You might 
also need to add a reference process or an email notification to the form. In addition, you can 
auto-create records from certain forms. 

Similar to the Action form, you can add email notification data element to a non workflow BP 
View form. The user can select the fields, from a View form, to include in the email notification. 

Users who receive email notification (based on events triggered) will see the data elements 
based on email notification elements setup in uDesigner which is across all view forms for 
Workflow BPs. For Non-workflow BPs, the email notification received will show all the data 
elements based on email notification elements setup across all upper forms in uDesigner.   

Similar to the BP View Form, you can create multiple View forms in a shell type, similar to 
non-workflow business process.  

Note: In uDesigner, you can only have one Action form for a shell type. 

You can create multiple View forms manually, or by using the Copy option. From the toolbar 
(Company Workspace > Admin mode > uDesigner > Shell Manager > Detail Form), for both 
existing shell types and creating new shell type, you can use the: 

 New

To create multiple View forms. 

 Copy

To copy existing forms and create new View forms. 

Note: You can create both Action and View forms in any order, but the 
design must have one Action form, only. 

When creating a new View form manually, in the Form Design window, General tab: 

 If an Action form already exists for the shell design, then the View Form option will be 
automatically selected, and the Action Form option is disabled. 

 If an Action form does not exists for shell design, then when creating a new form you will 
have the option to select the new form an Action form or a View form. 

When creating a new View form by way of Copy, , in the Form Design window, General tab: 

 If an Action form already exists for the shell design, then the copied version will have the 
View Form option selected and disabled, automatically. 

 If an Action form does not exist for the shell design, then the copied version will have both 
the Action Form and the View Form options enabled, and you can select one of the form 
options. 
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You can create multiple View forms and a single Action form in shell design, and the system 
does not place any restrictions regarding the sequence of the created forms. 

After your design is deployed, deleting a View form will remove the form the View Forms tab, in 
the Shell Details window. 

Custom data elements that you add to a View form must be present in Action form; otherwise, 
the shell design cannot be completed. 

SYS Rich Text type Data Element 

The data elements of SYS Rich Text type are allowed to be placed on the upper forms of all 
types of BPs. You can put a maximum of five data elements, of the SYS Rich Text type, within 
the BP design. There are no limits for the number of columns in a block that contains the SYS 
Rich Text type data element, within the BP form.  

The following table explains the expected behavior when you place the SYS Rich Text type data 
element on a BP: 

BP component Any 
impact? 

Expected behavior 

Data Picker 
Configuration 

Yes DE of SYS Rich Text should not be available in setting 
query conditions for the data picker 

Data Elements 
Configuration 

Yes Unique: DEs of SYS Rich Text type should not be 
available to be added as 'Unique' Data Elements on a 
BP. 

Auto-Sequence: Not applicable. 
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BP component Any 
impact? 

Expected behavior 

Integration (in 
the BP 
properties) 

Yes Input XML: 

If the Rich Text DE is set to input/both in integration 
setup within the BP, then it should show up in the input 
xml file with proper tags. 

When the user does an input into Unifier using this XML, 
the input for the SYS Rich Text DE can be plain text or in 
HTML. 

The DE will be supported in REST calls only. The DE will 
not be supported in SOAP services.  

Output XML: 

If the Rich Text DE is set to output/both in integration 
setup within the BP, then it should show up in the output 
xml file with proper tags. 

Note: When data will be extracted via xml, the value of 
SYS Rich Text DE will be in HTML. 

Input CSV Template: 

If the Rich Text DE is set to input/both in integration 
setup within the BP, then it should show up the input 
CSV Template. 

When creating data via the csv template, user can input 
the SYS Rich Text DE value as plain text or HTML. 

Note: In both SOAP and CSV import/Export of Rich Text 
type DEs, only HTML format of content will be supported 
(JSON will stay unsupported). 

Templates Yes. The 
DE should 
be allowed 
to be 
placed on 
the Form 
Templates. 

When blocks are added to a BP form by copying from 
Template, the DE should get copied over correctly. 

When related forms are updated using the template, the 
DE should get pushed to blocks correctly. 

Upper Forms Toolbar: 
Yes 

Link Elements: 

This DE should not be allowed to be set as a Linked Data 
Element on BP forms. 

Tooltip: 

DEs of this type should be available for adding a tooltip. 

Note: The remaining options on the toolbar are not 
applicable for this DE. 
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BP component Any 
impact? 

Expected behavior 

Upper Forms Action 
Form: Yes 

View Form: 
Yes 

This DE should be allowed to be placed on the upper 
forms of all types of BPs. 

Access: 

The user has the ability to mark SYS Rich Text DEs in all 
three access types (Editable, Required, and Read-only). 

Email Notification Elements: 

This DE cannot be added as an Email Notification 
element. 

Formula: 

This DE cannot create formulas in source or in 
destination. 

Auto-populate: 

This DE cannot be auto-populated (AP), as per matching 
DD. 

The user cannot set a constant value in this DE. 

Reverse-Auto-populate: 

This DE cannot be reverse auto-populated (RAP) as per 
matching DD. 

Reset:  

The user can reset this DE. 

Add Note: 

The user can add note to this type of DE. 

Mobile: 

The user can add this DE to mobile DEs. 

Note: The remaining properties are not impacted by this 
DE. 

Detail Form Not 
applicable 

Not applicable 

Query Items Not 
applicable 

Not applicable 

Item Logs Not 
applicable 

Not applicable 

Workflows No This DE is not available to be used as a Trigger Element 
or Action Name (or in any other place) within a Workflow. 
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BP component Any 
impact? 

Expected behavior 

Log (Standard) Yes Layout:  

This DE cannot be placed in the Layout tab. 

Sort Order: 

Not applicable. 

Find: 

This DE cannot be added for "Find." 

Log (Picker) Yes Same as Log (Standard), above. 

Note: This DE cannot be added in the Group By tab. 

Reference 
Process 

Yes General tab: 

This DE cannot be a Source element in this tab. (This 
applies to both the 'Source Element' drop-downs in this 
tab.) 

Query tab: 

Yes 

Note: This DE cannot be used to create queries. 

Integration 
(setting of DEs 
inside the BP) 

Yes Upper: 

This DE cannot be added in integration and set as Input, 
Output, or both. 

Detail: 

Not applicable. 

Auto-creation 
Processes 

Yes Upper: 

The DEs of SYS Rich Text type cannot be included in the 
Display Element drop-down in the auto-creation 
configuration for BP creators 

Detail: 

Not applicable. 

Bid 
Comparison 
Sheet (Applies 
to RFB type 
BPs only.) 

Yes This DE cannot be added to the sheet from the Bidder 
form or as a custom element. 
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Moving Data Elements 

Once you have added elements to the fields on the form, you can drag and drop the elements 
from one location to another and one block to another block. To do so, position your cursor over 
the name of the field, right-click, and drag the field to its new location. 

Note: You cannot move data elements in a block that comes from a 
linked template. 

You cannot move an element into a cell that is already occupied by another element. To make 
room for rearranging elements, insert an extra row. When you are through moving elements 
around, delete the extra row. 

Previewing the Form 

Once you have designed the form, you can preview it to see how it will look in Primavera Unifier. 
On the open form in the Designer window, click the Preview button. uDesigner displays the form 
in a new window. 

Making Fields Required, Editable, or Read-Only 

As you define the purpose of each form, you will often want to specify whether fields are 
required (the user must enter information), editable (the user can change the information in the 
field), or read-only (the user cannot change the information in the field). 

If you are using a dynamic data set on the form, the Master Data element can be marked as 
Editable, Editable (Required), or Read-Only.  

To specify a field's behavior 

Select the cell, then click Editable or Required or Read-Only as appropriate. 

Any field used in a formula must be marked "required;" otherwise, the calculation cannot be 
performed. 

Including a Map 

For shells and some projects, you can include a map that will show the user a map of the shell 
or project location. The map is an aid to identifying and visualizing the shell or project in 
Primavera Unifier. 

You can offer the map option to the user in two ways: 

 By entering an address 

 By using latitude and longitude coordinates 

To provide the mapping feature, you must include on the form either: 

 An address field: uuu_address_code
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This field can be a manual-entry field, or you can create the field with a string formula. 
For example, if you had separate data elements for City, State, and Zip Code, you 
could combine them as a string formula for the address code. 

If you are using a formula to create the code, be sure to include the delimiter (such as a 
space or comma) between the fields; otherwise, the map might not appear. 

 Both a latitude and longitude field: uuu_latitude and uuu_longitude

The latitude field is accompanied by a globe icon, which users can use as a latitude 
picker. 

Including Tooltip 

To add a tooltip to a business process form 

1) Click the Company Workspace tab and switch to Admin mode.  

2) Click uDesigner > Business Processes in the left Navigator. 

3) Open the business process for which you want to create the upper form. 

4) In the Navigator, click Upper Forms. The Form Designer - Upper Form window opens. 

5) From the toolbar options, click Tooltip to open the Tooltip window. 

6) Double click on a Data Element to open the Edit Tooltip window, where you can change the 
tooltip. 

If a data element in a BP form contains a tooltip (associated in the design), at runtime a question 
mark (?) symbol appears next to that field.  

When you click on the Tooltip option, the Tooltip window opens which displays the following 
information in columns: 

 Data Element: The name of the data element. 

 Form Label: The label for the data element. 

 Tooltip: The description of the tooltip. 

The Tooltip window has the following toolbar options: 

 Open

 Find

 Update from Data Element Properties

When you open the Tooltip window from the Upper Forms, all unique data elements from 
across all of the Action and View forms are displayed. 

Note: If a data element exists in multiple forms, the data element will 
appear on this window once, only. 

The data elements can be read-only or editable. 

When you open the Tooltip window from the Detail Form, the data elements from across all of 
the line item detail forms are displayed. 

When you open the Tooltip window from the Attribute form, the data elements present in the 
Attribute form are displayed. 
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When you click the Update from Data Element Properties, the Update tooltip Description
window opens which contains the following information in columns: 

 Data Element

 Form Label

You can select multiple items from the list. 

The list of data elements are filtered based on the data elements available in the Tooltip 
window. You can select one or multiple fields and click Update. When you click Update, Unifier 
processes the changes and updates the tooltip contents. 

Existing Designs 

If a design existed prior to including the tooltip option, and you decide to use the tooltip feature 
at runtime, then you must perform the following: 

 Enter the tooltip in the Data Element properties. 

 In uDesigner, in the tooltip window, click on the Update from Data Element Properties
option to get the updated tooltip from the data element properties. 

 Deploy the design to see the tooltip at runtime. 

 Alternatively, you can open the data element in the tooltip of the design and manually enter 
the tooltip and then redeploy the design. 

Adding Formulas to Fields 

Using uDesigner, you can create formulas for fields that will calculate the value of the field and 
display it. Calculated fields usually will be read-only fields. You can also build composite fields 
that combine string text data elements into one field. 

Tip: As a best practice, any field used in a formula should be marked "required;" otherwise, the 
calculation cannot be performed. 

Notes: 

 You cannot designate a multi-select field as a formula field; however, 
you can use a multi-select field as an element in a string formula. 

 Summary Elements are not allowed in defining the formula.  

Creating Formulas using String (Text) Data 

In uDesigner, you can create a composite field that combines multiple data elements. String 
building involves combining values from text box data elements and specifying a string-type 
pull-down. For example, you can create a field called "Project Identifier" using a formula that 
includes Project, Record No., and location. 

You can define a string formula only for text box and multi-line text field data elements. This 
feature is typically for building fund code segments, but you can also use it to build an address 
code field to Including a Map (on page 313). 

String formulas can be up to 250 characters long, including the delimiters (such as dashes or 
underscores). 
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To create a string formula 

1) Open the form containing the field for which you want to build a formula. The Form 
Designer window opens. 

2) Click the Properties button on the toolbar. The Elements Properties window opens. 

3) Select the field and click the Formula button. The Formula Creation window opens. 

4) Select the delimiter. 

The delimiter separates the elements. For example if you select a dash (-) between elements 
for Project Identifier, it would appear as Project-Record-Location. 

You must select the delimiter before adding the element to the right pane. 

5) Select an element from the left pane and click Add Parameter. The element moves to the 
right pane. 

If you want to change your selection, click Undo or Clear All. After you add an element, the 
element list is disabled and the delimiter icon is activated.  

6) Click the delimiter icon to add it into the formula creation field. 

7) Continue adding other elements following the same procedure. 

8) Click OK to save the formula and close the window. 

Creating Numeric Formulas 

You can use any integer, currency, or decimal amount data element to create a formula. The 
field that holds the calculated value must be numeric with decimals, and there must be other 
numeric data elements on the form. The formula is based on calculations that you assign to the 
field by selecting from a list of the numeric data elements on the form. A numeric formula can 
include a logarithmic function. 

Besides integer, decimal or currency amounts, you can also use the values in pull-down menus, 
radio buttons, and checkboxes for numeric formulas. For pull-down menus in calculations, the 
value of the chosen data set will be used. For radio buttons, the value of the button will be used 
(1 or 2 are the default values, but the formula will use whatever values are specified in 
Primavera Unifier when the business process is set up). For checkboxes, 1 or 0 will be used in 
the formula. If the check box is checked, the value will be 1; if it is not checked, the value will be 
0. 

Numeric formulas can be up to 250 characters long, including the delimiters (such as dashes or 
underscores). 

To create a numeric formula: 

1) Open the form that contains the field for which you want to create a formula. The Form 
Designer window opens. 

2) In the Form Designer window, select the field for which you want to create the formula. 

When the calculation is performed, this field will appear as read-only on the form and is 
automatically updated whenever the fields that make up the formula change. 

3) Click the Formula button. A Formula Creation window opens. 

4) In the Formula Type field, choose Formula from the list. 

5) Click the Create button. Another Formula Creation window opens. 
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6) In the Element pane, select the data element and click Add Parameter to add it to the 
Formula pane. 

Only those fields that can be used in a formula will appear in this list. 

7) Use the numeric keypad to enter the calculating operators to create a formula, or to enter 
numeric values to use on the element. 

Each time you enter an operator, the elements become available again to add to the formula. 

8) Continue Steps 6 and 7 until you have completed the formula. 

9) Click OK to save your changes and close the window. 

To create a numeric formula with a logarithmic function 

The log function supports fields on business process forms only, not attribute forms, 
attribute/detail forms for managers, or manager sheets. Also note: uDesigner calculates base 10 
logarithms, so the base is assumed. 

1) Follow steps 1 through 5 explained in the previous procedure. 

You can start the formula using the log function, or start it using an element or numbers and 
operators, followed by the log function. For example: 

log(SQ Footage) * Unit Cost

or 

100*Quantity/log(Cost) + 75

2) However you start the formula, you must click the log button to enter the logarithm. When 
you do so, uDesigner enters log( ( into the formula box. 

3) To continue the log formula, you can use an element from the Element list, or enter numbers 
and operators using the number pad. 

4) At the end of the log function, click the end-parenthesis ( ) ) button on the numeric pad. 

5) To complete the formula, add other operators and numbers to the formula, if necessary. 

6) Click OK. 

Creating formulas that use dates 

You can create two types of date formulas: 

 A date plus/minus formula will produce a date from a date element, plus or minus a 
specific number of days, or plus/minus the value in another date or numeric element on 
the form. 

 A date-difference formula will produce the number of days between two date fields. This 
numeric operation is useful for calculating payment due dates. 

Formulas Using Date Fields

uDesigner provides two data definitions upon which date pickers can be built: Date Picker, which 
includes the date and time, and Date Only, which does not include the time. Data elements built 
on these definitions cannot be mixed in a formula. For example, to create a date-add formula for 
a date-and-time type of field, you can add an integer only to another date-and-time element; you 
cannot use a date-only type of element in the equation. 
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To create a date plus/minus formula 

1) Open the form that contains the date field for which you want to create a formula. The Form 
Designer window opens. 

2) In the Form Designer window, select the date field for which you want to create the formula. 

When the calculation is performed, this field will appear as read-only on the form and will be 
automatically updated whenever the fields that make up the formula change. 

3) Click the Formula button. A Date Formula window opens. 

4) For Calculations based on, choose: 

 Calendar Days to calculate the formula based on calendar days. This option does not 
take company non-working days into account. 

 Work Days to calculate the formula based on the company calendar working and 
non-working days. 

Example:  

When: Date 2 = Date 1 + 1 working day 

 If Date 1 is a working day, then the system calculates from the selected date and adds 
the number of working days. So, if Date 1 = 01/23/2023 (working day), then Date 2 = 
01/24/2023. 

 If Date 1 is a non- working day, then the system calculates from the next working day and 
adds the number of working days. So, if Date 1 = 01/21/2023 (non-working day), then 
Date 2 = 01/24/2023 because the system calculates from 01/23/2023 at 12.00 AM 

To create a date-difference formula 

1) Open the form that contains the field for which you want to create a formula. The Form 
Designer window opens. 

2) In the Form Designer window, select the date field for which you want to create the formula. 

When the calculation is performed, this field will appear as read-only on the form and will be 
automatically updated whenever the fields that make up the formula change. 

3) Click the Formula button. A Formula Creation window opens. 

4) In the Formula Type field, choose Date Difference from the list. 

The window expands to show additional fields, as shown in the table below. 

5) Click OK to save your changes and close the window. 
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In this field: Do this: 

Latest Date Click the down arrow. uDesigner displays a list of all 
the numeric fields on the form. From this list, choose 
the field that contains the later of the two dates that 
will be used in the calculation. 

Earliest Date Click the down arrow. From this list, choose the field 
that contains the earlier of the two dates that will be 
used in the calculation. 

Calculations based on Choose Calendar Days to include all the days of 
the week in the calculation. Choose Work Days to 
use only the work days of the week in the 
calculation. 

Linking Data Pickers Using a Formula 

Data pickers can be linked to corresponding pickers in order to make available to the user the 
functionality of the data picker and also of the linked picker. 

 Shell data pickers can be linked to shell pickers to facilitate shell auto-creation 

 Configurable manager data pickers can be linked to configurable manager pickers to 
enable quantity and cost rollups to configurable manager sheets 

 User Pickers can be linked to user data pickers to offer the functionality of both types of 
picker on a business process form. To do this, place the user data picker on the business 
process upper or detail form and place the linked User Picker in a hidden block on the 
form; then link the two types of pickers as described in the following steps. 

To link a data picker 

1) Open the form on which you want to link the pickers. 

2) In the Form Design window, click the Properties button. The Elements Properties window 
opens. 

3) On the Elements Properties window, select the shell picker, the code picker of a configurable 
manager, or the user picker you want to connect to a data picker. 

4) Click the Formula button. The Formula Definition window opens. 

5) In the Data Picker Element field, select the data picker element on the form that you want to 
link to the picker or shell you selected. 

 For rollups to a configurable manager sheet: The configurable manager data picker 
will populate the code picker for the manager with the value and the data will roll up to 
the code on the sheet. The field becomes read-only. Anytime the data picker value 
changes, it will be automatically reflected on the code picker. 

 For BP auto-creation across shells: The shell will use the shell data picker to tell it 
where to create the business process. 

 For business processes, a Configurable Manager, and shells: The user data picker, 
when linked to the User Picker, will provide the functionality of both the User Picker and 
the User Data Picker. Refer to the Unifier Data Reference Guide for descriptions of the 
picker data elements. 
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Using a Formula in a Required Field 

You can define a formula for a required field in your form.  

If you create a BP record or line item by way of CSV/Excel or RESTful web services, if the 
required elements are set as formulas, and the required elements are not included in the 
Integration tab (company or shell), then the system will not complete the BP record or line item 
creation. 

In the Bidder detail form, the short description (short_desc) DE is a 
required field. You cannot add the (short_desc) DE in a hidden block. 

Adding a Note to a Field 

Using a note, you can enter details about this element and what it is designed to do. Adding a 
note to a field on the form is optional, but can be helpful to others in understanding how this 
element works on this form, particularly if it has a special behavior, such as automatically 
creating another record. 

To add a note 

1) Open the form for which you want to add a field note. 

2) In the Form Designer window, click the Properties button on the toolbar. The Elements 
Properties window opens showing a list of the fields (data elements) on the form. 

3) Select the field you want to add a note to. 

4) Click the Add Note button. A Notes window opens. 

5) Add the note in this window and click OK. 

 You can enter up to 4000 characters.  

 uDesigner will display the note in a Notes column on the Elements Properties window. 

 To read the note, scroll over to the Notes column, or double click the data element to 
open another Element Properties window that shows the entire note.  

Adding a Dynamic Data Set 

A dynamic data set will not be visible on the form as a "set" in a single cell, but rather as 
separate data elements that will act with a specific behavior in Primavera Unifier. Consequently, 
you cannot click on a dynamic data set and see it in the cell you select. Instead, you must add 
the set's data elements to the cells individually. Then, to make the elements a dynamic data set, 
click the Dynamic Data Set button. Although you will not see any indication at that point, the 
dynamic data set will instruct Primavera Unifier to use the elements named in the set in the 
behavior the set specifies. 

For more information on dynamic data sets, see Dynamic Data Sets (on page 207). 

To add a dynamic data set 

1) Open the form for which you want to create a dynamic data set. 

2) In the Form Designer window, add the data elements specified in the dynamic data set by 
choosing from either the custom or standard elements. 
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3) Click the Add button. The Dynamic Data Sets List window opens, showing the dynamic data 
sets that have been created. 

4) Select the set you want and click OK. uDesigner displays the set in the Dynamic Data Set 
window. 

5) Click Close. Primavera Unifier will use the elements named in the set in the behavior the set 
specified. 

Updating Query-Based Field Values with a Trigger Element 

Data elements built on the SYS Numeric Query Based data definition extract data from any 
business process or manager sheet. These elements prompt Unifier to run a query to extract the 
information. (This query is created by the administrator at the time the business process is 
configured.) These elements are updated:  

 When a user opens the business process in edit form. 

Unifier runs the query and displays the latest value in the query-based field, if the conditions 
are met. 

Unifier updates the system numeric query-based Data Elements (DEs) of a BP form in edit 
mode, only. Also, you must save (or send) the updated value in order to ensure that the 
value is committed to the database, displayed when viewing the form, and displayed in the 
BP log. 

 When a user changes the value in a "trigger element" on a business process form. 

The trigger element prompts Unifier to run the query again and dynamically update the value 
in the query-based field. 

The instructions in this section show you how to assign a trigger element to a query-based field. 

Note: This feature is not available for company-level, single-record 
business processes. 

To assign a trigger element to update a field value 

1) Open the form that contains the field you want to update. The Form Designer window opens. 

2) In the Form Designer window, click the Properties button on the toolbar. The Elements 
Properties window opens showing a list of the fields (data elements) on the form. 

3) Select the query-based field(s) you want to update and click the Trigger Elements button. 
uDesigner displays the Trigger Elements window. 

4) Click the Add button. The Trigger Column Header window opens. 

5) In the Data Element Label field, select the data element you want to act as the trigger that 
will update the value in the query-based field(s) you selected in Step 3. 

The Data Element Name field will show the name of the data element you selected. 

Note: The trigger element must be an editable field, such as the refid
element that references a contract business process. 

6) Click OK. 

7) On the Trigger Elements window, click OK. 
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To remove a trigger element from a field 

1) Open the form that contains the query-based field currently being updated. The Form 
Designer window opens. 

2) In the Form Designer window, click the Properties button on the toolbar. The Elements 
Properties window opens showing a list of the fields (data elements) on the form. 

3) Select the field(s) you want to remove the trigger element from. 

4) Click the Trigger Elements button. uDesigner displays the Trigger Elements window. 

5) Select the trigger elements you want to remove and click the Remove button. 

6) Click OK. 

Validating Field Values 

For many situations, you might want to place limits on the values the application will accept for 
numeric fields on a form.  

Example 

A budget transfer might move monies from one CBS code to another. In this situation, the 
transfer must show a net zero amount. For this case, you would want to validate the amount 
field to verify that it equals zero. At runtime, the application will validate the value in the 
amount field and display an error message if the value exceeds zero. 

For some situations: 

 You might require that the user fill out one or more fields before leaving a form.  

Example 

For a list of five checkbox items, you might require users to check at least three out of the 
five. So for validation, you could include a hidden field on the form containing a formula that 
adds the value of each checkbox (checked = 1, unchecked = 0). If the value of this hidden 
field is less than 3, then the user will not be allowed to leave the form. By data definition, 
checkboxes are integers, and you cannot place a formula on an integer field; however, you 
can use integer fields in formulas. The hidden field in this example must, therefore, be a 
decimal field that holds the total value of the checkboxes. That decimal field must be greater 
than or equal to 3 for this validation. At runtime, the application will validate the value in the 
hidden field and display an error message if the value is not greater than or equal to 3. 

You require that the user includes at least one associated attachment.  

Example 

Submittals are used to track items that are produced by an outside supplier or subcontractor 
and are delivered to a contractor for use in a project, so Submittals would require to include 
attachments in the record or line item to support the process. In such cases, you might 
require users to include at least one attachment. So for validation, you could include a 
read-only DE on the forms to display the attachment count. 

This DE (uuu_attachment_count) can be placed in any form, whether the form allows 
including attachments or not. 

To validate fields, you need to create validation rules and then apply them to the field when you 
design the form. 
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To create a validation rule 

1) Open the form that contains the field you want to validate. The Form Designer window 
opens. 

2) Click the Validation button in the Designer window toolbar. The Validation Rules window 
opens. 

3) Click the Add button. A Validation Rule window opens. 

4) In the Name field, enter a name for this rule. 

5) In the Expression field, click the Formula button. The Formula Creation window opens. 

6) On the left pane, double-click the element you want to validate to move it to the right pane. 
Then click OK to close the window. 

7) In the Condition field on the Validation Rules window, click the down arrow and choose the 
criteria the field value must meet, such as "Greater than or equal to." 

8) In the Value field, enter the value the field must not exceed. 

9) In the Show this message... field, enter the error message the user should see if the field 
value exceeds the value you specified.  You can enter up to 400 alphanumeric characters. 

10) Click OK. 

To apply a validation rule to a field 

1) In the Form Designer window, select the cell containing the field you want to validate. 

2) Click the Validation button on the toolbar. The Validation Rules window opens. 

3) Select the rule you want to place on this field and click Close. 

Erasing or Resetting Field Values During a Workflow 

At some point in a workflow, you might want to force users to re-enter data into a field; for 
example, if a form is rejected and returned to a previous step, where the user must enter new 
data in the field in order for the form to be approved. Or, you might want a field to return to a 
default value whenever a step is revisited in the workflow. In such cases, you can erase, or reset 
the field when it arrives at the next step so that either the user must re-enter the data, or 
Primavera Unifier must recalculate the field. (If a formula field is dependent on the reset value, 
then the system recalculates the formula.) 

This feature applies only to required upper form fields in BPs with workflows and is applicable for 
the following Data Element (DE) types: 

 Text 

 Pull-down 

 Radio button 

 Check box fields 

 Hidden blocks 

 Date Picker (Only non-uuu date pickers) 

 Date Only Picker (Only non uuu-date only pickers) 

 Data Picker (all types) 

 User Picker 

You cannot use the above DE types for the following: 
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 Read-only fields 

 System elements such as due_date, creator_id, and "uuu" elements, except if the DE is of 
Custom type 

 SYS type data definition, except if the Data Definition (DD) is of SYS string data type 

Note: If you use this feature, be aware that the field will be erased or 
reset at each step of the workflow in which it is used. For those steps in 
which you want the value of the field to "stick," use another action form 
where the field is not set to Reset. 

To erase or reset a field value 

1) Open the form that contains the field you want to erase or reset. The Form Designer window 
opens. 

2) Click the Properties button on the toolbar. The Elements Properties window opens 
showing a list of the fields (data elements) on the form. 

3) Select the field(s) you want to erase or reset. 

4) Click the Reset button. 

Auto-Populating Fields 

Using uDesigner's auto-population feature, you can automatically populate fields on a form at 
the time the form is created. You can populate the fields on the new form with: 

 Data from fields on other forms or Primavera Unifier sources 

 A constant value or boiler-plate text you specify (see "Auto-populating fields with a 
constant value," below.) 

Dynamic Data Sets

 You can auto-populate only the master element of a dynamic data set. 

 You cannot auto-populate the fields in a value set or behavior set. 

 You cannot auto-populate a dynamic data set on a Payment Application. 

 You cannot auto-populate role name data pickers. 

This can save time for users because they don't have to fill in every field of the form. For 
example, you could use this feature to automatically fill in a "Plant Location" field from an 
attribute form. For another example, you could set up the date field on a time sheet to default to 
the server date and time so that users do not need to use a date picker. You could also set up a 
field to automatically display a title or other boilerplate text for common forms users need to fill in 
on a frequent basis.  In addition, auto-population can be used with the Primavera Unifier portal. 
When a user logs into the portal to submit a form, such as a work order, the user's information, 
such as his/her location and department, can be automatically populated on the work order. Or, 
when an employee "move" request is created, the current location of the employee can be 
auto-populated onto the move request form. 
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Auto-population works similarly to reference processes: It links a field on a form to outside data 
by "mapping" the field to a field on the outside source. In operation, the field you want to 
auto-populate will point to the outside source and use the value in that field to populate the field 
on the new form. Once the mapping link is created, you can use the outside source to populate 
any fields that the outside source and the new form have in common. 

Note: To auto-populate fields, the data definition of both fields--the one 
on the current form as well as the one on the outside source--must 
match. 

Auto-population occurs on the creation step

The new form will be populated only once with the field values, during the creation step in the 
workflow. Therefore, the field you want to populate must be included on the form(s) that will be 
attached to the creation step in the workflow. If you do not want this field to be visible on the 
creation step form, put it in a hidden field or block on the form. Once the field is auto-populated 
in the creation step, it remains static in all subsequent workflow steps; the values will not be 
updated by this feature. 

Auto-population can be triggered whenever a business process is created using auto-creation 
(S-step or I-step) integration, CSV files, Unifier on mobile devices, or portal submissions. In 
some cases, you can design the auto-population to be triggered by a user data picker. (This is a 
type of data picker you can create. See About User Data Pickers (on page 198).) For instance, 
you can design an office move order for an employee to be auto-populated with the employee's 
current location when the Unifier user chooses the employee from a user data picker. 

Use auto-population for text boxes, text areas, pickers (including user data pickers), pull-down 
lists, checkboxes, and radio buttons. 

You can populate fields on a form from the following sources: 

 Fields on an attribute form for managers (except a code-based configurable manager) 

 Fields on another (referenced) business process form 

 Fields on a user attribute form (via a user data picker) 
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 Shell attribute forms 

 Fields from an upper form (to fields on a detail form) 

 Fields on single-record BPs at the company, shell, or standard project level 

 User data picker on a referenced business process (from a user data picker on the 
source business process) 

 Fields on an SOV (for a payment application BP) 

 Fields from document properties of a line item attachment 

 The total value from a line-item numeric field (can populate a field on an upper form; 
becomes a read-only field) 

 A constant value you enter when you set up auto-population for the field 

You cannot auto-populate: 

 BP pickers 

 Multi-select fields 

 The master element of a dynamic data set 

To auto-populate a field 

1) Open the form that contains the field you want to auto-populate. The Form Designer window 
opens. 

2) Click the Properties button on the toolbar. The Elements Properties window opens showing 
a list of the fields (data elements) on the form. 

3) Highlight the field you want to auto-populate and lick the Auto-populate button. The Auto 
Populate window opens. 

The Destination Element field shows the data element that you are populating on this form.  

4) In the Source Name field, specify the outside source where the data should come from. 

The source of the populating data depends on the type of component you are designing. For 
example, for a payment application business process, you could auto-populate a field using 
data from: 

 A BP picker on a referenced business process 

 A line item picker on the upper or detail form of a referenced business process 

 A fund or CBS picker on the detail form of a fund attribute or cost attribute form 

 A single-record BP 

 The upper form or detail form of the BP you are creating 

 The detail form of a Base Commit or Change Commit BP 

 The schedule of values (SOV) 

 A shell attribute form 

For another example, you could auto-populate the location field on an employee re-location 
business process by using a user data picker. When the re-location form is created, the 
employee name chosen from the data picker will auto-populate the location field with the 
employee's current location. 

5) In the Source Element field, click the Select button and choose the name of the data 
element that contains the data you want to populate this field. 
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 The source elements you can choose depend on the Source Name you specified. The list 
will show the data elements the source and destination forms have in common; that is, those 
elements whose data definitions match. 

6) Click OK. 

Auto-Populating Fields with a Constant Value 

If you are populating a field with a constant value, the Auto Populate window works differently. 
When you highlight the field you want to populate and click the Auto-populate button, the Auto 
Populate window opens.  

Note: You cannot use a constant value for pull-down lists, check boxes, 
or radio buttons. 

To auto-populate a field with a constant value  

1) Open the form that contains the field you want to auto-populate. The Form Designer window 
opens. 

2) In the Form Designer window, click the Properties button on the toolbar. The Elements 
Properties window opens showing a list of the fields (data elements) on the form. 

3) Highlight the field you want to auto-populate and click the Auto-populate button. The Auto 
Populate window opens. 

4) In the Destination Element field, enter the name of the data element you want to populate. 

Enter the data element name; not the field label. 

5) In the Source Name field, click the Select button and choose ConstantValue. 

When you choose Constant Value, the Source Element field changes to read Source Value. 
See the table below. 

6) Click OK. 

If you entered 
this as the 
Destination 
Element: 

The Source Value field will show: 

A date field A single read-only value—Today Date/Time. This means the 
Destination Element will be populated with the current server date 
and time. 

Note: This option is not available for any due_date element, or any 
data element built on the SYS Date Picker data definition. 

A text field A text area where you can enter the text you want to populate the 
destination element field. For example, if you want the field populated 
with the attendees of a regular meeting, enter a list of the attendee 
names. 

A numeric field A text area where you can enter the numbers you want to populate 
the destination element field. For example, if you want the field to 
contain a numeric ID for a type of document, enter that ID here. You 
can enter up to 13 digits; 15 if you include a fraction or a decimal. 
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If you entered 
this as the 
Destination 
Element: 

The Source Value field will show: 

The name of a 
user data picker

"Login User." At runtime, the field will display the name of the user 
who has signed in and is using the business process. The field will be 
read-only. 

Updating Records Using Reverse Auto-Population 

In much the same way you use the Auto-Populating Fields (on page 324) feature to populate 
fields on other forms, you can use reverse auto-population to update fields on records, as well 
as attribute forms and line items, including auto-created business processes. This can 
streamline the use of forms by keeping the information on them up-to-date with the latest 
Primavera Unifier data from components inside or outside the business process. 

Example 

You could design a "preventive maintenance" business process that auto-creates "work 
order" records for your assets. The work orders, in turn, could update the asset information 
on the original preventive maintenance record. 

Example 

You could create an "office move order" that uses a data picker to reference a user attribute 
form. In Primavera Unifier, the user would use this user data picker to specify the user who is 
moving. The data picker, in turn, will trigger the reverse auto-population once the move is 
complete and update the attribute form with the user's new location. (For information on 
creating this data picker, see About Data Pickers (on page 195).) 

 Fields that use formulas are not eligible for updating with reverse auto-population. 

 To update fields, the data definition of both fields—the one on the current form as well as 
the one on the outside source—must match. 

 You cannot use this feature to update single-record BPs unless they exist under child 
shells, where they can update single-record BPs under any parent shell in the hierarchy. 

 Supported on auto-created BPs. 

Reverse auto-population can be set as a condition. If no condition, then the Reverse 
auto-population happens at every status change of the source Business Process Record. If you 
select a condition, then only the status of the selected source will be updated. When a Workflow, 
or a non-Workflow, in a Business Process record is routed to the next step, and contains a DE 
set to Reverse Auto-Populate (RAP) in the form: 

 If you do not select a source status for RAP, Unifier RAP the DE value after each status 
change. 

 If you do select a source status for RAP that meets the specified status, for example, you 
select RAP to occur at status A and B, as soon as the status of the record changes, the DE 
value RAP as per configuration. 
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Note: The RAP must be evaluated, and occur, after a status change and 
not before.  

Reverse auto-population is the process of passing data from a "destination" object back to a 
"source" object. It is the reverse of auto-population, which passes data from a source object to a 
destination object. 

Reverse auto-population works similarly to reference processes. It links a field on the form or 
line item to outside data by "mapping" the field to a field on the outside source. In operation, 
whenever the value of the field on the outside source changes, it will update the field on the form 
or line item you are designing. The update occurs when the Primavera Unifier user fills in the 
form and: 

 (for a workflow BP) routes the form to the next step 

 (for a non-workflow BP) clicks Finish Editing

Reverse auto-population can be triggered whenever a business process is created using 
auto-creation (S-step or I-step), integration, CSV files, Primavera Unifier on mobile devices, or 
portal submissions. For some reverse auto-population cases, the update can be triggered by a 
user data picker. (This is a type of data picker you can create. See About User Data Pickers
(on page 198).) For instance, you could create an "office move order" that uses a data picker to 
reference a user attribute form. In Unifier, the user would use this user data picker to specify the 
user who is moving. The data picker, in turn, will trigger the reverse auto-population once the 
move is complete and update the attribute form with the user's new location. 

Setting up reverse auto-population is a two-part process. You need to: 

1) Create an integration interface for the form that will be updated. The interface will push the 
updated information to the BP form. 

2) Map the fields to be updated. 

Use reverse auto-population for text boxes, text areas, pickers, drop-down lists, checkboxes, 
and radio buttons. You cannot use the reverse auto-population for the role name data picker. 

You can update fields as follows: 

You can update from this: To this: 

The upper form of a 
business process 

Upper forms of BPs specified in reference processes 

The attribute form for a Code and Records-based 
manager 

An Asset record 

A Resource record 

A Planning Item record 

A line item on the source record that is linked using a 
line item picker 
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You can update from this: To this: 

A line item form Upper forms specified in reference processes 

A line item form linked using a Line Item picker 

An Asset record 

A Resource record 

A Planning Item record 

A child shell attribute form A parent shell attribute form 

A child shell business 
process 

A parent shell attribute form 

The upper form of a single-record business process in a 
parent shell 

A company-level business 
process 

A Code and Records-based manager's attribute form 

A project/shell-level business 
process 

A Code and Records-based manager's attribute form 

User data picker A field on the upper or detail forms of BPs specified in 
reference processes 

A user data picker on a referenced business process 

Reference BP creator elements on upper or detail forms 

Upper or detail forms of single record business 
processes 

Code and Records-based configurable manager attribute 
forms 

Creating an Integration Interface 

To use the data transfer function of the integration feature, you will need to create an integration 
interface. 

For "Direction," be sure it is either Input or Both. 

Notes: 

 You must create the integration interface first; otherwise, you will not 
be able to map the fields for reverse auto-population. This type of 
auto-population takes place via the integration interface, not via 
Unifier. 

 Data Elements of DD = "Record Status Pulldown" can only be set as 
"Output" in Business Process integration settings. 
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Mapping a Field to be Updated 

To map a field to be updated: 

1) Open the form you want to be updated. 

2) In the navigator, click: 

 Upper Forms to update fields on the upper form. 

 Detail Forms to update fields on a detail form. 

 Line Item List to update fields on a line item list. 

3) On the right panel, double-click the name of the form to open the Form Designer window. 

4) Click the Properties button on the toolbar. The Elements Properties window opens, showing 
a list of the fields (data elements) on the form. 

5) Highlight the field you want to be updated and click the Reverse Auto-populate button. The 
Reverse Auto Populate window opens. 

6) Review the content of the Source Element field. 

The Source Element field displays the field name (DE) on the form that will update the field 
on the destination form. When the value in the field changes in Unifier, the destination 
element is updated. 

7) In the Destination Name field, choose the name of the form that contains the field you want 
to be updated. 

The Destination Name is the name of the Business Process, or the Attribute form, that 
contains the field you want to be updated. 

8) In the Destination Element field, click the Select button and choose the name of the data 
element you want to be updated on the form or line item. 

The Destination Element is the name of the DE you want to be updated on the Business 
Process, Attribute form, or Line Item. 

In operation, when you enter the Destination Name, uDesigner checks the integration 
interface you created for the form you want to update. It locates any fields with data 
definitions that match those of the Source Element and displays them when you click the 
Select button. 

9) In the Status(es) field, click Select and select the status of the source record that you want 
to be updated by way of the RAP. 

Notes:

 If you do not select a specific status, RAP occurs on every status. 

 The list of statuses reflects those that are currently Active. If a status 
is selected that is subsequently set to Inactive, an error message will 
be displayed when the business process is completed.  

10) Click OK, then click Close on the Elements Properties window. 

11) On the Form Designer window, click Save, then click Close Window. 
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Reverse Auto-Populate Status of non-Workflow BP 

The Status DE on a non-Workflow Business Process (BP) can be Reverse Auto-Populated 
(RAP) from another non-Workflow or Workflow Business Process. 

Example 

A non-Workflow Asset Business Process (BP) (a non-workflow BP) record is in an 
"In_Service" status. Another Business Process goes through approvals to shut down that 
Asset. As a result, the Asset BP status changes to "Inactive." 

You can use the "Record Status Pulldown" Data Definition (DD) to create the Data Elements 
(DEs) that can RAP in the "Status" DE of a non-Workflow BP. The "Record Status Pulldown" DD 
is a drop-down menu type that is available in the list of "Custom" DEs. 

The following list the behavior of DE when you add it to a form: 

 Can be marked as Editable / Editable Required / Read Only 

 Cannot be used in Validations 

 Cannot be set as Formula 

 Cannot be set for Auto-populate  

 Should be available for "Reset" 

 Is not available when defining "Linked' Elements" 

 Is not available to be added to "Dynamic Datasets" 

Notes: 

 The DEs of the DD = "Record Status Pulldown" can be set as 
"Output" in Business Process integration settings. 

 The DEs of the DD = "Record Status Pulldown" will be opened for 
Mobile. 

 The DEs of the DD = "Record Status Pulldown" will not be opened for 
Bulk Edit or Bulk Action settings. 

 Only Active statuses will be shown in the RAP configuration. 

Reverse Auto-Populate Configuration Window 

You can define the runtime picker dataset, and default value, in the RAP configuration window. 

The Reverse Auto-Populate (RAP) configuration window contains the following fields: 

Source Element

(Read-only) Contains the name of the DE, which will be the source of reverse auto-population. 

Source Dataset

To configure the statuses that can be reverse auto-populated into the destination BP "Status" 
element. 

Note: Only select values that are valid statuses for the destination BP. 

The selected statuses will be available as drop-down dataset values during runtime. 
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Add

To select one Status, or more (Same as in a BP Properties > Statuses tab). 

Remove

To remove one Status, or more (Same as in a BP Properties > Statuses tab). 

Default

To select one Status and set the Status as default. Once set as default, the system 
populates the "Default" column with the "Yes" value. This option overrides previous 
selections. You cannot set more than one Status as default. You can clear the default status 
by selecting the status and removing it.  

Destination Name

This field lists all possible destinations for the reverse auto-population from "Record Status 
Pulldown" DE. The Destination Name drop-down list contains all the pickers (BP or Data) that 
point to a non-Workflow type BP. You cannot configure a picker to a Workflow type BP. 

Note: You can select a RAP destination as a Data Picker and then 
remove that Data Picker from your form.  

Destination Element

(Read-only) Contains the name of the DE that is impacted by RAP. 

Status(es)

In the Status(es) field, click Select and select the status of the source record that you want to be 
updated by way of the RAP. 

Notes:

 If you do not select a specific status, RAP occurs on every status. 

 The list of statuses reflects those that are currently Active. If a status 
is selected that is subsequently set to Inactive, an error message will 
be displayed when the business process is completed.  

Additional information about configuring RAP 

Add the "Status" element of Destination BP in the Integration settings as "Input" or "Both". If the 
DE is not added, RAP will fail with an error. 

Example 

If "Asset" BP is a non-Workflow BP, and you want to RAP the status of "Asset" BP from 
another BP, then you need to add the "Status" element of Destination BP in the Integration 
settings as "Input" or "Both". 

uDesigner > Business Processes > Asset - Home > Integration node > Upper sub-node 
> Upper design window > Data Elements tab > Element Label column: "Status" > Data 
Element column: "Status" > Direction column: "Both" 
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Making a Field a Hyperlink 

If the form you are designing includes a data picker field, you can make this field a hyperlink. 
Once you make the field a hyperlink, the data picker will operate as follows: 

On an Action Form On a View Form 

If the data 
picker 

If the field is editable If the field is read-only 

Has a 
value 

Show as a picker with a 
value 

Show the picker as a 
hyperlink 

Show the picker as a 
hyperlink 

Does not 
have a 
value 

Show as a picker field Show as blank Show as blank 

To make the data picker field a hyperlink 

1) Open the form that contains the data picker you want to make a hyperlink. The Form 
Designer window opens. 

2) In the Form Designer window, click the Properties button on the toolbar. The Elements 
Properties window opens showing a list of the fields (data elements) on the form. 

3) Select the field you want to make a hyperlink. 

4) Click the Hyperlink button. uDesigner makes the field a hyperlink and enters Yes in the 
Hyperlink column on the window. 

To disable the hyperlink, highlight the field and click the Hyperlink button. 

Linking Elements in Shell Hierarchies for Easy Restructuring 

Companies, such as banks, that often move sites from one division, region, or market to 
another, need to be able to restructure the shell hierarchies in Primavera Unifier without having 
to re-enter a lot of information on attribute forms and business processes. Linking data elements 
(fields) between shells and other forms makes it easier for the user to rearrange shell hierarchies 
in Primavera Unifier by automatically reflecting new field values on the forms as the shell is 
moved. This feature ensures that data referenced from parent shells to child shells and business 
processes is correctly reflected in the new hierarchy so that reporting is accurate and Primavera 
Unifier's operation is not interrupted. 

 This feature works only on attribute forms for child shells, or for single-record BPs at the 
project or shell level. You cannot use this feature for an anchor shell. 

 You can place linked elements on upper forms only; not detail forms. 

 You cannot link elements that are from a template that is linked to the form. 

 You cannot link elements that are part of a dynamic data set. 

Using this feature, you can create a dynamic connection from a field on the following forms to a 
field on the attribute form of any parent shell in the hierarchy. 

 Child shell attribute form 

 Business process forms in child shells 
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The field on the form you are designing will automatically display the current value of the field 
you link to on the parent shell's form, regardless of where the child shell is moved. 

Note: Before you can link elements on the form you are designing here, 
the linkable elements from the Shell must be specified when you start 
the Shell design. 

To link an element 

1) Open the shell or single-record business process you want to work with. 

2) Open the upper form in the Form Designer window; for a configurable manager, open the 
detail form. 

3) On the Form Designer window, highlight an empty cell and click the Linked button on the 
toolbar. The Linked Data Element Picker window opens, showing a list of the fields that you 
chose for linking when you started the design for this shell or business process. 

4) From the list of data elements, select the field(s) on the attribute form that you want to link to 
this form and click OK. 

uDesigner links these fields so that the current value of the field you link to always appears 
on the form you are designing, regardless of where the shell is moved. 

In operation, when the user moves a child shell, the linked field on the form will not display the 
current value until the user clicks Finish Editing and reopens the record. 

Linking Tagged Elements from a Schedule Attribute Form to Another Form 

Linking a tagged field from a Schedule attribute form maps it to one or more fields on another 
form. When you link a tagged field to a destination field, you must specify the data element that 
will receive the information. For example, if you want to show multiple activity start dates from 
the Schedule Sheet on the destination form, you would link the source element uuu_start with 
the fields on the form that will display that information. In this way, you can link uuu_start with 
multiple fields on the form. 

Once you link these elements, the element on the form you are designing will automatically 
display the current value of the field you link to on the schedule attribute form. 

Note: Before you can link elements on the form you are designing here, 
the linkable tagged fields from the schedule attribute form must be 
specified when you start the Schedule Manager design (see Starting an 
Attribute Form For the Schedule Manager). 

To link an element from the schedule attribute form to a business process form 

1) Open the business process you want to work with. 

2) Open the upper form in the Form Designer window. 

3) On the Form Designer window, highlight an empty cell and click the Linked button on the 
toolbar. The Linked Data Element Picker window opens, showing a list of the fields that you 
chose for linking when you started the design for the schedule activity. 

4) From the list of data elements, select the field(s) that you want to link to this form and click 
OK. 
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uDesigner links these fields so that the current value of the field you link to always appears 
on the attribute form or BP you are designing. 

Linking Elements from Other Forms to a Planning Item 

While working with planning items, users often need access to the latest information from other 
Primavera Unifier components. For example, users might need information about the shell under 
which the planning item resides, or information about a schedule activity that is involved in this 
planning item. You can link elements from the Shell attribute form or the schedule activity form to 
a planning item form so that the planning item form will always show the current value for these 
elements from other forms. 

By linking elements, you can create a dynamic connection from a field on the following forms to 
a field on the planning item: 

 A shell attribute form 

 A single-record business process 

 A configurable manager attribute form 

 A schedule activity attribute form 

At runtime in Primavera Unifier, the field on the planning item form you are designing will 
automatically display the current value of the field you link to on these forms. 

Linking elements is a two-part process. First, you must specify the elements on the shell 
attribute form, single-record BP, configurable manager attribute form, or schedule activity that 
can be linked. (See For a Code and Records-based Manager (on page 165), For the 
Schedule Manager (on page 172), For the Shell Manager (on page 172), and the Adding 
Link Elements to a Form (on page 386).) Then you place those elements on the planning item 
form using the Linked button on the Form Designer window as follows. 

To link elements from another form to a planning item 

1) Open the planning item detail form you want to link. 

2) Open the upper form in the Form Designer window. 

3) On the Form Designer window, highlight an empty cell and click the Linked button on the 
toolbar. The Linked Data Element Picker window opens, showing a list of the fields that you 
chose for linking when you started the design. 

4) From the list of data elements, select the field(s) that you want to link to this form and click 
OK. 

uDesigner links these fields so that the current value of the field you link to always appears 
on the planning item you are designing. 

Viewing Details About Form Fields 

After a form is complete, you or another designer might need to re-check field details to see how 
they behave. An easy way to see an overview of the fields and how they have been designed is 
to open the Properties window from the Form Designer window.  

On the Elements Properties window, double-click the name of the element. A second element 
Properties window opens. This window displays the following information about the field: 
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This field:  Shows this information: 

Name The system name of the data element 

Label The name of the field as it will appear on the form 

Type Where the element came from—the Custom Elements list or 
the Standard Elements list. If the data element is linked, for 
instance, to a field on an attribute form, this field will display 
"Linked Data Element." 

Data Definition The data definition on which this element is built 

Access How the Primavera Unifier user can interact with this field. If 
it is: 

 Read-only, the field displays information; the user can 
do nothing in the field 

 Editable, the user can enter text or numbers in the field, 
or select it if it is a radio button or check box 

 Editable (Required), the user must enter something in 
the field, or select an option 

Block The name of the block in which the elements appears on the 
form 

Data Entry How data will be entered into this field. If it is: 

 Manual, the user should manually enter the data 

 Formula, Primavera Unifier will calculate the value for 
this field and automatically enter it. 

 Auto-Populate, Primavera Unifier will automatically 
populate this field with data 

Formula If the data entry type is Formula, uDesigner will show the 
formula here. 

Auto-Populate Source If the data entry type is Auto-Populate, uDesigner will show 
the source the auto-populated data comes from (such as a 
referenced business process or a constant value). 

Source Element If the data entry type is Auto-Populate, uDesigner will show 
the name (not the label) of the data element the 
auto-populated data comes from. If the source of the 
auto-population is a constant value, the content of that value 
will appear in this field. 

Reverse Auto-Populate 
Destination 

If the field on the form is configured to update other 
information using the Reverse Auto-Populate feature, 
uDesigner will show the name of the record, form, or line 
item that will be updated. 
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This field:  Shows this information: 

Destination Element If the field on the form is configured to update other 
information using the Reverse Auto-Populate feature, 
uDesigner will show the name (not the label) of the data 
element that will be updated. 

Notes Any notes that were included when the field was added to 
the form, such as the field's behavior, or how it is populated.

Selecting Fields for an Email Notification 

If your company's employees are often out of the office, Primavera Unifier can keep the workflow 
moving and avoid delays by automatically notifying employees via email of tasks they are 
responsible for. For example, your company might have facilities managers who are usually in 
the field and cannot access Primavera Unifier; however, they do have a laptop or other access 
to email. Primavera Unifier's email notification can include details of the task and a workflow task 
action, such as "Approve" or "Reject." Employees can review the information and click the 
Approve/Reject link in the email to respond. When Primavera Unifier receives the email, it 
verifies their identities, processes their responses, and moves the workflow forward. 

For another example, project or shell administrators can receive email notification whenever a 
new project or shell has been created. This notification occurs whether the project or shell was 
created manually, through Web Services or a CSV file, or by auto-creation. For this example, 
you could include data elements that pertain to the shell or project creation. The system includes 
the project or shell details (project or shell name, number, and location) in the email, 
automatically. 

Additionally, project or shell managers can receive email notification whenever a business 
process is auto-created, or when an auto-creation fails. For these notifications, the following 
location information will be included, automatically: 

 Project or shell name and path 

 BP number and both the location of the originating BP and the destination 
where the BP was created, or failed. 

Also, a user can receive email notification that action has been taken on a business process 
through the Self-Service Portal. 

If the user has designated a proxy user in his/her absence, the email notification will also be sent 
to the proxy. 

In uDesigner, you can select the fields from a view form of a workflow or non-workflow business 
process to include on the email notification. When the form is published to production, the 
Primavera Unifier administrator will configure the step that uses this form to enable an email 
response. To select the fields for an email notification Open the view form that contains the fields 
you want to include on the email notification. From the View menu, choose Email Notification 
Elements. uDesigner opens an Email Notification Data Elements window. Use the information in 
the following table to complete this window. 
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Note: This feature works with view forms only, except for business 
processes that are enabled for the Self-Service Portal. 

To select the fields for an email notification 

1) Open the view form that contains the fields you want to include on the email notification. 

2) From the View menu, choose Email Notification Elements. uDesigner opens an Email 
Notification Data Elements window. 

3) Use the information in the following table to complete this window. 

To: Do this: 

Add fields 
from the 
view form to 
the email 

1. Click Add to open the Add Data Elements window. 

2. Click the arrow beside the Element Label field and choose the field you 
want to include on the email notification. 

Note: Do not choose fields that are pictures or images; they will not show 
up on the email. 

3. Click OK. 

4. Repeat steps 1 through 3 to add other fields, if necessary. 

Remove 
fields you 
do not want 
to include 
on the email

1. Highlight the data element and click Remove. 

2. Repeat this step to remove other fields, if necessary. 

3. Click OK. 

Put the 
fields in a 
different 
order for the 
email 

1. Highlight the data element and click the Move Up or Move Down 
button. 

2. Repeat this step until you arrange the fields in the order you want for 
the email. 

3. Click OK. 

Selecting Fields for Unifier on Mobile App 

If you are abbreviating a form layout for a mobile device:  

 You must include at least one field from each action or view form. 

 You must include all the required fields on an action form. 

If you include any field that is part of a dynamic data set, then you must include all the fields in 
the set. 

To select the data elements for mobile devices 

1) Open the form that you want to make available on the mobile device (business process, 
asset class form or shell attribute form). 

2) In the Form Designer window, click the Properties button. The Elements Properties window 
opens. 
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3) Click the Mobile button. The Mobile Elements window opens. 

4) Click the Add button. A Column Header Properties window opens. 

5) In the Data Element Label field, select the field you want the form to show on the mobile 
device. 

6) Click Add to add another field, or click OK to close the window. 

7) On the Mobile Elements window, you can move the fields into the order you want them to 
appear on the mobile device. Click OK to close the window. As shown, the Mobile column 
will display a Yes value for every field that appears on the version of the form shown on the 
mobile device. 

8) On the Elements Properties window, click Close. 

Adding Auto-Sequencing Data Elements 

Business process forms can contain data elements that are numbered using auto-sequencing. 
This functionality requires that the business process upper form and/or lower form contain up to 
two data elements that are based on the SYS Auto Sequence data definition. 

You can create any number of data elements (fields) using this definition. Fields using this 
definition provide auto-sequencing of unique numbers for all business processes or line items 
created. The content of the field is automatically generated based on the format for the 
auto-sequence data elements that is   configured in Unifier. Data elements that use this data 
definition: 

 Are always read-only 

 Can be placed in a hidden block 

 Are available for Mobile configuration 

 Can be selected as a display element of a Data Picker 

 Can be added to Integration, marked as Output only 

 Cannot be selected as a linked element 

 Cannot auto-populate or reverse auto-populate 

 Cannot use a hyperlink 

 Cannot be part of a Dynamic Data Set definition 

See Auto Sequence Tab (on page 245) for more details. 

Defining Totals (Payment Application Grid and Summary Payment Application Grid) 

In uDesigner, you can define the Total property for a particular Data Element (DE) (in case of 
Payment applications Business Processes (BPs) and Summary Payment Application BPs) for 
the Standard Tab form.  

Note: This feature is not available for other types of BPs. 

You are able to define the Total in three ways, as explained below: 

 Blank 

There will be no value (empty) in the Total column when the Total field is defined as "Blank" 
for a data element, within the element properties. 
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 Sum of All Rows 

The Total column will contain the value for the "Sum of All Rows" when the Total field is 
defined as "Sum of All Rows" for a data element, within the element properties. 

 Use Formula Definition 

The Total column will contain the value for the "Formula Defined" when the Total field is 
defined as "Use Formula Definition" for a data element, within the element properties. 

The following table shows the default values in the Detail form, based on the DEs: 

Data Definition (DD) Default Value 

Currency Amount Sum of All Rows 

Integer Amount Sum of All Rows 

Decimal Amount Sum of All Rows 

Pickers (all types) Blank 

BP Creator Blank 

Drop-Downs (Pull-downs) (all types) Blank 

String description (all types) Blank 

Short description (all types) Blank 

For DEs having Data Definitions (DDs) other than the Currency Amount, Integer Amount, and 
Decimal Amount, when you try to add/modify the total property, Unifier displays an alert 
message: This data entry is not suitable for defining total. 

This condition is also applicable to DDs such as: 

 Date pickers 

 Data pickers 

 BP pickers 

 BP Creator 

 Drop-Downs (Pull-downs) (all types) 

 String description (all types) 

 Short description (all types) 

When you click Total, in the element properties, a new window opens and based on the data 
element (where the Total property has been modified), the default value will be selected. 

For DEs having the DDs Currency Amount, Integer Amount, and Decimal Amount, Unifier 
enables the options "Blank" and "Sum of All Rows," and the default selection will be "Sum of All 
Rows." 

If the data element contains a formula that has been defined in the element properties, then the 
Use Formula Definition is enabled. 

If you select "Use Formula Definition," then the same formula that is defined on the data element 
is used to calculate the Total. 
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If you reset the DE that has a defined formula (formula defined) to manual, then Unifier resets 
the Total to "Sum of All Rows." 

For Amount DE, the blank option is always disabled; therefore, the Amount DE is calculated by 
using "Sum of All rows" and "Use Formula Definition." 

Note: The value 0 (zero) is used as the preference for data elements 
that: 

 Have the following data definitions set to "Blank," in uDesigner: 

 Currency Amount 

 Integer Amount 

 Decimal Amount 

 Are used in any formula 

 Are used to auto-populate in the upper form or details form. 

Unifier does not allow you to define a formula, in the Element properties, for the special DEs in 
Payment applications BPs and Summary Payment Application BPs that have predefined 
formula. 

If you try to define a formula, Unifier displays an alert message: This data entry is not suitable for 
defining formula. The following is a list of special DEs: 

 %Complete to Date (uuu_spa_per_comp) 

 Amount This period (uuu_spa_amt_tp) 

If there are any exiting custom-defined formulas on % (percent) Complete to Date 
(uuu_spa_per_comp), then the exiting custom-defined formulas are retained. 

If the DE is reset to Manual, Unifier displays the confirmation message: <DE name> will not be 
available for defining formula after resetting the data element to Manual. Do you want to 
continue? 

After reset, the values for the DEs (in run-time) are calculated based on the system predefined 
formula, and you will not be able to add a formula after the reset. 

For %Complete to Date (uuu_spa_per_comp), the "Use Formula Definition" option is enabled 
whether it is DE-defined as Manual Entry or Formula.  

For existing BP records, if you had added a custom formula, and the total was being calculated 
as "Sum of All Rows," then you will have the option to use the formula definition, if needed. 

For existing BP records, if you use the predefined system formula, then you will have the option 
to calculate Total based on the system based formula.  

Defining Summary Totals 

If you add a DE "refid" that has been configured to point to a Base Commit BP of SOV type 
Summary Payment Applications to the Upper Forms of a Cost-type BP (sub-type: Line 
Items with CBS Code and classification: Payment Applications), then the Elements 
Properties window (of the Detail Form) displays these additional elements:  

 Summary Total column (appearing after the 'Total' column, highlighted on the image below) 
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 Summary Total option (at the bottom of the window, highlighted on the image below) 

Note: The Summary Total option is available to define the Summary 
Total calculation for the Payment Applications of SOV Type = Summary 
Payment Applications, only. This option is not available for Payment 
Applications Business Process (BP) or any other BP types. Also, if the 
DE "refid" has not been configured to point to the Upper Forms, or it has 
not been configured to point to some other type of BP, then the 
Summary Total option will not be available. 

(Company Workspace > Admin mode > uDesigner node > Business Processes > select and 
open your <Payment Applications with Summary BP> > from the left Navigator click Detail Form
> select and open the form > click Properties) 

When you select DEs that correspond to the Decimal Amount, Currency Amount or Integer 
Amount Data Definitions (DDs), only, the Defining Summary Total for Column window opens 
which enables you to select the following options under in the Summary Total block: 

 As Defined

 Sum of All Rows

In the Defining Summary Total for Column window: 

 If the Data Entry for a Data Element is set to Manual, then the option of Sum of All Rows 
is selected, by default. 

 If the Data Entry for a Data Element is set to Formula or Auto-Populate, then the option of 
As Defined is selected, by default. 

Note: If the DE is set as Formula, then select the option As Defined for 
Summary Total.  

The following examples explain how Unifier processes the Summary Total value when the Data 
Entry for a Data Element is set to Manual:  
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If: 

Requested this period = 69,000.00 

Total previous claim = 118,600.00 

And: 

Total completed to date = Requested this period + Total previous claim 

Then: 

Total completed to date = 69,000.00 + 118,600.00 = 187,600.00 

Result: 

This is calculated correctly because this is how the Summary Total value is calculated 
when the Data Entry for a Data Element is set to Formula. 

------------------------------------------ 

If: 

Scheduled value = 165000.00 

Total completed to date = 187,600.00 

And: 

Balance to finish = Scheduled value - Total completed to date 

Then: 

Balance to finish = 165000.00 - 187,600.00 = -22600.00 

Result: 

This is calculated correctly because this is how Unifier processes the Summary Total
value when the Data Entry for a Data Element is set to Formula. 

The system-defined field "amount" is an exception to the rules above. That is to state, when the 
user selects this field and clicks Summary Total, then the option As Defined is selected by 
default. 

The users have the ability to select the other option (Sum of All Rows) and click OK. Clicking 
Cancel cancels the operation, and closes the window, without making any changes to the 
selected option. 

If the user selects a data element of data definition other than Currency, Decimal, or Integer 
Amount and clicks Summary Total, then Unifier displays an error.  

If the user selects any of the following system defined DEs and then clicks Summary Total, then 
Unifier displays an error: 

 scheduled_value 

 uuu_spa_prev_amt 

 uuu_spa_per_comp 

If the user selects no DE and then clicks Summary Total, then the standard uDesigner error is 
displayed. 

The column Summary Total displays the option as selected by the user in the Summary Total
window. For DEs of Data Definition other than Currency, Decimal, or Integer Amount, the 
column Summary Total displays as blank. 
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In addition, the Element Properties page for a DE on the detail form of a Payment Application 
BP which refers to a Base Commit of SOV Type = Summary Payment Applications, displays the 
Summary Total field. 

Note: This field is not visible for Payment Applications of other types. 

Advanced Formulas in Business Processes 

In uDesigner, you can create formulas for fields in order to calculate the value of the fields and 
display the values, during runtime. The calculated fields are read-only fields. You can also build 
composite fields that combine string text data elements into one field. Formulas can be created 
for Numeric, String, and Date fields.  

Important Information Regarding Advanced Formula 

Advanced formulas are available for hyperlink pickers as a string data element. Hyperlinks are 
only validated at runtime, not during formula creation.  

The advanced formula is not available for the Summary Payment Application (SPA) SOV type 
BPs (Base Commit Type BP Line Item, Change Commit Type BP Line Item) and Payment 
Application Business Processes.  

When a formula definition includes fields (for example: Record Number, Status, and so forth) 
that get evaluated after the record has been submitted:  

- In case of Workflow BPs, the formula will get re-evaluated upon sending the record to the next 
step in the workflow and the new value will be seen only when the record is on the next step of 
the workflow  

- In case of Non-workflow BPS, the formula will get re-evaluated when the record is submitted. 

In Unifier, you can go beyond simple arithmetic functions and use expression languages when 
developing formulas. 

The advanced formula supports: 

 If-then-else conditions on string, numeric, and date DEs 

 Complex conditions, for example: ((a or b) and (c and d)) or (e and f) 

You can edit, or update, the fields that are a part of an advanced formula definition. The 
advanced formula fields get re-evaluated after a successful update.  

Adding Advanced Formula 

The field is an input text field that is editable and required. 

You can either type in the Data Element name while building the formula or insert the data 
elements and functions using their respective fields. 

There is no limit to the maximum number of characters allowed in the formula definition field. 

Commonly used keyboard shortcuts such as Ctrl+C, Ctrl+V, Ctrl+Z, Ctrl+Y, Ctrl+A, and so forth, 
will be supported. You can copy and paste the content from other formulas on to the formula that 
you are designing. 
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When the formula definition passes error checks, the validation result box will have the following 
message: 

"There is no syntax error in the formula definition. However, there might be calculation errors. 
The "Sample Calculations" tab is now available next to the Definition tab. Oracle recommends 
that you review the sample data and fix any calculation errors before saving the formula 
definition." 

Sample Calculations tab 

The Sample Calculations tab will enable you to look at possible calculation errors resulting 
from the formula definition.  

All of the fields that make up the formula definition will be seen as columns in the grid. Sample 
data will be generated based on the data type. 

If there are any errors, then the error column will be populated with the error message. Unifier 
does not have control over the error messages seen. 

A user can modify the content of the sample fields and post-cell focus, the values will be 
recalculated. 

An additional Error Check is also provided for the user to re-verify for errors. 

The sequence of the columns seen is based on the formula definition. 

If the user chooses to save the formula in spite of the formula having calculation errors, then the 
following alert will be seen: There are some calculation errors. Do you still want to save the 
formula? 

When formulas cannot be evaluated, Unifier will try to evaluate the formula. In case the formulas 
cannot be evaluated, then Unifier will set the following values: 

 String = blank; 

 Date = blank, 

 Numeric = blank or 0 

Runtime 

You can place fields that have advanced formula definition, and evaluate the definitions during 
runtime, in: 

 The business process forms, line item detail form and in grid. 

 The business process logs and line item logs. 

 The field value: Any time a field value that is part of the formula definition is changed, per 
below, the destination formula will also get evaluated: 

 Manual edits to data  

 Web service methods (REST only) 

 Mobile app 

 When formula fields are used as search parameters in the BP log and Line Item list log, the 
records will be returned correctly. 

 Any form-level validation (the upper form or detail form) which may have designed based on 
the fields that have advanced. 
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The following explain the functions and their available formats. 

Functions and Available Formats 

The following is an overview of the functions and their available formats: 

String 

Function Tooltip 

(indexOf(String, int)) Starting point of a string within another 
string starting at a defined point in the 
string. 

(indexOf(String)) Starting point of a string within another 
string starting at the beginning of the 
string. 

(length()) Length of a string. 

Formating a numeric field to a string, for 
example: numeric value of 9 with a format 
of "00000.00" would result in a string of 
"00009.00". 

(startsWith(String, int)) Checking to ensure if a string starts within 
a defined string starting from a defined 
index. Needs to support indexOf. 

(startsWith(String)) Checking to ensure if a string starts within 
a defined string. 

(endsWith(String)) Checking to ensure if a string ends with a 
defined string. 

(substring(int)) Pulling a substring from another string 
starting at a defined point till the end. This 
needs to support indexOf. 

(substring(int, int)) Pulling a substring from another string 
starting at a defined point till a defined 
point in the string. This needs to support 
indexOf. 

(concat(String)) Concatenating stings including being able 
to define numeric fields as strings. 

(contains(String)) Checking to ensure if a string contains 
another string. 

Comparing strings Not available. 
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Numeric 

Function Tooltip 

(toString(format)) Converting a number or currency to a 
string with a defined format. 

(abs()) Absolute value of a number 

(sqrt()) Square root of a number. 

(power(int)) Raised to the power. 

(log()) Logarithm Base 10. 

(ln()) Natural Logaritm. 

(min(number, ….)) Minimum of a set of numbers. 

(max(number, ….)) Maximum of a set of numbers. 

(ceil()) Round up to the smallest integer that is 
greater than or equal to the value of the 
field. 

(floor()) Round down to the largest integer that is 
less than or equal to the value of the field. 

(round(int)) Round to the number of decimal places. 

Comparingnumbers =, !=, >, >=, <, <= Not available. 

Date 

Function Tooltip 

(toString(format)) Converting a date to a string based on a 
defined format. 

Converting a datetime to a date only Not available. 

Add or subtract number of days from a 
date 

Not available. 

Add or subtract number of months from a 
date 

Not available. 

Add or subtract number of years from a 
date 

Not available. 

Extracting day, month, or year from a date. Not available. 

Comparing Dates =, !=, >, < Not available. 

The following provides the list of functions: 
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Note: Use the tooltip to learn more about each function. 

String Functions Numeric Functions Date Functions 

 compare(str1,str2) 

 compareIgnoreCase(str
1,str2) 

 concat(str1,str2) 

 contains(str,search) 

 containsAny(str,search1
,search2,...) 

 containsIgnoreCase(str,
search) 

 endsWith(str,suffix) 

 endsWithIgnoreCase(str
,suffix) 

 indexOf(str,search) 

 indexOfAny(str,search1,
search2,...) 

 indexOfIgnoreCase(str,s
earch) 

 isAlpha(str) 

 isBlank(str) 

 isEmpty(str) 

 isNumeric(str) 

 isNumericSpace(str) 

 lowerCase(str) 

 upperCase(str) 

 matches(str,regex) 

 left(str,len) 

 leftPad(str,size) 

 leftPad(str,size,padStr) 

 mid(str,pos,len) 

 right(str,len) 

 rightPad(str,size) 

 rightPad(str,size,padStr)

 replace(str,search,repla
cement) 

 replaceAll(str,regex,repl
acement) 

 replaceFirst(str,regex,re
placement) 

 abs(num) 

 max(num1,num2) 

 min(num1,num2) 

 ceil(num) 

 floor(num) 

 log(num) 

 log10(num) 

 pow(base,exponent) 

 round(num,places) 

 sqrt(num) 

 isNumber(num) 

 numberFormat(num,patt
ern) 

 toDouble(num) 

 toInt(num) 

 toLong(num) 

 cos(num) 

 sin(num) 

 tan(num) 

 acos(num) 

 asin(num) 

 atan(num) 

 cosh(num) 

 sinh(num) 

 tanh(num) 

 date(year,month,day) 

 day(date) 

 edate(date,months) 

 eomonth(date,months) 

 month(date) 

 now() 

 today() 

 weekday(date) 

 weeknum(date) 

 year(date) 

 addDays(date,amount) 

 addHours(date,amount) 

 addMonths(date,amount
) 

 addWeeks(date,amount
) 

 addYears(date,amount) 

 dateDiff(start,end) 

 dateFormat(date,pattern
) 

 isSameDay(date1,date2
) 

 toLong(date) 

 toDate(long) 
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String Functions Numeric Functions Date Functions 

 startsWith(str,prefix) 

 startsWithIgnoreCase(st
r,prefix) 

 size(str) 

 strip(str) 

 substring(str,start) 

 substring(str,start,end) 

 truncate(str,maxlen) 

Rules for Setting Fields as a Formula Destination 

The fundamental rules that currently exist in the product for defining formulas on various types of 
fields will remain the same. The data elements that cannot be set as a formula, will continue to 
be unsuitable for defining formula.  

Example 

Data elements such as QBDE, BP Creator, Record Number (record_no), and so forth. If you 
(designer) select a QBDE as a formula destination, and the user has selected "Pending 
Changes" (which is a QBDE) with the intent to define a formula on it, then Unifier prevents 
the action.  

The data definition of the following Input types will be blocked from being defined as a formula: 

 Checkbox 

 Pull-down Menu (drop-down list) 

 Radio buttons 

 Multi-Select Input 

 All pickers including Data Pickers 

Note: All previous formatting will be lost if you change the data entry 
method, or type, from Auto-populate to Advanced Formula. 

Adding Advanced Formulas 

When designing the upper form, in the Elements Properties window, you can use the 
Advanced Formula option to set up your advanced formula. The option will be available for 
"Published" designs, as well. 

Note: To reduce the design time, you can set a formula definition, and 
copy it on to other fields that have similar formula definitions. 

You can add any type of formula in the Advanced Formula window. 
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In the Elements Properties window, select the data element that allows formula definition to 
open the Advanced Formula window for <Data Element Name> - <Data Element Label>. The 
data element name and label seen in the window title comes from the previous screen of 
Elements Properties window, where you selected a data element that can have a formula 
definition. 

Design Example 

To add a formula with delimiters, when you do not see the option of delimiters, you must add 
Delimiters as string constants. 

Submittal number = Project # + " - " + Project Type + " - " + Submittal unique # 

In this example, the various parameters that form the formula definition need to be separated 
by a hyphen. While designing the formula “ - ”will have to be added. At runtime: Submittal 
number = San Jose Recreation Park - New Construction - SUB009 

Data Elements in the Formula Definition Window 

The formula definition window will have the following attributes: 

Note: When you save the formula definition, Unifier checks to ensure 
that there is no circular referencing. 
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String Data Elements Numeric Data Elements Date Data Elements 

The list will be 
alphabetically sorted. The 
list of all the string type 
fields that exist in the 
current form will be 
displayed.  

This list will include the 
following: 

 String Pull Down type 
fields 

 Multiple Text Lines 
fields 

 Text Box fields 

 Radio Buttons fields 

 Multi-Select Input fields 

The list will exclude the 
following: 

 The data element for 
which the formula is 
being defined 

The list will be 
alphabetically sorted. The 
list of all the numeric data 
types that exist in the 
current form will be 
displayed.  

This list will include the 
following: 

 Numeric Amount fields 
such as Decimal 
Amount, Integer 
Amount, and Currency 
Amount 

 Checkbox type fields 

 Integer Radio button 
type fields 

 Integer Pull Down type 
fields 

The list will exclude the 
following: 

 BP creators 

 All types of Pickers 
including Data Pickers 
and Fields of Rich Text 
Field type 

 The data element for 
which the formula is 
being defined 

The list of all the date fields 
that exist in the current form 
will be displayed. The list 
will be alphabetically sorted.

The list will exclude the 
following: 

 The data element for 
which the formula is 
being defined 

Additional Information

 Unifier allows linked elements and summary elements to be a part of the formula definition. 

 The Type-ahead and list features are supported in all of the data elements fields. 

 Each function will have a tooltip that will enable you to understand what the function entails. 

 The fields are classified based on the type of function. 

 String Functions 

 Numeric Functions 

 Date Functions 

 The functions fields will list all of the functions available to be defined. See Functions and 
Available Formats (on page 347) for additional details on the functions. 

Setting Time Zone in Advanced Formula 

The Time Zone field is a required field that must be set by you (the designer).  
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Note: The system by default will always set the time to 5 PM. 

At the time of designing the formula, your time zone (the designer's time zone) will be populated 
into the Time Zone field. As an example, when the designer is in the process of designing the 
form and if the user's time zone is set to Pacific Time (US & Canada), then this field will be 
populated with this time zone, but you can change it to suit the customer's time zone. 

This Time Zone field is used only for formula calculation. That is to sate: When an Advanced 
Formula is using a date function such as 'date diff' with a combination of Date Only Picker and 
Date Picker, then the Time Zone set in the Formula Definition will be used for calculation. 

A tooltip will be provided in the Time Zone field with the following content: 

"The Time Zone specified here will be used for any formula calculations involving Date and 
Date Only Picker fields. In addition, certain Date Functions will also use this value. At 
runtime, Unifier converts the formula evaluated value to retain the Time Zone of the 
logged-in user." 

Similarly, for date functions such as today(), the time zone specified in the formula definition will 
be used. At runtime, the logged-in user's time zone will be used for further calculating the 
resultant value. 

In the Unifier server, all date objects in Java use the Server time zone, and the code is adjusted 
to use the user's time zone preference. 

Unifier adjusts the time zone of Date Pickers to be set as the server time zone, but Unifier does 
not adjust for the Date-Only picker. Therefore, the result derived from the date difference is 
adjusted to fit the logged-in user's time zone. 

The following scenario provides information about the variety in setting up the time zones 
options involving date operations (for example formula calculations involving date operations 
such as 'Date Diff' and 'Date Add'), when the data elements that make up the formula are a Date 
Picker and a Date-Only Picker. 

User A's Time Zone in CA - 2 PM PDT 

User B's Time Zone in NY- 5 PM EDT 

Server Time Zone in London- 10 PM GMT - Stored in database 

For Date Picker fields

When the user A opens the form, the system does the time zone conversion from the server 
time zone to PDT. In the above example, the time in the server location is 10 PM. The 
system will deduct 8 hours to adjust to User A's location and set the value as 2 PM PDT.  

For Date-Only Pickers fields

Unifier does not do any adjustments, and the time internally is always treated as 12 AM i.e 
timestamp is 00:00. No timestamp is visible to the user. 

When a user sees both of these fields,, the timestamp is seen as 12:00 AM and 2:00 PM 
respectively for Date-only. When a 'date diff' is done, the value returned maybe 0 days. 
When the calculation for date formula is done, the system converts date only picker to have 
a timestamp of 2:00 PM 

Problems could arise based on the time zone when "date difference" kind of operations are 
performed. The value seen varies depending on the user's preferred time zone. 
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Adding a Response List to a Text Business Process 

In Primavera Unifier, text business processes automatically include a response list that appears 
at the bottom of the form. This area is where the user can add and organize text comments or 
file attachments. The response list is designed at the time the text business process is designed. 
uDesigner creates a default response list for business processes, and only the tab name (the 
label for the response list area) is editable. 

To edit the response list tab name: 

1) Open the text form you want to edit. 

2) Select the response list in the Response List pane and click Open. The Responses window 
opens. 

3) Enter a new name for the Tab Name of the Response List. This is the name that will appear 
on the tab of the Response List section on the form. 

4) Click OK. 

Previewing the Response List 

You can preview the response list at any time to get a picture of how it will look on the form. 

To preview the response list: 

1) In the Responses window, click Preview. A preview of the Response List opens. 

If there are a lot of blocks on the form, you may not see all the fields when you open the 
form. To see them, expand the form by clicking on the tab name or the expand button on the 
top right of the tab section. 

2) Click Close to return to the Responses window. 

Adding a Text Entry Area to a Form 

Text BPs contain a text entry area that appears at the bottom of the form if the business process 
requires an action. This area is where the user enters the requested text.  

uDesigner creates a default text entry form for BPs, and only the tab name (the label for the text 
entry area) is editable. 

To edit the text entry form tab name 

1) Open the text form you want to edit. 

2) Select the text entry form in the right pane and click Open. The Text Entry Form Designer 
window opens. 

3) Enter a new tab name and click OK. 
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Adding a Reference Process to Auto-Populate Data 

Primavera Unifier populates the data in some pickers with a reference process form. Reference 
processes are necessary for any form that uses BP or line item pickers. Primavera Unifier users 
use these pickers to call data from another—a referenced—business process. The reference 
establishes a link between the records (for example, an invoice record to a purchase order). 
Because of this link, record to record, you can populate one form with data from other forms. 

To make these pickers effective, you must connect both forms by "mapping" a field on the picker 
to one on the referenced form. In operation, the picker will point to the referenced form and use 
the values in the fields you specify to display data on the picker. Once the reference link is 
created, you can use the referenced form to populate any data elements that the referenced and 
current form have in common. 

Likewise, if a form includes a line item picker, the user can select specific line items from a 
referenced form. To make a line item picker effective, you must specify what line items the user 
can select from the referenced form. Once you do this, the referenced line items will 
automatically populate those line item fields that the referenced and the current form have in 
common. 

 For asset classes, you can reference only other company-level business processes. 

 To populate pickers, the data definition of both fields—the one on the picker as well as the 
one on the referenced BP— must match. 

To specify a reference process or line item for a picker: 

1) Open the form and click Reference Processes in the left Navigator. 

2) Click the New button. The Select Business Process window opens. 

3) From the menu, select the form to which you want the picker or line item to point. 

4) Click OK. The Reference Process window opens. 

5) To complete the General tab, use the information in the first table below. 

6) Click on the Query tab. 

Note: Unifier allows you to select one Data Element, only: Status. No other Data Elements 
are available for selection.  

7) Click the Add button. The Query Condition window opens. 

Use the information in the second table below to complete the Query tab. 

8) Click OK. 

In this field: Do this: 

Name Enter a name for the reference process. 

Description (Optional) Enter a description of the purpose of the picker in 
referencing this process. 

Destination 
Element 

Select the data element (the picker) you want to populate. The list 
displays the fields on the upper form of the BP you are creating. 

For example, if you are creating an invoice form and you want to link 
the PO picker to a Base Commit, choose the PO picker. 
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In this field: Do this: 

Reference 
Process 

Shows the name of the form you selected in Step 3. This is the source 
from which the data will come. 

Source 
Element 

Select the field on the referenced form that you want to link to. The list 
displays the fields on the upper form of the BP you are referencing. 

Note: The field names of the source and destination fields do not have 
to match, but the data definitions supporting these fields must match. 

Location 
Element 

Select the shell where the form you are pointing to resides. 

Show reference 
value as a 
hyperlink 

Select the checkbox to display the field name as a hyperlink. Users 
can use this hyperlink to open the referenced form from the detail form 
you are designing. For example, if an invoice references a purchase 
order contract, the name of the referenced purchase order will appear 
as a hyperlink on the invoice form and allow users to open the PO 
record. 

Allow Line Item 
Referencing 

Select the checkbox to allow users to refer to specific line items on a 
detail form. 

For Destination Element, select the data element (line item) you want 
to populate. The list displays the fields on the upper or detail form you 
are designing. 

For Source Element, select the field in the referenced form. The value 
in this field will populate the line item field on the form you are 
designing. The list displays the fields on the upper or detail form you 
are referencing. 

Source 
Referencing 
Element 

Select the field or picker on the referenced line item that should be 
updated with the ID of the record from which the line item was 
selected. 

At runtime, when a user uses a BP Line Item Picker to select a line 
item and sends the record forward, the source referencing element 
will be updated to show the ID of the record from which the user 
picked the line item. 

Note: You cannot use a BP Line Item Picker in an Activity Attribute 
Form.  

At runtime, if the user deletes the line item that updated this source 
referencing element, or clears the line item picker, Primavera Unifier 
will clear this field. 

Data Element Select the field you want to appear on the picker. 

Condition Select the condition the field must meet to be included on the picker. 

Value Click the Select button and choose the value the data in the field must 
show in order to be included on the picker. 
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Connecting Records in the Same Business Process 

Some business circumstances require that records in the same business process be connected 
hierarchically. For example, a master lease may need to be connected to sub-leases, or a 
master work order may need to be connected to work order line items. In uDesigner, you can 
design a business process to create this hierarchy (parent record to child record) by using the 
Reference Process feature. Using this feature, you can design a business process that will 
reference itself for the purpose of populating the BP pickers and line item pickers that a 
Primavera Unifier user can use to create the records and, along with them, the hierarchy. 

As an example, you could create a data element for the BP form, such as a check box, that 
users could check to indicate that the record they are creating is a master record. Records that 
should be "child" records to the master would use a BP picker to reference the master record 
and a line item picker to display the records that were extracted by the reference process query. 

To connect records within the same business process, create a reference process using the 
instructions above, under "To specify a reference process or line item for a picker." 

Auto-populate on Payment Application from a Base Commits BP 

You can use the method described in the topic Auto-Populating Fields (on page 324) to 
auto-populate a Payment Application with the line items from a Base Commits and Change 
Commits BP, or you can do it in one step when you design a Base Commits BP. To accomplish 
the auto-population in one step, you can use the Options tab to map the fields when you launch 
the Base Commit BP.  

Note: If you select to auto populate the Payment Application with the line 
item fields from the Base Commits BP (Options tab > Auto-populate on 
Payment Application), then the fields will be available as columns in the 
SOV sheet. If there are any picker fields that refer to other sources, 
those fields cannot be added as columns. 

You can use this feature only on:  

 SOV type Payment Applications 

 SOV type Summary Payment Applications (Base Commits BP) 

 SOV line item type individual commit line items 

In operation, the Base Commits, Change Commit, and Payment Application BPs work as a "set." 
The Payment Application reflects the Base Commit and Change Commit line items. When you 
design the Base Commit BP to auto-populate the Payment Application, at runtime, Primavera 
Unifier will automatically check any Change Commits for the same field(s) and include their 
values as well on the Payment Application. 

The runtime Payment Application detail form grid receives the auto-populated values from Base 
Commits source into its costed as well as summary lines. 

You can configure the Data Elements (DEs) in the Payment Application to receive 
auto-populated values from: 

 Base Commits BP 

 Schedule of Values (SOV) 
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 Any other source (Upper Form, Detail form, Constant Value, Single Record BPs, etc.) 

If a Data Element on the Payment Application is configured to receive auto-populated values 
from the Base Commits, and it is also configured to receive auto-populated values from other 
sources within the Payment Application, Unifier overrides the auto-populated values received 
from Base Commits in the Payment Application (PayApp). The override applies to the 
auto-populated values in the costed and summary lines. 

When the auto-populated values comes from the Base Commits and auto-populates the costed 
lines values, other columns may be generated in the PayApp grid. The formulas for those 
columns are based on the auto-populated costed column. 

Auto-populating values are completed in spite of any merge from the Change Commit (SOV and 
new lines). 

All of the DEs in the Summary Payment Application grid accept auto-population, and the costed 
rows receive auto-populated values from Base Commits source, in all instances. 

Note: For auto-populating a Payment Application, the data element 
names must match. 

Caveats

 If the Payment Application is auto-populated using both methods, the "usual" method will 
override this method. 

 You cannot auto-populate the following fields on a Payment Application: 

 amount 

 uuu_quantity 

 bitemid 

 any picker, except a date picker 

 short_desc 

 uuu_unit_price 

 any data element that is part of a dynamic data set on the Base or Change Commit BP 

Auto-populate on Payment Application from a Change Commit BP 

You can set the values of an auto-populated data element (for Payment Application) to be 
updated when a line item is referenced in a Change Commit BP. This enables the users to see 
the latest values of the payment records, from the Change Order, when the Change Order is 
referencing an existing SOV line item that contains the data elements defined in the 
auto-populate on Payment Application from a Base Commit BP.  

In the Options tab, the Settings block for Change Commit - Line Items with CBS Code, you 
can select to update the data elements that auto-populate on Payment Application. This 
selection is applicable for the: 

SOV Type: Payment Applications or Summary Payment Applications 

SOV Line Items: Individual commit line items 
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As a part of the Change Order business process design, if you (the designer) select this option, 
and at the run time when a Change Order references an existing SOV line item, then the data 
elements defined in "Auto-populate on Payment Application" are updated and then the SOV is 
updated. 

Auto-Creating a Record or Line Item from a Form 

There are several ways to automatically create records in Unifier. If a business process has a 
workflow, a new record can be created when the form reaches a specific status. (For 
information on this method, see Auto-Creating a Record from a Workflow (on page 406).) If 
you use the Scope Management feature in the Schedule Manager, an activity on the schedule 
sheet can create a new business process record for a self-managing project. (For information 
about this method, see Automating a Schedule Using Scope Management (on page 104).) 

For more information see Mapping Line Items from References during BP Creator 
Auto-Creation (on page 297). 

Using another method—the one described here—you can manually or automatically create a 
new record based on: 

 A condition, such as a dollar amount 

 A frequency, such as a daily or weekly time frame 

Note: Line items cannot be created with a frequency trigger. 

 Both a condition and a frequency

When the form reaches the trigger(s), the form will automatically create a new record. (Or a line 
item on the form will create a new record or line item.) 

For example, you could auto-create a new record for a lease that automatically generates 
payment requests on appropriate days, using a pre-generated payment schedule, and routes 
them for approval. Or, you could auto-create a record that generates work orders for your 
company's assets at periodic intervals, depending on the service needs of the asset. You could 
also auto-create a planning item when an initiative business process has been approved. The 
planning item could then be fleshed out with details, such as budgets, locations, personnel. 

After a new workflow record is created, it is sent to the assignees as an initiation task (I Step)
that appears on the user's Tasks log and the BP log to which the record belongs.  If a new 
record is sent as an initiation task, the user must accept the task to manually launch the record. 

After a new non-workflow record is created, it is sent to the designated creators as 
an initiation task (I Step) that appears on the user's Tasks log and the BP log to which the 
record belongs. The user must accept the task to view the record.  
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Note: Regardless of the number of assignees or creators, only one user 
may accept the I Step task. 

The difference between condition-based auto-creation and workflow auto-creation: 

Upper/detail form auto-creates a record 
(using a BP Creator element): 

Workflow link auto-creates a record (S-Step): 

Creates a new record from an upper 
form or from a line item list 

Line item lists are ignored 

Creates a new record when the 
workflow reaches a specific condition 
or time frequency (or both) 

Creates a new record when the form reaches a 
specific step 

Creates multiple records if records are 
generated from the detail form (line 
item list); individual line items can be 
copied or ignored 

Creates one record that contains an exact 
duplicate of the information in the original 
record—all information that was contained in 
that transaction, including forms, and 
attachments 

Can specify where the new record will 
reside (such as a project, or shell) 

New record will reside in the same place as the 
source record 

Can specify who will own the new 
record 

User who owns the original record becomes 
the owner of the auto-created record 
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Upper/detail form auto-creates a record 
(using a BP Creator element): 

Workflow link auto-creates a record (S-Step): 

After being created, a new record 
(workflow or non-workflow) appears as 
an initiation step (I Step) on the user's 
Tasks log and the BP log. 

The user must accept an initiation step 
task to launch the record into the 
workflow. 

For non-workflow records, the user 
must accept the task to view the 
record. 

If the I Step is bypassed: 

Workflow records are sent 
automatically to the next step in the 
workflow. When the record is created, 
data will roll up to manager sheets 
unless Unifier encounters errors (in 
which case, the record will remain at 
the Create step until the user resolves 
the errors). 

Non-workflow records are 
auto-created and appear in the BP log 
in either an "edit" or "finish edit" mode. 
If it appears in an "edit" mode, the user 
will have to open the record and add 
or correct information on the form. If it 
appears in a "finish edit" mode, the 
record is considered complete, and 
data will roll up to manager sheets. 

After being created, the new record is sent 
automatically to the next step in the workflow. 

Bypassing the I Step 

During business process setup in Unifier, the administrator can set up an auto-created workflow 
BP to skip the initiation step and send the record directly into the workflow, where it normally 
arrives at the first step after the Create step (or the first step in a conditional routing). For a 
workflow BP, the administrator can specify the schema, the step in the workflow that the record 
should use as its first step, the workflow duration, and the name of the person or group who will 
be the owner of the auto-created record. When the record is created, data will roll up to manager 
sheets at the appropriate status; however, if Unifier encounters errors or invalid data, the record 
will remain at the Create step, and rollups will not occur until the user resolves the errors. 

For a non-workflow BP, the administrator can set up an auto-created record to skip the initiation 
step. In this case, the non-workflow BP will be created and will appear in the BP log in either an 
"edit" or "finish edit" mode. If it appears in an "edit" mode, the user will have to open the record 
and add or correct information on the form. If it appears in a "finish edit" mode, the record is 
considered complete, and data will roll up to manager sheets. 
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Auto-Creation Protocol for Bypassing the I Step 

Auto-creation uses details specified in the BP Creator element to create the record. If these 
details are not present in the BP Creator element, the auto-creation feature will use the following 
protocol to attempt to create the record. 

For a Non-Workflow BP For a Workflow BP 

Checks for owner specification: 

 Checks the source BP setup 

 Checks the destination BP setup 

If no owner can be identified, sends an 
error notification to those specified in 
source BP. 

Checks for status: 

Checks the destination BP setup 

If no status found, creates the record and 
puts it into "edit" mode for user to correct. 

Checks for owner specification: 

 Checks the source BP setup 

 Checks the destination BP setup 

If no owner can be identified, sends an 
error notification to those specified in 
source BP. 

Checks for a workflow schema: 

Checks the destination BP setup 

If no schema is specified, the record will be 
sent as an I Step to the user's Tasks log 
and the BP log to which the record 
belongs. The user must accept the task to 
manually launch the record. 

Checks for an action specification: 

Checks the destination BP setup 

If no action is specified, the record will be 
sent as an I Step to the user's Tasks log 
and the BP log to which the record 
belongs. The user must accept the task to 
manually launch the record. 

Auto-Populating the New Record 

Auto-creating a record includes auto-populating fields (data elements) on the new form. To 
auto-create a new record using this method, you must decide how you want to auto-populate the 
new record—using the upper form or the detail form of the source record. Primavera Unifier 
offers three types of auto-creation: 

 Record-to-record creation 

 Line-item-to-record creation 

 Line item creation 

Note: Auto-populated field values will override any field values that have 
migrated with the auto-creation. 

Record-to-record Auto-Creation 

Record-to-record auto-creation has the following characteristics: 
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 Creates a single record. 

 The source record populates any upper form fields on the destination record that the two 
records have in common (that is, their data element names match). 

 By mapping, you can move the contents of the tabs on the source record to tabs on the 
destination record. The tab names do not have to match. The source record populates 
any fields that the tabs on the destination record have in common with it. 

Line-Item-to-Record Auto-Creation 

Line-Item-to-record auto-creation has the following characteristics: 

 Each line item that contains a creator element will auto-create a new record. For 
example, if source tab A has a creator element on 10 line items, and source tab B has 
the same creator element on 7 line items, 17 new records will be auto-created. 

Sometimes creating a record for every line item is cumbersome. You can end up with 17 
records that differ in only one aspect, such as a color. For cases like this, 
administrators can group line items for auto-creation in order to create fewer 
generated records. In a simple example for a lumber yard order, you might have 
doors made of wood or steel, both in colors of white and red. You could group the line 
items according to the material (wood or steel) and color (red or white) to create fewer 
work order records. This kind of grouping for auto-creation is set up by the Primavera 
Unifier administrator. For more information, refer to the "Business Process Setup" in 
the Unifier Administration Guide. 

 The source record populates any upper form fields on the destination record that the two 
records have in common. 

 You can use line items on the source record to populate fields (data elements) on the 
upper form of the new record if the data element names match. 

 If you map the contents of any tab on the source record to tabs on the new record, this 
type of auto-creation will also copy the line items of those mapped tabs to tabs on the 
new record. The tab names do not have to match. The source line items will populate any 
fields that the tabs on the destination record have in common with it. 

Line Item Auto-Creation 

Line item auto-creation is useful for adding new line items to an existing record. For example, a 
submittal registry record could contain line items that auto-create separate submittal business 
process forms for each contractor on a project. In the course of work, someone might realize 
that the original submittal registry record is missing a submittal for an architectural drawing. That 
person could submit a new submittal record that would add the missing architectural drawing 
submittal to the original registry record. 

uDesigner provides a BP line item creator element to auto-create line items. You can place this 
creator element on either an upper or detail form. This element will auto-create a new line item 
on another, existing, record and populate the fields of that line item with the values of the fields 
on the form (upper or detail) that auto-created the line item. 
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You can set up reverse auto-population so that the line item added to the existing record can be 
updated with information as the record that created the line item moves through subsequent 
steps in a workflow. 
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How Creator Elements and Pickers Function in Line Item Auto-Creation 

Pickers and creator elements work together to auto-create line items. 

Auto-Population and Reverse Auto-Population in Line Item Auto-Creation 

To populate and reverse auto-populate fields on business processes and line items with line 
item creation, you can use the following data elements in collaboration: 

 BP Line Item Picker 
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 BP Line Item Creator 

Note: You cannot use a BP Line Item Picker in an Activity Attribute 
Form.  

Preparing the Auto-Creation 

To use this method of auto-creation, you must first: 

1) Create data elements based on these data definitions: 

 BP Creator  (for creating a business process record) 

 Planning Item Creator (for creating a planning item record) 

 BP Line Item Creator (for creating a line item on another, existing, business process 
record) 

These elements use built-in intelligence to create records or line items and create hyperlinks 
from the original record to the new records or line items that have been generated. 

For example, to auto-create a work order record, you might create a BP creator data element 
called "Work Orders." To auto-create a planning item from a business process, you might 
create a Planning Item Creator element called "Type." 

Note: For more information on the BP Creator, BP Line Item Creator, 
and Planning Item Creator data definitions, refer to the chapter on data 
definitions in the Unifier Data Reference Guide. For instructions on 
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creating data elements, see the information beginning with Creating a 
Data Structure (on page 189). 

2) Create the forms for both the source record and the destination record (the record or line 
item that will be generated). You cannot map the elements from one record/line item to the 
other until they both exist. 

The best practice is to first create the destination form (the one that will be auto-created); 
then create the source form and set up the auto-creation processes for it. For this, you must 
determine exactly what the destination form should contain. Once you have determined the 
look of the generated form, you can then design and create the source form that will 
automatically populate the generated form. 

3) Place the BP Creator element(s), BP Line Item Creator element(s), or the Planning Item 
Creator element(s) on the upper or detail form of the source record from which you are going 
to generate the new record or line item. 

 If you want record-to-record auto-creation, place the creator element on the upper form. 

 If you want line-item-to-record creation, place the creator element on the detail form. 

 If you want line item creation on an existing record, place the line item creator element 
on either the upper or detail form. 

You can use multiple different creator elements on a single form to auto-create different types of 
business process, line items, or planning item records. For example: A user wants to create a 
service request that is routed for approval, upon which a work order is auto-created. When the 
service request is complete, the work order will automatically create the charges against the 
work order. 

Creator elements: 

 Cannot be copied 

 Cannot be used in a dynamic data set (DDS) 

 Cannot be placed on a RFB bidder form 

Setting Up the Auto-Creation 

When you auto-create new records or line items from an upper or detail form, you can specify a 
number of creation criteria in uDesigner: 

For an auto-created record: 

 The owner of the new record 

 The workflow duration of the new record 

 The location where the new record should reside 

 The auto-creation method to be used (record-to-record or line-item-to-record) 

 The record that the creating record should populate 

 A link from the source record to the new record 

 Line item auto-population onto the new record 

For an auto-created line item: 

 The record on which the new line item will be created 
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 A line item picker that will reference the line item being created, which can then be used 
to reverse-auto-populate the new line item 

 The tab on which the line item will be created 

 Other fields that will be populated with a reference to the record that created the line item 

To set up the auto-creation 

1) Open the form from which you want to generate a new record or line item. 

2) In the navigator, click Auto-creation Processes. 

 Click Upper to auto-create a record record-to-record. 

 Click Detail to auto-create a record from the line item list (line-item-list-to-record). 

 Click Detail to auto-create a line item to add to an existing form. 

The right pane lists the creator elements that were placed on the upper or detail form. The 
log also shows: 

 The name of the business process that will be created, or the name of the 
business process to which a line item will be added 

 What the auto-creation process creates: a record or a line item 

3) Double-click the name of the creator element you want to configure. An Auto-Creation
window opens. This window differs, depending on whether you are auto-creating a record or 
a line item. 

4) Use the information in the table below to fill in the fields in this window. 

5) Click OK. 

6) Repeat steps 3, 4, and 5 for any remaining creators on the form. 

In this field: Do this: 

Trigger Element Shows the name of the creator element you selected in Step 
3. 

Record Owner Element (Optional) Choose the user or group who should receive this 
task. 

If you leave this field blank, the Primavera Unifier 
administrator can specify a default owner when he/she sets 
up the auto-creation in Primavera Unifier. The list will get 
populated with all the user pickers existing in the form.  

Note: If the user's status is not active, if a group name 
contains no active members, or if the user does not exist in 
the group, the auto-creation will fail. 
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In this field: Do this: 

Duration Element Select the duration (in days) of the workflow for the new 
record. Use this to override the workflow duration specified 
in workflow set up 

If you leave this field blank, the new record will use the 
duration that is specified in the workflow set up. The field 
gets populated with all the integer amount fields existing in 
the form. 

(This field is not applicable if you are creating a 
non-workflow record.) 

Location Element Select the location where the new record should reside, 
such as at company level, or in another project/shell. 

If you leave this field empty, Primavera Unifier will spawn 
the new record in the same location as the source record. 

Creation Method Shows whether the auto-creation is being made 
record-to-record (using the upper form) or 
line-item-to-record (using the detail form) 

Auto-create Records Select the destination record this record should populate. 

Display Element 

(appears for both 
business process and 
line item auto-creation) 

Select the field you want to appear as the link from the 
source record to the new record being auto-created. The list 
displays all the fields on the source record. The field you 
specify here will appear on the source record as a hyperlink 
to the new record. 

If the auto-creation creates a line item on an existing form, 
the field you specify here will appear on the creating record, 
showing the name of the line item that was created. 

Show reference value as 
hyperlink 

Select the check box to display the field name as a 
hyperlink. Users can use this hyperlink to open the new 
records that have been generated from this form. For 
example, if a payment request record was auto-created from 
a lease record, the name of the payment request record will 
appear as a hyperlink on the lease form and allow users to 
open the auto-created record. 

Auto-populate from Line 
Item to upper form 

Select this check box if you want to include line items on the 
upper form of the new record. 

If you check this box, data elements on the upper form of 
the new record will be populated with line item data from the 
source record, but only if the data elements—the one on the 
line item of the source record as well as the one on the new 
record—match. 
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In this field: Do this: 

Specify Source and 
Destination tabs 

Use this part of the form to map line items to data elements 
on the new record for auto-population. 

Note: Data will not be copied into any tabs that are hidden. 

Record-to-record auto-creation: If you map a tab on the 
source record to a tab on the new record, all the line items 
from the tab on the source will be copied into the tab on the 
destination (new) record. 

Line-item-to record auto-creation: With this method, the 
Primavera Unifier user can selectively choose which line 
items should generate new records. 

Source tab name lists the tabs on the source record. 
Destination tab name is a drop-down list of the tab names 
on the destination record. This is where you can map the 
contents of a source tab to a different tab on the destination 
record. 

If you are using record-to-record creation, the new record 
will show the tabs and line items you mapped here. 

If you are using line-item-to-record creation, one record 
for every mapped line item on the source record will be 
created. So, if source tab A has 10 mapped line items and 
source tab B has 7 mapped line items, 17 records will be 
created. 

Target Record Element 

(line-item creation) 

Select the field (usually, a BP picker) on the form that 
identifies the record where the line item should be created. 
This field is part of establishing the link between the line 
item on the existing record and the record that created it. 

Note: If a shell picker and the BP picker you specify here 
are linked, then if the user resets the shell picker value, the 
BP picker will also be reset, as will the BP Line Item 
Creator. Primavera Unifier will re-populate any fields that 
were auto-populated from the BP picker, and will also 
recalculate any formulas on these fields. 

Line Item Reference 

(line-item creation) 

Select the line item picker that references the created line 
item. This field links the line item on the existing record to 
the record that created it for auto-population and reverse 
auto-population purposes. 

Destination Tab 

(line-item creation) 

Select the tab on which the record containing the line item to 
create resides. 

Source Record Element 

(line-item creation) 

Select the BP Picker, BP Creator, or BP Data Picker that will 
be populated with a reference to the record that created the 
line item. 
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Dynamically Updating an Auto-Created Record or Line Item 

You can design the source business process (the one that auto-creates new BP records or line 
items) to update a field on the auto-created record or line item whenever the value of a field 
changes on the source BP. In operation, the source BP will "push" field value changes to the 
auto-created BP records or line items. 

Note: This feature is not available for planning item records. 

To dynamically update auto-created records and line items, you need to use the Reverse 
Auto-Population feature in the business process design. 

To update an auto-created record or line item 

1) Open the business process containing the creator element that auto-creates the new 
business process or line item. 

2) Open the form (upper or detail) that contains the creator element. 

3) In the Form Designer window, click the Properties button on the toolbar. The Elements 
Properties window opens, showing a list of the fields (data elements) on the form. 

4) Highlight the field you want to update the auto-created business process or line item and 
click the Reverse Auto-Populate button. The Reverse Auto Populate window opens. The 
Source Element shows the field on this form that will update the field on the auto-created 
form. When this field value changes in Unifier, it triggers the update of the Destination 
Element.  

5) In the Destination Name field, choose the name of the business process or line item that 
will be auto-created by the creator element on this form. 

This field creates the link between the source business process and the auto-created 
business process or line item created by the creator element. 

6) In the Destination Element field, click the Select button and choose the name of the data 
element you want to be updated on the auto-created business process p or line item. 

In operation, when you enter the Destination Name, uDesigner checks the integration 
interface you created for the form you want to update. It locates any fields with data 
definitions that match those of the Source Element and displays them when you click the 
Select button. 

7) Click OK, then click Close on the Elements Properties window. 

8) On the Form Designer window, click Save, then click Close Window. 
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Designing a Bid Comparison Sheet for an RFB 

For the Request for Bid (RFB) business process, Primavera Unifier includes an bid tabulation 
feature. This feature provides a default comparison sheet with which Primavera Unifier users 
can compare the bids they receive from vendors. 

The default bid comparison sheet (shown above) shows only the bid dollar amounts for each line 
item for which the vendor submitted a bid. 

Alternatively, you can design a custom bid tabulation sheet in uDesigner that can include more 
information in a layout specific to your company's needs. Using a custom bid comparison sheet, 
you can compare vendors on criteria besides price, such as certifications and re-negotiated line 
item prices. You could also add comments to the submitted bid that can be displayed on the bid 
tabulation. This sheet becomes part of the RFB process in Primavera Unifier; users can view this 
sheet from the RFB when the bidding has ended. 

Note: You can design only one custom bid comparison sheet for your 
company. 

To design the bid comparison sheet, you will create upper and detail forms, as you would any 
business process. You must design the bidder form first, as uDesigner automatically enters the 
fields from this form on the sheet design. In addition, you can add other elements to the design 
from the Custom Data Elements list. 

Note: The bid comparison sheet must match the upper and detail forms 
of the bidder's BP. When you create the design for the sheet, uDesigner 
automatically adds the data elements from these forms. If you later add 
or remove an element from the bidder forms, you will also have to add or 
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remove it from the sheet. 

The custom-designed bid comparison sheet shows the following:  

 General bid information from each vendor who submitted a bid. 

 Each line item from the RFB that the vendor has bid on. If the vendor adds line items of 
their own to the bid, these line items will appear on the sheet as well. 

To design a bid comparison sheet 

Note: You cannot use the following on a Bid Comparison Sheet: 
Dynamic data sets, Formulas, Auto-population, and the Value reset 
feature. 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Business Processes.. 

3) Open the RFB business process and click Bid Comparison Sheet in the Navigator. 

4) Click Upper, then click New on the right pane. The Upper Design Properties window opens. 

5) On the General tab, enter a Name and Description for the form. 

6) Click the Data Elements tab. uDesigner displays a list of the data elements that were 
included on the upper form of the bidder form. uDesigner automatically adds these elements 
to the upper form of the comparison sheet. These elements will be read-only on the sheet in 
Primavera Unifier. 

You can add other data elements to the Bid Comparison Sheet if you want. 

7) To add additional data elements to the sheet, click the Add button and  choose: 

 From Bidder Form to add elements from the bidder form. Fields from the bidder form will 
be read-only in Primavera Unifier. 

 Note: uDesigner automatically includes the elements from the bidder 
form. Use the From Bidder Form option if data elements were 
added to the bidder form after the bid comparison sheet was 
designed and activated in Primavera Unifier. Because the sheet must 
match the bidder form, if new elements were added, use this option 
to add them to the sheet. 

 The Add Data Element window opens. In the Element Label field, select the data 
element you want to include on the comparison sheet and click Add. 

 Custom to add elements from the list of custom data elements available for designing all 
business processes. Fields you choose from this list will be editable on the sheet in 
Primavera Unifier. 

Select the element you want to include on the comparison sheet and click OK. 

8) On the Upper Design Properties window, click OK. 

9) In the Navigator, click Detail, then click New on the right pane. The Detail Design Properties 
window opens. 

10) To design the detail form, repeat steps 3 through 6. 
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Hiding a Data Element on the Sheet 

Once a Bid Comparison Sheet is in use in Primavera Unifier, you cannot remove any data 
elements from it. You can, however, hide the custom data elements if you no longer want them 
visible to the Primavera Unifier user. 

Note: You cannot hide the data elements that came from bidder forms. 
You can hide only those data elements that have been added from the 
Custom data elements list. 

To hide an element 

1) Open the RFB business process and click Bid Comparison Sheet in the Navigator. 

2) In the Navigator, click Upper or Detail, depending on where the element you want to hide is. 

3) Click the Data Elements tab. 

4) Select the data element you want to hide and click the Hide button. 

To "unhide" an element 

1) Open the RFB business process and click Bid Comparison Sheet in the Navigator. 

2) In the Navigator, click Upper or Detail, depending on where the element you want to show 
is. 

3) Click the Data Elements tab. 

4) Select the data element you want to show and click the Show button. 

Saving a Version of a Design 

As a designer, you will often be asked to make changes to a business process or manager and 
then redeploy it to production. Especially with business processes that evolve over time, many 
changes can result in a muddle of form and workflow variants, some with major changes and 
others with fine-tuning tweaks. 

uDesigner offers a versioning feature with which you can save distinct versions of a design 
(including template designs), and, if necessary, restore all or part of a published design to a 
previous version. This feature makes the ongoing evolution of a manager or business process 
design easier to track and control. 

To save a version of a design, you will be using uDesigner's snapshot function. The snapshot 
function creates a version of a business process that includes the upper and detail forms as well 
as the workflow(s), if any. For managers and shells, the snapshot function includes the detail 
form and any other components that were designed for the manager. When you take a 
snapshot, uDesigner will timestamp it with the date and time it was created. 

Using the snapshot function, you can create distinct versions of a design and, thereby, create an 
audit trail of the changes you have made to it. 

Taking a Snapshot 

You can take a snapshot of a BP design at any time during the design process, when the BP is 
in draft status. uDesigner will add the snapshot to a log of snapshots that you will see only if you 
choose to restore a BP version (see Restoring a Version of a Design (on page 375)). 
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Note: uDesigner automatically takes a snapshot of a design whenever it 
is marked "Complete" and also whenever it is published to production. 

To take a snapshot of a design: 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner.

3) Click Business Processes or click the manager or shell you want to work with. 

4) From the log on the right pane, open the BP/manager/shell you want to take a snapshot of. 

5) From the File menu, choose Snapshots. The Snapshots Log window opens. 

6) Click New. The snapshot Properties window opens.  

Note: The New option will not be enabled unless the user is signed in as 
the owner of the business process. 

7) Enter a name and description for the snapshot and click OK. 

uDesigner creates a snapshot of the business process's, manager's, or shell's  forms and 
the workflow(s), if any, and displays the name of the shot on the Snapshot Log along with the 
date and time it was created. 

Restoring a Version of a Design 

As you try out versions of a business process, manager, or shell design, you might find that an 
earlier version of it worked better, or that an earlier version contained components that you need 
to revive; or that you just want to start over at a specific point in the design. With this feature, you 
can use a Saving a Version of a Design (on page 374) to restore a previous version of a 
design, replace a design with another design, or create a new form or workflow in an existing 
design. 

There are two restore scenarios: complete and partial. 

 Complete: 

 Restores the entire business process, manager, or shell, including all the forms, 
workflow(s), attribute forms, statuses, data elements, reference processes, logs, etc. 

 You can make a complete restoration from the last published version (the one that is 
currently in use in Primavera Unifier), or from the last version marked "Complete" in 
uDesigner (Development).  

 Partial

Restores any of the following components of a BP: 

 Upper form 

 Detail form 

 Workflow 

A partial restoration can be made from any snapshot that was made of the business 
process/manager. You can also use a partial restore to replace a form or workflow with 
another design. 
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Note: Partial restorations are only for business processes, since 
managers and shells do not include upper forms and workflows. 

Restoring a Complete Version of a Design 

In this scenario, you can restore an entire business process, manager, or shell, including all the 
forms, the workflow(s), attribute form, statuses, data elements, reference processes, logs, etc. 

To restore a complete version of a design: 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner. 

3) Open the business process, manager, or shell you want to work with. 

Note: If you are currently working on another draft of the design, be sure 
to take a snapshot of it if you want to keep it! 

4) From the Edit menu, choose: 

 Restore > Last Completed to restore the last version of the design that was marked 
"Complete." 

This will overwrite any draft version of the form you are currently working on. 

 Restore > Last Published to restore the last version of the design that was published. 

This will overwrite any draft version you might currently be working on, but it will not 
overwrite the last version of the design marked "Complete." 

Restoring or Replacing an Upper Form 

Use a partial restoration if you want to restore or replace only the upper form of a business 
process. For upper forms, you can use the restore feature to restore a previous form layout, or 
replace the form layout with that from another snapshot. 

To restore/replace an upper form from a snapshot: 

1) Open the business process, manager, or shell you want to work with. 

Note: If you are currently working on another draft of the design, be sure 
to take a snapshot of it if you want to keep it! 

2) In the navigator, click Upper Forms. In the right pane, uDesigner displays a list of the upper 
forms that have been created. 

3) Double-click the name of the upper form to open it in the Form Design window. 

4) Select File > Restore. The Snapshot Log opens. 

5) Highlight the name of the snapshot containing the upper form you want to use and click 
Open. 

uDesigner replaces the layout with the one from the snapshot you specified. 



Designing a Form

377

Restoring or Replacing a Detail Form 

Use a partial restoration if you want to restore or replace only the detail form of a business 
process. For detail forms, you can use the restore feature to restore a previous form layout, or 
replace the form layout with that from another snapshot. 

Note: You can restore/replace a Standard form (tab) only from a 
snapshot of another version of the Standard form. 

To restore or replace a detail form 

1) Open the business process, manager, or shell you want to work with. 

2) In the navigator, click Detail Forms. In the right pane, uDesigner displays a list of the detail 
forms that have been created. 

3) From the File menu in the Form Design window, choose Restore. The Snapshot Log opens. 

4) Highlight the name of the snapshot containing the detail form you want to replace the current 
form and click Open. 

uDesigner replaces the layout with the one from the snapshot you specified. 

Restoring or Replacing a Workflow 

Use a partial restoration if you want to restore or replace only the workflow of a business 
process. For workflows, you can use a snapshot to restore or replace a workflow layout with a 
layout from another snapshot. 

To restore or replace a workflow 

1) Open the business process you want to work with. 

2) In the navigator, click Workflows. In the right pane, uDesigner displays a list of the 
workflows that have been created for this BP. 

3) Double-click the name of the workflow to open it. The workflow Design window opens, 
showing the current workflow layout. 

4) Select File > Restore. The Snapshot Log opens. 

5) Highlight the name of the snapshot containing the workflow layout you want to replace the 
current workflow and click OK. 

uDesigner replaces the layout with the one from the snapshot you specified. 

Creating a New Form or Workflow From a Snapshot 

You can use a snapshot to insert a new form or workflow into a design. 

To create a new upper form from a snapshot 

1) Open the business process you want to work with. 

2) In the navigator, double-click Upper Form. 

3) Select New > From Snapshot. The Snapshot Log opens. 

4) Highlight the name of the snapshot containing the upper form you want to use and click 
Open. 
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uDesigner opens the form's Properties window. 

5) On the General tab, enter a name and description for the new form. 

If this is to be a read-only form, click View Form, then click OK. 

If you want the reader to be able to edit the fields on this form and include attachments or 
line items, click Action Form, then click Apply. 

6) Click the Options tab. 

This tab displays different options, depending on the BP type you are creating. To complete 
the Options tab, use the instructions in the topic "Designing an Upper Form (on page 257)." 

7) Click OK. 

uDesigner creates the new upper form and displays the name on the upper form log. 

To create a new detail form from a snapshot: 

If you are designing a form with multiple tabs to organize the data, you can use a snapshot to 
create a detail form for a new tab. 

Note: You cannot create a new tab from a Standard form. 

1) Open the business process you want to work with. 

2) In the navigator, click Detail Form. 

3) Click New > From Snapshot. The Select Snapshot window opens. 

4) Double-click the name of the snapshot you want to use for the new tab. The Form Design 
window opens. 

5) On the General tab, enter a name for the new form and click OK. 

uDesigner adds the new detail form to the list of forms on the right pane. The new detail form 
will be a replica of the one from the snapshot. 

6) To edit the form, double-click the name of the form on the log. The Form Designer window 
opens. 

To create a new workflow from a snapshot: 

1) Open the business process into which you want to insert a new workflow. 

2) In the navigator, click Workflows. In the right pane, uDesigner displays a list of the 
workflows that have been created for this BP. 
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3) Select New > From Snapshot. The Snapshot Log opens. 

4) Highlight the name of the snapshot containing the workflow you want to insert and click 
Open. 

uDesigner opens the workflow's properties window. 

5) Enter a name and description for the new workflow and click OK. 

uDesigner inserts the new workflow and displays the name on the workflow log. 

Adding Mobile Data Elements 

Hidden blocks in the form will not be displayed in the mobile app. If you place a required field in 
a hidden block, the app will not display the required field. As a result, if the required field does 
not have a value, then the user will not be able to submit the record. In a scenario that you must 
place a required field in a hidden block, you can set up the mobile data elements list in a way 
that it can include the auto-populated value of the required field in the hidden block.  

In such scenario, you must ensure that you include the auto-populate source in the mobile data 
elements list. The same rule will be applicable to formula fields, in addition to using 
auto-population. You must ensure that the elements added to the mobile form meet all of the 
validation rules for a successful record submission. 

The following BPs cannot be enabled for mobile app: 

 RFB  

 Project/Shell creation 

The "Payment Application" BP is partially supported in the mobile app. 

Creating a Business Process Design 

To create a business process (BP) form:  

1) Go to your Company Workspace (Admin mode). 

2) From the left Navigator, click the uDesigner node to expand. 

3) Click the Business Processes sub-node to open the Designer-Business Processes log. 

4) From the toolbar options, click New to open a list of BP form types, and click to select the 
desired BP. The tables in the following sub-topics list the BP form types and their fields. 

5) In the window (Edit Studio) that opens, General tab, enter or select values. 
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6) Click Apply and then click OK. 

Once you click Apply or OK, Unifier will display other tabs that help you define the other 
properties of the Business Process. The tabs displayed are: 

Note: The tabs might vary depending on the type of the Business 
Process, but in general the following are the tabs that are available for 
most Business Process types (Workflow or Non-Workflow). 

 General (default tab) 

 Statuses

 Options

 Consolidation

Cost 

The Cost BP form type contains the following fields: 

 ID 

 Name 

 Description 

 Type 

Cost (read-only) 

 Sub-Type 

 Commit at company level 

 Line Items with CBS Code 

 Line Items with Fund Code 

 Line Items with both CBS and Fund Codes 

 Line Items with both CBS and WBS Codes 

 Line Items with Company Accounts Code 

 Line Items with Asset Code 

 Line Items with Multiple Codes 

 Classification 

If you do not select a sub-type, then you have two options: 

 Generic 

 Transfer 

If you select a sub-type, then this field is disabled. 

 Configurable Managers 

 Level 

 Company 

 Project/Shell (selected by default and read-only) 

 Behavior 

 Workflow 

 Non-Workflow 
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 Record Instances 

 Single 

 Multiple (selected by default and read-only) 

Document 

The Document BP form type contains the following fields: 

 ID 

 Name 

 Description 

 Type 

Document (selected by default and read-only) 

 Sub-Type 

 With Folder Structure 

 Without Folder Structure 

 Level 

 Company 

 Project/Shell 

 Behavior 

 Workflow 

 Non-Workflow 

 Record Instances 

 Single 

 Multiple (selected by default and read-only) 

Text 

The Text BP form type contains the following fields: 

 ID 

 Name 

 Description 

 Type 

Text (selected by default and read-only) 

 Level 

 Company 

 Project/Shell 

 Behavior 

 Workflow 

 Non-Workflow 

 Record Instances 

 Single 
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 Multiple (selected by default and read-only) 

Line Item 

The Line Item BP form type contains the following fields: 

 ID 

 Name 

 Description 

 Type 

Line Item (selected by default and read-only) 

 Sub-Type 

 Generic 

 Line items to filter company Business Process records 

 Preventive Maintenance 

 Classification 

If you select Preventive Maintenance as Sub-Type, then you have the following 
classifications: 

 Asset 

 Asset Template 

 PM Book 

 PM Book Template 

 Meter Reading 

 Configurable Managers 

If you select Preventive Maintenance as Sub-Type, regardless of the classification type, then 
the Configurable Managers window opens which enables you to select one or more 
configurable managers. 

 Level 

 Company 

 Project/Shell 

 Behavior 

 Workflow 

 Non-Workflow 

 Record Instances 

 Single 

 Multiple (selected by default and read-only) 

Simple 

The Simple BP form type contains the following fields: 

 ID 

 Name 
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 Description 

 Type 

Simple (selected by default and read-only) 

 Level 

 Company 

 Project/Shell 

 Behavior 

 Workflow 

 Non-Workflow 

 Record Instances 

 Single 

 Multiple 

RFB (Request for Bid) 

The RFB BP form type contains the following fields: 

 ID 

 Name 

 Description 

 Type 

RFB (selected by default and read-only) 

 Sub-Type 

 Generic 

 Line Items with CBS Code 

 Line Items with Generic Cost Manager 

 Level 

 Company 

 Project/Shell (selected by default and read-only) 

 Behavior 

 Workflow (selected by default and read-only) 

 Non-Workflow 

 Record Instances 

 Single 

 Multiple (selected by default and read-only) 

Resource (Resource Booking or Timesheet) 

The Resource BP form type is divided into the following forms: 

 Resource Booking
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 Timesheet

The Resource Booking BP form type contains the following fields: 

 ID 

 Name 

 Description 

 Type 

Resource (selected by default and read-only) 

 Sub-Type 

 Resource Booking (selected by default and read-only) 

 Level 

 Company 

 Project/Shell (selected by default and read-only) 

 Behavior 

 Workflow (selected by default and read-only) 

 Non-Workflow 

 Record Instances 

 Single 

 Multiple (selected by default and read-only) 

The Timesheet BP form type contains the following fields: 

 ID 

 Name 

 Description 

 Type 

Resource (selected by default and read-only) 

 Sub-Type 

 Timesheet (selected by default and read-only) 

 Level 

 Company (selected by default and read-only) 

 Project/Shell 

 Behavior 

 Workflow 

 Non-Workflow 

 Record Instances 

 Single 

 Multiple (selected by default and read-only) 

Project/Shell Creation (Simple or Line Item) 

The Resource BP form type is divided into the following forms: 
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 Simple

 Line Item

The Simple BP form type contains the following fields: 

 ID 

 Name 

 Description 

 Type 

Project/Shell Creation (selected by default and read-only) 

 Sub-Type 

 Simple (selected by default and read-only) 

 Classification 

 Level 

 Company 

 Project/Shell 

 Behavior 

 Workflow 

 Non-Workflow 

 Record Instances 

 Single 

 Multiple (selected by default and read-only) 

The Line Item BP form type contains the following fields: 

 ID 

 Name 

 Description 

 Type 

Project/Shell Creation (selected by default and read-only) 

 Sub-Type 

 Line Item (selected by default and read-only) 

 Classification 

 Projects or Shells only 

 Shell and sub shells 

 Level 

 Company 

 Project/Shell 

 Behavior 

 Workflow 

 Non-Workflow 

 Record Instances 

 Single 
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 Multiple (selected by default and read-only) 

Adding Link Elements to a Form 

For some components, uDesigner displays a Link Elements option on the Forms toolbar. Linking 
creates a dynamic connection between a field on a source form, such as a Shell or Schedule 
Attribute form, and a field or fields on a destination form, such as a child Shell, or a Business 
Process. 

Note: This feature does not work like Auto-Population. Auto-population 
is static; it happens only once at the creation step of a Business 
Process. Element-linking is dynamic; the elements always reflect a 
current value as the value in the source element changes. 

This section explains the following topics: 

 Business Process Upper Forms and Linked Elements 

 Business Process Detail Form and Linked Elements 

 Business Process and Linked Elements Errors 

 Shell Attribute Forms and Linked Elements 

 Other uDesigner Objects and Linked Elements 

Business Process Upper Forms and Linked Elements 

The Business Process Upper Forms and Detail Form toolbars contain the Link Elements option. 
The Link Elements option in the Upper Forms toolbar is used to define the DEs that need to be 
linked to a source and become the linked DEs to an Upper form. The following explains the 
fields related to the Business Process Upper Forms. The fields related to the Business Process 
Detail Form are explained later in this section. 

The Linked Elements window has the following options: 

 Add By Shell: This option replicates the Link Elements by using the "Add" functionality from 
the Business Processes "Properties" tab. 

 When the user clicks Add By Shell, the same window as the Business Processes 
"Properties" tab window opens. Go to Link Elements and the Add option appears.  

 By using this option, the user can add Linked Elements from a single record Business 
Process or Shell Attribute forms. 

 When an element is added by way of Add By Shell option, the element appears in the 
Linked Elements window. 

 Add By Picker: This option enables you to select a P6 Activity Picker element from all 
available P6 Activity Picker DEs (Data Structure Setup > Data Elements) and map a P6 
Activity Attribute to another uDesigner Data Element. 

 Similar to Auto-populate functionality for form Data Elements, the mapping via this 
window will be as per matching Data Definitions. Select values for the fields in the Link 
Elements window as described below: 
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a. Source Name: Select the P6 Activity Picker Element that you want to be the source of 
Linked DE on the Business Process form. This field is required and lists all the DEs from 
the Data Structure Setup > Data Elements whose DD = P6 Activity Picker. 

b. Source Element: Select the actual P6 Activity attribute whose value you want to be 
mapped to the Linked DE on The Business Process form. This field is required and lists 
all the "Form Label" for all the attributes in the P6 Activity Attribute Sheet form (Schedule 
Manager > Source Element), in alphabetical order. 

c. Destination Element: Select the DE that you want to get updated dynamically by way of 
receiving the value from a P6 Activity Attribute form as the value changes within an 
Activity Sheet. This field lists all DEs from the Data Structure Setup > Data Elements that: 

- Match the DE of the "Source Element" selected above, and 

- Have not already been placed as a "Custom" Element on any of the Upper forms that 
will contain the elements. 

Click OK to add the element to the Linked Element window. 

 Remove: This option allows you to remove a linked element from the list. You can select the 
element and click Remove. 

Whether you add an element by way of "Add by Shell" or by way of "Add by Picker" options, the 
element appears in the Linked Elements window, and the Linked Elements window provides the 
following information: 

 Data Element: Displays the name of the uDesigner Data Element which is being added as a 
linked element. 

 Form Label: Displays the Form Label of the linked DE. 

 Source Name: Displays the name of the source of the linked uDesigner DE.  

 If the linked element is added by way of "Add by Shell" option, this column corresponds 
to the "Name" column of the existing linked elements (Properties > Link Elements) and 
displays the name of the P6 Activity Attribute. 

 If the linked element is added by way of "Add by Picker" option, this column displays the 
name of the P6 Activity Attribute form, from uDesigner (Schedule Manager > Activity 
Sheet Attributes). 

 Source Type: Displays the type of source. 

 For linked elements added by way of "Add by Shell" option, this column corresponds to 
the "Type" column of the existing linked elements (Properties > Link Elements) and 
displays the source type as "Single Record BPs" or "Shell Attribute Form" as applicable. 

 For linked elements added by way of "Add by Picker" option, this column displays the 
source type as "P6 Activity Attribute." 

 Source Picker: Displays the P6 Activity Picker DE "Label" (the Form Label of the "Source 
Picker" if the linked element is being added by way of "Add by Picker" option). 

This field will be blank if the linked element is being added by way of "Add by Shell" 
option. 

 Source Element: Displays the actual Source Element that is being linked to the uDesigner 
DE. 

 For linked elements added by way of "Add by Shell" option, this column corresponds to 
the "Source Label" column of the existing linked elements (Properties > Link Elements). 
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For linked elements added by way of "Add by Picker" option, this column displays a list of "P6 
Activity Attribute" labels that the user selected, when adding the linked element. On the 
destination form, the linked field: 

 Will be read-only 

 Cannot be auto-populated, nor can it auto-populate other fields 

 Cannot update (using reverse auto-population) any other fields, nor can it be updated 

 Cannot be used in formulas 

 Cannot be used in form rule validation 

 Is only available for integration output via Web Services 

As explained in detail below, the Linked Elements are suitable for business cases such as: 

 Shell re-organizing 

 Quick access to schedule information 

 Including dynamically updated data on planning items 

After you define the linked elements by using the "Linked Elements" option, the user can add the 
linked elements to the Business Process Upper form and perform the following: 

When the user opens an Upper form and clicks Linked Elements, the resulting window displays 
all linked elements as defined by way of "Linked Elements" option, in the Upper form toolbar. 

Note: When the user clicks Custom to add custom DEs to the Upper 
form, the resulting window does not display any of the DEs that have 
been defined as available linked element for the Business Process 
Upper form. 

All the linked elements that have been added by way of "Add By Picker" option have the same 
properties as those of an existing linked elements. These added linked elements: 

 Cannot be used in formulas 

 Are not available for Auto-Population 

 Are not available for Reverse Auto-Population 

Notes: 

 For all types of Business Processes which support linking elements, 
the Linked Elements option is available on the toolbar of the Upper 
Forms and Detail Form logs. 

 For all types of Shells which support linking elements, the Linked 
Elements option is available on the toolbar of the Detail Form log. 

 For all other objects in uDesigner (Space Manager, Portfolio 
Manager, and so forth) that support linking elements, the Linked 
Elements option is available on the toolbar of the Forms log. 

 You cannot use this feature for an anchor shell or at the company 
level. 

 You cannot use this feature for Request for Bid (RFB) and Resource 
Booking business processes. 

 You cannot link elements that are from a template that is linked to the 
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form. 

 You cannot link elements that are part of a dynamic data set. 

Business Process Detail Form and Linked Elements 

Similar to the Business Process Upper Forms, the Detail Form toolbar contain the Link Elements 
option. The Link Elements option in the Detail Form toolbar is used to define the DEs that need 
to be linked to a source and become the linked DEs to a Detail form. 

The "Add by Shell" option is not available for a Detail form. 

The available options under the Link Element option in a Detail form are: 

 Add By Picker: Same as Upper form. See the "Business Process Upper Forms and Linked 
Elements" topic above. 

 Remove: Same as Upper form. See the "Business Process Upper Forms and Linked 
Elements" topic above. 

Business Process and Linked Elements Errors 

As mentioned, the Linked Elements, or Dynamic Linking, is available for a Business Process 
Upper Forms and Detail Form. Users will receive error messages: 

 If a form (Upper or Detail) holds Linked Elements which have been defined by way of "Add 
By Picker" option, but the source P6 Activity Picker element does not exist on the form. 

 If you define a linked element on a Business Process, and you remove linked element 
source field from the "Activity Sheet Attribute" form. 

 If a Business Process picker, used as an Auto-Populate source (for a DE of DD = P6 Activity 
Picker), is pointed to a record outside of the Shell that the Business Process resides. A 
Business Process picker must point to a record that resides within the same Shell. 

Shell Attribute Forms and Linked Elements 

You can include the DEs of DD = P6 Activity Picker on CBS type Shells. When you define the 
link elements for a Shell Attribute form, the resulting window displays the following options: 

 Add By Shell: See "Add By Shell" part of the "Business Process Upper Forms and Linked 
Elements" topic above. 

 Add By Picker: See "Add By Picker" part of the "Business Process Upper Forms and Linked 
Elements" topic above. 

 Remove: See "Remove" part of the "Business Process Upper Forms and Linked Elements" 
topic above. 

After you define the link elements, the user can add the elements to the Shell Attribute form. If 
you include a linked DE on a form by do not include the source picker element, then an error 
message will be generated by the system. 

Other uDesigner Objects and Linked Elements 

For the following objects in uDesigner that support Link Elements on their Detail forms by way of 
Properties window, the process is similar to that of a Business Process and Linked Elements 

 Shell Manager 
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 Code and Records-based Manager 

 Planning Manager 

 Portfolio Manager 

 Schedule Manager 

The Link Elements window for these objects has the following options, only: 

 Add By Shell: See "Add By Shell" part of the "Business Process Upper Forms and Linked 
Elements" topic above. 

 Remove: See "Remove" part of the "Business Process Upper Forms and Linked Elements" 
topic above. 

Note: You cannot link elements by way of "Add by Picker" to uDesigner 
objects. 

Additional Information about Linked Elements 

 If "Linked" is enabled on a form, then the form toolbar contains the "Linked Elements" option. 

 If "Linked" is enabled on a form that belongs to any Shell object, then the Detail Form toolbar 
contains the "Linked Elements" option, only. 

 If "Linked" is enabled on a form that belongs to an Attribute form, then both "Add By Picker 
and "Add By Shell" options are available. 

 If "Linked" is enabled on a form that belongs to any other object, then "Add By Shell" option 
is available, only. 

For Re-Organizing Shells 

Some companies, such as banks, that often move sites from one division, region, or market to 
another, need to be able to restructure the shell hierarchies in Primavera Unifier without having 
to re-enter a lot of information on the forms in the child shell(s). Linking data elements (fields) 
among the forms used in shells makes it easier for the user to rearrange shell hierarchies in 
Primavera Unifier by automatically reflecting new field values on the child shell's forms as the 
shell is moved. In addition, anytime the value in a linked field changes on the parent shell's 
attribute form, it is immediately reflected on the child shell's forms. This feature ensures that data 
referenced from parent to child shells is correctly reflected in the new hierarchy so that reporting 
is accurate and Primavera Unifier's operation is not interrupted. 

Specifically, you can link fields on a parent shell's attribute form or single-record BP to: 

 A child shell's attribute form or single-record BP 

 The upper form fields of any multiple-record business process in a child shell 

Linking elements in this manner is for shell movements. Using this feature, you will be creating a 
dynamic connection from a field on a child shell's attribute form, single-record BP, or business 
process form to a field on the attribute form or single-record BP of any parent shell in the 
hierarchy. The field on the form you are designing will automatically display the current value of 
the field you link it to on the parent shell's attribute form/single-record BP, regardless of where 
the shell is moved. 
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For Accessing Schedule Information 

Users on schedule-driven projects need to access schedule data without having to open the 
Schedule Manager. Using tags, you can link a "tagged" activity from a schedule sheet to one or 
more linked elements on forms and show current schedule data, such as start dates or 
milestones. 

You can link tagged fields from a schedule attribute form to: 

 A shell attribute form 

 An attribute form for a configurable manager 

 Any business process at project/shell level 

For Including Dynamically Updated Data on Planning Items 

While working with planning items, users often need access to the latest information from other 
Primavera Unifier components. For example, users might need information about the shell under 
which the planning item resides, or information about a schedule activity that is involved in this 
planning item. You can link elements from other forms to a planning item form so that the 
planning item form will always show the current value for these elements from other forms. 

You can link fields from the following forms to a planning item: 

 A Shell attribute form 

 A single-record form 
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 An attribute form for a configurable manager 

 A schedule activity form 

 Any business process at the project/shell level 

To link elements 

Linking elements is a two-part process. First, you must specify the elements on the shell or 
schedule attribute form/single-record BP or business process that can be linked. The steps here 
show you how to specify those elements. You can place these elements on the form, at a later 
time (when you design the form for a child shell, business process, or shell). 

1) Click Linked Elements option from the Forms toolbar. The Linked Data Element Picker 
opens. 

2) From the View drop-down list, choose the attribute form or tag you want to link to. 

uDesigner displays the fields from the chosen attribute form or tag that can be linked to the 
form you are designing. 

3) Select the fields you want to link to the destination form. 

Note: To add a Data Element (DE), click Add. To remove a DE, click to 
select the DE and then click Remove. 

4) Click OK. 

To link the elements in the design, see: 

 Linking Elements in Shell Hierarchies for Easy Restructuring (on page 334) 

 Linking Tagged Elements from a Schedule Attribute Form to Another Form (on 
page 335) 

 Linking Elements from Other Forms to a Planning Item (on page 336) 

Designing Workflows 

Business processes can include one or more workflows to specify how a BP should proceed 
from start to finish. This chapter explains how to design the workflows that are part of business 
processes and other components that will be used by the users in Primavera Unifier. 

Workflows are optional. 

About Workflows 

Workflows illustrate each step in a business process, and each step will utilize the forms that you 
have created in uDesigner. Like business processes, you can create workflows at both the 
project/shell and company levels (see Designing Process Functions at These Levels). 

Workflows define how forms are routed and govern the behavior of each step in the business 
process. Using uDesigner, you will be creating the workflow schemas—the flow of business 
process steps and the forms the users will use at each step. 
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In Primavera Unifier, the administrator will fill in the workflows with the who, what, where, and 
when information for each business process, and users will fill in the forms with the information 
they will need to run the project, such as maintaining action items, managing document 
archiving, tracking workflow tasks and milestones, communicating and collaborating with project 
team members, and generating project reports. 

Non-workflow BPs

Most business processes will include one or more workflows; however, some business 
processes have a single purpose of storing data. These business processes are called 
non-workflow BPs. An example of a non-workflow BP is one or more forms that record contact 
and other general information about a company. Non-workflow BPs are editable after the form is 
complete, unless you place a terminal status on the form at completion. 

Overall Steps for Workflow Design 

It is important that you design your workflows on paper before designing them in uDesigner. 
Workflows will often need modifying before they satisfy all the requirements of a business 
process. 

Once you design the workflow for a business process in the Development environment, Oracle 
recommends that you do not delete the workflow, as it may cause unexpected results in Unifier. 
You can, however, deactivate your workflow in the Development environment, and then 
republish the business process with a new workflow.  

Overall steps for designing a workflow

1) Name the workflow. 

2) Add the workflow steps. 

3) Specify each step's properties. 

 The name and description of the step 

 Any read-only forms that are available to the recipient at this step 

 Any action item forms the recipient must respond to at this step 

4) Link the steps. 

 Specify each link's action (such as send, reject, or approve). 

 Specify the status the task should be in after the team member completes the action 
(such as approved, rejected, or closed). 

5) Group any sub-workflows (if any). 

6) Add conditional steps (if any). 

Specify the step properties, including any situation at this step that might trigger a conditional 
step that must be resolved before the workflow can continue. 

For designing a successful workflow, follow these instructions:

 Create all the action and view forms of a business process before you design the workflow. 

 Be mindful that every action in a workflow creates a potential email notification. The fewer 
steps, the better. 

 Do not recycle actions to users unnecessarily. 

 Use multiple-approver steps rather than serial approvals whenever possible. 
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 For the workflow steps, use a noun, such as Customer Approval or Finance Review. 

 For the links between steps, use a verb that designates the action being taken, such as 
Send Back for Clarification or Reject. 

 If a step's inbound action has a terminal status, then all outbound actions from that step must 
have the same terminal status. 

 For a business process with multiple workflows, use the same form for the end step of each 
workflow. This ensures that the same final form will be generated each time a BP record is 
complete, regardless of the workflow that is used. 

Starting a Workflow 

To create a new workflow, you begin by naming the workflow. Then you can open the workflow 
"canvas" to design the workflow. 

To begin a workflow 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Business Processes. 

3) Open the BP for which you want to design a workflow. 

4) In the Navigator, click Workflows. 

5) Choose New > Manual. The Workflow Properties window opens. 

6) Enter a Name for the workflow and (optional) a Description. 

7) Click OK. The new workflow appears in the Workflows pane. 

8) Select the workflow in the Workflows pane and click Open. 
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uDesigner opens a canvas where you can build the workflow. By default, the workflow has a 
Create and End step. This is your starting point for designing a workflow.  

Workflows can often be very large. If you are designing a large workflow, you can enlarge the 
canvas screen to make it easier to add steps to the workflow progression. 

To enlarge the canvas, you can drag the window sides until the workflow fits in the window, or 
you can quickly maximize the canvas. To maximize the canvas, click the icon in the upper-right 
corner of the window. To restore the canvas window to its normal size, click the Restore icon. 

About Create and End Steps 

The Create and End steps in a workflow have unique characteristics you should be aware of 
during the design and setup of the workflow. 

For the Create step in uDesigner:

 You can rename the Create step to something else if you want. 

 You can place only outgoing links on the Create step. 

 You can attach only action forms to the Create step. 

 You cannot send a link back to the Create step. If the workflow requires that a form be sent 
back to the creator (Create step), add a separate "back step" or "revision step" that will send 
the form back to the creator. 

For the End step in uDesigner:
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 You cannot rename the End step. 

 You can place only incoming links on the End step 

 You can attach either an action form or a view form to the End step. 

For the Create Step in Unifier:

 You cannot "Cc" users on the Create step. 

 A workflow cannot send a link back to the Create step. If the workflow requires that a form be 
sent back to the creator (Create step), the workflow design should include a separate "back 
step" or "revision step" that will send the form back to the creator. If your workflow includes 
such a "back step," specify match step <Creation> for the Assignees on that step. 

For the End Step in Unifier:

 You can "Cc" users on the End step. 

 You can send the form to the editors who have been assigned to the form. 

 You can add comments to a business process at the End step, and also at any status in a 
workflow, including "terminated." 

Adding Steps to the Workflow 

To add steps to a workflow: 

1) Click the S Step button. 

2) To add a workflow step, click anywhere in the canvas area of the window. 

3) Continue to add as many steps as necessary by clicking the canvas again. 

4) When you have added all the steps, click the S Step button again. 

5) Adjust the layout of the workflow as follows: 

a) Click the Select  tool. 

b) Click a step and, while holding down the mouse button, drag the step to its new position. 

c) Continue to move the steps into place until you are satisfied with the layout. 
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Note: You may need to return to this step during the workflow design 
process. 

Specifying the Steps' Properties 

Specifying a step's properties is where you will give the step a name and designate the forms 
attached to this step. Be sure you have created all necessary action and view versions of these 
forms before you start these procedures. 

To specify a steps' properties 

1) On the Workflow Designer window, click the Select tool. 

2) Double-click a step. The Step Properties window opens. 

3) Use the information in the table below to complete the step properties. 

4) Click OK. 

In this field: Do this: 

Step Name Enter a name for the step. Use a noun, such as 
"Customer Approval" or "Finance Review." To help you 
determine a name, fill in the end of this sentence: 

           "Sent for ____" 

You can enter up to 50 alphanumeric characters for the 
name. 

Note: You can give a creation step a name, but you 
cannot rename the End step. 

Description Enter a description of what the step entails. 

View Form Select which read-only forms should be available to the 
recipient at this step. (View forms are not available for the 
creation step because the only purpose of the creation 
step is to begin an action.) 

Note: For business processes with multiple workflows, 
use the same form for the end step of each workflow. 
This ensures that the same final form will be generated 
each time a BP record is complete, regardless of which 
workflow is used. 

Edit Form Select the name of any action-item forms the recipient 
should respond to at this step. 

Note: For business processes with multiple workflows, 
use the same form for the end step of each workflow. 
This ensures that the same final form will be generated 
each time a BP record is complete, regardless of which 
workflow is used. 

Sub-Workflow Name If this step is part of a sub-workflow, enter the name of 
the sub-workflow to which it belongs. 
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In this field: Do this: 

Trigger Element Optional) Click the Add button and select the field (data 
element) that will serve as the trigger for a conditional 
step that must be resolved before the workflow can 
continue. The value of the data element at runtime will 
dictate whether or not the conditional step must be 
resolved. 

You can specify multiple data elements. If you do so, the 
values of all the data elements must be met in order to 
trigger the conditional step. 

Note: You cannot use a multi-select data element as a 
trigger element because the trigger element feature does 
not recognize the commas that separate the values in 
these elements. 

Linking the Steps 

In this procedure, you will be: 

 Connecting the steps 

 Specifying each link's action (such as send, reject, or approve) 

 Specifying the status of the BP (form) after the step action is taken; for example, "Pending" 
for a transmittal in the approval process, or "Approved" for a transmittal enroute to the end 
step in the workflow 

Note: These statuses are drawn from the statuses that you specified for 
the BP form being used at this step. 

When you link steps, you can also "stamp" the form with information about the action that was 
taken at that point in the workflow. For example, a project manager might want to see who has 
reviewed the record on a step, or who has made final approval of the record, as well as the date 
and time of the action. This information can also be included on the business process log so that 
users can see this information quickly, without having to open a record. 

You can link steps using two types of connectors: 
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Connecting the Steps 

The Create step can have only one outgoing line; the End step can have multiple incoming lines, 
but only one incoming line from any single step. 

To connect the steps 

1) Click the Line or Elbow tool. 

2) Hover over the step until you see a border of red x's. These points (x's) indicate where you 
can attach a connector line. 

3) Click the step and hold, then drag the arrow to the next step. When you see a red border of 
x's, release the mouse. 

4) Continue to add lines until you have connected all the steps in the workflow. 

To modify a line: 

1) Click the Select tool, then click the line you want to modify. 

2) Click and hold the red squares to move the start and end points of the line. 

To modify an elbow: 

1) Click the Select tool, then click the elbow you want to modify. 
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2) Click and hold the yellow diamond to expand the distance of the elbow, or click on the red 
squared to move the start and end points connected to the step. 

To delete a line or elbow: 

1) Click the Select tool, then click the line or elbow you want to delete. 

2) Click the Delete button. 

Specifying Each Link's Action 

Each link between steps denotes the progression of the business process through the workflow. 

The action the link takes (Approve, Return for Edit, etc.) appears in Primavera Unifier as a 
choice the user makes on the business process form. This choice moves the task to the next 
step. 

Note: A link can also automatically create other records. If the action of 
the workflow should include creating another record, see the instructions 
under Auto-Creating a Record from a Workflow (on page 406) to 
accommodate this. 

How Terminal Statuses Affect Workflows 

Every record, line item, and asset must have a status indication at every step in Primavera 
Unifier. The status is what moves the record forward in the workflow. A terminal status indicates 
the end of the workflow or the end of a step within the workflow. 

Here are the rules that govern terminal statuses:

 The status of any link leading to an end step must be a terminal status. When you choose 
the statuses for these links, uDesigner will display only those statuses that have been 
specified as terminal. 

 If a step's inbound action has a terminal status, then all outbound actions from that step must 
have the same terminal status. 
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 A terminal status creates a permanent record that populates each BP log, line item, or asset 
with all the information that was generated during the workflow (or step, if it uses a terminal 
status), including the forms, documents, comments, and other data that was collected in 
Primavera Unifier during runtime. 

 For this reason, once a record, line item, or asset reaches a terminal status, that status 
cannot change. 

 Statuses assigned to links Y and Z must be terminal; they reach the end step. 

 If link W has a terminal status (Approved) and link X has a non-terminal status (Pending), the 
workflow will produce an error because the status of the step changed from a terminal to a 
non-terminal status. 

 Likewise, if link W has a terminal status (Approved) and link Z has a terminal status 
(Rejected), the workflow will produce an error because the record changed from terminal 
status Approved to terminal status Rejected. 

 A terminal status for a record can have a significant effect on business processes in that it 
can be made to trigger an automatic action in Primavera Unifier. You can use a terminal 
record status to trigger certain functions outside the scope of the business process or to 
make external data accessible from the business process (see Statuses Tab (on page 
221)). 

To specify the link's action 

1) In the Workflow Designer window, double-click a line or elbow connecting two 
non-conditional steps. The Action Properties window opens. 

2) Use the information in the table below to complete the fields on this window. 

3) Click OK. 

In this field: Do this: 

Action Name

Enter a name that describes the action the link is taking. Use a verb 
that designates the action being taken, such as "Send for Review," or 
"Return for Clarification." You can enter a total of 40 characters for the 
Action Name. 

Description

(Optional) Enter details about this action and what it is designed to do. 

This can be helpful to others in understanding how this action works, 
particularly if it has a special behavior, such as automatically creating 
another record. You can enter up to 4000 characters. 
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In this field: Do this: 

Record 
Status

Choose the status of the record at this point in its progress through the 
workflow; for example, "Pending" for a transmittal in the approval 
process, or "Approved" for a transmittal enroute to the end step in the 
workflow. 

This is the status that will appear on the form the users see in 
Primavera Unifier whenever they open a task. 

The list of possible record statuses resides in uDesigner's 
Administration mode under the Data Structure node of the Navigator. If 
the status you want is not on the list, return to Administration mode and 
create it. 

Note: For non-workflow business processes, inactive statuses are not 
displayed to users when they create new records. 

Select data 
elements to 
capture 
action taken

(Optional) Include these data elements if you want to gather information 
on the action that was taken on this link. By using these options, you 
can "stamp" the form with this information This information can also be 
included on the business process log so that users can see this 
information quickly, without having to open a record. 

Taken By Specify the user picker or a data picker (one based on the 
user attribute form) on the upper form of the business process that will 
contain the name of the user (or the last user) who accepted the task. 

Action Name Specify the name of the field that describes this link's 
action. 

Taken On Specify the date picker on the form that will contain the date 
and time the action was taken. 

Generate 
Event 
Notification

This is a checkbox. If checked, will have an impact on the business 
process record during runtime. When checked for an action in the 
workflow, in uDesigner, (when the action is taken during runtime) 
Unifier generates a notification for the users. You can select this option 
for more than one action within a given Workflow.  

Auto-create 
other record

Use this check box to instruct this action to automatically create another 
record. For more information about this setting and how to use it, see 
Auto-Creating a Record from a Workflow (on page 406). 

Aligning the Steps 

Once you have created and linked the steps, you can align the steps to improve the appearance 
of the workflow. You can align the steps both horizontally and vertically. 

To align steps 

1) Select all the steps you want to align by pressing Shift and clicking the left mouse button on 
each of them. 



Designing Workflows

403

2) Click the Align tool on the toolbar and select Vertical or Horizontal. 

Designing a Sub-Workflow 

A sub-workflow is a grouping of one or more steps into a mini-workflow. Sub-workflows can 
simplify workflow configuration and setup in Primavera Unifier by allowing you to assign 
workflow properties to a group of steps at once. You can identify a sub-workflow by color-coding 
it. 

Note: You cannot create a sub-workflow within another sub-workflow or 
create parallel sub-workflows. 

To create a sub-workflow 

1) In the Workflow Designer window, select the steps to include in the sub-workflow by holding 
down the Shift or Ctrl key and clicking the steps. 

2) Click the Sub-workflow button and select Group. The Sub-Workflow Properties window 
opens. 

3) Enter a Name for the sub-workflow. 

4) (Optional) Enter a Description for the workflow. 

5) To help identify it from the rest of the workflow, you can color code it. To color-code it, click 
the Select button and select a Color. 

6) The selected steps will be outlined in the chosen color, and the sub-workflow steps will 
appear as a barred rectangle: 

7) Click Ok. 

To add or remove a step from a sub-workflow 

1) Select the sub-workflow. 

2) Click the Sub-Workflow button and select Ungroup. 

3) Select the steps to add or remove. 

4) Click the Sub-Workflow button and select Group (to add) or Ungroup (to remove). 
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Adding a Conditional Step 

A workflow can contain a conditional step that must be resolved before the workflow can 
continue. Conditional steps entail separate (conditional) routing. This routing is triggered at the 
step by a field condition or situation you can specify in uDesigner. An example of conditional 
routing is a purchase order that follows one path through a workflow if the total amount is less 
than a certain amount, and follows another path if it is equal to or greater than that amount. (The 
trigger value for the field on the conditional step's form is assigned when the business process is 
set up in Primavera Unifier.) 

When the workflow reaches a conditional step, the business process tests the value of the field 
on the form to see whether or not it meets the trigger value. 

To design a conditional routing, in uDesigner, you need to specify: 

 Which step spawns the conditional routing 

 Which field(s) in the form attached to the step contain the trigger value(s) that will be 
tested by the BP 

When you define the trigger condition, you can specify the data elements that must be satisfied 
to activate the trigger. For example, on a purchase order, conditional steps could be triggered by 
a combination of the dollar amount and the region where the purchase is being made. A cost 
above $500,000 in New York may not trigger a conditional step, whereas a cost above $500,000 
in Georgia may. 

Tip: If you are creating a business process that allows users to add line 
items, keep in mind that users may be able to add line items after the 
conditional routing step. For instance, using the purchase order 
example, if the P.O. is under $1000 and is routed appropriately, a 
subsequent user could add line items that push the total over $1000, 
thereby bypassing the "over $1000" workflow. A way to prevent this is to 
create an additional Action form for the BP that prevents adding line 
items and use that as the Action form for the workflow steps that follow 
the conditional routing step. 

To add a conditional step 

1) In the Workflow Designer window, click the Condition button. 

2) Click on the canvas. The conditional step appears as a diamond shape. 
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You can include multiple conditional routings in a workflow, but only one condition per step. 

3) Specify the conditional step's properties. 

Use the instructions under Adding Steps to the Workflow (on page 396). 

4) In the Trigger Element field of the Step Properties window, click the Add button and select 
the field (data element) that will serve as the trigger for the conditional step. 

This is the trigger that must be resolved before the workflow can continue. The value of the 
data element at runtime will dictate whether or not the conditional step must be resolved. 
(These trigger values are assigned when the business process is set up in Primavera 
Unifier.) 

You can specify multiple data elements. If you do so, the values of all the data elements 
must be met in order to trigger the conditional step. 

Notes: 

 You cannot use a multi-select data element as a trigger element 
because the trigger element feature does not recognize the commas 
that separate the values in these elements. 

 You can use data elements that have been linked in shell hierarchies. 

5) Connect the conditional step to other steps as appropriate. 

A conditional step must have one incoming connector and two outgoing connectors. 
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6) Denote the links as conditional: 

a. Double-click the line or elbow connecting the conditional step (the diamond) to another 
conditional step. The Conditional Properties window opens. 

b. In the Conditional Name field, enter a name for the action of the conditional link; for 
example, "Under 1 Million" to route an invoice approval to one authorizer, or "Over 1 
Million" to route it to another authorizer. 

Auto-Creating a Record from a Workflow 

Primavera Unifier maintains a record of each business process once it reaches a terminal status. 
This record contains all the information that was generated during the business process, 
including the forms, documents, comments, and other data that was collected in Primavera 
Unifier during the BP's runtime. 

Note: You cannot auto-create company-level or single-record BPs. 

For workflows that would benefit from this feature, you can design a workflow that will 
automatically create a new record after the form reaches a specific step. The new record will 
contain an exact duplicate of the information in the original record—all the information that was 
contained in that transaction, including forms, attachments, and comments. In Primavera Unifier, 
the user who owns the original record becomes the owner of the auto-created record. After 
being created, the new record is sent automatically to the next step in the workflow. 

For example: A user wants to create a service request that is routed for approval, upon which a 
work order is auto-created. When the service request is complete, the work order will 
automatically create the charges against the work order. 

Another example: A user wants to create a request for bid that is routed for approval, upon 
which a bid is auto-created and sent to vendors. Once the submitted bids are collected, a 
contract will be auto-created and sent to the winning vendor. 

In addition to creating a new record, you can direct the original record to automatically populate 
the upper form and detail form information on the new record. This auto-population works only if 
the data elements of the form fields are the same on both records; that is, if a field using the 
same data element appears on both records, then the text in the original record can be entered 
automatically in the new record. 

 For multi-tab forms, only the system-defined Standard tab will be auto-populated. None of 
the data in user-defined tabs will migrate to the new record. 

 The fields will not show auto-populated values until the user accepts the task. 
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To auto-create one record from another 

1) On the Workflow Designer window, double-click a line or elbow connecting two 
non-conditional steps. The Action Properties window opens. 

2) Select the Auto-create other record check box. 

3) Click the Add button. uDesigner displays a list of all the business processes to which you 
have access. 

4) From the list, choose the business process you want the record to create. 

5) If you want to auto-populate fields in the new record, click the Auto Populate drop down list 
and choose what you want to auto-populate—upper form (header) fields only, or both upper 
and detail form fields for the Standard tab. 

Note: Auto-populated field values will override any field values that have 
migrated with the auto-creation. 

6) Click OK to save your changes. 

To indicate that the linking action will automatically create a new record, uDesigner inserts an 
S icon in the link. 

If an action is not going to auto-create a new record, you can select the Do not evaluate 
condition cased autocreation checkbox to avoid using unnecessary processing power of 
executing or evaluating BP creator conditions when there are no BP creators on this action. This 
option is unchecked by default.  

Viewing a Summary of the Workflow 

To help you verify the workflow, you can view it as a text summary in a table format if you prefer. 

To view a summary of the workflow 

From the Workflow Designer window, click the Summary button. The Workflow Summary 
window opens, displaying all workflow steps, including sub-workflows, the forms attached to 
each step, as well as the links and conditions attached to the step. A blue circle appears next to 
any action name that is marked as a "resolving action." This format can help you verify the 
workflow against your outline. 

The Workflow Summary window has the following columns:  

 Step Name

 View Form

 Edit Form

 Action Name

 Record Status (after action)
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 Event Notification (after action)

 Condition Name

 Next Step

Error-Checking the Workflow 

Error-checking the workflow validates it for completeness. If the check finds errors, uDesigner 
displays a window listing them. 

To error-check the workflow 

1) On the Workflow Designer window, click the Error Check button on the Toolbar. If there are 
errors in the workflow, an Error Check window opens. 

2) Fix any errors listed; then click the Error Check button again to recheck the workflow. 

3) Repeat step 2 until the window shows no error messages. 

Arranging the Step Order To Aid the Setup Process in Primavera Unifier 

As you design a workflow, you are likely to add steps to the canvas in a random order and 
rearrange them as you work on the design. This is usually how workflows are designed; 
however, it has an inconvenient affect on the process of setting up the workflow in Primavera 
Unifier. When you configure the workflow in Primavera Unifier, the steps appear on the Settings 
tab in the order you added them to the canvas. This is not likely the order they were in by the 
time the workflow design was finished, nor the chronological order the Primavera Unifier 
administrator needs to see them in when configuring the workflow. 

To ease the configuration process, uDesigner provides a "Step Order" feature you can use to 
arrange the steps in chronological order for the Primavera Unifier administrator. This feature is 
for ease of use in Primavera Unifier; it makes no changes to the workflow itself. 

The Step Order feature includes another advantage: It can organize the workflow actions into a 
logical, easy-to-use list for the user. The Workflow Actions option on a BP form may list an 
extensive number of actions. 

By listing the actions in descending order by "most-used," you can increase the user's efficiency 
and prevent them from scrolling through long lists for the actions they will be using most often. 
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To arrange the step and link order 

1) In the Workflow Designer window, click the Step Order button. The Step and 
Sub-Workflow Order window opens. 

The window divides the workflow into steps, sub-workflow steps, and link actions. 

2) To arrange the steps in their logical workflow order, highlight each step and use the Move 
Up or Move Down buttons. 

3) Use the Step Links section to arrange the actions into a more usable order for the list that 
appears when the user clicks the Workflow Actions drop-down list on the form. 

4) Click OK. 

Printing a Workflow 

You can create a PDF copy of the workflow, which you can then print or save to your local drive. 

To print a workflow 

1) On the Workflow Designer window, click the File menu and choose Print to PDF. 

2) Choose to Save the PDF file to your local system, or Open the file (as a PDF file). 

3) From the PDF file, click File>Print. 

Copying a Workflow 

You can copy an existing workflow and create a new workflow.  

To copy an existing workflow: 

1) Go to your Company Workspace (Admin mode). 
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2) Click to expand the uDesigner module. 

3) Go to your business process. 

4) Click Workflows sub-node to open the Workflow log. 

5) From the menu, click Copy and select Copy From to open the Business Process 
workflows window 

In the Business Process Workflows window you have the following menu options that enable 
you to copy a workflow or find a workflow that you want to copy: 

 Copy

Use this option after you select the workflow that you want to copy to the destination BP 
design. You can copy one workflow at a time, only. 

 Find

Use this option to find and search for workflows based on Business Process, Workflow 
Name, and Description fields. 

 Close Window

To close the Business Process Workflows window. 

In the Business Process Workflows window you have the following columns that provide 
details for each available workflow: 

 Business Process

This column displays a list of BPs that are workflow BPs. The BPs can be Company-level or 
the Project-level BPs. 

 Workflow Name

The name of the workflow. The workflow can be in draft (Status = Draft) or complete (Status 
= Complete). Published workflows are also listed. 

 Description

The description of the workflow, if available. 

When you select a workflow from the Business Process Workflows window and click Copy, 
the Workflow Properties window opens. In this window you have the following fields: 

 Name

The name of the copied workflow. If the destination BP contains a workflow with the same 
name as the one copied, then Unifier adds the words "Copy of" to the beginning of the 
workflow name. 

 Description

Enabling you to provide a brief description about the copied workflow. 

When creating a new workflow by using a copied one, the following data will be copied: 

 All the steps and their names. 

 All action links. 

 All sub-workflows, if any exists in the source BP design. 

 The S-Step auto-creation process, if any, along with the BP name, 

 Data associated with each of the steps: 

 Step Name 
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 Description 

 View Form 

 Edit Form 

 Trigger Element 

If the trigger elements, and the workflow action fields such as the ones stated below do not 
exist in the destination BP, then these Data Elements (DEs) will not be brought over; 
however, if the DEs already exist, then the workflow will have these DEs. 

 Select Data Elements to capture Action Information 

 Taken By 

 Action Name 

 Taken On 

When creating a new workflow by using a copied one, the following data will not be copied: 

The action forms and view forms, associated with the workflow. 

To ensure that the action forms and view forms, associated with the workflow, are copied to 
the destination BP, the user must access the individual step and do the setup of the forms 
again. 

When creating a new workflow by using a copied one, Unifier will notify you whether or not: 

 All of the forms defined in the workflow exist. 

 Any trigger elements exist in the Business Process (BP). 

 Any of the Data Elements (DEs) that exist in the BP are updated. 

Creating a Business Process Log (Standard or 
Picker) 

This topic explains how to create logs for business processes.  

Note: The default elements and fields (log layout, view, search, etc.) that 
are defined in the Standard Log, in uDesigner, determine the Standard 
user interface elements and fields of all logs.  

Logs appear in the right pane in Primavera Unifier. Each business process and spaces type 
populates its own log with all the records that were created whenever the business process 
completed its cycle through a workflow. The logs contain one record for each cycle of the 
workflow. 

Note: For instructions on creating a log for a manager, see "Designing a 
Log for a Manager (on page 181)." 

Each record contains all the information that was generated during the cycle, including the 
forms, documents, comments, and other data that was collected in Primavera Unifier during 
runtime. 
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Purposes of logs 

Logs are for two purposes: 

a) To allow users to select a particular record to work on, monitor the record status quickly, and 
monitor the record content. 

b) To allow users to populate pickers. 

Unifier populates most pickers with the records that you see in the logs and uses the layout 
of the headings on the logs for the layout of the picker. These logs show the records that 
were created, for the most part, with attribute forms.  

Example log:

Types of logs 

There are two types of logs you can design for any business process: 

 Standard log

This kind of log displays a flat list from which you can select a BP record, or a shell, to work 
with. The standard log is the most common log display. 

 Picker log

This kind of log displays a tree, or hierarchy, structure for BP records. This tree structure 
makes it easier for the you to view and select BP records from a log of business processes. 

A picker log must be designed for any business process that contains records that will be 
displayed on a data picker, or on a master BP log (master log). For more information about 
data pickers, see About Data Pickers (on page 195).  

For simple project logs, Oracle recommends that you design a standard log. 

If you design a picker log, then that picker log  is displayed, in the application. 

Example 

You can create a picker log for work order records that could be displayed by their status, 
such as "pending," or "complete." 

A standard log shows only a flat list of all the records, which cannot be expanded or collapsed. 

A picker log displays a tree structure where users can drill down to more specific records by 
expanding or collapsing records.  

In general, the only difference between a standard log and a picker log is that the picker log 
includes a grouping structure, but the standard log does not.  

Designing a Business Process Log (Standard or Picker) 

Since the steps are the same, use the following procedures to design either a standard or a 
picker log. 
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Important information about a business process log in Standard View

In order for the user to be able to filter for a particular field or fields, you (the designer) must add 
the fields to the standard log design manually, and then re-deploy the log business process; 
otherwise, the user will not be able to filter a record per added fields in a business process log, 
in Standard View. 

To design a business process log 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Business Processes. 

3) Open the business process for which you want to design the log and click Log; then select 
the Standard Log or the Picker Log node. 

4) Click New. The Log Page Design window opens. 

5) Complete the tabs as described in the following sections. 

The following topics explain the: 

 General tab 

 Layout tab 

 Sort Order tab 

 Find tab 


 Group By tab 

General Tab 

1) In the Name field, enter a name for the log. 

2) (Optional) In the Description field, enter text that describes the log. 

3) (For RFB logs only) In the field titled RFB view form seen by bidders, specify the view or 
action form that was designed when the bidder form was designed. 

4) Click Apply. 

Layout Tab 

Use the Layout tab to designate what data (fields) from the record should appear in the columns 
of the log. Only the fields from the upper form (including linked elements) are eligible for the log. 

For Cost-Type, Multiple-Tab BP Forms

If you include an "amount" field on the log for a line item list for a tab, a total of the line item 
amounts will automatically appear at the bottom of each numeric column on the BP form. 

To add a column of data to the log 

1) Click the Layout tab. 

2) Click Add. The Layout Header Properties window opens. 

3) Use the information in the following table to complete the column layout. 
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In this field: Do this: 

Data 
Element 
Label 

Click the down arrow and choose from the list of data elements. The list 
shows only those data elements that were on the upper form of the BP. 
If you do not see the data element, go to the upper form of the BP and 
add it. 

Data 
Element 
Name 

No entry required. This field automatically shows the database name of 
the element you selected. 

Column 
Heading 

This field automatically shows the data element label. You can change 
this field to show a different heading on the log. 

Width Enter the width (in pixels) the column should be. The default is 150.  

Alignment Choose the positioning of the data within the column, including the 
heading. Select Left, Center, or Right. 

1) Click OK. 

uDesigner displays the columns on the Log Page Design window. 

2) (Optional) To change the order of the columns on the log, use the Move Up and Move 
Down buttons. 

These buttons move the columns left or right, respectively, on the log. 

3) To add another column to the log layout, repeat steps 1 through 4. 

4) Click Apply. 

Sort Order Tab 

Use the Sort Order tab to sort the log by column order. You can determine which column to use 
as the default sort order for the Log. This allows you to choose a column to sort by initially. 

1) Click the Sort Order tab. 

2) In the Initial Sort Column field, choose the field by which you want to sort the log. 

3) In the Sort Order field, choose whether the sort order should be ascending (A-Z) or 
descending (Z-A). 

4) Click Apply. 

Find Tab 

Use the Find tab to specify search criteria for the Find feature. 

In the course of a user's work in Primavera Unifier, he or she will sometimes need to locate 
particular business process records or line items in the logs, often for the purpose of task 
management or milestone tracking. To make it easier for users to locate a record, use the Find 
tab to specify field names they can use to search for particular records. The user can also 
narrow a search by using operators on the fields, such as "contains" or "equals." 
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The following images show the Find field in Classic view at runtime. 
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The following image shows the Search window in Standard view at runtime. 
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Tip: Users can search for tasks in the various Tasks logs in Primavera 
Unifier using the field names you specify in the Find tab. You might take 
this into account when deciding which field names to include on the Find 
tab. If no fields are specified on the Find tab for a business process, the 
Find window displays the default search criteria fields, which are From 
(Company), From (User), Record Number Contains, and Record Title 
Contains. As a general rule, it's a good idea to use all the fields you 
included on the forms. 

To specify search criteria 

1) Click the Find tab. 

Use the Find tab to specify the fields on both the upper form and detail forms that can be 
used in a search. 

2) To add a field to the search list, click Add in either area of the window. The Find Properties 
window opens. 

3) In the Data Element Label field, select a field (data element) users can use to find a 
record(s) or line item(s). 

When you enter a data element label, uDesigner automatically displays the database label of 
the element in the Find Label field. This field is editable. 

4) If you want to change the name of the element to something more meaningful to the user, 
enter the name in the Find Label field. 

5) Click Add to add another data element field to the find criteria, or click OK to close the 
window. 

6) On the Log Page Design window, click OK. 
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Group By Tab 

This tab appears only if you are designing a picker log for a data picker, or a master BP log. This 
is where you can create a tree or hierarchy structure for the business process and space 
records. When the Primavera Unifier user opens a data picker on a form or a master BP log, this 
tree structure appears and makes it easier for the user to view and select records from the log. 

For more information on data pickers, see About Data Pickers (on page 195). 

On the Group By tab, you specify what fields from the form you will use to make the tree 
structure. When the business process or space type is imported into Primavera Unifier, the 
Primavera Unifier administrator will configure these fields with a query to extract the appropriate 
records from the database and display them on the data picker list or the log. 

To create the tree structure 

1) On the Group By tab, click the Add button. uDesigner opens the Add Data Element window. 

2) In the Data Element field, select the field you want to appear in the tree structure. 

uDesigner shows the label of the element in the Data Element Name field. 

3) To add another field for the tree structure, click Add; otherwise, click OK. 

The Log Page Design window displays the fields you selected for the tree structure. 

4) (Optional) If you want to rearrange the order in which these fields will appear in the tree 
structure, highlight the fields and use the Move Up or Move Down keys until the fields are in 
the order you want.  

Note: If a field in this tree structure is removed from the business 
process form or space attribute form, the Add Data Element window will 
show the removed field in red. 

Activity Attributes and Activity Picker 

You can include activity attributes in a business process, change the activity attributes values 
(such as actual dates: actual start, actual finish, and duration) from the business process, and 
update the activity sheet. In such a business process, you can use the activity picker and:  

 Update (auto-populate) the values of the activity attributes of the System Activity Sheet. 

 View the activity attributes from custom or manual activity sheets. 

Also, you can: 

 Conduct a reverse auto-populate (RAP) the activity attributes values (such as actual start, 
actual finish, and duration) from the business process and into the custom or manual activity 
sheets. 

 View updated activity attributes on a business process record as the activity attributes get 
updated using linked data element. 

To include activity attributes in a business process:  

1) Go to your Company Workspace (Admin mode). 

2) From the left Navigator, click uDesigner node to expand. 
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3) Click the Activity Manager sub-node to expand. 

4) Click Activity Sheet - Home (activity sheet attribute form) sub-node to expand. 

5) Click Picker sub-node to open the Log Page Design window. 

6) Go to the Layout tab. 

7) Click Add to open the Column Header Properties window. 

8) From the Data Element Label field, click the drop-down arrow and select a data element 
label. 

Use the Picker sub-node, which you use to define the activity picker log on a business process 
upper or detail forms in Unifier, select data elements from the manual activity attribute form.  

You can add the data elements from both the activity attribute forms (standard and manual) into 
the picker log. 

You can move (or reorder) the data elements that need to be seen in the picker log using the 
move up or move down options. The list of data elements shown in the picker log will be a union 
of data elements seen in both attribute forms. 

You can define the "Sort Order" and "Find" attributes within the picker log configuration window. 

The fields Activity ID (uuu_P6ActivityID) and Activity Name (uuu_P6ActivityName) are 
mandatory in the picker log. 

Business Process or Shells and P6 Activity Picker 

You can add a data element of data definition = P6 Activity Picker in any project-level or 
shell-level business process (upper form or detail form).  

Note: This feature does not apply to the bidder form, project or shell 
creation business process, and any resource-type business process. 

You can also add a P6 Activity Picker data element in any CBS-type shell attribute form. 

Note: You cannot add a P6 Activity Picker data element in any other 
attribute forms. 

Auto-Populate (AP) and Reverse Auto-Populate (RAP) 

You can use a P6 Activity Picker data element as a source and define auto-populate and 
reverse auto-populate relationship. All of the P6 Activity Picker data elements that are a part of 
the activity attribute forms can be used as a source, if the data definitions match that of the 
destination data definitions. 

You can reverse auto-populate all of the supported data elements int the activity attribute form 
that has the direction of Both or Input. If the user attempts to define a reverse auto-populate 
relationship for an Activity ID or Activity Name, then Unifier displays the following error message: 
This data entry is not suitable for defining reverse auto-population. 
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Linked Data Elements using P6 Activity Picker 

You can define linked data elements by using the P6 Activity Picker field through the Link 
Elements option in a business process upper form, business process detail form, or a shell 
attribute form. All of the data elements within an activity attribute form (both manual and 
standard activity attributes) are available to be added as linked data elements by using the P6 
Activity Picker field.  

The following table explains the options that are available: 

Source 

The Source field shows all of the data elements that are of data definition type as P6 Activity 
Picker. This is a required field where you can select one of the P6 Activity Picker type data 
element. 

Source Element 

The Source Element field lists all of the data elements from activity attribute form (both 
manual and standard activity attributes). This is a required field. 

Destination Element 

The Destination Element field, lists all of the data elements from Data Structure Setup that 
match the data definition of the Source Element field. 

The data elements that have been added as custom data elements, in the form, will not be 
shown in the list of matching data elements. 

Testing a Component in uDesigner 

When you have completed a business process, attribute form, shell, manager, or other 
component in uDesigner, it must be tested in Development environment before importing and 
deploying it into the Test, or Production, environment. 

Before the component is tested and published, it is important that you preview all the forms in 
the process, check them for errors, and change the status to "Complete." 

Checking for Errors 

The uDesigner error check feature validates the form for completeness. All errors must be 
corrected before you can change the status of the form to "Complete" and deploy the component 
to the Test, or Production, environment.  

The validation verifies that: 

 Any business process that is referenced on the form being validated has been imported. 

 Business process pickers are referenced correctly. 

 At least one workflow has been created for a workflow business process. 

 The auto-created BP design has been imported for any workflow that auto-creates a 
business process. 

 All action and view forms that appear in the workflow steps are included. 
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 Trigger elements have been defined for conditional steps. 

 Statuses, including terminal statuses, have been properly defined, and Inactive statuses 
have not been selected.. 

 Formula fields have been properly defined. 

 Auto-populated fields have been properly defined, and referenced processes are present. 

 Form validation rules have been correctly defined. 

To check for errors 

1) Click the Company Workspace tab and switch to Admin mode. 

2) In the Navigator, click uDesigner. 

3) Click the object that you want to work in (business process or manager). 

4) In the list, on the right pane, highlight the name. 

5) From the toolbar, click Error Check. If there are errors in the component, a window opens 
listing the errors found. 

6) Return to the form and fix any errors listed. 

7) Repeat the above steps until you have corrected all errors. 

Changing the Status to "Complete" 

During the design process, the form is in draft status. When you finish creating and 
error-checking the form and are satisfied with it, as well as any workflow(s), log, etc., change the 
status to "Complete." The form must be complete before you can deploy it into the Test, or 
Production, environment.  

Note: You cannot edit a form with a status of "complete." You can, 
however, change a completed form back to "draft" status and edit it; then 
change the status back to "complete," and redeploy it to Unifier. 
Thereafter, any new BP or other form created with the edited  form or 
workflow will reflect the changes. 

To change the status of a component 

1) Click the Company Workspace tab and switch to Admin mode. 

2) In the Navigator, click uDesigner. 

3) Click the object that you want to work in (business process or manager). 

4) In the list, on the right pane, highlight the name of the form. 

5) From the toolbar, click Status and select Complete. 

Deploying to the Test Environment for Testing 

The Test environment is where you test the component before it is imported into the 
Development, or Production, environment.  

In the Test environment, you can:  

 Test BP workflows 
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 Modify, configure, or setup BPs 

 View forms in action 

Configuring a uDesigner Component for Testing 

In the Test environment, you can test the workflows and view forms in action.  

Example 

Do the right fields become editable or read-only at the right steps? 

Are fields missing at any step? 

Does the workflow work the way you want it to? 

Ensure that you involve the people who will use the components and gather the necessary 
requirements. 

If you are not satisfied with your design: 

a) Go back to the Development environment. 

b) Change the uDesigner component (e.g., BP) status back to "Draft" in the Development 
environment. 

c) Ensure that the necessary changes are applied. 

d) Deploy the changed design. 

e) Test the design in the Development environment. 

It may take several iterations to get everything exactly the way you want it. 

To configure a uDesigner component: 

1) Click the Company Workspace tab and switch to Admin mode. 

2) In the Navigator, click Configuration. 

3) Click the component/object that you want to work in (business process or manager). 

4) In the list, on the right pane, highlight the name. 

To use the component in the Development, or Test, environment, you must configure, and set 
up, the component the same way that you would in the Production environment. 

Refer to the Unifier Administration Guide and review topics related to setting up business 
processes and manager for instructions on how to configure, and set up, a component (a 
business process or manager). 

Loading the Business Process or Manager for Testing 

In order to test the business process or manager, you need to load it into the Project/Shell in 
which it will be used and set it up for operation. 

Refer to the Unifier Administration Guide and review topics related to setting up business 
processes and manager for instructions on how to configure, and set up, a component (a 
business process or manager). 
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Modifying a Design 

You can modify your design in the Development environment, only.  

Modifying a published BP or manager design can be a simple matter of changing a field on a 
form and re-deploying the component, or it can be a delicate balancing act of making 
modifications that will affect a workflow with trigger elements and conditional steps. 

In uDesigner, you cannot edit a design with a status of "complete." You must change a 
completed component back to "draft" status and edit it; then change the status back to 
"complete," and redeploy it. Thereafter, any new records created with the edited design will 
reflect the changes. 

Before you modify a published design, familiarize yourself with what you can and cannot 
change, and the possible ramifications of a change. 

Test, Test! Test!

Making changes to a BP can have unexpected results on a business process. Test the BP 
thoroughly in the Development environment before re-deploying it. Keep in mind that a 
published BP can set internal requisites and conditions that a re-deployed BP can disrupt. You 
may encounter error conditions you did not expect.  

What You Can Change 

Following are the things you can change in a business process or manager design, with some 
caveats. 

 You can change field protocols—"editable," "required," etc. 

 You can add fields (including auto-populated fields on a  Payment Application BP, even if 
the Base Commit BP has been published). 

 You can change the fields on a log. 

 You can change "Find" fields. 

 You can change workflow schemas. 

Be aware that schemas are a combination of forms and workflows, so if you change a form, 
you have effectively changed the schema as well. 

 You can change conditional routing triggers. 

 You can change the auto-created BPs on a workflow link. 

 You can change the Default setting of Line Item Statuses for business processes. 

What You Cannot Change 

To protect the integrity of your existing records, uDesigner restricts the kinds of changes you can 
make to a published design. Following are the components you cannot change in a business 
process or manager design, with some explanations. 

 You cannot change the name of a business process or other component once it has been 
imported into production. 

 You cannot change data definitions that have been assigned to data elements that are in 
use. 
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If you change a definition, it changes the meaning of the data type and how it is used. For 
example, if you change a data definition from "currency" to "integer," it can disrupt cost 
rollups all the way to the company level. 

 You cannot change a fund code after it has been used in the system. 

 You cannot change a status value, once it is created. You can, however, deactivate it if you 
no longer want it to be available. 

 You cannot change steps and links in a workflow 

After a workflow has been published, uDesigner locks the design. The best solution is to 
design a new workflow. Specifically, you cannot: 

 Change step names 

 Add or remove steps 

 Change link names 

 Add or remove links 

 You cannot delete fields from a business process once it is active in the system. Deleted 
fields could disable a formula or cause a cost rollup, auto-population, or conditional routing to 
fail. Rather than remove the field, a safer idea is to place it in a hidden block, even if it is not 
going to be used elsewhere in the BP. 

 You cannot delete any published workflow, even if it is no longer being used. If you want to 
modify a workflow, create a new one and re-deploy the BP. 

 You cannot edit trigger elements in published workflows. You must create a new worklflow. 
In-flight records will not have any impact if the existing wokflow is inactive. 

Workflows are so integral to those business processes that use them that a deleted workflow 
will disable all the BP's configurations, setups, and records. 

 You cannot delete a work package after it exists in the system. You can, however, inactivate 
a work package as long as it is not linked to any line items that may be in the Cost Sheet. If 
you inactivate the work package, approved and completed line items linked to the package 
will not be affected, but you will not be able to link any new line items to the package. 

 You cannot change the following options in the BP General tab (navigate to the Company 
Workspace > Admin mode > uDesigner > click on a BP > click Open > click General), once 
you click Apply or OK. 

 ID 

 Type 

 Level 

 Behavior 

 Record Instances 

You can only edit the Name and Description fields. 

Integration 

Primavera Unifier integration feature imports and exports data between Primavera Unifier and an 
outside data source. Using this feature, you can import data from an outside data source, such 
as a business management system or a text file, into Primavera Unifier, and export information 
from Primavera Unifier to an outside data source, such as an accounting system database. 
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An integration interface is necessary for Primavera Unifier bulk editing feature. The bulk edit 
function works only on fields from the action form (upper form) for the current step in a workflow. 
It cannot be used to edit the following: 

 Auto-populated fields 

 Fields in a dynamic data set 

 Read-only fields 

 Fields from line items 

 System-defined fields, such as record number, status, or due date 

The integration feature supports: 

 Cost BPs 

 Line item BPs 

 Simple BPs 

 Text BPs 

 Document BPs and documents 

 Asset Manager classes 

 Code and Records-based configurable manager classes 

 Planning Manager planning items 

 Shell Manager shells 

 User Administration 

Integration operates using two methods: CSV files and Oracle Primavera Web Services. 

CSV Files 

You can use CSV files from the Primavera Unifier interface. This integration method is typically 
for bulk loading data into Primavera Unifier. It creates records and line items, and is useful for 
converting a company's legacy data into Primavera Unifier forms. 

Web Services 

Web Services works outside of Primavera Unifier. It is useful for exchanging information 
between Primavera Unifier and other applications, such as a third-party accounting system that 
needs to interface with Primavera Unifier on a regular basis to exchange cost information. To 
use Web Services, customers need a basic knowledge of XML and the GET, CREATE, and 
UPDATE calls. Using these XML calls, Web Services can: 

 Create Primavera Unifier records and line items using data from an outside database. 

 Update upper form information in Primavera Unifier on demand 

 Retrieve information from Primavera Unifier for use in an outside application. 

For more information about Web Services integration, refer to the Unifier Integration Interface 
Guide. XML integration via Web Services must be coordinated with a representative (Oracle 
Support). 
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Integration Interface 

To integrate data using either method, you need to create an integration interface in uDesigner. 
This interface specifies what fields in the Primavera Unifier forms you want to create and 
populate. 

For CSV, this interface becomes a template in Primavera Unifier that users can use to enter 
data. After users enter data into the templates, they must import the template back into 
Primavera Unifier to create and populate specific upper or detail forms. 

For Web Services, this interface is used to validate the data that is imported into Primavera 
Unifier. For example, the interface will be used to verify that all required fields are present and 
that the pull-down lists contain the correct information. 

In uDesigner, the interface design consists of upper and detail forms, much as it does in 
business process design. The upper form of an integration interface collects the upper form 
information of a business process or attribute form. The detail form collects line item information. 
In uDesigner, you can create the integration interface for a business process or other 
component (such as an asset or a planning item) as you create the component itself. 

Creating an Integration Interface 

To create an integration interface, you need to use an action form for a business process, or an 
attribute form for managers. With these forms, you can verify that all required fields are included 
in the interface design. Once you have specified the fields you want on the interface, you need 
to create an interface template (a CSV file). This template, along with the other details of the 
integration interface, is imported along with the BP or manager into Primavera Unifier. 

Tips for a successful interface design

 Data elements that are marked as required fields on the validation form should be included 
in the integration interface and should have the direction set to Input or Both. 

 Standard data elements can only have a direction of Output. Avoid using them if you plan on 
using CSV integration for input. 

 Be sure all field labels on a form are unique. If your form contains two fields with the same 
label, Primavera Unifier will stop the integration and issue an error message. To avoid this, 
be sure that all field labels on a form are unique. For existing forms, either remove the 
duplicate from the integration interface, or change one of the duplicate labels to something 
unique. (Changing the label will affect all forms in which that field (data element) is used. 

 You cannot override the template project currency using the Project/Shell Creator business 
processes. 

 CSV import is only available for a Simple-type Project/Shell Creator business process. 

 Microsoft Excel truncates csv files with 15 or more rows and drops the additional commas 
from the 15th row onwards, resulting in an error when you try to import the file. You can 
avoid this issue for Unifier users by placing a required field as the last column of the design, 
and therefore, avoid having empty columns at the end of the file. 

 If you add new data elements to your forms after creating the integration interface, they will 
not automatically be added to your existing integration design; you must add them manually 
if you want to include them in the design. 
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 If you remove a data element from a form after creating the integration interface, the data 
element will not be automatically removed from the interface design; you must remove it 
manually to avoid an error. 

 If you change the design of your integration interface, be sure to export the new version of 
the xml or csv template first, before importing new records. 

 Unifier can update Workflow BP records with the workflow details, and uses the step action 
form for validation. This enables an integration user to use the workflow step form to 
validate, when creating or updating a Workflow BP record through the new Rest Services. 
Also, when an integration form is defined in a Workflow BP, the following note is displayed 
under the Validation Form drop-down field: Note: The Validation Form will be used for 
business process methods of REST Web Services V1 type. This note is not available for 
Non-workflow BP records and other attribute forms in uDesigner. 

 Unifier does not preserve, or retain, the query conditions for BP pickers that have been 
enabled to receive values through any type of integration. Oracle recommends that you use 
BP data pickers instead of BP pickers. In addition, when you are using BP pickers ensure 
that the display element value is unique; otherwise, the integration will fail if multiple 
business process records with the same display element value exist.  

Creating an Upper Interface 

The upper form of an integration interface collects the upper form information of a business 
process. The integration upper form is where you choose the form that verifies the required 
fields. Be sure you include all the required fields from the form you choose. 

To create an upper integration interface 

1) Click the Company Workspace tab and switch to Admin mode. 

2) In the left Navigator, click uDesigner > Business Processes.

3) Open the business process and click the Integration > Upper in the left Navigator. 

4) Click the New button. The Upper Design window opens. 

5) Enter a Name and Description for the interface. 

6) In the Validation Form field, select the upper form you want to use to verify the required 
fields for the interface. 

The list displays only the action forms that were created for the business process. 

Notes:  

 Images are not supported for import through CSV, MS Excel, and web services. You 
must ensure that the validation form that is used for creating the record does not include 
image picker fields.  

 Required fields in a hidden block of the form will not be exposed in the Import template. If 
the hidden fields are a part of the validation form, then the import will fail. It is important 
that the validation form, used in the integration interface, is designed correctly to prevent 
import errors. 

7) Click the Data Elements tab. 

8) To add a field to the interface, click Add. The Add Data Element window opens. 

9) In the Element Label field, choose the field you want to add to the interface. The Data 
Element field will show the actual name of the data element you chose. 
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10) In the Direction field, select how the interface should direct the data in this field: 

 Input means the data will be imported into Primavera Unifier, using either csv or xml 
format, to create records or line items. 

 Output means the data will be exported from Primavera Unifier via Web Services, using 
xml format. 

 Both means the data will be available for both import and export between Primavera 
Unifier and an outside system via Web Services, using xml format. 

11) Click OK. 

To change the order of the elements on the form 

Once you have added elements to the form, you can rearrange the order of their appearance on 
the Data Elements tab in two ways: 

 Using the Move Up and Move Down keys 

 Changing the order of the rows by editing the Row column 

Integration and QBDE 

The Upper form of the Integration interface collects all of the data elements from the upper 
form of a business process.  

Unifier will dismiss direct QBDE value updates, if:  

a. The "refresh" condition has not been defined, or  

b. The "trigger element" is not updated through input request. 

Go to uDesigner > Business Processes > Asset - Home > Integration node > Upper
sub-node > Upper design window > Data Elements tab > Element Label column: "Status" > 
Data Element column: "Status" > Direction column: "Both" 

Existing users 

If the Direction column value is set as Both, or Input, for the QBDE, then Unifier will dismiss 
these direction values (and direct updates) and will evaluate the query conditions based on the: 

a. The "refresh" condition, or  

b. The "trigger element". 

Using the Move Up/Move Down keys 

1) On the Data Elements tab, highlight the data element and click the Move Up or Move 
Down key until the element is in the order you want. 

2) Click OK. 

Editing the Row column 

1) On the Data Elements tab, highlight (or double-click) the row number of the element you 
want to reorder. 

2) Enter the new row number the data element should occupy. 

3) Repeat step 2 for any other data elements you want to reorder. 
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4) Click the Update Order button; then click OK to save the changes and close the window. 

Row Numbering 

Row numbering follows a relative numerical progression. 

Row numbers on the list start at 1. When you change the order of the rows, you can enter just 
about any number; even positive, negative, and duplicate numbers. uDesigner will re-sort the 
rows by retaining the relative order of the numbers you enter.  

If you enter this: This happens: 

A negative number (e.g., -100) 

The row will move to the top, becoming row 1. If 
you enter two negative numbers, the "most 
negative" number becomes row 1, and the "next 
negative" number becomes row 2. 

Zero (0) 
The row will move to the top, becoming row 1 (or 
the row following any negative number you 
entered). 

A number greater than the existing 
number of rows (e.g., 100 when 
there are only 50 rows) 

The row will move to the end, becoming row 50. If 
you enter two numbers greater than the existing 
number of rows (e.g., 100 and 101), the sort will 
retain the order of the numbers. In this example, 
100 and 101 will become rows 49 and 50. 

A duplicate number (i.e., the same 
number for two or more different 
rows) 

The duplicate-numbered rows will become 
adjacent rows (in no specific order). 

Creating a Detail Interface 

A detail integration interface will collect line item information from the detail forms of business 
processes and the attribute/detail forms of managers. You can include any field on the detail 
form. A validation form is not necessary because the required fields are specified on the 
interface upper form (if there is one). 

To create a detail integration interface 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click uDesigner > Business Processes.

3) Open the business process or manager attribute form and click the Integration > Detail in 
the left Navigator.node. 

4) Click the New button. The Design window opens. 

5) Enter a Name and Description for the detail interface. 

6) Click the Data Elements tab. 

7) To add a field to the interface, click Add. The Add Data Element window opens. 
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8) In the Element Label field, choose the field you want to add to the interface. The Data 
Element field will show the actual name of the data element you chose. 

9) In the Direction field, select how the interface should direct the data in this field: 

 Input means the data will be imported into Primavera Unifier, using either csv or xml 
format, to create records or line items. 

 Output means the data will be exported from Primavera Unifier via Web Services, using 
xml format. 

 Both means the data will be available for both import and export between Primavera 
Unifier and an outside system via Web Services, using xml format. 

10) Click OK. 

Creating an Integration Template 

To create a template for a business process, you must define Integration in the business 
process. The integration template is the structure that imports or exports the data that you 
defined in the Integration forms. 

To create the template 

1) Click the Company Workspace tab and switch to Administration Mode. 

2) In the left Navigator, click Business Processes or select the manager for which you want to 
create the integration template. 

3) On the right pane, select the business process or manager attribute/detail form. 

4) Click the Integration button at the top of the right pane and choose what template you want 
to create: 

 Input CSV Template to create a csv template to import data into Primavera Unifier 

 Input XML to create an xml template to import data into Primavera Unifier using Web 
Services and uLink 

 Output XML to create an xml template to export data from Primavera Unifier using Web 
Services 

When you specify what template you want to build, uDesigner takes the fields you specified 
and builds the csv or xml template, mapping field to field. 

A "file download" notification appears, asking if you want to open or save the template file. 

5) Open the file if you want to review it, or click Save to save the file. 

You might want to give the file an easily recognizable name for the Primavera Unifier users. 

Upper Form Templates 

For most companies, the upper forms in business processes contain many of the same fields. It 
can be difficult to ensure that forms are consistent, with fields in the same location for similar 
forms. To make creating upper forms easier, and reduce the chances of errors when 
modifications are made, you can create templates for upper forms so that you do not have to 
design and edit each one manually. When you add blocks from a template to an upper form, the 
template becomes linked to the upper form so that any changes you make to the template can 
be quickly and automatically "pushed" to the upper form. 
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A template provides only a layout of fields for the upper form. Once a template layout is on the 
form design and linked to the template, you can use all the design features for the fields, such as 
formulas, auto-population, and dynamic data sets; but you: 

 Cannot add, remove, or rearrange the template fields. 

 Cannot move fields into or out of the template block. 

 Cannot link template elements. 

The procedure that follows explains how to create a template. 

For information on how to use these templates to design an upper form, see Adding Blocks to 
the Attribute Form (on page 175). 

Creating a Template 

You can create a template manually, from a snapshot of the template, or copy a template from 
another business process. 

Template "Can's" and "Can'ts"

 When you are creating a template, be aware of the following: 

 The template provides only a layout of fields for the upper form. 

 You can make fields in the template editable, required, or read-only. 

 You cannot create dynamic data sets in a template. 

 You cannot link elements in a template. 

 You cannot validate the fields in a template. 

 You cannot see a preview of the template design. 

 You cannot use any of the functions that are available on the layout properties, such as 
formulas or auto-population. 

To create a template manually 

1) Open the business process for which you want to create a template and click Templates > 
Upper Forms in the Navigator. 

2) From the New menu, choose Manual. A Form Design window opens. 

3) Enter a name and description for the template. 

The name must be unique. A description is optional, but recommended. 

4) Click OK. uDesigner displays the name of the template on the right pane. 

5) Double-click the template name to open the design window. The Form Designer window 
opens. 

6) Create the template using the instructions under "Adding Blocks to a Form (on page 
271)" and also "Adding Fields to the Form (on page 304) and Adding Blocks to a Form
(on page 271). 

To copy a template from another business process 

1) Open the business process for which you want to create a template and click Templates > 
Upper Forms in the Navigator. 

2) From the New menu, choose Copy From. The BP Template Forms window opens, showing 
a list of the upper form templates that have been created for this business process. 
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3) Select an upper form from the list and click Open. A Form Design window opens. 

4) Enter a name and description for the template. 

The name must be unique. A description is optional, but recommended. 

5) Click OK. 

uDesigner copies the layout of the template to the template you are designing. At this point, 
you can edit the template. To edit the template, use the instructions under "Adding Blocks 
to a Form (on page 271)" and also "Adding Fields to the Form (on page 304)." 

Using a Template In a Design 

Once you have created a template, you can add it to the design of the upper form when you add 
blocks to the form. For information on adding template blocks, see Using a Template in a 
Design (on page 268). 

Updating an Upper Form Using a Template 

Once a template has been used in the design, you can make changes to that template and push 
those changes to any upper form that is linked to the template. 

To push template changes to upper forms 

1) Open the business process with the upper form(s) you want to update and go to Templates 
> Upper Forms in the Navigator. 

2) On the right pane, select the name of the template you want to use to update the form(s). 

3) Click the Update Forms button. uDesigner will ask you to confirm the update. Click Yes. 

uDesigner updates all upper forms in the business process that are linked to this template. 
Here is what the template will update: 

 Any block label name, width, or position change 

 Show or hide setting for the block border or label 

 Blocks added to the template will be added at the end of the form 

 Field positions, to reflect a change in the template (however, field settings, such as 
editable or read-only, will not be updated) 

 Fields added to the template will be added to the form and will reflect the editable, 
required, or read-only settings from the template. 

Note: This is an "all or nothing" operation. If uDesigner finds any errors, 
it will not update any of the upper forms. For example, if the template 
does not exist in an upper form, or if you have added a field to the 
template that already exists on the form, the update will fail and 
uDesigner will display a window listing the errors. 

Unlinking an Upper Form from a Template 

When you unlink a form from a template, uDesigner leaves the block on the form design; 
however, the fields in the block are now available for any of the field functions, such as formulas 
or auto-population. 
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To unlink the form from a template 

1) Open the business process with the template you want to unlink and go to Templates > 
Upper Forms in the Navigator. 

2) On the right pane, select the name of the template you want to unlink from the form. 

3) Click the Usage button. The Template Usage window opens, showing a list of all the upper 
forms the template is linked to. 

4) Select the upper form you want to unlink and click the Unlink button. 

5) Click Close Window. 
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